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Introduction to Automation Anywhere

Automation Anywhere allows you to create automated tasks with ease. It's intuitive interface provides you the essential features to
record, modify and run tasks that range from simple to more complex ones.

This topic provides a summary of features available in Automation Anywhere Client . It also provides the necessary information to dir-
ect you to related topics.

Note: For prerequisites and setup details, refer the Automation Anywhere Enterprise - Installation
Guide that is shipped with the product.

Client Dashboard - Overview

The Client Dashboard basically comprises of the Menu Bar, Tool Bar, Automate & Manage Panels, Task Panel, and Feature Panels.
Collectively these allow you to create, record, run and modify your Bots.

The Tool Bar

The Tool Bar (located below the menu bar) is a combination of tool buttons and functions for recording, running and modifying tasks:

l Record tasks with different recording methods available on the 'Automate' window.



Copyright © 2018 Automation Anywhere, Inc. 4 https://support.automationanywhere.com

Refer Selecting Recording Methods for details.

l Record keystrokes as well as mouse clicks and movements.

Refer Using the Screen/Standard Recorder for details.

l Run the selected task

Refer Running a Task for details.

l Modify the selected task using the Workbench.

Refer Using the Workbench for details.

ROI

It displays the return on investment (ROI) accrued through use of Automation Anywhere. Click to launch the ROI calculator.

Refer Using the ROI Calculator for details.

Note: While recording and running automated tasks ensure that you follow best practices documented
in the help topic Best Practices for Recording/Running Tasks.

Additionally, Automation Anywhere offers features to troubleshoot in the form of 'Search Help', 'Chat' and 'Client Notifications* '.
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l Access the Automation Anywhere online knowledge base with the 'Search Help' feature.

l Chat with our support executives with the 'Chat' feature.

l Receive trial status, task failure and external notifications. Reference Automation Anywhere Client Notifications for details.

Automate

The Automate panel allows you to automate your processes by combining TaskBots, MetaBots, and Workflows.

You can find all automation tasks under the Tasks tab. These are displayed in folders; clicking each folder will navigate to the relevant
Task List visible to the right. Right click a folder to open, create, rename or delete that folder:

A. Tasks

The Tasks list, which takes up most of the work space, displays relevant task details in columns such as File Name, Description,
Created At, Duration, Size, Hotkeys (if any) and Status etc.

 Tip: Select column view from View > Column Displayed

Located at the top-most right corner of the Task List are buttons that enable you to delete, create an exe and upload the selected task.
Alternately, click the Action drop-down button to carry out task relevant actions such as run, edit, upload*, copy, rename, locate and
send.

https://support.automationanywhere.com/hc/en-us/articles/230199308-Automation-Anywhere-Client-Notifications
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B. MetaBots

The My MetaBots List shows the MetaBots that are designed by you. A MetaBot is an automation blueprint of an application that can
be re-used to optimize processes. They help you standardize your processes end to end.

MetaBots enable you to create automation building blocks that capture information in the form of visuals or application APIs. These can
thereon be integrated as commands and further leveraged by varied processes to deliver value at multiple levels.

Refer Introducton to MetaBot Designer for details.

C. Workflows

It helps you build process flow diagrams in a graphical environment. These you can subsequently use to build and run automated
tasks in the program.

Refer Using the Workflow Designer for details.

Manage

Manage panel has features that allow you to manage your automated bots. These include: 

A. Repository

Communicate with your Control Room to upload and download TaskBots, MetaBots, IQBots, and Workflows.
Refer Uploading and Downloading Tasks and Dependencies for details.

B. Schedules

It is a convenient facility to manage automated Bots on time based scheduling capabilities. You can schedule to run the TaskBots daily,
weekly, monthly or with a trigger event.
Refer Using the Schedule Manager for details.

C. Triggers

It provides a unified view of the triggers that are connected to your tasks. Use it to enable or disable selected or all triggers as well as
add, modify and delete specific triggers connected to a task.
Refer Using the Trigger Manager and Adding Triggers to a Task for details.

D. Reports

It provides graphical reports that display the status of tasks and workflows, as well as the ROI over time.
Refer Using the Report Designer for details.

E. Control Room

This launches the Control Room to which you are connected. Use the credentials provided by the Control Room admin to login.

Panel for Task Relevant Activities 

Below the Task List is a panel that displays task related Properties, Schedule and Trigger in the form of tabs.

A. Properties

View and set general properties such as allocating priority status or specifics such as frequency/conditions to repeat the selected task,
adjusting speed, email notifications, hotkeys, security parameters to ensure authorized users run the task etc.
Refer Setting Task Properties for details.

B. Schedule

Schedule your automated tasks to run at preferred times, without requiring supervision or intervention.
Refer Scheduling Tasks using the Scheduler for details.

C. Trigger

Connect a trigger type to the selected task. It automatically runs the task in response to an event that occurs on your computer.
Refer Adding Triggers to a Task for details.
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Description/Notes Panel

An additional tab towards the bottom right is the Description/Notes panel, which allows you to enter free text for selected task. The text
can be edited if and when you modify the task.
Refer Viewing and Setting General Properties for details.
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Understanding the Features and Benefits

Automation Anywhere is intelligent automation software, providing unparalleled performance and scalability for greater efficiencies in
your business processes.

Capabilities: What Does Automation Anywhere Offer?

Automation Anywhere helps you to optimize the time spent on running tasks by providing the following capabilities:

l Transform a repetitive, 20-step process to a single mouse click or keystroke.

l Run scheduled tasks anytime by using powerful task scheduling, even when computer is locked.

l Automate scripts that exist in disparate formats.

l Easily manage automated processes across a single machine or multiple machines, and across a division or an enterprise.

l Create automation tasks in minutes: record keystrokes and mouse clicks, and use easy, point-and-click wizards.

l Easily manage automation users with a scalable server that provides true collaboration.

l Maintain centralized systems for backup, security, and resources.

l Capture and reuse automated processes in a central repository.

l Manage job scheduling and execute batch data processing with ease.

l Automate FTP/SFTP processes.

l Download, upload, schedule & run tasks in multi-user environments like Citrix and Terminal Server.

l Scale and extend AAE platform with MetaBots Designer to serve unique business needs. Learn more.

Unique Features: How Do We Do It?

Automation Anywhere provides the following features, making it the only solution in the market to offer complete automation cap-
abilities:

l Automation Technology that quickly automates complex tasks, with no programming required, and is highly reliable and accurate.

l Centralized Enterprise Control Room that makes it easy to set up and maintain automated processes, users, and client machines.

l Industry-leading Web Recorder and Object Recorder that recognize objects, even when they move position.

l Over 550+ actions available, including:

1. Active Directory support for user/client management

2. Conditions and loops

3. User prompts

4. File, database, and system management

5. High-speed replay of automated tasks

6. Automatic email notifications

7. Task chaining

8. Hotkey setup and management

9. User-defined and system variables

10. Advanced error logging

11. PDF automation

https://support.automationanywhere.com/categories/20151068-MetaBot-Designer-Documentation


Copyright © 2018 Automation Anywhere, Inc. 9 https://support.automationanywhere.com

Benefits: Why Do I Want To Use This Solution?

l Enable your teams to be 30-80% more efficient.

l Eliminate human error in data entry processes.

l Improve collaboration between employees and divisions.

l Increase transaction speeds.

l Reduce costs and achieve higher ROI on your existing IT systems

l Integrate multiple, disparate systems and data, including legacy systems, ERP systems, partner data, and Web portals.

Value: What Can I Do With Automation Anywhere Client?

Automation Anywhere helps companies achieve process consistency across a team, department, division, or enterprise by automating
and managing workflows, processes, and tasks.

Some of the processes you might consider automating include:

l Time-consuming data entry processes like:

1. Checking inventory

2. Re-ordering supplies

3. Formatting and running reports

l Logging into websites, searching websites, submitting web forms, or updating records on a website.

l Managing ERP front-end processes, including SAP, Oracle Applications, Peoplesoft, MS Dynamics, Salesforce, and more.

l Automating data transfers, including importing/exporting data between applications or files.

l Use the Automation Anywhere Object Recorder to manage and execute Windows controls as a background process.

l Automate routine backups and file management tasks.

Automation Anywhere is the most complete business process automation solution available today!
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Verifying Automation Anywhere System Requirements

This section helps you determine whether your system has the proper hardware and software to install Automation Anywhere. Before
installing the Automation Anywhere, verify that your environment supports the following requirements.

Operating Systems

(32-bit and 64-bit OS versions are supported.)

l Microsoft Windows Server 2016 - Datacenter Edition

l Microsoft Windows 10* - Pro / Enterprise Edition

l Microsoft Windows Server 2012 R2 - Standard Edition

l Microsoft Windows Server 2012 - Standard Edition

l Microsoft Windows Server 2008 R2 - Standard Edition

l Microsoft Windows 8.1/ 8 - Pro / Enterprise Edition

l Microsoft Windows 7 SP1 - Standard / Professional Edition

*With certain limitations, viz. Microsoft Edge Automation and triggers on Windows 10 Apps are not supported.

l Processor speed: Recommended - 3.5 GHZ+ with 4 Cores and above

l RAM Recommended: 8 GB or higher

l Hard Disk capacity: 300 MB of free hard disk space for installation

Note:

l On an average, an Automation Anywhere script is approximately 100-150 KB. Additional free disk space is required to develop
automation projects, as Automation Anywhere creates temporary files like screen-shots, server logs, audit files etc. during the exe-
cution of the automation scripts.

l The actual free space required increases with the project size and hence it is recommended to have at least 40-50 GB of free disk
space to implement long term projects.

l You might have to upgrade to a higher configuration post installation depending upon product usage. For instance, in MetaBot
Designer - generation of log files, Logic creation, and so on might require more disk space later.

Browser Support

l Internet Explorer - 10 and 11

l Chrome* - 49 and above
* Automation through Chrome is not supported in MetaBot.

l Firefox - 45, 46, and 47

l Edge# -
# Only for Microsoft Windows 10

Plugins

l Silverlight* - 5.1.x

l Adobe Flex - 24

l Internet Explorer 11 - 11.0

l Chrome - 49 and above

l MODI - 12.0

l TOCR - 5.0

* Automation through Silverlight is not supported in MetaBot.
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Technology Support

l Windows

l OCR

l HTML

l .NET

l WPF

l Flex

l Silverlight

l Java 1.6 (JRE 6.0.450) or later versions - Desktop and Web

Other Requirements

1. .NET Framework 4.6 and 4.6.1 (for Windows 8.1 and Window Server 2012 R2)

Note: The .NET Framework 4.7 update is also supported.

2. .NET Framework 3.5 + SP1

Note: If using Enterprise, you need to have both versions of .NET Framework installed.

3. 1024 x 768 or higher resolution monitor

4. Mouse or another pointing device

Synchronization between Client and Server

To synchronize the time between the Automation Anywhere Client and the Enterprise Control Room, enable the Network Time Pro-
tocol (NTP) settings on your network. For more information modifying the NTP settings for your network, see your system administrator.

 Important: On Terminal Server machines, Automation Anywhere does not support concurrent 'Terminal
Server' connections. There could be multiple users logged in on to the Terminal Server and they all can
use their individual instances of Bot Creator; however, one user must have only one active session.
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Connecting to Automation Anywhere Control Room

Automation Anywhere allows you to monitor and administer a large multi-site complex automation infrastructure using the web based
Control Room.

Login to the Control Room

As a Bot runner or Bot creator, you can launch the Client by connecting to the Control Room using either of two methods:

1. Client Login window

2. Command line

Log on using Client Login window

To log on,

1. Type the Control Room Service URL in the 'Control Room' field of the Client Login screen.

l If launching for first time, input the appropriate Control Room Service URL. On logging in the second time, your last login
URL is displayed.

l If you wish to login using another URL, simply input the appropriate URL.

2. Based on Control Room authentication type, you will have to provide your authentication details. You are authenticated using
either of the three methods - Windows or AD, Single Sign-On, and User Credentials.

Note: The "@" character is supported to accommodate email user-names for logging in to the Con-
trol Room.

a. Windows or AD authentication - This is available when the Control Room is configured for Active Directory authentication
type. When you select Windows authentication, you do not need to provide any credentials. You will be authenticated with
your active directory or windows credentials. This option is selected by default.
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Tip: If for any reason automatic Windows Authentication fails, select User Authentication
and enter your credentials.

b. Single Sign-On - This is available when the Control Room is configured for SSO SAML 2.0 authentication type. When you
select this option, you do not need to provide any credentials. Instead, when you click Login, you will be redirected to your
organization's IdP authentication page wherein you must log in using your SSO credentials.

Note:

l A registry entry (32 bit) shall be made under HKEY_CURRENT_USER\Soft-
ware\Microsoft\InternetExplorer\Main\FeatureControl\FEATURE_BROWSER_EMULATION since
Automation Anywhere Client makes use of the same rendering engine used by Internet
Explorer to display the SSO authentication page.

l If IdP Login page does not render properly, ensure that you include the Idp Login URL
in the trusted sites of Internet Explorer.

The below screen-shot shows a sample authentication page:
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Tip: You can re-size the window for better visibility.

l When you try to Login using an Authentication type other than the one Control Room is configured for, you get fol-
lowing error:

Important: You might experience some issues with the login display if the authen-
tication page has trouble while rendering in Internet Explorer.

c. User Credentials - This is available when the Control Room is configured for Database authentication type. When you
select User authentication, you need to provide the user credentials that were created by the Control Room admin. You can
use this when you want to login to the Control Room using your domain credentials. Refer User Management for details on

https://support.automationanywhere.com/hc/en-us/articles/115004578714-Profile-Management-An-overview
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how.

l Contact your Control Room administrator in case you forget your password.

l You might not be able to login to your Client due to any of the following reasons:

a. When you provide invalid UserName and/or password

b. The user you are trying to login as has been not been created in Control Room

c. The user you are trying to login as has not been allotted a license in the Control Room

d. You have not verified your user account using the email sent from Control Room

e. The user you are trying to login as has been deactivated in the Control Room

f. The user you are trying to login as has already been registered into the Control Room from a different machine

g. The user you are trying to login as has registered to the Control Room under different Windows credentials

h. The Client and Control Room versions are incompatible

i. The Control Room certificate is invalid

j. You already have an active bot session running on another machine

k. When you provide your old credentials during Client Login/ Re-Login or Auto-Login after the password policy is updated in
the Control Room

Refer Client Login Errors for details on more errors.
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3. Based on the license type used in the Control Room, while launching the Client, you are shown:

l The evaluation days remaining if you are on a trial license:

l The Getting Started screen if on purchased license:

l Note that the above screen is visible even after you login to the Client when on a trial license.

Important: It is recommended that a Bot Creator or Bot Runner should not switch Control Rooms. The
Client may not function properly if it keeps on connecting to different Control Rooms. Some of the
issues that may be encountered:

l Client getting disconnected from Control Room

l Inability to checkin/checkout Bots

l Operations Room not showing the correct Bot Progress



Copyright © 2018 Automation Anywhere, Inc. 17 https://support.automationanywhere.com

Re-Login to Control Room

l To re-login Control Room using a different user credentials, click Tools→ Re-login.

l Input user credentials in the Login dialog.

Note: The logged in username and status is displayed in the status bar.

Important: Connecting to multiple Control Rooms from an AAE Client instance is not recommended.

Log on using command line

An alternate method of connecting to the Control Room is using the command line. This is useful when, as an automation admin or
user you want to log into multiple Clients hosted in unattended mode on remote terminals. You can also create a script which can run
whenever you want to log on in case of a reboot.

To Log on,

1. Run the command line in administrator mode

2. Provide the following parameters in the command line:

C:\Windows\System32\"<Application Path>\Automation Anywhere.exe" "/c<Control Room URL>" "/u<User-
name>" "/p<Password>" "/aclose" "/l<login>"

For example,

C:\Windows\System32\"D:\Automation Anywhere\Enterprise\Client\Automation Anywhere.exe"
"/chttp://productlt.mydomain.com:81/" "/uMike.Lee" "/p12345678!" "/aclose" "/llogin"
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Parameters

Parameters that can be used for log in are provided with relevant description in the table:

Parameter Description
/c Control Room Login URL
/u Bot Cretor or Bot Runner Username
/p Bot Cretor or Bot Runner Password
/a Action. For example, /aclose
/l Login

Tip:

l If you do not provide the parameter for Control Room URL, the default URL given in the settings
file is considered

l If you provide username parameter, you should provide the password parameter

l It is recommended that you use the close parameter to close the application when you use the
password parameter

l When you want to login to a Client in different domain, then use the username parameter with
the domain name. For example, "/uAAE.Com\Mike.Lee"

l When you log in to a Client that is already active, that particular Client's session will
expire and the current logged in user would be the one that has been invoked using the command
line.

l For the above case, an active Task Editor session will not be terminated

Exit Error Codes

Error codes with their description are provided in the table:

Exit Code Description
0 Login attempt was successful
1 Login attempt was unsuccessful
2 Control Room is down
3 The parameter provided is incorrect or invalid
4 AAEClientService has stopped
5 Secure server certificate is invalid
6 Error encountered is due to an unknown cause

Disconnecting from Control Room

As a Client user - Bot Creator or Bot Runner, you are disconnected from the Control Room when:

l You are logged in and the network service is stopped.

l You are already using the Client and the license of the Control Room that you are connected to expires

Note: If a taskbot is currently deployed to your machine, the Client is disconnected only when
it finishes execution.
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You can also choose to exit from the Client. Refer Exiting Automation Anywhere Client for details.

Client Login Errors

While logging into the Control Room from the Client Login window, you might come across any of the following errors:

1. Login Unsuccessful

2. Unable to Connect to Server

3. Invalid User Name / Password

4. Forgot Password

5. Invalid Certificate

6. Version Mismatch

7. Login Unsuccessful due to Active Bot Session

8. Password policy updated

For details on Client Login errors, refer Client Login Errors.
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Recording, Editing and Running Tasks

This topic describes how to record and run basic automation tasks.

Recording and running simple automation tasks involves three basic steps:

1. Record

2. Save

3. Run

Recording an Automated Task

To record an automated task, follow these steps:

1. For recording simple tasks and which can be run on the computer they are recorded on, click the record button at the top of the
main client screen.

Refer Selecting Recording Methods for details.

l Automation Anywhere begins recording your activity, including keystrokes, mouse movements and mouse clicks.

l During this process, the Automation Anywhere client window disappears from view. A small "Stop Recording" window appears in
the bottom right corner of your desktop.

Note: You can also create a new automated task by clicking the New Task button at the top of the cli-
ent screen.

l A window is displayed that enables you to select from several methods for creating a task:



Copyright © 2018 Automation Anywhere, Inc. 21 https://support.automationanywhere.com

For more information on choosing a recording method, refer Selecting a Recording Method. Alternately, you can click the 'Help me
choose an option' link to go to 'Live Assist' - our support chat option.

2. Perform the actions that you want recorded for automation. You can open applications, open new windows, click on buttons, fill in
forms, search a website, and perform any other actions you want.

3. Click the stop button to stop recording the task.

l A Save Task window is displayed.

4. In the Save Task window, type the name of the directory where you want to save the task, or accept the default directory (My Tasks).

5. Type a file name for your task and click on Save.

6. If necessary, you can enter a password to protect the task.

l Your task is now created.

Creating a Shortcut for a Task on Desktop

It is possible for you to provide a shortcut on your desktop to run a saved task. An icon is associated with the task to launch it quickly.

To create a shortcut on the desktop, follow these steps:

1. In the Automation Anywhere Client window, select your task in the Task List.

2. Right-click on the task, and choose "Send To -> Desktop (Create Shortcut)".

3. Locate the icon on the desktop and drag it to the desired location.

Running Your Recorded Tasks

You can run the task that you recorded by choosing one of the following methods:

l Select the task in the Task List and click Run.

Or

l Double-click on the task in the Task List.

Or

l Double-click on the desktop icon.
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Stopping a Task

To stop a task from running, take one of the following actions:

1. Press and hold the ESC (escape) key for 2 to 3 seconds.

2. In the run-time status window, click on the Pause button.

Editing a Task

After you initially create an automated task, you might want to further customize or optimize the performance of your task. You can edit
the task file without the need to re-record it.

l To make changes to your task, select the task in the Task List and click the Edit button.

l The Workbench is launched, enabling you to add functions, remove delays, and add action sequences.

For more information, see Using the Workbench.

Also See...

l Using Special Keys

l Adding Properties to a Task

l Exiting the Automation Anywhere Client
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Adding Properties to a Task

You can add properties to increase the efficiency of a task. This topic describes in brief the properties that can be added to a task. It
also guides you to appropriate topics to enable you to directly access the one you wish to peruse.

Add the properties given below to help increase the performance, functionality and usability of your task:

1. General: View general properties such as file name, created at, last run time and log on the General tab. Also, change the priority*
of the task to determine it's precedence for queuing.

* Available for Enterprise version only.

Refer Viewing and Setting General Properties

2. Repeat: You may need to repeat a task for instance when extracting data from a website which is updated frequently. Specify when
running a task it should repeat particular number of times. Also specify that the task should repeat the run any number of hours,
minutes, or seconds.

Refer Repeating a Task

3. Speed: Specify how quickly a task should run. At times certain tasks require precise mouse movements. While recording, your
movements might be slow. After recording such a task you have the option of replaying the same at varying speed.

Refer Adjusting the Speed of a Task

4. Notification: You can specify that you want Automation Anywhere to send an e-mail to a particular e-mail address after the task
completes a run.

Refer Sending Email Notifications for a Task

6. Hotkey: Assign a keyboard shortcut to launch your automated tasks with the press of a single key termed as 'hotkey' in the pro-
gram.

Refer Setting up Hotkeys for a Task

7. Screen Security*: You can specify that Automation Anywhere run the task without displaying the actions on the screen during the
run. You can also disable the keyboard and mouse while the task runs.

* Available with purchased version of Enterprise Client only.

Also See...

l Running a Task

l Using Special Keys
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Using Special Keys

While recording, it is possible to increase the productivity of a task, by using special keys for a task.

The following special keys are available under Automation Anywhere while recording and playing automated tasks:

l - To stop (abort) a running task, press and hold the ESC key for 2 to 3 seconds. Automation Anywhere also provides you with
an option to configure your own hot key to stop an automation task from running.

The next time you run an aborted task, Automation Anywhere starts it from the beginning.

l - To pause an automated task while it is running, press the Pause/Break key or click on the 'Pause' button on the Run
Time window. Once you pause a task, a 'Resume' button appears on the Run Time window.

To continue running the task, click the Resume button.

Note: This feature is useful when you run long tasks that require interrupting in order to use the
machine for other purposes.

Also See...

l Recording, Editing and Running Tasks

l Exiting the Automation Anywhere Client
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Enabling Remote Desktop Connections

This topic provides information about using Remote Desktop applications to run your automated processes.

Running Automated Tasks under a Minimized Session

When you minimize a remote desktop window (the window that displays the desktop of the remote computer), the operating system
switches the remote session to the non-GUI mode and does not display windows and controls.

As a result, Automation Anywhere is unable to interact with the application GUI. At this point, the automated GUI task fails.

To run GUI tasks on a remote computer while minimizing the remote desktop window, change the registry keys on the computer from
which you connect to the remote Automation Anywhere workstation. Complete the following steps:

1. Log into the computer from which you connect to remote computers.

2. Close all open remote desktop sessions.

3. Click Start -> Run (or Windows + R).

4. In the Run dialog window, type "regedit" and press Enter.

l The Registry Editor starts.

5. Navigate to one of the following registry keys, depending on whether you want to modify the remote desktop settings only for the
current user or for all users on the computer:

l HKEY_CURRENT_USER\Software\Microsoft\Terminal Server Client

l HKEY_LOCAL_MACHINE\Software\Microsoft\Terminal Server Client

6. Create a DWORD value named RemoteDesktop_SuppressWhenMinimized and set it to 2.

7. Close the Registry Editor.

l When you minimize the Remote Desktop Connection window on your computer, the remote computer GUI should not be affected,
making the GUI available to your automated tasks.

Note: Changes made to the registry can affect the overall performance and function of the system.
Automation Anywhere is not responsible for adverse system behavior that results from making registry
changes. Working with your system administrator is advised.

Using VNC - An alternative to Remote Desktop

In general, Remote Desktop applications do not allow automation software to run or perform tasks when you minimize or close the win-
dow. Remote Desktop creates a session for every connection made to the remote machine. Under this session, it provides the con-
necting machine with complete rights to control the remote machine.

However, when disconnecting from or minimizing the remote window, Remote Desktop retrieves the rights and any access to the GUI
of the remote machine is lost. This causes automated tasks to lose control of the remote system, and they do not run as expected.

Tip: Use Virtual Network Computing (VNC) to connect to the server. VNC allows you to run automated
tasks even when the session is minimized or disconnected.

l VNC establishes connections with the remote system in a different manner from Remote Desktop. VNC physically connects to the
remote system, rather than creating sessions for each connection. The connection retains controls on the remote GUI, even when
the VNC window is minimized or disconnected.

l Your automated tasks can continue to run in the same manner as they do on a local machine.

l For more information on VNC, see: http://www.realvnc.com/download/vnc/

http://www.realvnc.com/download/vnc/
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Exiting Automation Anywhere

This topic describes how to close and exit Automation Anywhere.

You can exit the program by taking one of the following actions:

1. Click the "X" in the upper right corner of the client window.

2. Click on the File menu, and select the Exit option.

3. Simultaneously press the ALT+F4 keys on your keyboard.

Note: To exit out completely from Automation Anywhere, right click on the Automation Anywhere icon
in the System Tray available on the bottom right hand corner of your screen and select the 'Exit'
option.

Also See...

l Recording, Editing and Running Simple Tasks

l Using Special Keys
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Have a Question?

Do you have questions about Automation Anywhere?

l Using the software and its features

l Installing or configuring the software in your environment

l Creating your automated tasks

l Purchasing questions

Use any of the following methods to contact us:

l Use the Automation Anywhere Knowledge Base Help System

l Learn from Online Examples

l Contact Technical Support

https://support.automationanywhere.com/categories/20073904-Examples
http://www.automationanywhere.com/support/openSupportCase.htm
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Contacting Technical Support

Automation Anywhere is committed to outstanding customer care. Our support team wants to resolve your issues as quickly as pos-
sible.

Depending on the nature of your problem, please take these steps:

1. Check the Automation Anywhere Knowledge Base Help System, including Frequently Asked Questions

2. Learn from Online Examples for quick solutions to common automation use cases

3. View Online Demos and Videos

4. Open a Support Case

How to Open a Support Case

To open a support case, you may contact Technical Support. A support representative will contact you as soon as possible.

https://support.automationanywhere.com/categories/20073914-FAQs
https://support.automationanywhere.com/categories/20073904-Examples
http://www.automationanywhere.com/lrn/learn.htm
http://www.automationanywhere.com/support/openSupportCase.htm
http://www.automationanywhere.com/support/openSupportCase.htm
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Getting More Help

For more complex questions, use one of the following Automation Anywhere services:

1. Request a Live 1-on-1 Demo (in most cases, no fees charged)

2. Use the Ask the Expert Service (in most cases, no fees charged)

3. Use Automation Anywhere Consulting Services (fee-based services)

Contact us for pricing questions for these options.

http://www.automationanywhere.com/products/requestLiveDemo.htm
http://www.automationanywhere.com/support/askTheExpert.htm
http://www.automationanywhere.com/services/consultingService.htm
http://www.automationanywhere.com/company/contact.htm
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Requesting Live 1-on-1 Demos

l Do you have a specific question about an Automation Anywhere feature?

l Are you confused about how to automate a particular process?

l Do you have questions about how to work with applications while automating processes?

For help with any of these issues, contact the Automation Anywhere Support team.

Our team members are happy to demonstrate features, answer your questions, and show you various automation scenarios.

Request a Live Demo now.

Is your issue more complicated?

Learn about our Automation Anywhere Consulting Services, and how we can help you to automate more complex processes.

http://www.automationanywhere.com/products/requestLiveDemo.htm
http://www.automationanywhere.com/services/consultingService.htm
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Using our Ask the Expert Service

l Do you have a simple question about an Automation Anywhere feature?

l Are you trying to automate a process that involves common applications, such as Word, Excel, or other Microsoft Office products?

l Do you have a question about your account, your software version, or your environment?

If you need help with any of these topics, contact the Automation Anywhere Ask the Expert team.

Our knowledgeable team members are eager to answer your questions and help you quickly automate your processes.

Is your issue more complicated?

Learn about our Automation Anywhere Consulting Services, and how we can help you to automate more complex processes.

http://www.automationanywhere.com/support/askTheExpert.htm
http://www.automationanywhere.com/services/consultingService.htm
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Using Automation Anywhere Consulting Services

The Automation Anywhere team is led by industry experts in the business process automation field. We've helped major companies
from around the world automate their key business and IT processes.

The Automation Anywhere team is focused on streamlining the implementation of automation, and maximizing customer ROI.

We bring years of experience and best practices in dramatically reducing implementation time to ensure your team is successful.

Our services consultants are ready to provide expert, efficient hands-on training and implementation.

Both on-site and remote implementation services are available that provide:

l Implementation and consulting for simple and complex automation projects

l An unwavering focus on your company's objectives

l Best practices for business and IT process automation that maximize ROI and minimize risk

l When you engage the Automation Anywhere Consulting team, you are assigned a dedicated customer agent who is familiar with
your domain, requirements, technologies, and environment.

l If appropriate, your consultant can remotely log into your computer to help you automate processes and guide you with your pro-
ject.

Automation Anywhere helps you to automate any of the following processes:

1. Business processes

2. IT processes

3. Extraction of data from the Web

4. Data transfer from one application to another

5. ERP (Enterprise Resource Planning) data entry and integration processes

6. File and data management processes

Find out more about our consulting services by submitting the Consulting Services Request Form. A representative will contact you
shortly.

http://www.automationanywhere.com/services/requestQuote.htm


Copyright © 2018 Automation Anywhere, Inc. 33 https://support.automationanywhere.com

Section: Creating TaskBots
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Best Practices - Recording and Running Tasks

In order to record and consequently run your tasks, you need to follow certain practices which have been described in this topic.

Best Practices for Recording Tasks

l Avoid using mouse clicks. While recording a task, use keystrokes and shortcuts as much as possible, rather than mouse clicks.
Avoiding mouse clicks ensures that the task will run successfully, even when objects or icons have moved position.

l Use keystrokes as much as possible. Keyboard keystrokes are highly reliable and consistent to record.

l Use keyboard shortcuts while recording. Using shortcuts minimizes the dependency on mouse clicks and mouse moves, while
making your task more robust. You can find keyboard shortcuts in application menus, or press the ALT key on your keyboard to
view shortcuts highlighted on your screen.

l Maximize all windows. To ensure that Windows and web objects are consistently located when running the task, be sure to max-
imize all windows before working with them while recording.

l Avoid clicking on applications that are not involved with your process. While you are recording the task, avoid clicking on applic-
ations that are not part of the process that you want to automate.

l When running the process, any attempt to execute commands in an application that is not open on the machine results in
the following error message: 'Application not found'.

l Record the task at a low speed. To ensure tasks do not skip process steps when running, be sure that the task is recorded at a
reasonable speed that gives all applications enough time to completely open and process.

l Avoid dragging windows while recording. In general, efficiently automated processes do not include windows actions like min-
imizing, maximizing, or moving a window. If you must record one of these actions, remove it by editing the task.

Best Practices for Running a Recorded Task

l Properly open application windows. Using the Standard Recorder to record windows operations can present problems later when
you run the task. To minimize run-time errors with applications you work with, follow these guidelines:

1. Use the Workbench to add Open Program/File commands.

l To remove the possibility of application windows not opening properly, use the Workbench to add the 'If Window exists' com-
mand, which first checks for the window before opening it. The "If Window exists" command is listed under the 'If' conditions
in the Commands list.

l Combine this command with the 'Open Program/File' or 'Open Browser' commands to launch particular applications.

l You can also use Delay 'Wait for window' commands, which provides options to wait, continue with the next action, or stop
the task if the window is not present.

2. Avoid double-clicking on application icons to start applications while recording. Instead, open the recorded task in the Work-
bench and use 'Open Program/ File' commands and replace any mouse clicks.

3. If you do not want to use Workbench commands, such as "Open Program/File", ensure that any required windows are open
prior to running the task.

l Because most of the commands in the Standard Recorder are based on mouse clicks and keyboard keystrokes, be sure
that application windows used in the process are already open before running the task.

l Avoid moving the mouse and keyboard. The Standard Recorder uses the mouse and keyboard while running a recorded task. To
avoid errors, do not use them while running a task. Track the progress of your running task only by using the progress window that
is displayed at the bottom of your screen.

l Use Manage Windows Controls and Image Recognition. Use these advanced features to capture controls or click on images,
rather than using mouse clicks.

l Add robust features to your task using the Workbench. The Workbench provides a large menu of commands that you can use to
add efficiency and functionality to the task. Add commands such as 'IF/Else' conditions, loops, and variables to the task.

l Use wildcards. You can specify wildcards (*) for the Image Recognition command and the following IF/Else commands: Win-
dow Exists and Window Does Not Exist.

l For example, to perform an operation on all windows that contain the word 'Microsoft' in the title, use wild cards to
identify the windows.
Specify: IF Window Exists *Microsoft*
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Recording an Automation Task

Automation Anywhere provides several ways to create automation tasks. To ensure that you create a reliable task, you'll want to select
the right method.

When planning your automation task, be sure to select the Recorder (or Workbench) that best matches the behavior of your task.

Selecting a Recording Method

In most cases, the recorder you select will be based on the type of process that you want to automate. For example, for a process that is
based on web applications to extract data from websites, you would select the Web Recorder.

To record a new task, click New button at the top of the client screen.

A window is displayed that enables you to select from several methods for creating a task:

l Smart Recorder - It captures objects from various applications that use different technologies such as html, .Net, WPF, Java, Flex
and Silverlight. These are saved as a set of Object Cloning commands. Refer Using the Smart Recorder for details.

l Screen (Standard) Recorder - Use it to record tasks that need to be run on the same machine in which it is recorded. It records
mouse clicks and keyboard operations. Refer Using the Screen/Standard Recorder for details.

l Web Recorder - It understands all web controls. Hence applicable when recording web-only tasks. If website controls on a page
move location, the program can locate the correct controls and adjust the task to run without error. If the properties of the web con-
trols change, the automation task can be updated to ensure that the task runs successfully. Refer Using the Web Recorder for
details.

l Workbench - Use it to create tasks manually. You can assign relevant actions to the task using the commands provided in the
editor. Refer Using the Workbench for details.
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Using the Web Recorder

If you want to automate processes (tasks) that involve a web application or browser, use the Web Recorder. It understands all web
objects and controls, such as:

l URL command line

l Drop-down menus and command bar icons

l Web page text fields, graphics, and buttons

l Navigation and hotspot links

l Forms

Note: If the layout of a web page changes and the web controls move to a different location on the
page, Automation Anywhere is capable of locating the new position of these controls and running the
task correctly.

Common Use Cases

Most people use the Web Recorder to perform the following actions:

l Repeatedly extracting data from multiple web pages

l Extracting data from tables on web pages

l Web form filling

Use the Web Recorder when you want to automate the following processes (tasks):

l Opening web pages

l Logging into a website

l Navigating through search

l Entering data into forms and submitting them

l Extracting data and updating database records

l Using a Web-based ERP (Enterprise Resource Planning) system

l Extracting web data to a local file

l Testing an online application

When you 'Enable' Secure Recording

Note: If you enable ‘Secure Recording mode’: no values, caption, default texts are captured. Also,
no values are captured for ‘Extract Data’ and ‘Extract Multiple Data.’ Learn More
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Also See...

l Extracting Data from Web Sites
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Recording Web Actions with Web Recorder

The web recorder is basically used to record actions for web-only applications.

To use the Web Recorder to record actions on a web site, follow these steps:

1. In the Automation Anywhere main window, launch the Web Recorder in one of the following ways:

l Click New Task button and select Web Recorder.

l Or click on the Web Recorder link at the top.

l Select 'Web Recorder' from the list of recorders:

The initial Web Recorder window is displayed.

1. Enter the website address (URL) on which you want to record actions, and click Start. You can add the URL to your Favorites for
easy access in the future.

The Web Recorder Toolbar is displayed, and Internet Explorer is launched in a new window with the website.

2. Perform your actions on the website, including clicking on buttons, clicking on links, and typing in text.

3. Click the Stop Recording button on the Web Recorder toolbar.

4. In the Save Task window, specify a task name, optionally select a folder in which to save the task, and click on Save.
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6. To run the task, double-click on the task, or select it and click on Run button.

7. To stop a running task, press and hold the escape (ESC) key for 2-3 seconds. You can also configure your own hotkeys to stop
tasks. Refer Defining Client Hotkeys for details.

Note: When you edit the task using the Task Editor, the program displays the Web Recorder commands
and objects that were used while recording the task.

Also See...

l Extracting Regular Web Data

l Extracting Pattern-Based Data

l Extracting Table Data
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Extracting Data from Websites

Extracting data from web pages can take one of four forms, depending on the type of data that requires extracting:

l Regular data: Unstructured data that has no repetitive patterns. An example is a paragraph of text.

l Pattern-based data: Structured data that repeats a pattern, such as a row in a table or a list.

l Table data: Data that resides in a table.

Also See...

l Extracting Regular Web Data

l Extracting Pattern-Based Data

l Extracting Table Data
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Extracting Regular Web Data

To extract regular data from a web site, follow these steps:

1. In the Automation Anywhere main window, launch the Web Recorder in one of the following ways:

l Click the New button and select Web Recorder.

l Or click on the Web Recorder link at the top.

l Or click on the Tools menu and select Web Recorder.

The initial Web Recorder window is displayed.

2. Enter the website address (URL) on which you want to extract data, and click Start.

The program displays the 'Web Recorder Tip' window:
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Note: Select 'Don't show this message again ' if you do not wish the program to display the
tip.

The Web Recorder Toolbar is displayed, and Internet Explorer is launched in a new window with the website.

Note: This feature works with Internet Explorer only.

3. You can now perform any actions you like, including mouse clicks and text entry. When you need to extract regular data from
the website, click the Extract Data button on the Web Recorder toolbar.

The Extract Data Option window is displayed.

4. Select the Regular Data radio button and click Next.

5. You can now highlight the data you want to extract.

6. After highlighting the text, the Extract Data window is displayed, and contains the text you selected.
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6. Save this copied text to an existing variable in your task.

7. Optionally, save the control URL either as a new variable or to an existing variable in your task.

8. You can also assign Before and After Keywords for extracting data.

9. Click Save.

10. Click the Stop Recording button on the Web Recorder toolbar.

11. The Save Task window pops-up, wherein you can specify a task name. Optionally select a folder in which to save the task and click
save. You can also optionally specify a password to prevent the task from being run by unauthorized users.

12. Click Save.

Tip:

1. To stop a running task, press and hold the escape (ESC) key for 2-3 seconds.

2. You can also configure your own hot keys to stop tasks.

Also See...

l Extracting Pattern-Based Data

l Extracting Table Data
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Extracting Pattern-Based Data

When you need to extract data, which for instance, is spread over multiple pages and contains elements such as links you can use the
'Pattern Data' option in Extract Data .

To extract pattern-based data from a web site, follow these steps:

1. In the Automation Anywhere main window, launch the Web Recorder in one of the following ways:

l Click the New button and select Web Recorder.

l Click on the Web Recorder link at the top.

l Click on the Tools menu and select Web Recorder.

The initial Web Recorder window is displayed:

2. The program displays the 'Web Recorder Tip' window:
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Note: Select 'Don't show this message again ' if you do not wish the program to display the
tip.

The Web Recorder Toolbar is displayed, and Internet Explorer is launched in a new window with the website.

Note: This feature works with Internet Explorer only.

3. You can now perform any actions you like, including mouse clicks and text entry. When you need to extract regular data from
the website, click the Extract Data button on the Web Recorder toolbar.

The Extract Data Option window is displayed.

4. Select the Pattern-based Data radio button and click Next.

5. You can now highlight the data you want to extract

6.  Use it to set a pattern:

a. Highlight the first line of text and click on Capture in the window that pops up:
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b. Highlight a second line of text. This will set the pattern. The Extract Data Field window is displayed.

c. Enter a name in the "Enter Column Name" field and click Save.

l The Extract Multiple Data window is displayed, containing the column name you saved.

In the Extract Multiple Data window, you can do several things:

l Add: Click the Add button to select additional data from the website and add another pattern that you want to capture. The data
fields will be automatically viewed in the Classified Data Fields.

l Edit: Click the Edit button to change the name of the pattern.

l Delete: Click the Delete button to delete one or more patterns.

l Copy: Click the Copy button to copy one or more patterns.

l Paste: Click the Paste button to paste one or more copied patterns.

l Click Next when done.

The second window of Extract Multiple Data is displayed:
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l If the website has multiple pages from which you want to extract the patterned data, click the check box: "The data spans across
multiple pages".

l Use the Capture button to capture the control name for moving to the next page. Images extracted from multiple web pages are
saved in different folders.

l Click Next when done. The Preview Data section is displayed:
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l The Preview Data section displays a preview of the captured data. Save extracted images or data as CSV files in separate folders,
as required.

l Click Finish.

l Click the Stop Recording button on the Web Recorder toolbar.

l The Save Task window pops-up, wherein you can specify a task name. Optionally select a folder in which to save the task and click
save.

Note: The trial version supports extracting 5 pages of data for viewing only. No such lim-
itation exists in the purchased version.

Also See...

l Extracting Regular Web Data

l Extracting Table Data
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Extracting Table Data

When you need to extract data from tables on web pages, the Web Recorder guides you with visual steps.

Many websites have data organized in HTML tables. Extract Table makes it easy to save tabular data in a CSV (comma-delimited) file
that you can open in most spreadsheet and database applications, including Excel and Access.

1. Launch the Web Recorder:

2. Enter the website address (URL) on which you want to extract data, and click Start.

The program displays the 'Web Recorder Tip' window:

Note: Select 'Don't show this message again ' if you do not wish the program to display the
tip.

The Web Recorder Toolbar is displayed, and Internet Explorer is launched in a new window with the website.

3. You can now perform any actions you like, including mouse clicks and text entry. When you need to extract or copy table data from
the website, click the Extract Table button on the Web Recorder toolbar.

4. Move the yellow prompt bar to the table you want to extract and click on it.

Note: If the content you click on is not a table, the yellow prompt bar will change to red.

The Extracted Table window is displayed showing a preview of the data within the table.
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5. If the table spans multiple web pages, click the check box: "The table spans across multiple pages".

Use the Capture button to capture the control name for moving to the next page.

6. Click Next when done to preview and save the extracted table.
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7. Save the table as a CSV (comma-separated) file into a location of your choice. You can also use the "Append to an existing CSV
file" check box to append the extracted data to an existing CSV file.

8. Click Finish.

9. Click the Stop Recording button on the Web Recorder toolbar.

10. In the Save Task window, specify a task name, optionally select a folder in which to save the task, and click on Save. You can also
optionally specify a password to prevent the task from being run by unauthorized users.

Note: The trial version supports extracting 5 pages of data for viewing only. No such limitation
exists in the purchased version.

Also See...

l Extracting Regular Web Data

l Extracting Pattern-Based Data
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Using the Screen/Standard Recorder

You can use the Screen Recorder (known as Standard Recorder in versions less than 10.0) to record a task or a series of actions on
your computer when:

l Building simple tasks for processes that involve mouse clicks and keyboard operations.

l You plan to run the automated process (the recorded task) on the same computer on which it was recorded. This ensures that the
screen display coordinates are the same as they were when the task was recorded.

Recording a Task using the Screen Recorder

1. To create an automation task using the Screen Recorder, launch it one of four ways:

Note: 'Screen Recorder' should already be selected as the default recorder in the 'Record'
list-down for options 3 and 4 to work.

1. Using the 'Record' button list-down

l In the main window, click on the 'Down Arrow' beside Record button at the top.

l Select 'Screen Recorder' as shown:

2. Using 'Choose an Option'

l Click on New Task button:

l Select Screen Recorder from the 'Choose an option' dialog:

3. Using 'Record' option from Context menu in System Tray
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l Context click the Automation Anywhere Enterprise Client in the System Tray

l Select Record.

4. Using short-cut keys 'Ctrl + Alt + R'

l The Automation Anywhere window is minimized, and the Recording toolbar is displayed in the lower right corner of your computer
screen.

Note: If needed, you can pause the recording operation and resume it.

2. Perform all of the actions on the computer that you want to record in the task.

Note: While recording, the Screen Recorder recognizes the various windows that are open on
your desktop.

3. When done, click on the Stop button on the Recording toolbar.

4. Save the task by specifying a name, and optionally select a folder in which to store it. When saved, the task name is displayed in
the main Task List window.

Note:
• You can edit your recorded task using the Workbench. Refer 'Editing a Task'.

• If Version Control is enabled, a plus sign ( ) will be prefixed to a new task.
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Note: If you enable ‘Secure Recording mode’, no images are captured. Learn More

Also See...

l Using the Workbench

l Editing a Task

l Running a Task

l Open Program/File Command

l Manage Windows Controls Command
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Recording Tasks Using the Smart Recorder

Use the Smart Recorder to record a task or a series of actions on your computer when building tasks that require capturing objects
from applications that use technologies such as HTML, Java, WPF, Flex and Silverlight.

Note: If you enable ‘Secure Recording mode’, no values and images are captured. Learn More

Note that you can record tasks in Internet Explorer 8 and above only.

Tip: If appropriate plug-ins are not installed, you can install them using Plugin Settings. Learn More

Recorded actions are saved as a set of Object Cloning commands in the Workbench.

As it captures actions via an object window it saves the keystroke actions and mouse clicks in the 'Actions' list of the Object Cloning
command.

Note: It has the inherent ability to identify keystroke actions such as 'Shift + A' as capital A.

Also, special keystrokes such as 'Tab' and 'Enter' are saved as separate actions in the command.

Tip: To navigate across controls, it is recommended that you use 'Click' action instead of 'TAB'.

Recording a Task using the Smart Recorder

To create an automation task using the Smart Recorder, launch it one of four ways:

Note: 'Smart Recorder' should already be selecteas the default recorder in the 'Record' list-down
for options 3 and 4 to work.d

1. Using the 'Record' button list-down

a. In the main window, click on the 'Down Arrow' beside Record button at the top.

b. Select 'Smart Recorder' as shown:

2. Using 'Choose an Option'
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1. Click on New Task button:

2. Select Smart Recorder from the 'Choose an option' dialog:

3. Using 'Record' option from Context menu in System Tray

1. Context click the Automation Anywhere Enterprise Client in the System Tray

2. Select Record.

4. Using short-cut keys 'Ctrl + Alt + R'

'Enable' Secure Recording

If you enable ‘Secure Recording mode’, no values and images are captured. Learn More
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Using the 'Record' button list-down

When you click on ‘Re-Capture Image’, it shows an error “Secure Recording mode. Image will not be captured”. Also, if you try to save
the command, an error message appears, “Secure Recording mode. Record and Play using the Image Option is not supported.”

Also See...

l Using the Workbench

l Editing a Task

l Object Cloning Command

l Manage Windows Controls Command
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Creating a Task Using the Workbench

The Automation Anywhere Workbench is the most powerful facility in the product. Hundreds of commands and wizards are available
that enable you to automate almost any process-without programming.

If you want to manually create an automated task from scratch, you can use the Workbench.

1. Launch the Workbench by taking one of the following actions:

l Click on the New button and select Workbench.

l Click on the File menu and select New, and select Workbench.

l Click on the Tools menu and select Workbench.

2. Add actions to the new task by dragging commands from the left pane of the editor to the Task Actions List pane. After inserting
most commands, you are prompted to specify the properties that apply to those commands.

3. Save the task.

Also See...

l Using the Workbench
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Using the Secure Recording Mode

While automating any business process when you use Automation Anywhere recorders, the commands generally capture important
details such as object value, image, text, inner HTMLs etc. Although for environments such as BFSIs (Banking, Financial Services, and
Insurance); while automating a task, capturing these sensitive data (e.g. customer account, IDs etc.) may pose a security risk. The
’Secure Recording’ feature reduces the risk by not capturing any sensitive data.

Note: You can use Secure Recording mode on all the three prime recorders: Web Recorder, Smart
Recorder, and Screen Recorder.

Refer List of Commands in this topic that supports ‘Secure Recording mode’

l Delay/Wait

l Error handling

l If/Else Command

l Image Recognition

l Insert Mouse Click

l Manage Windows Control

l Object Cloning

l OCR

l Screen Capture

l Web Recorder

In Control Room, Client Configuration enables you to control the mode of recording done by a Client for business processes. If the pro-
cess requires a secure mode of recording, you can 'Enable' the 'Secure Recording' mode.

Note: 'Secure Recording' is disabled by default.

Control Room Administrator can select in the Control Room Setting> Select Client Configuration, where an option of Secure Recording
is available.

When you ‘Enable’, Control Room Administrator receives the following prompt:

If the Administrator, clicks on ‘Yes’ the setting is enabled and if the Administrator clicks on ‘No’, then the setting remains disabled.

When you ‘Disable’, Control Room Administrator receives a prompt.
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If the Administrator, clicks on ‘Yes’ the setting is disabled and if the Administrator click on ‘No’, then the setting remains enabled.

If you Enable Secure Recording Mode

Note: If a task is recorded when Secure Recording is 'disabled', it will consist object values and
images. If the Secure Recording is then enabled and the same task is opened with the AAE Workbench, the
object values and images will still be visible.

In Object Cloning/ Smart Recorder command, no values and images are captured. Also, when you click on ‘Re-Capture Image’,
images are not captured. When you try to record and play using the Image Option and Save the command, it is not supported in the
“Secure Recording mode.”

In Manage Windows Controls, no values are captured.

In Web Recorder, no values, caption, default texts are captured. Also, none of the values are captured for ‘Extract Data’ and ‘Extract
Multiple Data.’

In Image Recognition command, ‘Image1 is not saved and ‘Image2’ is not captured. While you try to capture ‘Image2’ ensure that it
does not contain any sensitive data.

In Insert Mouse Click/ Screen Recorder and Delay/Wait command, no images are captured.

In OCR command, no images are captured for preview.

In Screen Capture command, when you try to save the command, ensure that the captured image does not contain any sensitive data.
The image will be stored on disk at the location that you have specified

If you wish to continue, click ‘Yes’, and the command is saved. Click ‘No’, if you wish to discontinue and you are navigated back to the
command where you can ‘Cancel’ the command.

In AAE Main Client, screen-shots are disabled while recording when 'Secure Recording Mode' is enabled

l Tools -> Options -> Advanced Settings -> 'Capture Screenshots while recording a task' will be un-ticked and disabled
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l Tools -> Options -> Runtime Settings -> 'Capture Screenshots while running a task' will be un-ticked and disabled

In AAE Workbench, the ‘Visualize’ and ‘SnapPoint’ button is disabled. Also when you enable Snap view an error message “Secure
Recording mode. Image will not be captured” appears.

In Error handling command, while you try to save the command, ensure that the captured image does not contain any sensitive data.
The image will be stored on disk at the location that you have specified.

If you wish to continue, click ‘Yes’, and the command is saved. Click ‘No’, if you wish to discontinue and you are navigated back to the
command where you can ‘Cancel’ the command.

In IF/ELSE command, images are not captured
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Section: Working with TaskBots
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Using the Task List

Automation Anywhere provides a simple, visual view of your automation tasks in the Task List section. Here, you can easily navigate
task folders and work with your tasks.

Using the buttons above the Task List in the main Automation Anywhere window, you can perform the following actions:

1. Create a new task - Record tasks with different recording methods available on the 'Create New Task' window.

Refer Selecting Recording Methods for details.

2. Record a new task - Record keystrokes as well as mouse clicks and movements.

Refer Using the Standard Recorder for details.

3. Run the selected/existing task.

Refer Running a Task for details.

4. Edit/modify the selected/existing task using the Workbench.

Refer Using the Workbench for details.

Using the buttons in the top-right side of the Task List, you can perform additional actions:

1. Delete a task.

2. Upload a task to the Server.

4. Select an action:

l Run: Run the selected task (the automated process).

l Edit: Edit the selected task using the Workbench.
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l Check Out:Check out the selected task for modification after uploading to Version Control repository.*

Note: The option toggles to 'Undo CheckOut' once you have checked out the file for editing.

Undo CheckOut: Undo the last updates to the checked out file. You will be asked for confirmation:

l Upload Task: Upload the selected task to the Server Task Repository.

l Version History: Compare different versions of the task.

l Copy Task: Create a copy of the selected task.

l Rename: Rename the selected task.

l Locate on Disk: Create a copy of a task as an .atmx file in the location: My Documents\Automation Anywhere\Automation Any-
where\My Tasks

l Send To: Send a copy of a task to: Desktop(Create Shortcut), Mail Recipient, Startup Folder or My Documents.

l Delete: Delete a task.

Also See...

l Editing a Task

l Deleting a Task

l Running a Task
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Editing a Task

After initially creating an automation task, you can edit the task using the Workbench to add, modify, or delete actions and steps to the
process.

For example, you might want to remove all built-in delays to increase the speed of the task when it is run.

You can open a task in the Workbench in the following ways:

1. Select (highlight) the task and click the Edit button.

2. Right-click on the task, and select Edit from the pop-up menu.

3. Click on the Actions button, and select Edit.

If you want to edit a task when double-clicking on it, change the setting by following these steps:
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1. In the main Automation Anywhere window, click on Tools -> Options.

2. Click on Advanced Settings.

3. Check the "Edit Task on double click in Task List" check box.

Editing a Task when Version Control is enabled

The editing of a task and its properties will vary depending upon the status of the task when Version Control is enabled.

l When the task file is not Checked Out, you will not be able to edit the task and its properties; it will open in 'view only' mode if you
click on the 'Edit' option:

Also, Properties tab will be disabled for editing and will denote "Checkout the file to enable editing the Properties."

Note: Viewing of logs will not be disabled. To view, click 'View Logs'.
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l When the task file is Checked Out, you will be able to edit the task and its properties.

Note: You can Check Out/Undo Checkout files such as Reports, Documents, Workflows, Scripts and
Lists.

Editing a Password Protected Task

Password protection of tasks is deprecated. Hence tasks that were password protected for editing in earlier versions must be edited,
saved and re uploaded to the Control Room on display of:

Click OK. This will launch the Enter Password window. To remove the password and open the task in edit mode, provide the password.

Save the Task.

Also See...

l Using the Task List

l Deleting a Task

l Repeating a Task

l Adjusting the Speed of a Task

l Stopping a Task

l Sending Email Notifications for a Task

l Locating a Task

l Sending a Task
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Editing a Web-only Task with Web Recorder Commands

You can use the Workbench to edit and enhance the automation tasks that you earlier recorded using the Web Recorder.

When you launch the Workbench, you can add any of the commands that are listed under "Web Recorder".

Using the Web Recorder commands, you can:

l Open and close websites in browser sessions

l Manage web controls

l Download data

l Extract tables

l Test websites and locate broken links

l Extract data

l Navigate URLs

l Extract Website source code

l Search by captions

l Navigate back

l Execute a java script

You can add the following actions to your Web Recorder automation task.

1. Open and Close Browser Sessions

l Open Browser: You can specify a website URL that you want the automation task to open prior to performing actions on that web-
site. For most processes website automation, opening the browser is the first command added to the task, usually followed by com-
mands that manage controls.
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l Close Browser: Closes an open browser session that was previously opened using an Open Browser command.
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2. Manage Web Controls

Use the Manage Web Controls command to select controls on the web page and work with them.

For example, you can insert actions on links, check boxes, radio buttons, drop-down menus, and other objects.

To use Manage Web Controls, follow these steps:

3. In 'Specify a Website URL/Page' choose either 'Open New URL' or 'Select Page' .

If you specify 'Select Page' you are required to select a page title (html page) that is open, from the list.
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Tip: Click 'Refresh' if window is open, yet not visible.

4. Use the Capture button to capture a web control by selecting it with the yellow prompt bar:

5. The control details are displayed.

6. Click the Advanced View button if you wish to include more options.

l Control Name / Control ID: Searches for the web control based on the control name or ID.

l Caption: Searches for the web control based on the caption name that is entered or selected from the text box. For
example, if you record a menu object with a caption titled "Buy Now", this web control lets you search the web page for this
caption when the task runs.

l Control Index: Searches for the web control based on the index number of the control, which is stored while recording a
web page.
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l Attributes:Searches for the web control based on the tag attributes, which are stored while recording a web page. You can
select the tag attributes and specify their values for the web page that is being searched.

You can add or delete tag attributes, as required.

Tip: Best Practice is to use 'Search by Caption' as the first option, 'Search by Attrib-
utes' as second option, and 'Search by Index' as the third option.

7. Enable or disable 'Page Title' and/or 'Page URL' to decide whether to play in existing or new Internet Explorer window.

Note: Both are enabled by default and the task will play in existing Interenet Explorer win-
dow.

8. Specify the action that you wish to perform during task play time.

Tip: You can opt to use a Variable while using the actions Set Text and Append Text. If the
text needs to be encrypted, you can insert Credential Variables* using function key 'F2' for
enhanced security. Learn More
*Available in Enterprise edition from version 10.3

9. Click Save.

3. Download File

Use this command to download HTTP files. This command does not require a browser.

Common Use Cases: Downloading stock data, log files, security patches, or other files that you
routinely need to download.

4. Extract Table

Use this command to select a table on a web page and save the data to a CSV file.

After running the task, including the Extract Table command, Automation Anywhere stores the table data in a system variable named:
$Table Column(index)$
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You can use this variable to retrieve the data that you extracted in row-and-column format by using a combination of Loops for each
row in an Internet Explorer table.

Common Use Case: Transfer data from a web-based ERP system to another application, such as Excel.

Follow these steps to extract table from a website:

1. Select Extract Table

2. Launch the website you wish to extract the table from by clicking on 'Launch'.

3. Use the 'Capture Table' button to capture the table by selecting it with the yellow prompt bar:

The program will display the table number.

4. You can optionally save or append the table data to a .csv file. Or you can process the table data using loops within your task.
Refer Loop Command for details.
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5. Click on View extracted table button to preview the table data in the Extracted Table window:

6. Click the Advanced View button to add more options such as Session Name, Page Title, Page URL, Extract selected Tag Details to
a .csv file

7. Click Save

5. Find Broken Links

Use this command to validate all links on a website or a web page.

After running the command, Automation Anywhere stores the results in a CSV file that you can open in Excel.

Using this file, you can identify any broken links.
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6. Extract Data

Extracts text data from a website or a web page.

This command enables you to specify a range of text that you want to copy, using "Before" and "After" keywords.

Example: Given the text string "= Price: $249 xyz"

You want to capture only the price, which is $249. Specify the following range:

Before keyword: "= Price:"

After keyword: "xyz"

TIP: In some cases, the Extract Data command might skip extracting some records. If this occurs,
select "First and Last record" while capturing pattern-based data. For extensive pattern-based data
extraction, use the Web Recorder.
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7. Navigate URL

Use this command to navigate to a website URL in a browser window that is already open.

8. Extract Source

Use this command to extract source code from a web page.
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Tip: 'Capture' button disabled? Refer the section on Web Recorder in Troubleshooting for details.

9. Search by Caption

Use this command to navigate to a caption or title in a browser window that is already open. Navigation using this command is pos-
sible even if URLs change.

10. Go Back

Use this command to navigate to the previous URL location that was used during website recording.

11. Execute Java Script

Use this command to execute Java Script internally on a web page.
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Note: It is mandatory to enter the 'Function Name' without which the specific script named therein
will not be executed.

l Ensure JavaScript has been enabled for Internet Explorer. If disabled, you may receive an access denied message. For details
refer the Microsoft Support section.

l 'Capture' button disabled? Refer the section on Web Recorder in Troubleshooting for details.

Also See...

l Using the Web Recorder

l Extracting Regular Web Data

l Extracting Pattern-Based Data

l Extracting Table Data

http://support.microsoft.com/gp/howtoscript
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Editing Multiple Commands (Bulk Edit)

To make editing automation tasks easier, Automation Anywhere provides a Bulk Edit feature, which enables you to edit multiple com-
mands at one time.

Prerequisite for Editing Multiple Commands

*Available from 9.0.2

Before you Bulk Edit multiple commands it is important to ensure that all the selected commands are of same type and enabled.

Note: Bulk Edit doesn't work if any of the selected command is disabled.

Editing Multiple Delay Commands

Using Bulk Edit, you can apply the settings for a specific delay command to multiple delay commands in your task. Follow these steps:

1. In the Workbench, select multiple Delay commands in the task.

2. Right-click on one of the selected commands and select Bulk Edit from the pop-up menu.

3. In the Delay/Wait window, set values for the delay settings and click Save.

4. In the Task Actions List view of the task, you'll see that all of the Delay commands that were included in the Bulk Edit operation are
now changed to the new settings.
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Note: Bulk Edit works with two command types: 'Delays' and 'Keystrokes'. You can however edit
either keystrokes or delays, individually.

Use Case Scenarios

1. Set a common delay of 5 seconds to multiple Delay commands

1. Open the task in the Workbench.

2. In the Task Actions List, select (highlight) multiple Delay commands using the Control key, or use the Filter to view all of the Delay
commands in the task.

3. Right-click on one of the selected commands and choose Bulk Edit.

4. In the Delay/Wait window, enter "2000" in the Delay field.

5. Click Save.

2. Set a common random delay for multiple Delay commands

1. Open the task in the Workbench.

2. In the Task Actions List, select (highlight) multiple Delay commands using the Control key, or use the Filter to view all of the Delay
commands in the task.

3. Right-click on one of the selected commands and choose Bulk Edit.

4. In the Delay/Wait window, Select Random Delay.

5. Enter "5" in the 'From' field.

6. Enter "500" in the 'To' field.

7. Select the Delay in Seconds radio button.

8. Click Save.

Editing Multiple Keystroke Commands

Using Bulk Edit, you can apply the settings for a specific Keystrokes command to multiple Keystrokes commands in your task. Follow
these steps:

1. In the Workbench, select multiple Keystrokes commands in the task.

2. Right-click on one of the selected commands and select Bulk Edit from the pop-up menu.

3. In the Insert Keystrokes window, set values in the Keystrokes settings and click Save.

l In the Task Actions List view of the task, you'll see that all of the Keystrokes commands that were included in the Bulk Edit operation
are now changed to the new settings.

Also See...

l Editing a Task

l Deleting a Task

l Changing Window Titles
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Changing Window Titles

If you record a task with an application for which the window title changes frequently, use the Workbench commands for updating the
task to refer to the proper title.

For instance, several scenarios can exist:

1. The window title of a web page or a Windows application changes continuously due to dynamic content.

l The title in Microsoft Outlook changes frequently as the user selects new folders.

l A web page title contains a session ID for the website.

2. Copied tasks - If you copy a recorded task to create a new task, the application titles will need to be changed.

3. When you use a wild card, the 'Current Active Window' command, or variables to use for setting window titles.

Tip: You can use the Windows filter to select a particular Window name, enabling you to view task
actions that are sorted by application.This filter provides a convenient view of any or all applic-
ations that are used in your task.

How to use the Change Window Title action

To use the Change Window Title action to apply a common window title to multiple application windows, follow these steps:

1. In the Workbench, use the Windows filter to select a particular Window name.

2. Select one or more commands with the window title for which you want to change.

3. Right-click on one of the selected windows commands and choose the Change Window Title action. You can also use the Actions
button to select the Change Window Title option.

4. Set a common Window title for the selected windows that your want to change and click OK.

l In the Task Actions List view, you'll see that the windows titles are changed to the new title that you've assigned. Refer the example
given here:

Assign a common window title to multiple window actions

1. Open the task in Workbench.

2. In the drop-down list of the Windows filter, select one particular application window.

3. Using the Control key, select (highlight) multiple windows commands to edit their window titles.
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4. Right-click on one of the selected commands, and choose Change Window Title from the pop-up menu of actions.

5. In the Change Window Title dialog, specify a window title to replace the current selected window titles.

l Use the Find and Replace commands to browse and replace the title, as appropriate.

6. Click Save.

Also See...

l Editing a Task

l Deleting a Task

l Changing Window Titles
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Copying or Renaming a Task

One of the enormous benefits of using Automation Anywhere is the ability to reuse processes that you automate. Copying and renam-
ing automation tasks allows you to reuse tasks that have been previously built.

Copying a Task

To copy a task, follow these steps:

1. In the Task List, select (highlight) the task you want to copy.

2. Copy the task using one of the following methods:

l In the File menu, select Copy.

l In the Actions button, select Copy from the drop-down list.

l Right-click on the task and select Copy.

3. In the Copy Task window, select a directory location and specify a file name for the new copy of the task.

4. You can also create a desktop shortcut, if required.

5. Click Save.

l The new task is added to the Task List view.

l All commands in the original task are available in the new copy of the task.

Renaming a Task

To rename a task, follow these steps:

1. In the Task List, select (highlight) the task you want to rename.

2. Rename the task using one of the following methods:

l In the File menu, select Rename.

l In the Actions button, select Rename from the drop-down list.

l Right-click on the task and select Rename.

3. In the Rename File window, specify a new file name for the task.

4. Click Save.

l The renamed task is displayed in the Task List view.
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Copying and Renaming files and folders if Version Control is enabled

You can copy and rename files and folders in the local repository.

l Copying and Renaming Files

l When copying a file, if the same file exists in the repository you will not be able to over write the same.

l When renaming a file that has been uploaded to the server repository, you will be prompted:

If the file is checked out for edit, you will be prompted:

Only the local file version will be renamed. Undo Check out to rename the file.

l Copying and Renaming Folders

l You can rename folders in the local repository only:

l If selected folder comprises a file that is checked out for edit, you will not be allowed to rename the folder. In order to
rename the folder, you will have to undo checkout or upload the relevant file first.

Also See...

l Using the Task List

l Editing a Task

l Deleting a Task
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Deleting a TaskBot

As a Bot Creator with access privileges to particular folders, you might want to delete an existing automation TaskBot.

To delete a TaskBot, follow these steps:

1. In the Task List, select (highlight) the TaskBot you want to delete.

2. Delete the TaskBot using one of the following methods:

l In the Edit menu, select Delete.

l In the Actions button, select Delete from the drop-down list.

l Right-click on the TaskBot and select Delete.

3. In the Delete Task? window, click on Yes.

l The TaskBot is removed from the Task List view.

Similarly, you can delete a TaskBot from the server:

1. Go to Manage → Repository

2. Select TaskBot(s) from the Server Repository

3. Click Delete

l The TaskBot is removed from the Server Repository→ My Tasks list view

Note: After deleting a TaskBot, you cannot restore the TaskBot on the client. Before deleting a
TaskBot, be sure you no longer have use for that TaskBot.

If the TaskBot was copied to the server, you can restore it by copying the server version to the client.

Tip: As a best practice, be sure that all tasks are copied to the server as a way of backing up your
automation projects.
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Deleting a file and folder if Version Control is enabled

1. Deleting a TaskBot

a. Deleting from local repository - If you have version control enabled, while deleting a TaskBot or a file from the Client, apart
from confirmation, you will be notified that the TaskBot/ file will be deleted locally only.

b. Deleting from Server repository - To delete a TaskBot/file from the server repository, you will have to select it from the rel-
evant folder of the repository.

o Scheduled Bot (Task/File) - While attempting to delete a Bot that is used in a schedule, you are shown:

l To deleta a Bot that is scheduled to run, you must remove it from the schedule.

o Dependent Bot (Task/File) - While attempting to delete a Bot that is dependent on another TaskBot, you are shown:

l To delete a task that is listed as dependent on some other TaskBot, you must first remove the dependency
from the Client. You can then upload the TaskBot to the server again to ensure it is not being used as
dependency.

2. Deleting a Folder
You can delete a folder from the local repository only:
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Note: The 'Delete Folder' option is disabled if it comprises a TaskBot that has been checked
out for edit.

Also See...

l Using the Task List

l Editing a Task
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Running a Task

In most cases, as you create automated tasks, you'll want to test the process to ensure that the results match your expectations. You
can test an automated process by running the task.

When running tasks, Automation Anywhere provides advanced task-queuing technology with run-time settings that you can tune.

You can run a task manually or you can schedule a task to be run at a later time.

To manually run a task, follow these steps:

1. In the main Automation Anywhere window, select (highlight) the task you want to run.

2. Run the task by using one of these methods:

a. Click the Run button.

b. Click on the File menu and select Run.

c. Click on the Actions button and select Run from the drop-down list.

d. Right-click on the task and select Run.

l When a task begins to run, a Run-Time window is displayed.

You can pause or stop a task from running at any time.

1. To pause the task, press the Pause button on the 'Run Time Window'

2. You can resume running the task by using the Play button on the 'Run Time Window'.

3. To stop a task from running, use one of the following methods:

a. Use the Stop button.

b. Press the Escape (ESC) key on the keyboard.

Tip: You can also modify your hotkeys to use a different key to stop tasks that are running.
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When stopping a task, the process does not end abruptly. The Run-Time window displays the message "Aborting" and completes any
step that is in progress.

Note: When using the 'Run Task' command, if you have a sub-task running within the main task, the
window will display the task hierarchy.

The run-time window will display:

l The selected and current task being executed.

l The task's action being performed.

l The task's line number.

l Tool tip - if the task flow is too long to fit within the window.

Tip: Hover the cursor over the task name and the task flow is displayed as a tool tip.

Running Password Protected Tasks

In order to run a password protected task, you are prompted to edit, save and re upload the task to the Control Room as the Password
protection feature is deprecated.

While running such tasks you are displayed:
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Click OK. This will launch the Enter Password window. To remove the password and open the task in edit mode, provide the password.

Save the Task.

Also See...

l Setting Up Hotkeys for a Task
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Stopping a Task

While running an automated task, you can pause or stop the process, as necessary. You can stop a task from running either manually
or by inserting a conditional command within the task.

Stopping a Task Manually

To stop a task manually, simply click the Pause or Stop button on the progress window, or press the Escape (ESC) key on the
keyboard for 2-3 seconds.

Stopping a Task Using a Condition

You can stop a task by using specific conditions by inserting a 'Stop Task' command.

A Stop Task instruction looks like this in the Workbench:

Tip: Stop the task only when encountering a file that is larger than a particular number of megabytes
(MBs).

To know more about using this command refer Stop Task Command.

Also See...

l Running a Task

l Editing a Task

l Deleting a Task
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Locating a Task on Your Computer

In some cases, you might want to locate the task file that is associated with an automated task you've created.

Automation Anywhere files have the file extension of: '.atmx'

To locate an Automation Anywhere task file on your computer, follow these steps:

1. In the main Automation Anywhere window, select the task in the Task List for which you want to locate the .atmx file.

2. Either click on the Edit menu or on the Actions button, and select 'Locate on Disk'. A Windows Explorer window is displayed show-
ing the folder containing the task files.

3. Locate the automation task file. The task name matches the name you've assigned to the task.

Also See...

l Sending a Task
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Sending a Task

Occasionally, you might want to distribute your automation tasks to other people and locations. Using the 'Send To' option, you can
send a task to the following locations:

1. The Desktop - you can create a desktop shortcut to run the task with a click of a button.

2. An email recipient - Send the task to another person using an email address.

3. The Start-up folder - Enable the process to be run each time the computer starts by using the Windows Start-up folder.

4. The My Documents folder - Organize and run tasks from the My Documents folder.

To send a task to any of these locations, follow these steps:

1. Either click on the Edit menu or on the Actions button, and select 'Send To'.

2. Select one of the Send To options and complete the information, srequired.

Also See...

l Sending Email Notifications for a Task

l Locating a Task on Your Computer
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Setting Task Properties

After you create an automation task, you can view and change its properties.

Use the Properties tab to set and adjust the settings for your task. On this tab, you can do the following:

l View and set general properties, such as setting the priority status and viewing the date it was created.

l Specify the frequency or conditions to repeat the task.

l Adjust the speed for which a task runs.

l Set up email notifications for a task.

l Specify hot keys to use with you task.

l Set security parameters to ensure that only authorized users run the task.

l Enable sharing data for Analytics

Also See...

l Viewing and Setting General Properties

l Repeating a Task

l Adjusting the Speed of a Task

l Sending Email Notifications for a Task



Copyright © 2018 Automation Anywhere, Inc. 95 https://support.automationanywhere.com

Viewing and Setting General Properties

After you create a task, you can view and edit the task's general properties by using the General tab.

The general properties include task name, status, last run time, and other statistics. You can also use the Description/Notes field to
enter useful comments about the task.

General Properties - An Overview

l File Name - Displays name of the task

l Created at - Displays the date and time of task creation

l Status - Displays the last time the task was run.

l View Log - Click View Log to see historic and detailed status of the task. If the task has failed, View Log shows the line number
where the task failed.

Refer the sample of the log as displayed in notepad given below:

l Last Run Time - Displays the last time the task was run.

l Mouse Clicks - Lists the total mouse clicks recorded in a task, automatically calculated based on the task.

l Keystrokes - Lists the total keystrokes recorded in the task, automatically calculated based on the task.

l Total Clicks - Lists the total clicks (Mouse Clicks + Keystrokes) recorded in the task. Automatically calculated based on the task.

l Priority for queuing - Specify a priority for the task, which will decide the precedence of the task when it is in a queue. Also, if the pri-
ority is same then rules apply for precedence of jobs.
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l Timeout - Specify timeout for the task to ensure that the task gets aborted automatically after the specified time. Timeout can be set
only in minutes between 0 and 9999. Refer Timeout for more details.

l Enable this task to run with other similar files or window titles - By default, the task recorded will only run on the specific file(s) it
was recorded on. However, an option is available for running the recorded task on any file within the application it was recorded in.
For e.g., a task recorded on the file abc.xls can run on def.xls, xyz.xls, or any other *.xls file, without editing the task.

l Description/Notes - Add descriptions and notes for a task in the Description/Notes window.

Also See...

l Running a Task
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Timeout

Timeout feature allows you to specify the time after which the task will be aborted automatically. The feature is especially beneficial for
tasks that are run in unattended mode. In any case, if the task gets stuck somewhere, it will automatically aborted if it doesn't get any
response within the specified time. Once a task gets timeout, the downstream tasks (the tasks in queue) can run smoothly.

To set the timeout for a particular task, follow the steps mentioned below:

1. Select the task for which you want to specify timeout.

2. Now simply input the timeout for a task in the Properties Section.

Note: Range of the Timeout is from 0 minute to 9999 minutes.

It is also important to note that Timeout for a task is not applicable:

l If the task is run in Debug mode.

l If the task is called through 'Run Task' command. In this case, timeout of the main task will be applicable.

For the tasks that are run in 'Repeat' mode, timeout should be specified keeping in mind the interval of repeat. For instance, a task is
set to repeat 5 times and the time between each repeat is specified as 5 minutes. In such a case, it is advised that Timeout for that task
is set after calculating the total time that it takes to finish all the repetitions.

Timeout time-frame is excluded:

l When a task is manually paused.For instance, if Timeout is set for 1 minute and the task is paused after 40 seconds. In this case,
the task will Timeout after 20 seconds of being resumed.

l When a low priority task is suspended and is resumed after completion of a High Priority task. For instance,if Timeout is set for 1
minute and the task is suspended after 40 seconds. In this case, the task will be timed out after 20 seconds of being resumed after
completion of the High Priority task.

l When first task is Paused, second task is aborted and first task is resumed.
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l When a low priority task is suspended and is resumed after the High priority task gets Timed out. For instance, ifTimeout is set for 1
min and the task is suspended at 40 seconds and High priority task is timed out. In this case the low priority task will not be
resumed.

Note: Timed out task ROI is not added to the total ROI.

For more information contact https://support.automationanywhere.com.

Timeout Notifications

l When a task gets Timed Out, user is informed about it through Notifications.

l You can also set Email Notification to be informed whenever a task is Timed Out. For more details, refer Setting Up Email Noti-
fications.

l You can see historic and detailed status of a Timed Out task by clicking on View Log in General Properties of the task.

l For more information on tasks that have been Timed Out, you can view Timeout entry in System Logs. Refer Viewing System Logs
for details.

l You can also see how many times a task has Timed Out in Visual Reports. Refer Reports for more details.
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Repeating a Task

Automation Anywhere enables you to repeat a task that is scheduled to run. This feature is especially useful while testing automated
tasks, or tasks that need to repeat upon run failure or even when running routine maintenance tasks.

Use the Repeat property in the main Automation Anywhere window:

You can set the following options for the Repeat property:

l Do not repeat: The task runs only once. This is the default option.

l Repeat a number of times: Repeats the task a number of times, as specified in this field.

Example: Repeat an email task 15 times to send 15 emails.

l Repeat until I Stop it: Repeats the task until you stop it by clicking the stop button or by pressing the ESC key. Use this option
when you are not sure how many times the task needs to run.

l Repeat for hh:mm:ss time: Repeats the task for a time period that you specify.
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Note: You can specify up to 99 hours, 59 minutes, 59 seconds (a repeat duration of just over 4
days).

l Time between repeats: Sets a duration of time to wait before repeating a task.

l Upon error, continue with next repeat: By default, running tasks are stopped when an error occurs. By setting this option, the
task is repeated regardless of run failure.

Also See...

l Viewing and Setting General Properties

l Adjusting the Speed of a Task

l Sending Email Notifications for a Task

l Setting up Hotkeys for a Task
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Adjusting the Speed of a Task

Use the Speed property to adjust the speed at which a task runs. You can also view the duration in hours, minutes, and seconds that it
takes the task to run.

The speed of the task can be adjusted to run in 3 speeds:

l Standard Replay - The task runs at the same speed as when it was recorded.

l High-Speed Replay - The task runs at a faster speed than was recorded.

l Turbo-Action Replay - The task runs at the fastest speed and excludes any mouse moves.

The Automation Anywhere SMART Automation Technology ensures that when you increase the replay speed, accuracy and reliability
are not compromised.

Tip: In some rare cases, certain pauses during the recording of a process have implicit application-
specific meaning. In these cases, set the replay speed to the Standard Replay mode to ensure the most
accurate replay.

Also See...

l Setting Task Properties

l Scheduling Tasks to Run
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Sending Email Notifications for a Task

When planning to run your tasks, you can set up email notifications that are sent to one or more email addresses that you specify.

In the Notification tab under Properties, select 'Send email notification when task finishes' and specify one or more email addresses.

If you select 'Send email notification when task finishes' check box, but do not specify an email address, Automation Anywhere uses
the email address that is specified in the 'To:' field in the Tools -> Options -> Email Notification.

Tip: If you only need to specify one email address to notify, set it using the Tools menu and select-
ing Options -> Email Notification. However, if you need different tasks to send status emails to dif-
ferent email addresses, specify these email addresses for each task individually.Refer Setting up Email
Notifications for details.

Also See...

l Setting Task Properties

l Editing a Task
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Setting up Hotkeys for a Task

One of the distinguishing benefits of automating your tasks with Automation Anywhere is the ability to launch a task with the press of a
single key.

You can assign a hotkey to an automated task by using the Hotkey property.

To assign a hotkey, follow these steps:

1. On the Properties tab, select Hotkey.

2. Either specify a hotkey in the field provided or select a hotkey from the pop-up window. If a hotkey is being used by another pro-
cess, it will be show as not selectable in the list.

Note: The automated tasks can run even when the Automation Anywhere client is not running.

Also See...

l Stopping a Task

l Scheduling Tasks to Run
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Setting Security Features for a Task

Automation Anywhere provides advanced security for running tasks in a secure manner using various features such as stealth mode
task play and disable mouse/keyboard.

Important: From Enterprise edition 10.2, Password protection in tasks is deprecated. On upgrading
to Enterprise edition 10.2, your password protected tasks will have to be manually edited to remove the
password.

The Security* property provides the following features:

Auto-Login Advanced Settings: You can specify the following advanced settings for Auto-Login:

l Running this task in stealth mode: Use this option to prevent information from being displayed on the screen while the task is run-
ning in Auto-Login mode. Application windows and programs are hidden from your screen to avoid unauthorized users seeing the
information.

l Disable mouse and keyboard for this task: Use this option to disable the computer mouse and keyboard while the task is running
in Auto-Login mode. Unauthorized users are prohibited from gaining control of the computer while the task runs. If the computer
recognizes an unauthorized user who is accessing the computer, Automation Anywhere automatically locks the computer, ensur-
ing security.

For this option to work you must ensure that the Run Task as an Administrator option is enabled in Tools > Options > Runtime Set-
tings. Learn More

Note: When nesting automation tasks, if a parent task runs a child task, the Auto-Login set-
tings of the parent take effect, regardless of the settings of the child.

* The security feature is not available in the Trial version.

Also See...

l Running a Task

l Scheduling a Task
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Viewing System Logs

Automation Anywhere logs all events that occur in the application. Major events, such as a task run, task creation, and changes to task
properties are logged.

To view this logged data, Automation Anywhere provides System Logs. The System Logs show all client activities. These reports are
very useful for monitoring and troubleshooting.

To view the system logs, follow these steps:

1. From the main Automation Anywhere window, click on the Tools menu and select System Logs.

2. Select the Log Type from the drop-down list. The types include:

l Task Creation

l Task Run

l Task Modification

l Task Deleted

l WorkFlow Creation

l Workflow Run

l Workflow Modification

l Workflow Deleted

l Report Creation

l Report Run

l Report Modification

l Report Deleted

l Task To Exe

l Schedule

l Trigger
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l Task Properties

l App Configuration

l File

l Folder

l Script

l Other

3. Specify the Start and End dates in the format you specify.

4. Click Generate Logs.

5. To export the logs to a CSV file, specify the name of the CSV file and click Export.

6. To delete an entry, select the check box next to the log and click Delete.

Also See...

l Using the Error View

l Enabling the Debugging Option

l Logging into Windows when Application Path Changes
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Scheduling Tasks to Run

After creating an automated task, you can schedule the tasks to run based on a schedule or on a trigger event.

Note: In Enterprise editions 10.0 & 10.1, Bot Creators - Client users with task creation privileges
can only test run the tasks using the 'One Time Only' schedule option. However, Bot Runners - Client
users with run time privileges, can continue to schedule tasks using various options if using Enter-
prise edition 10.2. and above. Learn More

Scheduling Tasks

Automation Anywhere provides a Scheduler and a Schedule Manager that you can use to run your tasks anytime you want.

Scheduling Tasks Using the Scheduler

The Automation Anywhere Scheduler provides time-based scheduling capabilities. You can schedule tasks to run on particular days,
weeks, or months of the year.

For more information on the Scheduler, see Scheduling Tasks Using the Scheduler.

Viewing Task Schedules Using the Schedule Manager

The Schedule Manager enables you to view, add, or edit the schedules of tasks that you have created.

For more information on the Schedule Manager, see Using the Schedule Manager.

Scheduling Tasks Using Triggers

To run a task based on a trigger event, use the Trigger tab on main Automation Anywhere window.

Some examples of events that can trigger a task to run include when:

l A new window opens

l A specific file is created

l A file is deleted

l An email is received in a particular in-box

For more information about using triggers, see Using the Trigger Manager

Also See...

l Recording an Automation Task

l Using Special Keys

l Setting Task Properties

l Exiting the Automation Anywhere Client
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Scheduling Tasks Using the Scheduler

The Automation Anywhere Scheduler enables you to schedule automated tasks to run at preferred times, without requiring supervision
or intervention.

Scheduling Tasks

Automated tasks and process workflows can be scheduled to run as shown:

Schedule a task using the Scheduler by following these steps:

1. Select the task that you want to schedule.

2. Click the Schedule tab.

3. Set the scheduling information for time, date, and frequency.

4. Click on Save.

5. Provide your Windows user name and password.

If you have already saved Windows Login Credentials in Login Settings option, then Scheduler
will not prompt you to input the credentials again.

6. Schedule a task to run, multiple times. To add more scheduled times, click the Add button.

To ensure the computer is unlocked when a scheduled task runs, see Using the Auto-Login Option.

Automation Anywhere provides scheduling options for running tasks with the following frequencies:

l Daily (for example, every day, only weekdays, or every 2 days)

l Weekly (specific days of the week; for example, Mondays)

l Monthly (specific days of the month; for example, January 1 and October 5)

l One time only

l When the computer is started

l When you log onto the computer

l When the computer is idle

Note: Schedules not visible after upgrade? Refer 'Migrating schedules to newer versions'.



Copyright © 2018 Automation Anywhere, Inc. 109 https://support.automationanywhere.com

Entering Windows Login Information

For security reasons, when scheduling tasks to run using the Scheduler, you may be required to enter the Windows user name and
password. This security check ensures that only the machine owner can schedule tasks to run.

No User Name and Password?

Many automation users do not have passwords set on their systems. In this case, you can create a password to enable you to schedule
tasks. Use the Auto-Login option to avoid needing to enter the password each time you start the computer.

To create a password on your system, follow these steps:

For Windows 7

1. On the Windows 7 desktop, click the Start button and click on the Control Panel.

2. Double-click on User Accounts.

3. Complete the instructions for creating a password. Any valid password is acceptable, although it cannot be a blank password.

To configure your machine to use the Auto-Login option, follow these steps:

1. On the Windows 7 desktop, click the Start button and click Run.

2. Type: control userpasswords

l The User Accounts window is displayed.

3. Go to the Advanced tab

4. Deselect the 'Require users to press Ctrl + Alt + Delete

Note: Enabling Auto-Login makes the computer more convenient to use, but can pose a security risk.
Be aware that any person can turn on the machine and access your files.
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Also See...

l Scheduling Tasks to Run

l Scheduling Tasks Using Triggers

l Setting Task Properties
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Using the Schedule Manager

The Automation Anywhere Schedule Manager is a convenient facility that displays all task schedules that are set for your tasks. Using
the Schedule Manager, you can view, add, or edit any of your task schedules.

Viewing Task Schedules

To view your task schedules, launch the Schedule Manager in one of the following ways:

l In the main Automation Anywhere window, click on the Schedule Manager tab on the lower left side.

l Or click on Tools -> Schedule Manager on the menu bar.

Note: Schedules not visible after upgrade? Reference 'Migrating schedules to newer versions'.

Creating, Editing, and Deleting Task Schedules

You can manage all of your task schedules by using the tabs in Schedule Manager:

1. Date and Time tab

2. System tab
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Date and Time Schedules

Within the Date and Time tab, you can use the Day, Week, and Month tabs to work with scheduled tasks.

You can add, edit, or delete scheduled task to run by using any of these views:

l Day: The Day view displays the time and description for each scheduled task. You can add, edit, or delete scheduled tasks. Use
this if you need to run your tasks daily and with more frequency.

l Week: The Week view displays the date and time of scheduled tasks for the week, and includes a description. Use this option
when you wish to schedule to run your task on a weekly basis.

l Month: The Month view displays the date and description of scheduled tasks for the month. Use this option when the frequency of
running your tasks could be scheduled monthly.

l Date Range: In the Select Date section on the left, you can specify a date range for scheduled tasks by clicking and holding the
mouse button on a start date and dragging it to the end date, highlighting the range. The Month view automatically opens to display
scheduled tasks within that date range.

Adding, Editing and Deleting Schedules

You can add, edit and delete schedules for tasks on your Client machine using various options:

l Daily (for example, every day, only weekdays, or every 2 days)

l Weekly (specific days of the week; for example, Mondays)
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l Monthly (specific days of the month; for example, January 1 and October 5)

l One time only

To add a schedule, click on and select the required option and save.

To edit a schedule, select the schedule and click on or double click or context click and select 'Edit'. You can per-

form similar actions by clicking on to delete a schedule.

System Command Schedules

Use the System Tab to view tasks that are scheduled to run based on system events, such as triggers.

Using this view, you can add, edit, or delete task schedules that use triggers to initiate a run.

The following system triggers are available:

l When My Computer Starts

l When I Log On

To add a System event schedule, click on and select the required option and save.
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To edit a schedule, select the schedule and click on or double click or context click and select 'Edit'. You can perform sim-

ilar actions by clicking on to delete a schedule.

Changing the Filter View of Task Schedules

You can change the view of scheduled tasks by clicking on Change Filter on the extreme right of the systems tab in the Schedule Man-
ager.

Select tasks to view by taking one of the following actions:

l Browse to the required file or folder, and select the task.

l Select multiple tasks by holding the Control (Ctrl) key and selecting the tasks.

l Select "All" to view all scheduled tasks for the system.

Also See...

l Scheduling Tasks to Run

l Using Triggers
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Scheduling Tasks in Bot Creator or Bot Runner

The Automation Anywhere Scheduler enables Development Clients to schedule automated tasks once to run at preferred times,
without requiring supervision or intervention.

It is important to note that Bot Creators - Client users with task creation privileges and Bot Runners - Client users with run time priv-
ileges, can only test run the tasks using the 'One Time Only' schedule option. However, the Bot Runners can continue to schedule
tasks using various options if using Enterprise edition 10.2.

To run a scheduled task on a Bot Runner, the Control Room Administrator can create a schedule using Tasks Schedule console in
Control Room.

Note: If you have already saved Windows Login Credentials in Login Settings option, then Scheduler
will not prompt you to input the credentials again.

Scheduling Tasks

A. Bot Creators i.e. Clients with Development privileges can schedule an automated task to run for 'One Time Only' as shown below:

1. Select the task that you want to schedule.

2. Click the Schedule tab.

3. Select 'One Time Only' option from a drop down.
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4. Set the scheduling information for time and date.

5. Click on Save.

6. Provide your Windows username and password.

B. Bot Runners i.e. Clients with only run-time privileges can schedule tasks using various options with the following frequencies:

l Daily (for example, every day, only weekdays, or every 2 days)

l Weekly (specific days of the week; for example, Mondays)

l Monthly (specific days of the month; for example, January 1 and October 5)

l One Time Only

l When My Computer Starts

Note: If you Shut down and then Start your machine instead of using Restart, it is important
that you first disable the fast startup option given in the Power Options settings of Control
Panel.

For example, if you are using Microsoft Windows 8, 8.1 or 10, follow these steps:

i. Go to Control Panel → Power Options

ii. Click Choose what the power button does→ Change settings that are currently unavailable.

iii. Disable Turn on fast startup option

Refer the Microsoft website for details.

https://answers.microsoft.com/en-us/windows/forum/windows8_1-performance/fast-startup-how-to-disable-if-its-causing/f9a4a2d0-104d-42dc-9946-4a2e13c0a348
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l When I Log On

To ensure the computer is unlocked when a scheduled task runs, see Using the Login Settings Option.

Note: Schedules not visible after upgrade? Refer 'Migrating schedules to newer versions' section in
Troubleshooting for details.
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Scheduling Tasks Using Triggers

In addition to scheduling a task to run based on a date and time, you can use trigger events to start your automated tasks.

The Trigger feature enables a task to run automatically in response to an event that occurs on your computer. You can use triggers to
run a task when, for example, a new window opens or a specific file is created.

To use triggers, select an automation task and click on the Trigger tab in the main Automation Anywhere window and select the trigger
type that suits the selected task.

Note: Be cautioned that on Windows login, the trigger for a scheduled tasks take some time to come
into effect. Hence, it is recommended that you wait for the trigger event to launch when you start your
machine and use Windows credentials to login.

Also See...

l Adding a Trigger to a Task

l Managing Triggers Using the Trigger Manager
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Adding Triggers to a Task

An Automation AnywhereTrigger automatically runs a task in response to an event that occurs on your computer. You can use triggers
to run a task when, for example, a new window opens or a specific file is created.

Automation Anywhere provides the following types of trigger events:

Before using trigger events you must take note of the following:

l Triggers do not work on machines when in Logged off state. However, when in Locked state triggers can work if Auto-Login is
enabled. Refer Using the Auto Login Option for details.

l Triggers are applicable only in the local instance of the Client.

l Triggers do not get uploaded with the task to the Control Room and hence cannot be deployed.

Using Window Triggers

Window triggers launch an automated task when an application window action takes place. Automation Anywhere provides the list of
open applications on your computer and enables you to refresh the list at any time. You can select from either of the following options
as the trigger event:

l When an application window opens

l When an application window closes
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Using File Triggers

File triggers launch an automated task when a file action takes place. You can select from any of the following options as the trigger
event:

l When a new file is created

l When an existing file is deleted

l When a file is renamed

l When a file is modified

Using Folder Triggers

Folder triggers launch an automated task when events affect folders on your computer. You can select from any of the following options
as the trigger event:

l When a new file is created in the folder

l When an existing file is deleted in the folder

l When a file is renamed in the folder

l When a new folder is created

l When an existing folder is deleted

l When a folder is renamed

l When a folder is modified
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Using Performance Triggers

Performance triggers launch an automated task when particular computer resources reach a threshold or certain criteria are met. You
can select from the following options as the trigger event:

l CPU Usage: The computer CPU usage reaches a level that you specify (in %).

l Free Disk Space: A certain amount of free disk space is reached that you specify in megabytes (MB).

l Process Count: When a particular number of processes that you specify are running.

Using Process Triggers

Process triggers launch an automated task when a system process starts or stops. Automation Anywhere provides the list of available
processes for your computer and enables you to refresh the list at any time. You can select from either of the following options as the
trigger event:

l When a process starts running

l When a process stops running
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Using Service Triggers

Service triggers launch an automated task when a system service takes action. Automation Anywhere provides the list of available ser-
vices for your computer and enables you to refresh the list at any time. You can select from any of the following options as the trigger
event:

l When a service starts running

l When a service stops running

l When a service resumes running

l When a service pauses

Using Email Message Triggers

Email Message triggers launch an automated task when an email is received in the email account that you specify. To specify a trigger
for new incoming email messages on a mail server, specify the following:

l Host name

l Port details

l User name

l Password

l A time interval to use between checking for new messages

l If the email account uses SSL, check the "Server Uses Secure Connection (SSL)" check box.

Examples of Using Triggers

Example 1: Run an automated task each time a 'Microsoft Excel' window opens:
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1. For Trigger type, select Window.

2. From the Window Title drop-down menu, select the title Evaluation Users - Excel. If the window is not available in the list, open the
application and click on Refresh.

3. Under Action, select 'When window opens'.

4. Save the trigger by clicking the Save button. The task will now run each time Microsoft Excel opens.

Example 2: Run an automated task that sends an email whenever a file is deleted from a critical work folder on the computer.

1. For Trigger type, select Folder.

2. For Folder Name, click on the ellipsis (...) and select the folder that you want to monitor.

3. For Action, select 'When any file is deleted.'

4. Save the trigger by clicking on the Save button. When a file is deleted from the selected folder, the task will run and send a noti-
fication email.

Recommendations for Using Triggers

Automation Anywhere recommends you follow these guidelines with using triggers to run your tasks:

l If you are running a task on a locked computer, use the Auto-login feature to unlock the computer when the triggered task runs. See
Using the Auto-Login Option. Refer Using the Auto-Login Option for details.

l You can assign a system variable to a trigger action that returns the name of the file, folder, or window that used to trigger the task.
Refer Trigger Variables for details

l Use triggers to run process work flows. Refer Scheduling Tasks Using Triggers for details.

Also See...

l Using the Trigger Manager
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Using the Trigger Manager

Over time, you might create several triggers that run various automated tasks. For example, a single task might be run using five dif-
ferent triggers, or a single trigger might run five different tasks. As the number of tasks and triggers grow in number, you will want to
organize and manage these triggers.

You can use the Trigger Manager to display, add, modify, and delete triggers you have set for your tasks.

Using the Trigger Manager, you can:

l Add a trigger

l Modify a trigger

l Delete a trigger

l Enable a trigger

l Disable a trigger

To use the Trigger Manager, follow these steps:

1. In the main Automation Anywhere window, click on Trigger Manager tab on the left side. The Trigger Manager window is displayed,
showing the tasks that are driven by each trigger.

2. Add additional triggers or work with your existing triggers:

l To add a new trigger, click the Add button.

l To edit an existing trigger, click the Edit button.

l To delete an existing trigger, click the Delete button and click "Yes" to confirm.

l To enable a trigger, ensure that the check box in the far left column is checked.

l To disable a trigger, un-check the check box in the far left column.

You can enable or disable all triggers at once by checking or un-checking the check box at the top of the Trigger Manager window.

Note: Be cautioned that on Windows login, the trigger for a scheduled tasks take some time to come
into effect. Hence, it is recommended that you wait for the trigger event to launch when you start your
machine and use Windows credentials to login.
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Also See...

l Scheduling Tasks Using Triggers

l Scheduling Tasks to Run
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Troubleshooting Scheduled Tasks

Having trouble running a scheduled task?

If your scheduled task fails to run, follow these steps:

1. Ensure that you have provided the user name/password.

For security reasons, you may be required to enter your user name and password to run a scheduled task.

2. If you have multiple accounts, verify that the correct user name/password are used.

If you have multiple accounts on the same computer, such as a domain account and a local account, verify that the user name
you specified is the same user name that was used to log into the computer. Scheduled tasks will not run if the scheduled task
attempts to run under a different user account. Automation Anywhere pre-fills the user name field with the user name you used
to log in.

3. Check the task status in Control Panel.

To check the status of the task in the Control Panel, follow these steps:

1. Open the Control Panel and click on Scheduled Tasks.

2. Select the task that corresponds to your task (the file starts with your task name).

3. Right-click on the task and select Run. If the task does not run, check the Status column.

4. Schedule the Calculator Application.

If your task still does not run, follow these steps:

1. Open the Control Panel and click on Administrative Tools.

2. Click on the Task Scheduler.

3. In the Active Tasks drop-down, select Calculator (see figure below). If the calculator does not run, the scheduler service is
not installed properly on your computer.

5. Verify that the Task Scheduler service is started.
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By default, the Scheduler service is started on all Windows XP machines. Verify that the service is started by following these
steps:

1. Open the Control Panel and click on Administrative Tools. Select Services.

2. Verify that the status of the Task Scheduler service is "Started."

3. If the status is not "Started", right-click on it and select Start.

4. Verify that the 'Startup type' is set to 'Automatic'. This ensures that the service will start automatically in the future.

6. Restart the Task Scheduler.

If the problem persists, restart the Task Scheduler by following these steps:

1. Open the Control Panel and click on Scheduled Tasks.

2. In the Advanced Menu, click on 'Stop using Task Scheduler.'

3. Wait 10 minutes.

4. Click on "Start using Task Scheduler" to restart the Task Scheduler service.

7. Contact Technical Support.

After completing these steps, if you are not able to run the task as scheduled, it is likely that the scheduler service is not
installed correctly on the computer. Contact Technical Support at: Open a Support Case.

Also See...

l Scheduling Tasks to Run

l Running a Task

l Debugging Tasks

http://www.automationanywhere.com/support/openSupportCase.htm


Copyright © 2018 Automation Anywhere, Inc. 128 https://support.automationanywhere.com

Using Caps Lock in Your Tasks

As a best practice, make sure that the Caps Lock key is turned OFF prior to creating your automation tasks.

When you create a new automation task, Automation Anywhere records the state of the Caps Lock key during the recording.

When running the task, Automation Anywhere changes the state of Caps Lock key to match the state that existed prior to recording the
task.

Recording with Caps Lock ON

If the Caps Lock key is turned ON when you start recording, Automation Anywhere records the task with Caps Lock ON.

When you run this task:

l Automation Anywhere checks the state of the Caps Lock key.

l If the Caps Lock key is OFF at the time it is run, Automation Anywhere turns Caps Lock to ON before running any of the steps.

l If you use Insert Keystrokes commands within the task, upon running the task Automation Anywhere toggles the state of Caps Lock
to OFF, resulting in lowercase characters.

Recording with Caps Lock OFF

If the Caps Lock key is turned OFF when you start recording, and you use Insert Keystrokes commands within the task to type upper-
case characters, Automation Anywhere turns Caps Lock ON.

Note: Be aware that when you use Insert Keystrokes commands, no indicator exists for changes to the
Caps Lock key status. Changes are carried out internally.

Also See...

l Debugging Tasks
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Debugging TaskBot/MetaBot Logic

For advanced users, Automation Anywhere provides the capability to debug automation TaskBots/MetaBot Logics. Although Auto-
mation Anywhere enables you to easily create simple Bots, some longer, more complex Bots might require debugging.

Automation Anywhere provides a Debug Toolbar to manage your debugging. Follow these steps to enable debugging mode:

1. Display the Debug Toolbar either by clicking on the Enable Debugging button or by clicking on the Debug menu and selecting
Enable Debugging.

The ' Variable(s) Watch Table' window is displayed. To understand more about this feature refer Watching Variables.

2. Use the Debug Toolbar to insert Breakpoints in your task. To insert a Breakpoint, select a command and insert a Breakpoint by
either clicking the Toggle Breakpoint button on the Debug Toolbar or by pressing the F9 function key.

3. Debug the TaskBot/MetaBot Logic action-by-action by using the Step Over button (or the F10 function key).

4. Run your task in Debug mode (one command at a time) to isolate any errors.

5. To remove a Breakpoint, select the command and either click the Toggle Breakpoint button or press F9. To clear all Breakpoints,
click the Clear All Breakpoints button on the Debug Toolbar.

6. Use the Set SnapPoint button in a task to capture images of the task while it runs. Use the Visualize button to view the images that
are captured when using the Set SnapPoint option in Debug mode.

7. To stop debugging, either click on the Disable Debugging button or click on the Debug menu and select Disable Debugging.

Note: Automation Anywhere does not store debugging information (Breakpoints); therefore, when exit-
ing application, be aware that all Breakpoint information will be lost.

Also See...

l Watching Variables
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Calling Tasks from Programs or Scripts

You can call Automation Anywhere tasks from other programs, scripts, or batch files.

By default, Automation Anywhere saves all tasks in the folder named:

My Documents\Automation Anywhere Files\Automation Anywhere

Calling a Task from a Batch File

Task-name: download-emails.atmx

l Call the task named download-emails.atmx from a batch file by adding the following line in the batch file:

"C:\Program Files\Automation Anywhere Enterprise 7.0\Client\AA.Player.exe"

"/fD:\My Documents\Automation Anywhere Files\Automation Anywhere\My Tasks\download-emails.atmx/e"

Calling a Task from an Excel Macro

Task-name: download-data.atmx

l To call the download-data.atmx task from an Excel macro, add the following text to the Excel macro:

Dim RetVal

RetVal = Shell("C:\Program Files\Automation Anywhere Enterprise 7.0\Client\AA.Player.exe "/fD:\My Docu-
ments\Automation Anywhere Files\Automation

Anywhere\My Tasks\download-data.atmx"/e", 1)

l If the task is successful, it returns 0 to the calling program. If it encounters an error, it returns 1.
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Uploading - Pending Changes or Files

As a Bot Creator with access privileges to particular folders, you can upload files from folders to the server using different options if Ver-
sion Control is enabled in Control Room.

l 'Upload Pending Changes' to upload files from a selected folder in the Tasks, Workflows and Reports list.

l Upload selected files from the Repository.

Uploading Pending Changes

Use the Upload Pending Changes option when you want to upload files from a folder in Tasks list, Workflow and Reports. These
folders and sub-folders comprise new and/or checked out files that are pending upload.

1. To upload, select the 'Upload Pending Changes' option from the context menu:

2. As you can see, all files other than the ones that have a remark are enabled by default for upload in the Upload Pending Changes
window.

However, the files that have are not selected as either:

l A file with same name exists in the repository.

l The file is part of a folder to which the user does not have access.

l The file is not checked out by the Bot Creator

l The file is force unlocked by the server administrator

3. Now select the files to upload.
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4. Input the required comments in 'Upload Comment' and click Upload. These comments are applicable to all files that are uploaded.

Note: During upload any failure results in cancellation of operation.

Once upload finishes, the list view will reflect the check in status.

Uploading Files

1. Click the Upload button

5. In the Upload Files window, the files that are 'Allowed' to be uploaded are selected; if required, de-select the files that you do not
want to upload.

6. Add your 'Upload Comments' and click 'Upload'.These comments are applicable to all files that are uploaded.

File Status and Action <update>

The following table describes the status of a file and the action that is marked for the same:

Status Description File Status Action

If the File is checked out by the Client Checkout Allowed

If the File is checked out by another Client or force unlocked by
server administrator Locked Not Allowed

If the File is new and does not exists in the server repository New Allowed

If the File is new and exists in the server repository Duplicate Not Allowed

If the File is new and folder access unavailable New Not Allowed

Also See...

l Uploading Comments

l Viewing Version History
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Uploading or Downloading TaskBots, Workflows and Dependencies

As a Bot Creator with access privileges to folders that contain TaskBots (tasks) and Workflows with dependencies, you can upload
such TaskBots and Workflows to the Control Room and downloaded in the Client Repository, automatically by using Upload/Download
option in the Client. This ensures you do not have to manually upload/download dependent TaskBot(s), MetaBots, and IQBots. You
also do not have to upload dependent files such as doc, docx, xls, xlsx, csv, mdb, pkx, atmx, exe, pdf, txt, jpg, png, bmp, and xml.

It allows smooth deployment of selected Bots and Files on Bot Runners from the Control Room.

Note: When Version Control is enabled, auto upload/download of tasks and dependencies is available
for users above Enterprise Edition 10 SP2 with product version 10.5.0. If you have Enterprise Edition
below 10 SP2, you need to upgrade in order to avail this facility Learn More

Uploading Tasks and Dependencies

You can opt to upload task(s) and its dependencies using any of the given methods:

1. To upload dependencies for single task:

l Context click the task and click on 'Upload' option:

OR

l Select the task and click on .

2. To upload dependencies for multiple tasks:

l Select multiple tasks using a combination of keys (ctrl/shift) and click on .

OR

l Select the tasks from the 'Client Repository' and click on 'Upload':
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The 'Upload Task(s) and Dependencies' window is displayed:

 Note: When Task(s), MetaBot(s), and/or IQBots do not fulfill certain dependency criteria, they are
not available for selection. The 'Remarks' column displays the reason for upload/download failure.
Refer the section on Remarks for details.

Uploading Workflow tasks

You can opt to upload Workflow(s) with its tasks using any of the given methods:

1. To upload a single workflow with tasks:

l Right click the workflow and select 'Upload' option:

OR
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l Select the workflow and click on .

2. To upload dependencies multiple workflows:

l Select multiple tasks using a combination of keys (ctrl/shift) and click on .

OR

l Select the workflows from Client Repository > My Workflow and click 'Upload':
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The 'Upload Task(s) and Dependencies' window is displayed:

Downloading Tasks and Dependencies

You can download task(s) and its dependencies from the Client Repository under Manage tab in the Client. Note that you can down-
load task(s) from the Repository only.

Tip: For Upload/Download, the Bots that are in ‘New’ or ‘Updated’ status are selected by default. It
is recommended that you go with this default option, unless necessary.
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Export to CSV

You may want a record of the Upload/Download details to troubleshoot. You can maintain one by exporting the details to a CSV file by
clicking 'Export to CSV' at the bottom left of the Upload/Download Task(s) and Dependencies' screen.

The default CSV name for:

1. Upload is ‘Upload_Logs_<username><date><time>.csv'

2. Download is ‘Download_Logs_<username><date><time>.csv'

VCS Enabled Upload/Download

*Available from Enterprise Edition 10 SP2 with product version 10.5.0

When VCS is enabled, you can easily upload/download TaskBots and dependencies (e.g. Sub-tasks, MetaBots, IQBots, and files used
in a task). This feature simplifies the process of uploading/downloading TaskBots to Control Room as you do not need to upload the
task dependencies separately.

1. This allows you to upload new and checked-out TaskBots when VCS is enabled.

2. To upload your master-task, you must checkout the file.

Note: The files uploaded successfully would be checked-in and the files that were interrupted
while uploading would remain in checked-out mode.

3. If the TaskBot is new but it has been uploaded by some other user you are indicated with the following remark: File with same
name already exists.

4. Task dependency scanner and Upload Pending Changes works for files that are new, checked-out, and eligible for upload.

5. In case of download with VCS enabled, you can download all the tasks and dependencies. 

Remarks - Decoded

When your task or dependency is not uploaded or downloaded, the 'Remarks' column displays the reason for the failure. Details
provided here will help you understand what each means:

l Invalid file format - When the file that is to be uploaded/downloaded is not of a format supported by Automation Anywhere Enter-
prise.

l File not found - When the application cannot be located at the filepath mentioned in the Taskbot.

l Not licensed - When a user who had not been allotted MetaBot and/or IQBot license by the Control Room administrator, attempts to
upload/download a Task with MetaBot and/or IQBot as a dependency.

l Password protected Bot - When a task that is password protected for edit is uploaded/downloaded.

l Insufficient folder privileges - When the user does not have required access permissions for that particular folder.

l Cyclic dependency - When the selected files are included and played in multiple tasks. E.g. Task A is part of Task B and Task B is
part of Task A.

l Variabalized path - When the variable specified in the file/folder path is other than the system variable $AAApplicationPath$ for
selecting/opening/saving files/folders.

l Locally renamed MetaBot – When the user renames a MetaBot (from the file system explorer) and tries to upload that.

l File with same name already exists* – When the user tries to upload a new file and a file with the same name already exists in the
Control Room repository at the same corresponding location.

l File is force unlocked by server administrator* – When the user tries to upload a file, which has been force unlocked by the Control
Room Administrator.
*These remarks will appear only if Version Control System is configured.

 Note: In case of multiple failures, an error report is displayed once the upload finishes.
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Viewing Version History

Use Version History to view the history of updates to the selected file. Also compare and roll back updates, if required.

On selecting Version History, you will be able to view a list of all revisions created for the selected file

Viewing history of file versions

You can view 'Version History' of the selected file from:

1. The Context Menu:

OR

2. Actions list:

3. On selecting Version History, you will be able to view versioning details for the selected file
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The Version History is displayed in descending order of the time-stamp i.e. the latest revision at the top and the first revision at
the bottom. It allows you to identify the user and relevant 'Action' that was performed during a specific 'Date and time' with rel-
evant check in 'Comments'.

Here, you can:

1. Compare two versions of a file.

2. Roll back the updates to a specific version.

1. Compare: Use this to compare different file versions.

Tip: Press the Control key to select two file versions.

In the Compare window, the updates between the selected files are displayed:

Note: The latest version is displayed in the right window.

It is recommended that before checking in any file, compare the latest file that has been updated with the local file to ensure all
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updates are included.

When a file is checked out for editing, the changes to the file are saved locally. Before the changes are checked in, it is recom-
mended you compare it with the latest version of the file. To do this, select the latest version in the list and click 'Compare'. The Com-
pare window will compare the latest version with local version as shown below:

2. Rollback:Use this to revert updates/changes in the selected file to the selected version from the version history.

Select the version to which you want the updates to be rolled back and confirm:

On confirming, all the changes done since the selected version to the latest version will be rolled back.

Note: It is recommended you check in (upload) the file once it is rolled back to the selected
version so that the latest version reflects the updates.

Also See...

l Copying or Renaming a Task

l Editing a Task

l Deleting a Task

l Comparing Files that Reside on the Client and Server

l Uploading and Downloading Tasks to the Server
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Upload Comments

Available with Enterprise Edition on purchase of a Version Control license only.

If you are enabled for version control, you will have to include comments while uploading your files. This ensures that the version his-
tory can be used as a reference point.

Uploading a Task to the Server

You can upload tasks to the Control Room Repository Manager using any of the four methods:

1. Selecting Upload from the Action button drop-down list

2. Clicking the 'Upload' button at the top right 'Task List' pane

3. Right clicking the selected task and choosing 'Upload'
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4. Selecting the task from the Repository feature:

l When the task is successfully uploaded, a confirmation window is displayed. Click OK.

l The task is displayed in the Server Repository Manager.

Downloading a Task from the Server

To download a task from the Repository Manager, you must follow these steps:

1. In the main Automation Anywhere window, click on Manage > Repository tab. The Repository is displayed, with a split screen show-
ing files that reside on the server- Control Room as well as the client.

2. Highlight the task file that you want to download to the client.

3. Click the Download button. The task is copied to the client.

Note: Be aware that files that are downloaded to the client with same names will be overwritten.
Before downloading files, be sure that the latest version of the task is on the server.

Also See...

l Uploading and Downloading Tasks to the Server

l Version History

l Using the Task List
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Section: Using Enterprise Client Workbench
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Using the Workbench

The Automation Anywhere Workbench is the most powerful component of the product, providing business process specialists and IT
staff with all the tools necessary for enhancing, streamlining, and deploying automated processes.

The Workbench provides hundreds of commands that you can use to create automated processes for your organization. It is unique in
the software automation industry: non-technical business users can quickly build and deploy automated processes with simple drag-
and-drop operations, yet the solution is flexible and robust enough for technical IT staff to build more complex, integrated, end-to-end
processes.

You can use the Workbench to create your automation which could include TaskBots and/or MetaBots. You can configure commands
to create your TaskBots and MetaBot Logics.

Opening a TaskBot / MetaBot Logic in the Workbench

1. TaskBot - You can open a TaskBot in the Workbench using any of the following ways:

l Select a TaskBot from the My Tasks List and click the Edit button.

l Double-click on a TaskBot in the Task List, provided that double-click editing is enabled in the Advanced Settings for Edit Task. By
default, this setting runs a TaskBot when double-clicking. For more information, see Editing a Task.

l Create a new TaskBot in the Workbench by clicking on the New button.

Note: This is automatically selected based on the option highlighted by default.
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2. MetaBot Logic - You can create a new MetaBot Logic in the Workbench using any of the following ways:

l Select a MetaBot from the My MetaBots List and click the Edit button.

l Double-click on a MetaBot in the My MetaBots List and open a MetaBot Logic from the Logic view

l Create a new MetaBot Logic in the Workbench by clicking on the New button.

Note: This is automatically selected based on the option highlighted by default.

For details on creating a MetaBot Logic, see Using the Logic Editor

Workbench Components

The Workbench provides the following components that make up the user interface:

l Commands panel

l Actions List

l Action buttons

l Error View and Variable Manager panel

l Filters

Using the Commands Panel

The left panel contains all of the Automation Anywhere commands that you can use to build and enhance TaskBots / MetaBot Logics.
You can drag and drop these commands into the Actions List panel, move commands, and edit commands in bulk, if necessary.

Using the Actions List

For your convenience, the Workbench can display multiple TaskBots / MetaBot Logics at once using tabs at the top of the Actions List.
Using these tabs, you can open multiple TaskBots / MetaBot Logics and edit them side-by-side, making copy/paste and reuse very
easy. This also makes building larger TaskBots / MetaBot Logics easier: you can record smaller processes, refine them, and then com-
bine them into one large, end-to-end complete process.

Note: The Normal / Visualize options are not available for MetaBot Logic.
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For more information, see Using the Actions List.

Using the Actions Buttons

At the top of the Workbench window, several action buttons are available. These involve actions for creating a new TaskBot /MetaBot
Logic, running the current TaskBot / MetaBot Logic that is open in the Workbench, saving the TaskBot / MetaBot Logic, enabling debug-
ging and setting snap points for certain commands.

1. New button to create a new TaskBot / MetaBot Logic.

2. Record button to start recording in the current TaskBot.

Your mouse click and keystroke actions will be recorded with the Recorder:

Note: The recorded actions will be saved as Object Cloning command(s). Learn More.

3. Run button to run the current TaskBot / MetaBot Logic.

4. Save button to save the current TaskBot / MetaBot Logic. This appears disabled when you launch the TaskBot / MetaBot Logic. It is
enabled once you add a command.

5. 'Enable Debugging' while creating TaskBots / MetaBot Logics for complex processes.

6. 'Set SnapPoint' to capture screen-shots while the TaskBot / MetaBot Logic is playing.

Note: If the ‘Secure Recording Mode’ is enabled, ‘SnapPoint’ is disabled. Also, if you try to
enable Snap view whilst ‘Secure Recording Mode’ an error message “Secure Recording mode. Image
will not be captured” appears. Learn More

7. The 'Normal/Visualize' buttons to switch views - between TaskBot details (Normal), a screen shot view of your task (Visualize), and
Bot Insight Analytics dashboard for data analysis (Analyze).

Note: When you click on ‘Visualize’, if ‘Secure Recording Mode’ is enabled an error message
“Secure Recording mode. Images have not been captured during recording' appears. Learn More

l While using the Workbench, if you change the resolution of your screen, it is recommended that you restart Automation Any-
where.
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l At lower screen resolutions; say 1024 X 768, the buttons Undo, Redo, Edit, Delete, Copy and Paste might not display. To
perform those actions, use 'Actions' or the 'Context' menu.

Note: On the same bar, actions are available for manipulating commands in the Actions List.
For more information on these buttons, see Using the Actions List.

Using Error View, Variable Manager, and Bot Dependencies

1. Error View - You can use the Error View tab to manage errors that might occur in your task. The view is automatically updated as
you make changes to the task. The Error View panel is useful when you want to track the progress of longer tasks and debug them
when errors occur. Use the Error View panel in conjunction with the Error Handling capability to properly debug your tasks. For
more information, see Debugging Tasks.

2. Variable Manager - The Variable Manager panel is useful when using several variables in your tasks. The Variable Manager dis-
plays the local variables that are defined by the user for a particular task. You can use the Variable Manager to add, modify, and
copy variables within automation tasks. For more information on how to use the Variable Manager, see Using the Variable Man-
ager.
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Note: AAE facilitates copying of variables to a new TaskBot while you copy task commands. This
is helpful, as you do not need to recreate the variables and the commands in the new task. If
some of the copied variables are present in the TaskBot, values and types for these variable are
overwritten.

3. Bot Dependencies - Automation Anywhere has the capability to ship all dependent files such as doc, docx, xls, xlsx, csv, mdb, pkx,
atmx, exe, pdf, txt, jpg, png, bmp, xml with the TaskBot. These are automatically uploaded to the Control Room and deployed while
running the TaskBot. 

Note: This option is available only for TaskBot and not MetaBot Logic.

You can use the Bot Dependencies option from the Workbench to manage the dependent files. Here, you can add, copy/copy all,
paste, and delete files from My Tasks, My Docs, and My Scripts folders. For more information, see Manage Bot Dependencies.

Using Filters

You can use the Filters bar to manage long tasks. When selecting these check boxes, the commands are made visible in the Task
Actions List. Using these filters can make isolating problems and viewing specific commands easier.

Note: This option is available only for TaskBot and not MetaBot Logic.

For more information on using the Workbench Filters, see Using Filters in the Workbench.

Editing a TaskBot / MetaBot Logic Using the Keyboard

If you prefer not to use the mouse to drag and drop commands, Automation Anywhere makes it possible to insert commands in your
task by using keyboard strokes. The Commands panel supports using Arrows, Tab, and Enter keys.

To open command windows, press the Enter key and complete the steps to specify command parameters.

This capability is useful for people who prefer to use quick keyboard shortcuts.

Tip: Type the first letter of a command to highlight it and ease navigation to that command. For
example, typing an "e" will highlight the Email Automation command.

Saving as, Copying and Adding a New Task when Version Control is enabled

If you provide a new file name using any of the options - Save As, Copy or New, you will be able to add unique names only in the
respective folder in which it is being created. If you attempt to add an existing file name, you will not be allowed to do so:

Also See...
.

l Using the Actions List

l Using Filters in the Workbench

l System Variables
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Using the Actions List

The Task Actions List is the main workspace for building your automation tasks.

You can insert commands by dragging them from the Commands list. After you insert commands, you can modify them using the fol-
lowing options:

1. To edit the parameters (settings) for a command, double-click on the command.

2. To take action on the command, such as copying it, right-click on the command to view the options.

3. The Task Actions List bar provides buttons for manipulating commands. The following options are available:

l Edit: Opens the command settings window to enable you to edit them.

l Delete: Removes the command from the Task Actions List.

l Copy: Copies a command for use in another location of the task.

l Paste: Pastes a copied command at the location below the cursor.

l Actions: Click on the Actions button to select one of the following actions:

a. Bulk Edit: Make changes to multiple Delay or Keystroke commands simultaneously.

b. Duplicate: Duplicate a command in the location below the selected command.

c. Convert to Variable: Convert a Keystroke command to a variable.

d. Convert to Prompt: Convert a Keystroke command to a prompt message.

e. Convert to if Web Control Exists: Runs the command if the specified Web control exists.

f. Convert If Windows Control Exists: Runs the command if the specified Windows control exists.

g. Insert If Condition: Inserts an IF condition for a selected block of commands.

h. Insert Error Handling: Inserts an Error Handling command for a selected block of commands.

i. Change Window Title: Change the name of a window title to one or more application windows.

j. Run from this Step: Runs the task when encountering this command.

k. Enable: Activates a command.

l. Disable: Disables a command.
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m. Move Up:Moves a command up in the Task Action List.

n. Move Down:Moves a command down in the Task Action List.

Also See...

l Using the Workbench

l Using Filters in the Workbench
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Using Filters in the Workbench

By default, automated tasks are shown in the Automation Anywhere Workbench with all commands and actions in chronological order
(sorted by time). However, to make working with TaskBot easier, it provides useful filters to enable you to customize your view. Filters
are particularly helpful when working with larger automation.

Filters do not modify a task; rather, they enable you to focus on specific commands within an automation without needing to modify the
entire TaskBot.

To view or hide particular commands in a task, select or deselect the filters in the Filter Bar in the Task Actions List.

The commands that you can filter include:

l Mouse Moves: Display or hide all mouse move actions from the editor.

l Keystrokes: Display or hide all Insert Keystrokes commands and actions from the editor.

l Mouse Clicks: Display or hide all mouse click actions from the editor.

l Delays: Display or hide all Delay commands from the editor.

l Other: Display or hide all commands from the editor that are not mouse moves, keystrokes, mouse clicks or delays.

l Windows: View all actions by application window. The drop-down list displays all application windows that are used in the task.

Using the Find Text Search Field

Use the Find Text search field to search within a task for names, text, variables, and other items. This can be helpful when editing
longer tasks.

Using the Windows Filter

You can use the Windows filter when a task involves two or more applications, such as the Calculator, Notepad, and Explorer. Use the
Windows filter when you want to view actions sorted by application.

In the drop-down list, select ALL, NONE, or the application title for which you want to view commands.

Also See...

l Using the Task Actions List
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Manage Bot Dependencies

Overview

As a Bot Creator you can manage TaskBot dependent files. You can ship all dependent files such as doc, docx, xls, xlsx, csv, mdb, pkx,
atmx, exe, pdf, txt, jpg, png, bmp, xml with the TaskBot. These are automatically uploaded to the Control Room and deployed while run-
ning the TaskBot. 

Manage Bot Dependent Files

You can use the Bot Dependencies option from the Workbench to manage the dependent files. Here, you can add, copy/copy all,
paste, and delete files from My Tasks, My Docs, and My Scripts folders.

To reference (include) the file in that particular task it is recommended that you use the System Variable $AAApplicationPath$.

Note that the dependent files can be added only if they reside in the My Tasks, My Docs, and My Scripts folders. If you choose any
other source, the following error appears:
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Add a dependent file

To add a dependent file to your Bot from Bot Dependencies panel:

1. Click on Add

2. Select the required file(s) either from My Tasks, My Docs, or My Scripts folders/sub folders

3. Click on Open

4. The dependent files are added and listed under Bot Dependencies:
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Copy/Copy All dependent file(s) and Paste

To copy/copy all file(s) from your Bot to another Bot from Bot Dependencies panel:

1. Select required file(s) listed under Bot Dependencies

2. Click on Copy/Copy All

3. Create/Open the Bot where you want to copy the dependent file(s)

4. Click on Paste

5. The dependent file(s) are copied and listed under Bot Dependencies

Note: If the dependent file is already present in the Bot it shall not be copied and an error mes-
sage appears:

Delete a file

To delete a dependent file in your Bot from Bot Dependencies panel:

1. Select the file

2. Click on Delete and confirm:

3. The file is removed from the list of dependent files.

Reference dependent file in Bot

To reference (include) the file in the Bot:

1. Drag and Drop the required command in the Task Actions List

2. Select the dependent file.

Tip: You can use the System Variable $AAApplicationPath$ if the task will be uploaded for use
by other users.
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Upload/Download dependent file(s)

All dependent files are automatically uploaded to/downloaded from the Control Room.

Learn More



Copyright © 2018 Automation Anywhere, Inc. 157 https://support.automationanywhere.com

Section: Using Enterprise Client Commands



Copyright © 2018 Automation Anywhere, Inc. 158 https://support.automationanywhere.com

Active Directory Command

Use this command to manage your Active Directory and create, modify, and delete users in the system with centralized control.

Overview

An Active Directory is a directory service that is provided by Microsoft. This facility assists the Administrator in managing users across a
group or wider organization.

Tip: All fields for the Active Directory command support the use of variables.

Automation Anywhere Enterprise uses LDAP (Lightweight Directory Access Protocol) to read from and edit users in the Active Dir-
ectory. The Server name and Domain name are combined to create an LDAP path, which is used to connect to the Active Directory.

Establishing a Connection with Active Directory

To manage users in the Active Directory, ensure that a connection is established between the Administrator and the Active Directory
server. Users who are logged into the Active Directory should have privileges for connecting to the Active Directory server and viewing
the Server name, Domain name, user name and password details.

Sub-Commands

The Active Directory command provides the following sub-commands:

l Create User

l Modify User

l Create Group

l Modify Group

l Create Object

l Modify Object

l Search

l Get Property

Using the Sub-Commands

Follow these steps to insert Active Directory commands.

l Create User Command:

This command creates a new user in the location specified in the Active Directory connection string. Follow these steps to insert
the Active Directory - Create User command.

1. Double-click or drag the Active Directory - Create User command to the Task Actions List pane. The Active Directory main
window is displayed.

2. To establish a connection with the Active Directory, provide the Login User name and Login Password or assign a variable
by pressing the function key 'F2'.

Tip: You can opt to input 'Credential Variables'
*
by selecting the required credential

keys from the list of 'Credential Variables' for enhanced security. Learn More
*Applicable from version 10.3
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3. Specify the Parent path in the Enter LDAP Path field.

3. If you do not know the Parent path, use the browse button to locate it.
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4. The Active Directory Object Browser window is displayed.

<update>

5. Enter the details for a new user. Check the password option check boxes as needed.

6. Click Save to complete the process.

l Modify User Command:

This command enables you to modify or rename users in the Active Directory. Follow these steps to insert the Active Directory -
Modify User command.

1. Double-click or drag the Active Directory - Modify User command to the Task Actions List pane. The Active Directory main
window is displayed.

2. Select one of the options in the 'Select User Action' drop-down menu.

A. Rename User: Use the check boxes in the 'Enter Modify User Details to rename the user logon name and/or the
user account name.

B. Enable User Account: Enables a user account.
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C. Disable User Account: Disables a user account. Select the User Name or Logon Name to disable either one, in the
'Enter Modify User Details' section.

D. Delete User: Deletes the user from the Active Directory. Select the User Name or Logon Name to delete either one,
in the 'Enter Modify User Details' section.

E. Update User Details: Use this option to update the user's details.

F. Update Account Options: Use this option to set account attributes for the user. Select from four attributes: User must
change password at next login, Is Active, User cannot change password, and Password never expires.

G. Change Password: Use this option to change a user's password.

H. Set Property: Use this option to assign a value to a user property , view the current details and update them.

Tip: Alternately, if you are unsure of the 'User Name' that has to be modified, click the
browse button in 'Enter LDAP Path' section. You will be guided to the 'Active Directory Object
Browser'; select a user from the list to perform any of the above 'User Actions'.
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l Create Group Command:

This command enables you to create a group in the Active Directory. Follow these steps to insert the Active Directory - Create
Group command.

1. Double-click or drag the Active Directory - Create Group command to the Task Actions List pane. The Active Directory main
window is displayed.

2. Select options for GroupName, Description, Group Scope and Group Type.
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Modify Group Command:

This command enables you to modify a group in the Active Directory. Follow these steps to insert the Active Directory - Modify Group
command.

1. Double-click or drag the Active Directory - Modify Group command to the Task Actions List pane. The Active Directory main win-
dow is displayed.

2. Select options for: Rename Group, Delete Group, Add Users To Group, Remove Users From Group and Set Property.

A. Rename Group: Use this option to rename an existing group.

B. Delete Group: Use this option to delete an existing group.

C. Add Users to Group: Use this option to add additional users to a group. A user list is displayed. Use the Add, Remove and Edit but-
tons and click on Add Users to the group.
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a. Adding/Editing/Removing multiple users in a Group: You can select a user or enter multiple users to add/edit/remove in/-
from a group from within the group list of the 'Active Directory Object Browser' Window.

Input the user names in the 'Enter user(s)' text box. If assigned, you can also insert variables.

Note: Multiple user names/variables must be separated with a ';' (semi-colon).
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b. Adding Logon Names as User(s): If your Active Directory comprises users with same names, you can add 'Logon'
names instead as 'User(s)'. To do so, select the option 'The above names are Logon Names' in the 'Active Directory
Object Browser' window. Optionally, insert variable(s), if assigned.

c. Editing Logon/User Names: You can edit your Logon Name, User Name and even the LDAP string, if input incor-
rectly.Select the User, Click 'Edit' and you shall be guided to the 'Active Directory Object Browser' window, wherein you
will be able to input the necessary changes. Click 'Save' once done.

Note: When editing a User Name, you can also select the 'Logon Name' option.

D. Remove Users from Group: Use this option to remove users from a group. A user list is displayed. Use the Add and Remove but-
tons and click on Remove Users.

E. Set Property:Use this option to assign a value to a group property.
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l Create Object Command:

This command enables you to create a new object, either for Computer or for Organizational Unit, in the Active Directory. Follow
these steps to insert the Active Directory - Create Object command.

1. Double-click or drag the Active Directory - Create Object command to the Task Actions List pane. The Active Directory main
window is displayed.

2. Select the option for creating either a new Organizational Unit or a new Computer by using the radio button.

l Modify Object Command:

This command enables you to modify an object in the Active Directory. Follow these steps to insert the Active Directory -
Modify Object command.

1. Double-click or drag the Active Directory - Modify Object command to the Task Actions List pane. The Active Dir-
ectory main window is displayed.

2. Select options for: Rename Object, Delete Object, Move Object, and Set Property.

A. Rename Object: Use this option to rename an existing computer or organizational unit.

B. Delete Object: Use this option to delete an existing computer or organizational unit.

C. Move Object: Use this option to change the location of an existing computer or organizational unit.

D. Set Property: Use this option to assign a value to an object property.
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Search Command:

This command enables you to search the Active Directory for users of a group or run a query on the Active Directory. Follow
these steps to insert the Active Directory - Search command.

1. Double-click or drag the Active Directory - Search command to the Task Actions List pane. The Active Directory main win-
dow is displayed.

2. Select one of the following options from the drop-down window:

A. Get All Users of a group: Use this option to find all users that are members of a group, and stores them in a list variable.
Depending on the return type of the list variable, it contains the user names or the LDAP paths for the members.

B. Run Query: Use this option to specify an Active Directory query and run it. The query results are stored in a list variable,
either for object names or LDAP paths, depending on the option selected.
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Tip: For Active Directory (LDAP) queries, you may refer this link.

l Get Property Command:

This command enables you to retrieve a specific property value for an object (user name, group name, computer, or organ-
izational unit) to a variable. Follow these steps to insert the Active Directory - Get Property command.

1. Double-click or drag the Active Directory - Get Property command to the Task Actions List pane. The Active Directory main
window is displayed.

2. Select the object type: user, group, computer, or organizational unit.

http://technet.microsoft.com/en-us/library/aa996205(v=exchg.65).aspx
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Also See...

l Printer Settings Command

l Services Command

l SNMP Command
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App Integration Command

Use this command to integrate applications with your automated task and capture text data.

Overview

Automation Anywhere makes it easy for you to integrate any application with your automated tasks using simple drag-and-drop oper-
ations. The App Integration command supports a large number of applications, including Java and Windows applications.

Sub-Commands

The App Integration command provides the following sub-commands:

l Browsers, such as Microsoft Internet Explorer and Mozilla Firefox

l DOS command prompts

l Java applications

l Java Applets

l Telnet Unix Shell

l Windows applications

l Other

Using the Command

To insert an App Integration command in your task, follow these steps:

1. Double-click or drag one of the App Integration commands to the Task Actions List pane. The App Integration window is displayed.

2. Select the application type from the drop-down window.

3. Select a capture option. You can capture text data from any application window by using the following options:

l Capture Window: Specify an application window title. When running the task, Automation Anywhere will capture the win-
dow as an image.

l Capture Area: Specify a specific area of an application window to capture.

l Capture Scrollable Text: Specify an area with scrollable text to capture all of the text in that area.

4. Select a window from which you want to capture the text.

5. Optionally specify a range of text, and assign the captured text to a variable.
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The App Integration command is flexible, enabling you to specify a range of text to capture. Use the Before and After keywords to spe-
cify the range.

Example: In the text string:

"Version 5.1 (Build 2600.xpsp_sp3_gdr.090206-1234 : Service Pack 3) Copyright"

l Specify "Version" in the Before keyword field, and "Copyright" in the After keyword field.

l You can also specify that you want to trim the captured text to remove leading and trailing spaces.

l Use this command to capture scrollable text that you cannot normally copy from documents like PDFs.

Note: Non-standard Windows controls are supported.

o
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When you 'Enable' Secure Recording

If you enable ‘Secure Recording mode’, no images are captured for preview and an error message appears “Secure Recording Mode.
Image not captured.” Learn More

Also See...

l App Integration Command - Examples

l Database Command

l Email Automation Command

l Excel Command

l OCR Command

l PDF Integration Command

l Read from CSV/ Text Files Command

l Terminal Emulator Command

l XML Command
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Clipboard Command

Use this command to automate Windows clipboard activities.

Overview

The Windows Clipboard is a very common application, and is used for a wide variety of purposes. When you copy text to the Clipboard
(for example, by using Ctrl+C), you can then paste this text in another application (by using Ctrl+V). Automation Anywhere provides a
system variable, named $Clipboard$, that you can use to retrieve text that has been copied to the Clipboard.

Sub-Commands

The Clipboard command provides the following sub-commands:

l Clear Clipboard

l Assign to Clipboard

l Assign from Clipboard

Using the Sub-Commands

To insert a Clipboard command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the Clipboard commands to the Task Actions List pane. The Clipboard window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

Clear Clipboard Command:

Use this command to clear the contents of the Clipboard.

Assign To Clipboard Command:

Use this command to assign the value of any variable that has been created using the Variable Manager to the Clipboard. You can
then access this value by using the $Clipboard$ system variable.
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Assign From Clipboard Command:

Use this command to assign the value contained in the Clipboard to any value type variable that has been created using the Variable
Manager.

Also See...

l Clipboard Command - Examples

l Using the Variable Manager

l Using Variables

l Value Type Variables

l System Variables

l Comment Command

l Error Handling Command

l Image Recognition Command

l Screen Capture Command

l Play Sound Command

l String Operation Command

l Variable Operation Command



Copyright © 2018 Automation Anywhere, Inc. 175 https://support.automationanywhere.com

Comment Command

Use this command to insert comments in your automation tasks to provide additional information about the TaskBot / MetaBot Logic.
Comments are ignored when the TaskBot / MetaBot Logic runs.

Comments are useful in annotating the TaskBot / MetaBot Logic steps. Some people use comments to extensively document details
about their TaskBot / MetaBot Logics. Some people use fewer comments just as reminders.

Inserting a Comment

To insert a comment, follow these steps:

1. Open the TaskBot / MetaBot Logic in the Workbench.

2. In the commands list, drag a Comment command to the Task Actions List, in the location where you want the comment to be dis-
played. Or, you can double-click the Comment command to insert it at the current location.

3. Type your comments in the Comment text box provided.

4. Click Save.

5. A comment is inserted in the TaskBot / MetaBot Logic. You can copy this comment to add multiple comments, or move the comment
to another position in the TaskBot / MetaBot Logic simply by dragging it.

The comment is displayed in green in the Task Actions List, and is always saved as a single line. Multiple-line comments are displayed
as a single line when the comment is saved.

Note: Though a command, a comment line is not executed.

Sample Comments
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Also See...

l Comment Command - Examples

l Clipboard Command

l Error Handling Command

l Image Recognition Command

l Screen Capture Command

l Play Sound Command

l String Operation Command

l Variable Operation Command
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Database Command

Use this command to integrate databases with your automated task and move or capture data.

Sub-Commands

The App Integration command provides the following sub-commands:

l Connect

l Disconnect

l SQL Query

l Insert/Update/Delete

l Run Stored Procedure

Overview

Automation Anywhere enables you to transfer data between a database and other applications. You can import or export data, in vari-
ous formats, and convert data from one format to another. For example, you might want to transfer and convert data while completing a
data migration project.

You can also transfer data from a custom database to a Microsoft Excel spreadsheet, or from one database to another in predefined
formats.

Restriction: For the Database command, Microsoft Access 2007 and Access 2010 users are required to use Microsoft Office 12.0
Access Database Engine OLE DB Provider.

Using the Sub-Commands

To insert a Database command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the Database commands to the Task Actions List pane. The Database window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

Connect Command

Use this command to connect to a database by providing a session name and a connection string.

To complete the connection string, click the browse button to display the Data Link Properties window. Select the database provider
and type the full path of the data source. When done, click on Save.

You can opt to insert 'Credential Variable' as a Connecting String by pressing function key 'F2' for enhanced security instead of build-
ing the Connection String. Select the required Credential Key and it's Attribute. Learn More.

Tip: When using the 'Connect' command to select a target database, click on the 'Test Connection' but-
ton in the 'Data Link Properties' window to ensure that the database connection is working.
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Note: In order to make the bot more secure, you can choose to add the entire connection string to
the Credential Manager and use the corresponding Credential Variable as the connection string.

Disconnect Command

Use this command to disconnect from a database.
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SQL Query Command:

Use this command to issue SQL queries using a Select statement.

Tip: If you must use wildcards when executing SQL queries, insert "*" if using MSAccess or "%" in
MSSQL.

Optionally, you can:

l Specify the number of records to fetch

l Specify a timeout value for the query

l Export the data file as a CSV (comma-separated) file in a specified location. Exporting data to CSV files support ANSI, UNICODE,
and UTF8 encoding.

Insert/Update/Delete Command

Use this command to specify an Insert, Update, or Delete operation by using a Select statement.
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Run Stored Procedure Command:

Use this command to run an existing procedure that is stored in your database. You can add and update by providing Input and Output
types of parameters.

You can export the data file to a CSV file in a specified location.

Sample Scenario: Transferring Data from a Database

The following code snippet illustrates how a TaskBot / MetaBot Logic can use a LOOP command to transfer data from a database to a
target application.
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Tip: Use LOOP commands in conjunction with the Database commands to transfer data from a database to
another application. For example, you might loop 'Each row in an SQL Query dataset'.

Also See...

l Database Command - Examples

l App Integration Command

l Email Automation Command

l Excel Command

l Loop Command

l OCR Command

l PDF Integration Command

l Read from CSV-Text Command

l Terminal Emulator Command

l XML Command



Copyright © 2018 Automation Anywhere, Inc. 182 https://support.automationanywhere.com

Delay/Wait Commands

Use the delay command to add a delay at a particular point in an automated Taskbot / MetaBot Logic. Or the wait command to insert a
wait condition in an automated Taskbot / MetaBot Logic.

Delay Command

l In certain cases, you might want a Taskbot / MetaBot Logic to wait a certain amount of time before moving to the next command.
You can use a Delay command to make the Taskbot / MetaBot Logic wait, and you can specify the amount of wait time.

l The Loop command is one of the more powerful commands in Automation Anywhere. When using loops, inserting delays can be
helpful for performing the subsequent actions in the Taskbot / MetaBot Logic, optimizing the timing that occurs.

Using the Delay Command

To insert a Delay command, follow these steps:

1. Open the Taskbot / MetaBot Logic in the Workbench.

2. In the commands list, drag a Delay command to the Task Actions List, in the location where you want to the Taskbot / MetaBot Logic
to delay before moving to the next command. Or, you can double-click the Delay command to insert it at the current location.

3. A Delay command is inserted in the Taskbot / MetaBot Logic. You can copy this command to add multiple delays, or move the
delay to another position in the Taskbot / MetaBot Logic simply by dragging it.

4. Optionally specify that the delay be in milliseconds or seconds. Or, insert a random delay by providing a range of numbers that
Automation Anywhere can use to generate a random number for the delay time.

Note: You can assign a variable to 'Regular Delay > Delay' and 'Random Delay > From and To' options.

Wait Command

l For some applications, automating actions might require waiting for a screen to change, or another window to open. Let's say you
want to wait for the contents of a screen (or an area within your application) to change before performing the next set of actions
(such as commands, mouse clicks, or keystrokes). This is useful in many application windows where the text is not a selectable
format.

l In this case, you might mark the area by using the capture button. An image will be displayed in the image preview so that you can
verify the captured portion. Keep in mind that the sample image is not used for comparison while the Taskbot / MetaBot Logic is run-
ning; it is only used to verify that the image was captured correctly. When the Taskbot / MetaBot Logic runs, a screen shot of the
area is captured, using the coordinates relative to the screen or window that you've specified. Here, let's call this image 'imageA.'

l Automation Anywhere now waits for the amount of time to pass that you've specified, then begins comparing the images on the
page to imageA. It continues to compare the image in the marked rectangular section to imageA, and when differences occur, the
comparison stops and the Taskbot / MetaBot Logic proceeds to the next command.

l However, if the images never differ within the specified time, it either stops the Taskbot / MetaBot Logic or proceeds to the next com-
mand.
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Sub-Commands

The Wait command provides the following sub-commands:

l Wait for Window

l Wait for Screen Change
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Wait For Window Command

Use the Wait For Window command to wait for a specified window to open or close before the Taskbot / MetaBot Logic performs the
next command.

Wait For Screen Change Command

Use this command to wait until a rectangular image on the screen changes before the TaskBot / MetaBot Logic performs the next
command.

Note: You can assign a variable when selecting a window in 'Wait for Window' and 'Wait for Screen Change'.

When you 'Enable' Secure Recording

If you enable ‘Secure Recording mode’, no images are captured and hence not displayed in Thumbnail Preview. Learn More
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If the image was captured when secure recording mode was disabled and you edit the command to recapture the image after the Con-
trol Room admin enables Secure Recording, the image gets deleted when you save the command.

Also See...

l Loop Command

l Pause Command

l Run Task Command

l Stop Task Command
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Email Automation Command

Use this command to automatically manage your email messages with your Automation Anywhere TaskBot / MetaBot Logic.

Overview

You can use the Email Automation command to intelligently automate your mail server functions and handle incoming email mes-
sages. Specifically, you can automate the following activities:

l Manage your incoming email messages and download attachments to specific folders.

l Clear unwanted email messages.

l Communicate with your mail server and monitor email activity.

l Extract email data (such as Subject, Message, From:, To: , CC:, and attachments) to applications (Excel, Word, Notepad, and oth-
ers) or folders on your computer.

l Select either IMAP or POP3 servers.

l Organize email messages while downloading them, based on status (All, Read, and Unread).

l Select either HTML and Plain text formats for your email messages.

Sub-Commands

The Email Automation command provides the following sub-commands:

l Get All Messages

l Delete All Messages

l Delete Message

Using the Sub-Commands

To insert an Email Automation command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the Email Automation commands to the Task Actions List pane. The Email Automation window is dis-
played.

2. Specify the email server information in the Email Server Details fields. Provide a Host name, user name, and password.

Tip: You can provide Credential Variables* from the list by pressing function key F2 for
enhanced security. Learn More

In case of invalid credentials, the following error message appears:

Optionally check the Server uses secure connection (SSL) check box for secure connections.

3. Select a server type. Depending on the email server in your environment, select either IMAP or POP3.
In case of incorrect Hostname or Port, the following error message appears:

4. Select an email status (All, Read, or Unread).

5. Select a message format. You can download messages in HTML or plain text format.

6. Optionally specify a location to which you want to download the email data.

7. Click Save to save the command to your automation TaskBot / MetaBot Logic.
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Get All Messages Command

Use this command to download all incoming email messages from the mail server to a specified folder on your computer.

The following screen shot shows how you can download messages from a POP3 server in HTML format.
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Delete All Messages Command

Use this command to delete all email messages from the mail server.

Delete Message Command

Use this command to delete the most recent email message from the Inbox. Use a LOOP command with the Email Automation com-
mand.

Also See...

l Email Automation Command - Examples

l Database Command

l Excel Command

l Loop Command

l PDF Integration Command

l Read from CSV-Text Command

l Terminal Emulator Command

l XML Command
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Error Handling Command

Use this command to handle errors while running a TaskBot / MetaBot Logic, to aid in debugging the TaskBot / MetaBot Logic.

Overview

By using the Error Handling commands, you can isolate errors that occur when running your TaskBot / MetaBot Logic.

When an error occurs, you can continue the TaskBot / MetaBot Logic after the error, or stop the Taskbot / MetaBot Logic.

Sub-Commands

The Error Handling command provides the following sub-commands:

l Begin Error Handling

l End Error Handling



Copyright © 2018 Automation Anywhere, Inc. 190 https://support.automationanywhere.com

Error Handling Options

Automation Anywhere provides the following options for error handling when an error occurs:

1. Take Snapshot: In case of any error, take a snapshot of the screen.

2. Run Taskbot / MetaBot Logic: Run another TaskBot / MetaBot Logic when the current TaskBot / MetaBot Logic encounters an
error.
To avoid task failure when the task is deployed from Control Room, use the variable $AAApplicationPath$ instead of any other
user defined variable in the Select Task field. If you do, you are shown the following error:

3. Log data into file: Log the error into a file.

l For example, you can log the Error Line No. and Description, then use the system variables $Error Line Number$ and $Er-
ror Description$.

4. Send Email : Send an email when the error occurs. Optionally 'Attach Snapshot' and/or 'Attach Variable'. You can configure email
settings from Tools > Options > Email Settings

l On selecting 'Attach Snapshot', a snapshot of the screen is attached to the email.

l On selecting 'Attach Variable', a text file that lists the values of all Variables (System Variables + User Defined Variables) is
attached to the email.

Note: The System Variable Excel Cell will not be attached as the values input are
dynamic.

5. Variable Assignment: Specify a value to be assigned to a variable and Set Task Status Pass or Fail depending on the Error
handling action.

l This is more useful when one wants to Continue running a task, and thus in that case the user wants to set a specific value
to a particular variable.

Use any or all four of these options in combination. For example, you can run a task and log data to a file.

When any of the Begin Error Handling option is selected, End Error Handling is automatically inserted in the Workbench. However,
one can also specifically select End Error Handling action when the related actions are completed.
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When you 'Enable' Secure Recording

If you click on ‘Take Snapshot’ option and save the command while the ‘Secure Recording Mode’ is enabled, a warning appears.

If you wish to continue, click ‘Yes’, and the command will be saved. If you click ‘No’, you are navigated back to the command where you
can ‘Cancel’ the command. Learn More

Also See...

l Using the Variable Manager

l Using Variables

l Value Type Variables

l System Variables

l Variable Operation Command
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Excel Command

Use this command to transfer data to and from Microsoft Excel spreadsheets.

Overview

The Excel command is one of the most powerful commands provided by Automation Anywhere. Microsoft Excel is one of the most
highly used applications in the world today. Most operations that involve using spreadsheets require repetitive tasks that can be auto-
mated.

Many Excel automation scenarios have been implemented by companies worldwide. Some common scenarios include:

l Copying data from one Excel spreadsheet to another.

l Extracting data from an application to an Excel spreadsheet.

l Extracting data from a website to an Excel spreadsheet.

l Moving data from an Excel spreadsheet to another application.

l Transfer data from Microsoft Access to Excel.

l Transfer Excel data to a website form.

l Delete rows or columns in Excel.

l Compare two columns or two cells in an Excel spreadsheet.

l Sort data in Excel spreadsheets and delete duplicate rows.

You can also run Excel macros as part of complete, end-to-end processes.

Note: The Excel command is only supported for Microsoft Office 2000 and later.

Sub-Commands

The Excel command provides the following sub-commands:

l Open Spreadsheet

l Close Spreadsheet

l Activate Sheet

l Get Cell

l Set Cells

l Go To Cell

l Run Excel Macro

l Delete Cells

l Save Spreadsheet

l Find/Replace

Open Spreadsheet Command

Use this command to open an Excel spreadsheet. If your TaskBot / MetaBot Logic involves working with many spreadsheets and work-
books, you can specify the session name, sheet name and even passwords for users with read only or edit rights. Also, fetch data from
spreadsheets with headings.

Enabling Contains Header option -You can retrieve/fetch data from cells in spreadsheet(s) that contain headings in the first row. You
can enable the option in Open Spreadsheet to be able to apply it to relevant sub-commands for that particular session.

Refer Excel Command - Contains Header for details.

l Excel Cell System Variable - has been introduce exclusively for the 'Contains Header' option; hence we recommended you use it
when configuring Excel operations - Get Cells, Set Cell, Go to Cell, Find/Replace and Delete Cells.
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Note: For Automation tasks created in versions 8.1 and below, the Contains Header was applicable to
Get Cells command only. Hence to ensure that those tasks run properly, it is recommended that you re-
configure the command.

Spreadsheet Password - Password options can be enabled in 'Advanced View'. You can open/edit your password protected spread-
sheet(s)and workbook(s) by enabling the 'Spreadsheet Password' option. Specify the password(s) to open and/or modify your spread-
sheet(s).

If you wish, you can assign a variable to your password(s). The specified password(s) are secure as they are encrypted. You can opt to
provide a local variable or a 'Credential Variable' for enhanced security* by clicking function key 'F2'. Learn More
*Applicable to Enterprise Editon only from version 10.3

Note: When enabling the 'Spreadsheet Password' option, ensure that you specify either the 'Read
Only' or 'Editable' mode listed in the 'Open Read-Only Recommended Spreadsheet' option.

Open Read-Only Recommended Spreadsheet - You can also select 'Open Read-Only Recommended Spreadsheet' independently to
open these in 'Read Only' or 'Editable' Mode.

l For instance, if your spreadsheet is password protected and read only you will be required to specify the 'Password to Open' plus
select 'Read Only Mode'.
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l If, however, you specify passwords to 'Open' and 'Modify', you have the option to open the spreadsheet in either 'Read Only' or 'Edit-
able' Mode, as required.

Close Spreadsheet Command

Use this command to complement the Open Spreadsheet command. It closes a spreadsheet that is previously opened using an Open
Spreadsheet command. The command identifies the spreadsheet using the session name that was provided in the Open Spreadsheet
command.

Activate Sheet Command

Use this command to activate a specific spreadsheet in an open workbook.

Get Cells Command

Use this command to retrieve the values of the active cell or a specific cell, as well as a range of cells from the spreadsheet opened by
the Open Spreadsheet command. When you retrieve values for an active or specific cell, you can assign the value to a variable.
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When retrieving values from multiple cells, the values are assigned to an $Excel Column (index)$ system variable. You can use this
variable in subsequent commands, for example, to loop through each row in the spreadsheet.

Set Cells Command

Use this command to set the value of the active cell or a specific cell in an Excel spreadsheet previously opened using the Open
Spreadsheet command. You can also use a variable to assign the value in the cell.

Go to Cell Command

Use this command to move to a specific cell. The movement options include:
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l Move one cell to the left or to the right of the active cell

l Move one cell above or below the active cell

l Move to the beginning or end of a row or column within a spreadsheet that was previously opened using the Open Spreadsheet
command.

Note: In Active Cell, End of the row/column refers to "end of the row/column where the data
ends"; not the end of spreadsheet row/column.

Run Excel Macro Command

Use this command to run an Excel macro that is stored within an Excel spreadsheet that was previously opened with the Open Spread-
sheet command.

Note: Automation Anywhere now enables you to Run Local and Global Macros seamlessly.



Copyright © 2018 Automation Anywhere, Inc. 197 https://support.automationanywhere.com

Delete Cells Command

Use this command to delete the values in the active cell or in a specific cell within an Excel spreadsheet that was previously opened
using the Open Spreadsheet command.

Save Spreadsheet Command

Use this command to save a spreadsheet in an open workbook.

Find/Replace Command

Use this command to find and replace data in a spreadsheet within an open workbook. You can specify a cell range with specific
search options.
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Using the Load Add-ins Option

Use this option when opening an Excel spreadsheet in which Add-ins are required.

Using the Sub-Commands

To insert an Excel command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the Excel commands to the Task Actions List pane. The Excel window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

Copying data from Excel to Notepad

To copy the content (data) of selected cells from Excel to notepad, follow the steps given below:
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1. Launch the Workbench.

2. Drag and drop or double click the 'Open Spreadsheet' option under the 'Excel Command' node to the Task Actions List pane.

a. Specify the session name and spreadsheet path. Select the option 'Specific Sheet Name' if it has more than one spread-
sheet worth of data.

b. Also select the 'Load Add-in' option, if applicable.

c. Click Save.

3. Drag and drop/double click the 'Get Cell' option under Excel Command to copy the cell data.

a. Specify the option 'Get Multiple Cells', session name and cell range in the 'From Specific Cell' & 'To Specific Cell' to copy
multiple cells from the spreadsheet.

b. Click save.

l The next step involves opening the application to which the cells are to be copied.
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5. Drag and drop/double click the 'Open File/Folder' command.

a. Specify the file name or select from a specific path by clicking .

b. You can provide the 'Start in' Path or set 'Parameters' and 'Launch Program/File' optionally.

c. Click save.

l At this juncture, you need to insert a loop that allows you to copy each row from the spreadsheet specified in the 'Open Spread-
sheet' session.

6. Drag and drop/double click the 'Loop' command.

a. Select 'Each row in an Excel dataset' and save.

l Now assign the copied data to a variable.
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7. Drag and drop/double click the 'Insert Keystroke' Command.

a. Select the file to which the data is to be copied from the 'Select Window' drop down.

b. Select 'Encrypt Keystrokes' to enable encryption.

c. Insert appropriate keystrokes and variables and click save.

8. Include the following comment and save:

Note: This will mark end of the loop.
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9. Drag and drop/double click the 'Close Spreadsheet' option:

a. Specify the 'Session Name' and save.

l The following depicts the above created TaskBot :

10. Save the TaskBot / MetaBot Logic.

Also See...

l Database Command

l Email Automation Command

l Loop Command

l OCR Command

l PDF Integration Command

l Read from CSV-Text Command

l XML Command

https://support.automationanywhere.com/entries/36128510
https://support.automationanywhere.com/entries/35653894
https://support.automationanywhere.com/entries/36128670
https://support.automationanywhere.com/entries/35653954
https://support.automationanywhere.com/entries/35653984
https://support.automationanywhere.com/entries/35654004
https://support.automationanywhere.com/entries/35654154
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Excel Command - Contains Header

When using Excel operations for fetching/retrieving large amounts of data from excel spreadsheets that has its first row defined as a
heading, you need to specify the rows and columns in a manner that they take those headings into consideration.

The 'Contains Header' option allows you to configure the command parameters to include or exclude headers; as the case may be.

l A sample Excel spreadsheet with Headings:

Contains Headers in Excel operations

Contains Header allows you to retrieve/fetch data from the active spreadsheet that has its first row defined as a header. You can define
the option in Open Spreadsheet for a particular session. It is applicable to Excel operations Get Cells, Set Cell, Go to Cell, Find/Re-
place and Delete Cell for that particular session (as configured in Open Spreadsheet).

Also, in cases where one or more columns of the target Excel spreadsheet change position due to any update (i.e. introducing new
columns/deleting existing columns), the corresponding automation TaskBot / MetaBot Logic has to be updated to accommodate the
change. Using 'Contains Header' you can enable the TaskBot / MetaBot Logic to automatically map re-positioned columns of the target
Excel spreadsheet.
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Excel Cell Variable - a must for Contains Header option

You can use the System Variable - Excel Cell when configuring Contains Header. This variable is exclusive to Contains Header.

Excel Cell should be used while configuring Excel commands Get Cells, Set Cell, Go to Cell, Find/Replace and Delete Cell. During
play time, the variable will indicate the column name and position of the cell from the header. It gives the column reference to the
defined cell; e.g cell defined is A5, it will refer to Row A , Column 6, if 'Contains Header' is enabled.

Note: The string defined in the variable has to be an exact match. For instance, while retriev-
ing/fetching data from each cell/specified cells under the heading 'Id', use the System variable $Excel
Cell(Id,2)$; variables such as '$Excel Cell(id,2)$' or '$Excel Cell(<space>Id<space>),2$' will be con-
sidered invalid.

When you use this variable, without configuring the Open Spreadsheet command, the program throws an error during play time - "To
enable Excel Cell variable configure Open Spreadsheet command."

To know more about the variable, refer Excel System Variables.

The where and how of Contains Header

You can apply the Contains Header option for Excel operations:

1. Open Spreadsheet - Contains Header option is controlled from this sub-command as it is configured to the session specified here.
Consequent Excel operations will consider the option; whether selected or not for the session specified in this command. Hence,
configuring this command is a must.

Reference Points:

l When you open multiple spreadsheets during automation, the program considers the last spreadsheet action. It means that
if 'Contains Header' is enabled in Session 1 and not in Session 2, the consequent command will not have Contains Header
enabled unless you specify the particular session that has Contains Header (Session 1 in this case).

l In spreadsheets with duplicate header name/content, the program will consider the first occurrence of the header name/-
content.

l If you include an invalid value or the header row mismatches, the program will throw an error during play time.

l You can input maximum three (3) alphabets for a Column title (e.g. ABC); if you input more then you will encounter an error
"Check the value specified in the Column Title. You can input up to 3 alphabets only."

2. Get Cells - For the 'Get Single Cell' or ' Get Multiple Cells' parameters, include the Excel Cell variable in the 'Specific Cell' or 'From
Specific Cell' and 'To Specific Cell' text boxes as shown:

In the variable, input the cell heading title. For e.g. if the cell range specified is A5 through A10, define the variable with heading
title as given in cell A1; in this case "Id".
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Note: In editions earlier to 8.1, Contains Header was applicable and available in Get Cells
command only. If you are re-configuring a task that uses that version with 'Contains Header'
enabled, it will be "grayed out." It is recommended that you re-configure the command in the task
if you want the task to run properly in the current edition.

l Set Cell - You can apply the 'Contains Header' option to parameters Active Cell and Specific Cell when configuring the Set Cell
command. If the cell position shifts, values in the specified cells will be set appropriately.

You cannot, however, reset value in the cells if the selected cell, is a header cell. You will encounter the error "The specified cell is
part of the header row. You cannot set value in it as 'Contains Header' is enabled." during play time.

You will also not be allowed to set the value of a cell that is defined as a header title. Same is true, if it's in edit mode and the option
is enabled.

l Go to Cell - You can Go to a specific or active cell when 'Contains Header' is enabled. All conditions that are applicable during Set
Cell are also applicable here.

Note: In Automation Anywhere Excel Command, Active Cell > End of the row/column refers to "end
of the row/column of data"; not the end of spreadsheet row/column.

l Delete Cells - When using this command for 'Contains Header', you will not be allowed to delete the cells that have a header title
defined i.e. the first row of the spreadsheet. If you have specified a cell that is defined as a header - either by using the active or spe-
cific cell parameter, you will encounter the error "The specified cell is part of a header row. You cannot delete it as 'Contains
Header' is enabled." during play time.

l Find/Replace -When using this command for 'Contains Header', you will be allowed to Find a cell value by Row/Column but
Replace the content in only those cells that are not defined as header titles. If you specify a cell that is defined as a header, you
will encounter the error "The specified cell is part of a header row. You cannot replace its value as 'Contains Header' is enabled."
during play time.

Also See...

l Excel Command

l Excel Command - Examples

l Excel System Variables

Export Dataset Command

Extracting huge amounts of data from a single source can be done using the Export Dataset command in a MetaBot Logic from the
Workbench. You can read data from various fields from source and save it into an external file such as an Excel spreadsheet using
single command. It enables you to create logic that would otherwise involve numerous keystrokes and clicks.

Supported Technologies and Controls

Export Dataset command supports the following technologies:

1. HTML

2. JAVA

3. MSAA

4. .NET

5. Flex

Export Dataset command supports the following controls and actions:

1. Static Text (label) - GetProperty

2. Text Box -GetProperty
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3. Radio Button - GetStatus and GetProperty

4. Check Box - GetStatus and GetProperty

5. Combo Box - GetProperty, GetTotalItems, GetSelectedIndex, and GetSelectedText

6. List - GetProperty, GetTotalItems, GetSelectedIndex, and GetSelectedText

7. Buttons - LeftClick

Export Data from an application

You can configure the Export Dataset command from Workbench → Commands.

1. Create a Screen using required application. Learn More

2. Configure the Screen for required parameters. Learn More

Tip: If an object does not display or displays an unidentifiable text and/or number, its recom-

mended you provide an alias to that object during Screen configuration. Learn More

3. In the Logic Editor, select Export Dataset from the Commands list.

4. Start filling in details using a combination of variables, text and controls. Unless a field is populated, you cannot move to the next.

Note: All the objects which are not selected for automation execution are disabled by default
in the Value column.

To enable editing of Value parameters, select Read.
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l You can use either the direct assignment of variable i.e. assign a Value or indirect assignment i.e. assign value from a text
document as shown:

n You can choose to create a variable, if not present when inserting one. In the Value field, press function key F2 to
launch Insert Variable dialog. Click New to create a variable.
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n Value, Random, Array, and List type variables are supported in Export Dataset

Tip: Define an Array type variable to export 'Values' that can be filled multiple times

for a single 'Entry Name'. Learn More

l You can also insert object values using the properties window. Double click the Value field to launch

i. Select Action that needs to be performed during Logic execution. This can be changed if required.

ii. Select the Property Name

iii. Select relevant variable

iv. In Advanced Options specify:

a. Wait time for the object to exist. This can be changed if required.

b. Optionally view the Object Properties which will be used to execute the command

v. Save or Update if in edit mode.
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l By default, all fields are displayed. Once you select fields for inserting values, and you open in edit mode after saving only
those are shown. To view all click Show All.

l You can also choose to change the sequence in which the object values will be filled when automation is executed. For this

you must click . This is the default state. To lock the sequence, click . This ensures the sequence is not changed.

l The data that is visible can be filtered on Type and sorted on Type and Entry columns.

5. Your logic will reflect theExport Dataset command in the event data.

6. Save.

Tip: The Save button is disabled until all object values that are selected for Play are filled.

It is a best practice to Calibrate Screens that are used for Export Dataset command if the application is subject to frequent updates.
These would affect the MetaBot during execution.
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File and Folder Commands

Use the File and Folder commands to automate common operations that involve manipulating files and folders.

Overview

These days, most occupations require the organizing and manipulation of files and folders on computer systems. Automating these
tedious tasks can help organizations become more efficient. In addition, less human error occurs when automating.

The File and Folder commands provide an easy way to automate creating, opening, copying, moving, renaming, deleting, and organ-
izing files and folders.

The File and Folder commands also offer advanced operations for working with files and folders based on their size and date created
or modified.

Using the Sub-Commands
Open File Command

Use this command to open an existing file.

Open Folder Command

Use this command to open an existing folder.
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Copy Files Command

Use this command to copy an existing file.

Copy Folder Command

Use this command to copy an existing folder.
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Rename Files Command

Use this command to rename an existing file.

Rename Folder Command

Use this command to rename an existing folder.



Copyright © 2018 Automation Anywhere, Inc. 213 https://support.automationanywhere.com

Delete Files Command

Use this command to delete an existing file.

Delete Folder Command

Use this command to delete an existing folder.
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Create File Command

Use this command to create a new file.

Create Folder Command

Use this command to create a new folder.
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Zip Files Command

Use this command to compress a group of files into a ZIP file.

Unzip Files Command

Use this command to unzip and extract a group of files that has previously been zipped.
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Print File Command

Use this command to print a file.

Print Multiple Files in a Folder Command

Use this command to print all of the files that reside in a folder.
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Create File Shortcut Command

Use this command to create a shortcut for opening a file. For example, you might want to create a shortcut to a file on a user's desktop.

Create Folder Shortcut Command

Use this command to create a shortcut for opening a folder. For example, you might want to create a shortcut to a folder on a user's
desktop.
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Also See...

l Log-to-File Command

l Manage Windows Controls Command

l Open Program/File Command

l System Command

l Windows Actions Command
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FTP / SFTP Command

Use the Automation Anywhere FTP/SFTP command to automate any FTP TaskBot / MetaBot Logic.

FTP (File Transfer Protocol) is a standard network protocol used to transfer files from one host to another host over a TCP-based net-
work, such as the Internet.

 Important: SFTP with SSH1 protocol has been deprecated, which is no longer supported by SFTP.

You can use the Automation Anywhere FTP/SFTP command to automate the following:

l Use FTP for file uploads and downloads

l Back up websites

l Use Secure FTP for secure remote file transfer

The FTP/SFTP command provides an Advanced View option for working with files and folders based on when they are created or mod-
ified.

Tip: To use this command, ensure that Visual C++ Redistributable for Visual Studio 2015 is installed
on the Client machine. You can download the redistributable from Microsoft’s website: https://www.-
microsoft.com/en-in/download/details.aspx?id=48145

https://www.microsoft.com/en-in/download/details.aspx?id=48145
https://www.microsoft.com/en-in/download/details.aspx?id=48145
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Using the FTP/SFTP Command

To insert an FTP/SFTP command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the FTP/SFTP commands to the Task Actions List pane. The FTP window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

The FTP/SFTP command includes the following options:

1. Connect: Connect to FTP/SFTP server. Specify the FTP/SFTP Server name, User Name, and Password. You can use variables in
Username and Password fields.

Tip: For more secure credentials, insert 'Credential Variables'* from the list of variables using
the function key 'F2'. 

* Available from version 10.2
You can also select any of the following options:

l Anonymous login

l Secure FTP - Select this to use secure FTP. This will also allow you to opt for Key File Authentication.

l Key File Authentication* - Select this option, to use a private key file for SFTP connection. Ensure the FTP Server has a cor-
responding public key file.

Note: Key File Authentication and Normal User Authentication for SFTP is not supported
for Windows Server.
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Test the connection to ensure all parameters work.

l Advanced View - Use this to set advanced connection options. Here, you can specify the number of reconnection
attempts, time between each attempt, transfer mode, transfer type, and default directory path.
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Note: Transfer Mode, Transfer Type, and Directory options are available only if you are
using a FTP connection.

2. Disconnect: Terminates the connection to an FTP/SFTP server.

3. Put Files: Uploads one or more files from a folder.

4. Get Files: Downloads one or more files to a local machine from an FTP/SFTP folder.
The FTP/SFTP command also offers advanced operations for working with files based on the date they are created or modified.

5. Put Folder: Upload an entire folder from a local machine to an FTP/SFTP server. You can specify filters using wild card characters
to restrict uploads to specific types of files.

6. Get Folder: Download an entire folder from an FTP/SFTP server to a local machine. You can specify filters using wild card char-
acters to download only specific types of files.
The FTP/SFTP command also offers advanced operations for working with folders based on the date they are created or modified.

7. Delete Files: Delete one or more files from an FTP/SFTP folder.

8. Rename Files: Rename one or more files in an FTP/SFTP folder.

9. Create Folder: Create a folder on an FTP/SFTP server.

10. Delete Folder: Delete a folder (including all sub-folders and files within it) from an FTP/SFTP server.
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11. Change Folder: Move to a different folder on an FTP/SFTP server. Use this option when you want to download or upload files in
more than one directory on your FTP/SFTP server. 

Also See...

l Internet Connection Command

l Launch Website Command

l Send Email Command

l Web Recorder Command

l Web Service Command
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IF/ELSE Command

Use this command to add conditional logic and actions to your automated TaskBot / MetaBot Logic.

Sub-Commands

The IF/ELSE command provides the following sub-commands:

l File Exists / File Does Not Exist

l Folder Exists / Folder Does Not Exist

l Window Exists / Window Does Not Exist

l Application Running / Application Not Running

l Script Successful / Script Unsuccessful

l TaskBot / MetaBot Logic Successful / Unsuccessful

l Ping Successful / Ping Unsuccessful

l Variable

l File Size

l File Date

l Web Control

l Image Recognition

l Service Running / Service Not Running

l Windows Control

l Else If

l Else

l End If

Overview

One of the most powerful features of Automation Anywhere is the IF/ELSE command. You can use the sub-commands to perform
actions when certain conditions exist.

When using most of the conditional sub-commands, you can specify how long to wait for the condition to be true before taking another
action.

Using the Sub-Commands

To insert an IF/ELSE command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the IF/ELSE commands to the TaskBot / MetaBot Logic Actions List pane. The IF/ELSE window is dis-
played.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.
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File Exists/File Does Not Exist Commands

Use these commands when you want to perform an action based on whether a file exists. For example, if a data file exists, you might
format the file and upload it to a database.
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Folder Exists/Folder Does Not Exist Commands

Use these commands when you want to perform an action based on whether a folder exists.
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Window Exists/Window Does Not Exist Commands

Use these commands to do the following:

l Check or verify that a specific application is open.

l Check whether an error has occurred.

l Check whether a file download has completed.

These are some of the most frequently used commands in Automation Anywhere.
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Application Running/Application Not Running Commands

Use these commands to perform an action based on whether an application is running. When a program is running in the background,
you can still perform actions by using this command.
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Script Successful/Script Unsuccessful Commands

Use these commands to integrate third-party scripts with your automation TaskBot / MetaBot Logic. After the script runs and issues a
return code, Automation Anywhere can determine if the script ran successfully.

For scripts that you have already developed, you can use this command to integrate them with your automation TaskBot / MetaBot
Logic.
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TaskBot / MetaBot Logic Successful / Unsuccessful Commands

Use these commands to run several Automation Anywhere TaskBot / MetaBot Logics, one after another. The command runs the selec-
ted TaskBot / MetaBot Logic, and depending on the return code, determines if it ran successfully and takes appropriate actions based
on the result.

For example, if a TaskBot / MetaBot Logic that monitors your website runs successfully, it means that your website is up and no action
is required. However, if the TaskBot / MetaBot Logic is unsuccessful, it means that the website is down and you need to take action.

To avoid task failure when the task is deployed from Control Room, use the variable $AAApplicationPath$, instead of user defined vari-
able. If you add any other variable in the Select Task File field, you are shown an error:
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Ping successful/Ping Unsuccessful Commands

Use these commands to check whether a machine or server is running, and take appropriate action based on the result.
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Variable Command

This command, though it looks simple, is perhaps the most powerful conditional command. Use this command to perform hundreds of
checks.

For example, you can copy data from an application or website and verify that the data you copied matches a specific text string. You
can also verify a numeric string, or check to see if it is greater than or less than a variable or a fixed value.

Using AND or OR conditions in IF Variable command*

When you need to include the 'AND' or 'OR' conditions in conjunction with the 'Variable' sub-command, use the 'Add
more conditions' option. It offers you the luxury of including all your AND or OR conditions within a single parameter,
instead of specifying separate parameters for each condition as was the case in earlier editions of Automation Any-
where.
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Enable the 'Match Any' option for 'OR' conditions or 'Match All' for 'AND' conditions (refer image below)

Note: You cannot include both; 'Match Any' + 'Match All' within a parameter. You are
required to specify them within a TaskBot / MetaBot Logic, separately.
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File Size Command

Use this command to check whether a file is larger, smaller, or the same as a size you specify.
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File Date Command

Use this command to check the date and time that a file was created or last modified. You can specify a date range using 'between' or
'before' keywords. You can also specify a range using a number of days or a time schedule hh:mm:ss format.
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Web Control Command

Use this command to identify whether a specific web control exists on a Web page. For example, your TaskBot / MetaBot Logic can
check for links, text boxes, and drop-down menus.

Use this command when editing TaskBot / MetaBot Logics that are created using the Web Recorder.

Note: If you have upgraded to version 8.1.2 and change the parameter to 'Select Page', you will have
to re-capture the control. Refer Editing a Web-only Task with Web Recorder Command for details.
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Image Recognition Command

Use this command to check whether an image exists within another image. Automation Anywhere can recognize images that are
stored in files or captured from a window when the TaskBot / MetaBot Logic runs. You can even specify a minimum 'percentage match'
for the If command to be true. Image Recognition also provides a powerful tool that enables you to click on an image if it is found within
the larger image.
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Service Running/Service Not Running Commands

Use these commands to check whether a particular service is running.
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Windows Control Command

Use this command to check whether a specific control exists in an active window. For example, you might check for command buttons,
list box items, text boxes, or menu tabs.
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Setting a Wait Time for Conditions

Most of the conditional commands let you specify how long to wait for a condition to be true.

Let's say you want to perform an action only if a specific window exists. You know that it might take from 5 seconds to 5 minutes for the
window to open. Obviously, you don't want to wait 5 minutes when the window comes up in just 30 seconds. Automation Anywhere
takes care of this for you by following this model:

Using the IF command, you can select IF and 'Window does not exist,' and type the maximum time in seconds to wait for the window to
be displayed. (In this case, 5 minutes, or 300 seconds.) Automation Anywhere checks for the window to be displayed.

If it appears in 30 seconds, Automation Anywhere immediately begins running the commands you specified within the conditional IF.

If you leave the 'How long would you like to wait...?' field empty, or enter '0 (zero)', Automation Anywhere checks for the condition imme-
diately and runs the actions.

If the condition does not exist, these actions are skipped and the actions that follow the ENDIF are run.

Note: If you enable ‘Secure Recording mode’, images and values are not captured. Learn More

Also See...

l Loop Command
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Image Recognition Command

Image recognition command provides a visual approach to make your TaskBot / MetaBot Logic work with the applications and inter-
faces.

Use this command to quickly search for a desired image within a source image and to readily automate any application that uses
visual elements. You can capture and process various images of different sizes using HiDPI display.

Another major benefit of using image recognition is to locate an image after the image might be moved, for example, from one location
on a web page to another.

Also, in some cases when application UI elements may not be available for automation you can use Image based automation. For
example, when application is exposed over Citrix or when application accessed from RDP, or when object detection is not as reliable
such as legacy applications, you can use the Image Recognition command.

Using the Image Recognition Command

To use the Image Recognition command, follow these steps:

1. Select an image file from a folder or that is captured from an application window. This image can be standalone or contained within
another image that is captured dynamically at run time.

2. Select Show Coordinates to capture and view the coordinates of the target image within the window.

3. Mention the wait time (in milliseconds) in the Wait before capturing the image text-box for target images that are to be captured from
windows that might take some time to load.

4. Select or Capture the image that you want to click upon during play time in Image2. Here, you can Capture the image from an open
Window or Select it from a File.
If you are using the command for a Window, you also have the flexibility to position your click location relative to an image. This is
useful when the target image is blurred, has some background noise, or the target image is visible multiple times.

l Image Recognition command identifies the images that are difficult to recognize and allows you to select an easily iden-
tifiable image and position your click relative to it.
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Note that you can select the relative click option only if you are using AAE Enterprise Client edition 11.0 and higher.

l Users below AAE 11.0 will continue using (cross-hair without relative click).

Note: If using in conjunction with 'If - Else' command, select the option 'If the image is
found, click on it'. for the cross-hair to appear.

Tip: To get back to the default cross-hair position (center of the image), simply click
'Reset Crosshair'.

l Once the image is captured, position the 'cross-hair ' at the spot where you wish to click during run time when the image is
found.

A number on the top left corner indicates that the image appears multiple times in the target screen. The consecutive
images are highlighted with a perforated border with the sequence number at the top.
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Tip: For larger images, you can scroll and position the 'cross-hair' as required.

5. Select Image Occurrence when the target image can be found multiple times. Here, you can use a variable when you do not know
the number of times the image might appear on the screen. While using variables ensure you assign variables that support
numeric values.

6. Select any of the three options - Left Click, Double-Click, or Right Click If Image is found within a larger image.

7. To locate the image at run time, specify options - Match Percentage, Tolerance, and Comparison Mode:

l Match Percentage: A 100 percent Match Percentage means none of the pixels should mismatch between the two images.
A Match Percentage of 20 means that even if up to 20% of pixels mismatch between the two images, the images will be con-
sidered to match. Use for images that are quite similar, yet are not matched.

l Tolerance: A 0% Tolerance means the individual RGB values of the pixels being compared must match, exactly. Similarly,
a 20% tolerance could allow the individual RGB values of the pixels to vary from + 20% to - 20% for a successful match.

n While Match Percentage defines the extent of overall mismatch allowed between Image1 and Image2, Tolerance
defines the extent of mismatch allowed between any two pixels under comparison.

n The RGB color space uses 8 bits each for red, green and blue and can have integer values ranging from 0 to 255.

n For instance, when using Tolerance: Case1 - mismatch with 20% Tolerance -

a. Case1 - mismatch with 20% Tolerance -

Image1 pixel values:

Image2 pixel values:

b. Case2 - successful match with 20% Tolerance -

Image1 pixel values:

Image2 pixel values:

In Case1, the images are clearly a mismatch. The difference in R value of both images exceeds the Tol-
erance limit by 10 (20% of 255 is approximately 50 and 250 - 190 > 50). While in Case2 it's a successful
match as the difference between the R,G and B values of both images fall within the Tolerance limit.

l Comparison Mode: Select one of the methods of comparison:

a. Advanced: It is the default mode of comparision. It is recommended that you select this mode as it is more accurate
as compared to other modes and provides better results in cases where, screen resolution/zooming or application
scaling is subject to change.

Note: If you have migrated Bots created in AAE Client 10.x version to the current
version, the comparison mode that you had selected will not change to Advanced auto-
matically. Only the Bots that are created in the current version will have Advanced as
the default mode of comparison.

b. Normal mode: Compares the RGB components of the pixels with the source. Use this when you are not bothered
about the speed and want exact color match in complex scenarios.

c. Gray-scaled mode: Converts pixels to an appropriate level of gray-scale prior to comparing. Use this when colors
are of limited benefit in comparison and you want your test to run faster.

d. Monochrome mode with Threshold: Converts pixels to either black or white prior to comparing. The threshold value
is used while converting the RGB or Gray-Scaled pixels to either black or white (a pixel value less than the threshold
value is black; greater is white). Use this when you want to recognize multi-colored text against multi-colored back-
grounds.

l A 'Quick Test': Use the 'Quick Test' button to quickly ascertain the output is as required. This eliminates the need to run the
entire test.

a. A 'Quick Test', being similar to an actual test, includes the parameters provided for Match Percentage, Tolerance and
Comparison Mode.

b. If variables are used in the TaskBot / MetaBot Logic, 'Quick Test' will not be applicable.
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c. For tasks created in earlier versions (prior to 7.5), 'Quick Test' will work only after you recapture the image as this fea-
ture is available from version 7.5 onward.

Tips and Tricks:

l Click on Image1 to preview in the default picture viewer.

l For faster image recognition, if a particular color dominates the entire screen (say gray),
make sure that the starting pixel of Image2 (the one on the upper left corner) doesn’t include
that color.

l For Faster image recognition, ensure Image2 to be recognized is as small as possible.

l Use delay wisely.

l Trouble running a quick test? Learn how to troubleshoot.

Enable Secure Recording Mode

Secure recording is enabled by the Control Room admin to ensure no sensitive data is captured while automating tasks. Learn More

When Secure Recording mode is enabled, you will find the following behaviour in command:

1. Creating an automation - When you capture the images during automation, both images - Image1 and Image2 are shown for pre-
view.

l Image1 will not be saved and Image2 will not be shown once you save the command.
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2. Editing an automation - When you open the command in edit mode, both images - Image1 and Image2 will not show in preview.

l When you recapture Image1, it is shown in the preview but not saved. Image2 is not shown.
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l When you directly recapture Image2, only that is shown in the preview. However, when you save the command, the image is not
visible.

l When you recapture both images and save the command, Image1 is not saved and Image2 is not shown in the preview. This is sim-
ilar to when you save the command when you are creating an automation.

l When you select From File option for Image2 you will not be able to locate the image once the command is saved.

Also See...

l Error Handling Command

l File and Folder Commands

l IF/Else Command

l Loop Command

l Variable Operation Command

Import DataSet Command

Inserting huge amounts of data from a single source can be done using the Import Dataset command in a MetaBot Logic from the Work-
bench. You can insert data into various fields from an external file such as an Excel spreadsheet using single command. It enables you
to create logic that would otherwise involve numerous keystrokes and clicks.

Supported Technologies and Controls

Import Dataset command supports the following technologies:

1. HTML

2. JAVA

3. MSAA



Copyright © 2018 Automation Anywhere, Inc. 247 https://support.automationanywhere.com

4. .NET

5. Flex

Import Dataset command supports the following controls and actions:

1. Static Text (label) - GetProperty, Click, LeftClick, RightClick, and DoubleClick

2. Text Box - SetText, AppendText, Click, LeftClick, RightClick, and DoubleClick

3. Radio Button - Select, LeftClick, RightClick, and DoubleClick

4. Check Box - Check, Uncheck, Toggle, LeftClick, RightClick, and DoubleClick

5. Combo Box - SelectItemByText, SelectItemByIndex, LeftClick, RightClick, DoubleClick, and Expand

6. List View - SelectItemByText, SelectItemByIndex, LeftClick, RightClick, and DoubleClick

7. Buttons - LeftClick

Import Data to an application

You can configure the Import Dataset command from Workbench → Commands.

1. Create a Screen using required application. Learn More

2. Configure the Screen for required parameters. Learn More

Tip: If an object does not display or displays an unidentifiable text and/or number, its recom-

mended you provide an alias to that object during Screen configuration. Learn More

3. In the Logic Editor, select Import Dataset from the Commands list.

4. Start filling in details using a combination of variables, text and controls. Unless a field is populated, you cannot move to the next.

Note: All the objects which are not selected for automation execution are disabled by default.
To enter value in those, click on the check-box in Write column.
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l You can use either the direct assignment of variable i.e. assign a Value or indirect assignment i.e. assign value from a text
document as shown:

l For variables that make use of credentials or any sensitive data, use Credential Variables. Select the required vari-
able listed under $CredentialVariables$ from Insert Variables. Refer the article Assigning Credential Variables for
details.

l You can choose to create a variable, if not present when inserting one. In the Value field, press function key F2 to
launch Insert Variable dialog. Click New to create a variable.

https://support.automationanywhere.com/hc/en-us/articles/230205168-Assigning-Credential-Variables
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l You can also insert object values using the properties window. To configure additional properties such as delay, search cri-
teria etc, double click anywhere on the corresponding object row and update the properties.

i. Select Action that needs to be performed during Logic execution. This can be changed if required.

ii. Optionally Insert Keystrokes and/or Mask the keystrokes

iii. Type the required text in Enter Text

iv. In Advanced Options specify:

a. Wait time for the object to exist. This can be changed if required.

b. Optionally view the Object Properties which will be used to execute the command

v. Save or Update if in edit mode.

l By default, all fields are displayed. Once you select fields for inserting values, and you open in edit mode after saving only
those are shown. To view all click Show All.
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l You can also choose to change the sequence in which the object values will be filled when automation is executed. For this

you must click . This is the default state. To lock the sequence, click . This ensures the sequence is not changed.

l The data that is visible can be filtered on Type and sorted on Type and Entry columns.

5. Your logic will reflect the Import Dataset command in the event data.

6. Save.

Tip: The Save button is disabled until all object values that are selected for Write are
filled.

It is a best practice to Calibrate Screens that are used for Import Dataset command if the application is subject to frequent updates.
These would affect the MetaBot during execution.

Note: You can fill the form in OCR mode, IR mode and mixed mode.
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Insert Keystrokes Command

Use this command to automate the typing of keystrokes in an application using your automation TaskBot / MetaBot Logic.

Note: Regional settings supported - English, German, French, Italian and Spanish.

To insert keystrokes, follow these steps:

1. Open the TaskBot / MetaBot Logic in the Workbench.

2. Double-click or drag the Insert Keystrokes command to the Task Actions List pane. The Insert Keystrokes window is displayed.

3. In the Select Window drop-down list, select the title of the application in which you want to type keystrokes.

Note: You can insert a variable here by pressing the function key 'F2'. You can opt to insert
either User (Local) variables or Credential Variables for enhanced security.
Learn More about benefits of using Credential Variables.

Applications that you have already referenced in the TaskBot / MetaBot Logic are listed at the top of the drop-down list. Applic-
ations that are currently open are listed below the dotted line in the list.

Tip: Before using the Insert Keystrokes command, verify that the application window is open. If
the application is not listed in the Select Window drop-down list, open the application and click
the Refresh button in the Insert Keystrokes Select Window drop-down list.

4. In the Keystrokes text box, type (or cut/paste) the text you want inserted when the TaskBot / MetaBot Logic runs.

To insert special keystrokes such as Control, Shift, or Tab, click the button in the Special Keystrokes box.
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l For example, if you want the TaskBot / MetaBot Logic to type Ctrl + C in an application, click Ctrl Down, type 'c,' then click
Ctrl Up. The following commands and text in the Keystrokes window will be displayed: [CTRL DOWN]c[CTRL UP]. Sim-
ilarly, if you want to type Ctrl + Shift + a, click Ctrl Down, Shift Down, type 'a,' and click Shift Up and Ctrl Up.

5. To prevent your TaskBot / MetaBot Logics from being altered by unauthorized users, use the Keystroke Encryption option. This
option hides sensitive information or passwords that are typed using the Insert Keystrokes command.

6. If required, you can add a delay to this command.

Note: The default delay is 0 (Zero) milliseconds.

You can even associate a variable with delay:

7. Click Save

Using Wild Cards

In the Select Window text box, you can type a wildcard character (*) at the start or end of the window title. This is helpful, for example, if
you expect the window title to change over time. For example, you can type 'Microsoft Excel*' or '*Excel' or '*Excel*,' so that the window
will still be selected when the TaskBot / MetaBot Logic runs, even if the window title has changed to reflect the name of an open doc-
ument. However, if you know the exact title of the window, we recommend that you type the complete window title to ensure that the
actions will always performed only in that window.

Also See...

l Insert Mouse Click Command

l Insert Mouse Move Command

l Insert Mouse Scroll Command
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Insert Mouse Click Command

Use this command to automate mouse clicks in your automation TaskBot / MetaBot Logic.

To insert a mouse click command, follow these steps:

1. Open the application in which you want to enter a mouse click.

2. In the Automation Anywhere Task List, select the TaskBot / MetaBot Logic and click Edit.

3. In the Workbench, drag or double-click the Insert Mouse Click command. The Insert Mouse Click window is displayed.

4. In the drop-down list at the top, all open applications are listed. Select the application in which you want to enter a mouse click. A
small graphic image of the window you selected is displayed.

If you do not see the application in the drop-down list, make sure the application is open and click Refresh.

5. For Applications that change titles: If the name of the application window title changes over time, you can use a wild card char-
acter (*) at the start or end of the window title that you specify. This ensures that the application is consistently found when running
the TaskBot / MetaBot Logic.

For example, to ensure the Microsoft Excel application is always found, use 'Microsoft Excel*' or '*Excel' or '*Excel*'.

Note: If you anticipate that the application title will never change, specify the exact name to
ensure that the TaskBot / MetaBot Logic references the correct application window.

6. Click Capture. Automation Anywhere activates the window you selected in step 4. Click in the window in the location where you
want to insert the mouse click. Optionally, you can click Advanced View and set the following options:

l Select the mouse button to click: Left Button, Middle Button, or Right Button.

l Select the type of click: Click, Double Click, Button Down, or Button Up.

l Select Relative To Screen or Window. Use the Window option when you work with varying screen resolutions (for example,
a dual-monitor).

7. Click Save.

When you 'Enable' Secure Recording
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Note: If you enable ‘Secure Recording mode’, no images are captured. Learn More

Also See...

l Insert Keystrokes Command

l Insert Mouse Move Command

l Insert Mouse Scroll Command
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Insert Mouse Move Command

Use the Insert Mouse Move command to automate the movement of a mouse from one location to another.

The Mouse Move command is useful in automating menu navigation, such as when using the Windows Start menu, where moving the
mouse over an item displays a new sub-menu. Inserting mouse clicks do not require moving the mouse to the click location.

To record mouse cursor movements, follow these steps:

1. Open the application in which you want to insert a mouse movement.

2. Open the TaskBot / MetaBot Logic in the Workbench.

3. In the Task Actions List, select the action after which you want to insert a mouse movement.

4. In the Commands list, double-click or drag the Insert Mouse Move command. The Insert Mouse Move window is displayed.

5. Select the Mouse Position (From) and click the Capture button to insert the mouse movement. Alternately, you can specify numeric
values, or press the F2 key to insert variables for the X and Y coordinates in Mouse Position (From).

6. After you click on Capture, Automation Anywhere switches to the active window in the application.

7. In the active window, click on the left mouse button and drag the cursor to the location in which you want the mouse movement to
begin. Release the mouse button. This step automatically captures the required information regarding the start location of the
mouse movement.

8. In the Insert Mouse Move window, select the Mouse Position (To) and click on Capture. Alternately, you can specify numeric val-
ues, or press the F2 key to insert existing variables for the X and Y coordinates in Mouse Position (To). The yellow prompt bar will
change to red if the content you click is not a table.

9. After you click on Capture, Automation Anywhere switches to the active window in the application.

10. Click on the left mouse button and drag the mouse cursor to the location in which you want the mouse movement to end. Release
the mouse button.

11. Optionally add a delay in milliseconds.

12. Click Save.

Also See...

l Insert Keystrokes Command

l Insert Mouse Click Command

l Insert Mouse Scroll Command
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Insert Mouse Scroll Command

Use this command to automate the action of mouse scrolling. Use this command in conjunction with the Insert Mouse Click command.

To insert a mouse scroll command, follow these steps:

1. Select a the application window in which you want to insert a mouse scroll action.

2. Open the TaskBot / MetaBot Logic in the Workbench.

3. Double-click or drag the Insert Mouse Scroll command to the location required in the Task Actions List. The Insert Mouse Scroll win-
dow is displayed.

4. Select a scrolling direction option, either Up or Down .

5. Enter number of iterations.

6. Specify the delay time required.

7. Click Save. The mouse scrolling action is inserted in the TaskBot / MetaBot Logic.

Also See...

l Insert Keystrokes Command

l Insert Mouse Click Command

l Insert Mouse Move Command
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Internet Connection Command

Use this command to have your task automatically connect to the Internet using a dial-up connection.

Using the Internet Connection Command

To insert an Internet Connection command in your task, follow these steps:

1. Double-click or drag the Internet Connection command to the Task Actions List pane. The Internet Connection window is dis-
played.

2. Select the dial-up connection from the drop-down list.

3. Specify whether you want to repeat the connection attempt if it fails. You can specify the number of times to attempt the connection,
and the time interval between connection attempts.

4. Click Save to save the command to your automation task.

You can also insert a Disconnect command in the task to disconnect the dial-up connection.

Error Messages

If you do not select or specify a connection from the drop-down list, the program will display an error.

Note: Only dial-up connections can be used with this command.

Also See...

l FTP-SFTP Command

l Launch Website Command

l Send Email Command

l Web Recorder Command

l Web Service Command
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Launch Website Command

Use this command to launch a website from within an automated TaskBot / MetaBot Logic.

Using the Launch Website Command

To launch a website from your TaskBot / MetaBot Logic, follow these steps:

1. Open the TaskBot / MetaBot Logic in the Workbench.

2. Double-click on or drag the Launch Website command to the Task Actions List. The Launch Website window is displayed.

3. Specify the URL of the website to launch.

4. Click Launch.

5. Select the title of the website. If you do not see the title, click Refresh.

6. Save the command.

Also See...

l FTP-SFTP Command

l Internet Connection Command

l Send Email Command

l Web Recorder Command

l Web Service Command
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Log-to-File Command

Use the Log to File command to create a log file in which TaskBot / MetaBot Logic information can be stored as the TaskBot / MetaBot
Logic runs.

Overview

Logging detailed TaskBot / MetaBot Logic information is an important aspect of optimizing and debugging your automation TaskBot /
MetaBot Logics. Automation Anywhere provides an easy was for you to create a log file that is full of useful data about the events that
occur as your TaskBot / MetaBot Logic runs.

Log files can be saved in the several file formats, including .csv and .txt files. Encoding is provided for log files with options for ANSI,
UNICODE, and UTF8.

The Log to File command helps you to do the following:

l Verify that a TaskBot / MetaBot Logic has run properly, especially if the TaskBot / MetaBot Logic has complex conditional and loop-
ing commands.

l Create a new log file if one does not already exist.

l Specify custom text to be included in the log file.

l Add a time stamp to the log file.

l Use a log file as a variable.

Also See...

l File and Folder Commands

l Windows Actions Command
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Loop Command

Use this command to create loop structures in your automation TaskBot / MetaBot Logic to automate repetitive TaskBot / MetaBot
Logics.

Overview

The Loop commands are some of the most powerful commands in Automation Anywhere. Four types of loop structures are provided:

l Start Loop

l End Loop

l Exit Loop

l Continue Loop

Sub-Commands

The LOOP command provides the following sub-commands:

l Start Loop

l Times

l List

l Condition

l Each Row in an Excel Dataset

l Each Row in an Internet Explorer Table

l Each Row in an SQL Query Dataset

l Each File in a Folder

l Each Folder in a Folder

l Each Row in a CSV/Text File

l Each Email Message on Server

l Each Node in an XML Dataset

l End Loop

l Exit Loop

l Continue Loop

Using the Sub-Commands

To insert an Loop command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the Loop commands to the Task Actions List pane. The Loop window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

Start Loop Commands

The following commands are Start Loop commands:

1. Times: Use this command to loop for a number of times. The command loops the actions between the Start Loop and End Loop
commands for the number of times you specify. For example, if you want to repeat the action 5 times, place the actions between
Start Loop and End Loop commands and specify 5.
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2. List: Use this command when you do not know how many times a TaskBot / MetaBot Logic needs to loop. If you have a list variable
that contains several values, you can use the List command to loop through the entire list until it reaches the end. Using this com-
mand, you can repeat the actions within the Start Loop/End Loop block as many times as necessary to reach the end of the list. You
can access the list variable values within the loop. For example, the first time the loop runs you can get the first value of the list vari-
able, the second time you get the second value of the list variable, and so on.

3. Condition: Use this command to run actions based on conditions that exist. For example, you might want to repeat a set of actions
based on whether a file exists. You can check the condition at the end of the iteration by selecting the check box.

Optionally, you can add a 'Wait' time for the condition to be true.
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Using AND or OR operators in Loop While > Variable command

When you need to include the 'AND' or 'OR' conditions in conjunction with the 'Variable' sub-command, use the 'Add more con-
ditions' option. It offers you the luxury of including all your 'AND' or 'OR' conditions within a single parameter, instead of spe-
cifying separate parameters for each condition.



Copyright © 2018 Automation Anywhere, Inc. 263 https://support.automationanywhere.com

Enable the 'Match Any' option for 'OR' conditions or 'Match All' for 'AND' conditions (refer image below)

Note: You cannot include both; 'Match Any' + 'Match All'. You are required to specify them
within a TaskBot / MetaBot Logic, separately.

Similar conditions are used in If Variable command. Reference If-Else Command for details.

4. Each Row in an Excel Dataset: Use this command in conjunction with the Get Multiple Cells sub-command of the Excel command.
When you have retrieved a range of cells from Excel using Excel > Get Cells > Get Multiple Cells, the rows and
columns of the range are stored in the system variable $Excel Column$.
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For example, if you retrieve a range of cells from Excel that has five columns, you can access the five columns of the table by
calling $Excel Column(1)$, $Excel Column(2)$, $Excel Column(3)$, $Excel Column(4)$, $Excel Column
(5)$. This command is extremely useful for transferring data from one Excel spreadsheet to another, or to any other applic-
ation.

5. Each Row in an Internet Explorer Table: Use this command in conjunction with the Extract Table sub-command of the Web
Recorder command. When you extract a table by using the Web Recorder Extract Table command, the rows and columns of the
table are stored in the system variable $Table Column$. For example, if you extract a table with five columns, you can access the
five columns by calling $Table Column(1)$, $Table Column(2)$, $Table Column(3)$, $Table Column(4)$, $Table
Column(5)$. This command is extremely useful for transferring data from a Web page table to other applications, such as other
Web pages or an Excel spreadsheet.

6. Each Row in an SQL Query Dataset: Use this command in conjunction with the Database commands. When you issue an SQL
query using the Automation Anywhere Database SQL Query command, the result set for the SQL query is stored in the system vari-
able $Dataset Column$.

For example, if you issue an SQL query to a database for five columns of data. You can access the five columns from the result
set by calling $Dataset Column(1)$, $Dataset Column(2)$, $Dataset Column(3)$, $Dataset Column(4)$,
$Dataset Column(5)$. This command is extremely useful for transferring data from a database to other applications, such as
a Web page or an Excel spreadsheet.

7. Each File in a Folder: Use this command to perform an action on all files in a folder. Often times, the number of files in a folder can
change. You can specify a folder and loop through all files in that folder.

You can obtain information about the files and folder by using the following system variables:

l $FileName$ - Use this variable to obtain the name of a file.

l $Extension$ - Use this variable to obtain a file's extension.

l $CurrentDirectory$ - Use this variable to obtain the path of the folder in which the filesa are stored.

All of these system variables return an empty value when used outside the looping command.

8. Each Folder in a Folder: Use this command to perform an action on one or more folders. To access the folder name within the loop,
use the system variable $FolderName$.

9. Each Row in a CSV/Text File: Use this command to loop through each row in a CSV or text file.

10. Loop For Each Message in Server: Use this command to perform an action on each message that resides on your mail server. You
might use this command to save mail attributes, such as Subject, Message, To:, Cc:, and Attachment.
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11. Each Node in an XML Dataset: Use this command to loop through each node of an XML data set to obtain values from multiple
nodes.

End Loop Command

Use this command to end the loop. The actions that exist between the Start Loop and End Loop commands will repeat based on the
type of loop you have selected.

Whenever you insert a Start Loop command, an End Loop command is also inserted. If the End Loop is mistakenly deleted, you can
insert an new one.

Exit Loop Command

Use this command to break out from a loop when a particular action or condition occurs. The Exit Loop command can exist only
between the Start Loop and End Loop commands.

Continue Loop Command

Use this command to continue the next iteration of a loop when a particular action or condition occurs. When a Continue Loop com-
mand is reached, the commands up to End Loop are skipped and the next iteration of the loop is run.

Also See...

l If Else Command



Copyright © 2018 Automation Anywhere, Inc. 266 https://support.automationanywhere.com

Manage Windows Controls Command

Use this command to capture Windows control properties, such as buttons, list box items, text boxes, menu tabs, combo boxes, check
boxes, and tables.

Note: If you enable ‘Secure Recording mode’, no values are captured. Learn More

Using this command, you can perform actions on these controls or assign the captured properties to variables.

You can also use this command to simultaneously record actions that you perform.

The following list shows the Windows controls that you can capture and the actions that are available.

Control - Actions

1. Button - Click, Get Text

2. Edit (Text box) - Get Text, Set Text, Append Text, Click On Link

Note: You can insert variables while using Set/Append Text. If the text needs to be encrypted,
you can use Credential Variables for enhanced security. Learn More

3. RadioButton - Get Radio Button Status, Select Radio Button

4. Checkbox - Set Check Box Status, Get Check Box Status

5. ComboBox/Drop Down - Get Total Items, Get Selected Index, Get Selected Item, Select Item by Index, Select Item by Text

6. Get Text - Click on link, Get Name of All Children, Get Value of All Children, Get Value Text, Get Name Text

7. Tab / TabItem - Get Total Items, Get Selected Index, Get Selected Item, Select Tab By Index, Select Tab by Text

8. List / ListItem - Get Total Items, Get Selected Index, Get Selected Item, Select Item by Index, Select Item by Text

9. Menu/MenuBar/MenuItem - Get Total Items, Get Text by Index, Get Index by Text, Click Item By Index, Click Item by Text

10. Tree / Tree Item - Get Total Items, Get Selected Index, Get Selected Item, Select Item By Index, Select Item by Text

11. Table - Exports To CSV, Get Cell By Index, Get Cell By Text, Total Row, Total Column, Set Cell By Index, Set Cell By Text

The following actions are common to all Windows controls:

l Left mouse click

l Right mouse click

l Double-click
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Capturing a Control of a Specific Type

Use the Capture a control of a specific type check box to select from a list of controls to capture. Only this control is captured when
using this option. This option can help in avoiding errors that might occur when clicking on certain controls that possess different attrib-
utes.
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The controls that are captured are displayed under Control Properties, showing the Control Type, Name, Value and its Location
(coordinates).

Note: Automation Anywhere can perform actions that use only standard Windows controls. If your
application contains customized controls, Automation Anywhere might not be able to capture them.

Capturing Web Controls

To capture web controls, be sure to use the Manage Web Controls sub-command in Web Recorder Command, as opposed to the Man-
age Windows Controls command. Internet Explorer controls are recognized by the Manage Web Controls command.

Also See...

l Log-to-File Command

l Windows Actions Command
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Message Box Command

Use this command to insert a message box in an automated TaskBot / MetaBot Logic.

Overview

The Message Box command enables you to insert a message box in a TaskBot / MetaBot Logic when you want to display a message
to the user when the TaskBot / MetaBot Logic runs. You can specify a custom caption for the message box.

You can specify the following components in a message box:

l Caption: Enter a caption name for your message box.

l Message: Enter your message in the dialog box.

l Scroll bar: Insert a scroll bar in your message. The minimum message length for a scroll bar to be displayed is 10 lines.

l Close Message Box: Enter the seconds value after which the message box should close.

Common Use Case: Message boxes are useful for issuing a message to the user whenever the TaskBot / MetaBot Logic concludes
running. For example, when a web form TaskBot / MetaBot Logic completes a run, you might issue a message that states: "Web Form
Filled and Complete."

Also See...

l Prompt Command
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Object Cloning Command

The Automation Anywhere Object Cloning Command allows you to create and play tasks that use technology specific applications,

The Object Cloning Command is specifically useful if you wish to capture objects within windows that use technologies such as Flex,
Silverlight, Java and Html etc.

Using this command, you can capture objects, its co-ordinates and images from desktop and web-based applications. You can then
select an action that can be performed on the captured object(s).

Note: Object Cloning command supports Internet Explorer, Chrome, Mozilla Firefox, and Edge*.
* Applicable for automation in Microsoft Windows 10

Selecting a Window

To capture an object and its parameters such as co-ordinates and image launch the application that you want to automate and follow
these steps:

1. Select the window from which you wish to capture the object(s).

Tip: Click 'Refresh' if unavailable in the drop-down list.
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2. Click 'Capture', hold the mouse and drag it to the object to be captured.

Note: The selected object will be highlighted with a red border.

l The object is captured and displayed in the 'Object' tab.

Note: The command captures the co-ordinates and image of the object, simultaneously.

Selecting the Play Mode

Coordinates: Use this option in 'Select Play Mode' if the objects are in fixed positions.

Image: Use this option, when the image is static.
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Tip: Click 'Recapture Position/Recapture Image' in case of any discrepancy in captured co-ordinates
or image.

/

Selecting an Action to Perform

After capturing the object and its parameters, you can select an action that needs to be performed when running your task.

Note: Select Action to Perform will vary depending on the object or its coordinates captured.

Some of the options that are available to you are:

l Get Name - Usually applicable to text-box, button, label

l Get All Children Name

l Get Value

l Get All Children Value

l Click Actions - Left Click, Right Click, Double Click

l Append / Set / Get Text

Tip: You can opt to use a Variable while using the actions Set Text and Append Text. If the
text needs to be encrypted, you can insert Credential Variables using function key 'F2' for
enhanced security. Learn More

l Get/Set Cell

l Set Cell by Index

l Set Cell by Text

l Get Cell Text by Index

l Get Cell Index by Text

l Get Total Columns

l Get Total Rows

l Export to CSV

l Get Property - Use this to capture object properties of multiple controls; namely Silverlight, Flex and Web applications. Assign the
values of the captured object properties to a variable.
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l Properties that can be captured using the Get Property action are:

Editing the Search Criteria

If you wish to change the properties of an object, you can do so by using the 'Search Criteria' option.

1. Click on 'Expand Search Criteria' icon - .
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l The 'Object Cloning - Search Criteria' window pops up.

2. Change search criteria by adding or removing the search criteria icon - in the column prior to 'Property'.

Note: You cannot set a search criterion for the property 'Path'.

'Enable' Secure Recording

If you enable ‘Secure Recording mode’, no values and images are captured. Learn More.
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When you click on ‘Re-Capture Image’, it shows an error:

Automation in Edge browser - known behavior

1. The Edge application should be open when automating using the browser. For this, you can choose to use Open Program Files
command with the URL as a parameter or make Edge as a default browser.

2. If the automation is recorded in Internet Explorer, it will not play in Edge.

Also See...

l Using Plugin Settings

l Using Java Settings

l If-Else Command

l Loop-While Command
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OCR Command

Overview

Use the OCR command to extract text from images/pictures and transfer the data to another application.

Sub-Commands

The OCR command provides the following sub-commands:

l Capture Window - Use this command to specify an application window title and capture the window as an image.

l Capture Area - Use this command to capture a specific area of an application window.

l Capture Image by Path - Use this command when text that you want to capture is contained in an image that is stored on your local
computer or network drive. Specify a path name by typing it or browsing to the path.

Note: When running the TaskBot / MetaBot LogicBot, the network drive that is specified must be
accessible.

l Capture Image by URL- Use this command to capture an image located on a website URL.

Using the Sub-Commands

To insert an OCR command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag the required OCR command to the Task Actions List pane.

2. Select/input an appropriate window/area/path/url based on sub-command selected.

Optionally, assign a variable by pressing F2.

3. Specify the OCR Engine; either MODI, Tesseract, or TOCR.

l Tesseract is pre-installed when you install the Client as it is bundled with the product. Hence it is selected as the default
OCR enging.

l Since TOCR is a third party component, ensure it is installed separately. The major advantage of having Tesseract as your
OCR engine is that, even if any other OCR engine is not installed, you can leverage Tesseract for your OCR automation
requirements.

l As Automation Anywhere Enterprise platform is extensible, you can configure plug-ins for other OCR engines. Post con-
figuration these will appear in the OCR engine list and can be used for automation.

l Note that the OCR engines are available in OCR Command, MetaBot - Add Screens and MetaBot - Custom Objects.

l If you use Tesseract as your OCR engine, you will need to install Visual C++ Redistributable for Visual Studio 2015. You can down-
load it from Microsoft’s website.

Tip: If you have upgraded to 8.0.1 and more than one OCR engine is installed to your system, it is
recommended that you select the relevant OCR engine to ensure your existing tasks run fine.

4. Optionally, select Enable image pre-processing (auto-threshold) or use the manual slider or specify a number for
Threshold to adjust gray-scale and contrasts in the captured image. This ensures the fonts that might be blurred or are of lighter
shade can be recognized and extracted easily.

Tip: Use View the Captured Text and adjust the threshold using either the slider or value till
you achieve the expected result.
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l For instance, if you wish to capture the text from the given image (this one has a gray background):

l In absence of the threshold option, the result could possibly be:
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l However on specifying the threshold value, the result can be as accurate as possible:

5. View the Captured Text and adjust the threshold value till you achieve expected result.

6. Assign the captured text to a variable. Optionally, specify the parameters for filtering the text strings using 'Before' and 'After' and
trimming leading/trailing spaces.

l For example, in the text string "Name: ABC Inc. Location:", if you require "ABC Inc.", specify Before = "Location"
and After = "Name:".

7. Save the command to your automation TaskBot / MetaBot Logic.

Note: If you use MODI as your OCR engine, ensure that:

l Microsoft Office 2003 or later is installed on your computer.

l The sub-component "Scanning, OCR, and Indexing Service Filter" (under Microsoft Office Document Imaging) is selected during
installation for Microsoft Office 2007.

l The component is installed separately if you are using Microsoft Office 2010 and above. Click here for details.

Using Wildcards (*)

You can specify wildcards (*) in a window title.

For example, use wildcards to perform an operation in any window that contains the word "Untitled" anywhere in the title. You can
place the wildcard character before or after "Untitled" to capture variations, such as "Window 1: Untitled" or "Untitled - Text Document".

To capture all variations of "Untitled," simply specify *Untitled*.

Automation Anywhere searches for a window with a title of exactly "Untitled" first. If it does not exist, Automation Anywhere searches for
windows with the word "Untitled" anywhere in the title.

http://support.microsoft.com/kb/982760
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When you 'Enable' Secure Recording

Note: If you enable ‘Secure Recording mode’, no images are captured for preview and an error message
appears “Secure Recording Mode. Image not captured.” Learn More

Also See...

l Database Command

l Email Automation Command

l Excel Command

l PDF Integration Command

l Read from CSV-Text Command

l XML Command
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Open Program/File Command

Use this command to automatically launch a program or open a file.

You can perform the following actions in a TaskBot / MetaBot Logic by using the Open Program/File command:

l If your program requires command line parameters, you can provide these parameters in the Parameters text box.

l If required, provide the directory path for your program in the 'Start in' Path text box. Automation Anywhere will verify that this path is
valid.

l You can insert the current window title in a TaskBot / MetaBot Logic.

l You can enter variables in a file path.

Also See...

l File and Folder Commands

l Log-to-File Command

l Manage Windows Controls Command

l System Command

l Windows Actions Command
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Pause Command

Use this command to pause an automated task at a particular point when it runs.

Overview

Inserting pauses into your tasks enables you to enter or modify information before a task completes a run.

Insert a pause in your task when you need to check the status of attributes while the task is running. This is a great way to test and
debug your tasks.

When a task reaches a pause, a Resume button is displayed. When you click on the Resume button, the task continues to run again.

Using the Pause Command

To insert a Pause command, follow these steps:

1. Open the task in the Workbench.

2. In the commands list, under Task, drag a Pause command to the Task Actions List, in the location where you want to the task to
pause when running. Or, you can double-click the Pause command to insert it at the current location.

3. A Pause command is inserted in the task. You can copy this command to add multiple pauses, or move the pause to another pos-
ition in the task simply by dragging it.

Also See...

l Delay/Wait Command

l Run Task Command

l Stop Task Command
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PDF Integration Command

Overview

The Automation Anywhere PDF Integration command takes process automation to a new level. PDF files are pervasive on the web, in
email, and across all sizes and shapes of business. It's become critical to automate routine tasks that involve manipulating and upload-
ing these documents to databases, websites, and other repositories.

All sub-commands provide an option for overwriting existing output files. If you check the Overwrite check box, and the file name exists,
the file is overwritten.

Tip: It is recommended that you use variables with the command as many fields support variables.

Sub-Commands

The PDF Integration command provides the following sub-commands:

l PDF to Image

l Extract Form Fields

l Extract Text

l Merge Documents

l Split Document

l Encrypt Document

l Decrypt Document

Using the Sub-Commands

To insert a PDF Integration command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the PDF Integration commands to the Task Actions List pane. The PDF Integration window is dis-
played.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

PDF to Image Command

Use this command to create separate images for each page of a PDF file. Follow these steps:

1. Select the PDF file using the Browse button. For encrypted PDFs, provide the user or owner passwords.

Tip: For enhanced security, you can opt to insert Credential Variables
*
using the function key

'F2' for user name and password. Learn More
* Available in Enterprise edition from version 10.3

2. Specify a page range for the pages that you want converted to images.

3. Complete the Output Image Details section:

a. Type: Select an output type from the drop-down list. The following types are available: TIFF, BMP, JPG, GIF, PNG, WMF,
EMF, EXIF. For JPG output, specify a JPEG Quality.

b. Folder Path: Specify a folder in which the images will be saved.

c. Image Prefix: Specify an image name as a prefix for the image files. The files will be suffixed with index numbers.

4. Using the Advanced View section:

a. Modify the X Resolution, Y Resolution, and Color for the output images. The default resolutions are 200 dpi.

b. Select an output image type (either color or grayscale).

c. Select a color property. The default is True Color (32 bits).

d. For TIFF files, select a TIFF compression type.
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Extract Form Fields Command

Use this command to extract all form field data and selected text to variables. Follow these steps:

1. Select the PDF file and click the Add button. A PDF Viewer window is displayed, showing all of the fields as dotted red boxes.

2. Right-click and select Add Field - here a solid red box is visible.

3. The Field Form is displayed, where a variable is assigned to the field. Click OK to view the inserted fields on the right side table of
Inserted Fields.
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4. You can also select particular text to store in a variable, if required.

5. Click Save to view the inserted fields in the command. Modify them by using the Add, Edit, and Delete buttons.

6. Save the command. The inserted field values are stored in the variables when the TaskBot / MetaBot Logic is run.

Extract Text Command

Use this command to extract text from a PDF to a text file. Follow these steps:

1. Select the PDF file using the Browse button. Enter passwords for encrypted PDF files.

Tip: For enhanced security, you can opt to insert Credential Variables.

2. Select a text type:

l Plain Text: Similar to a simple copy/paste of the entire PDF file

l Structured Text: Preserves the formatting from the original PDF file

3. Specify a page range.
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4. For Export Data To Text File, specify an output file name with a .txt extension.

Merge Documents Command

Use this command to merge selected PDF documents into a single PDF file. Both encrypted and unencrypted PDFs are supported. Fol-
low these steps:

1. To select the PDF files for merging, click the Add button. For encrypted PDFs, user or owner passwords must be specified.

2. For each PDF file added, specify the Pages to Include. After all files are added, you can modify the pages to include by selecting
each PDF file.

3. Specify an output file path for the merged PDF file.

Split Document Command

Use this command to split a PDF file. Follow these steps:
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1. Select the PDF file to be split and enter user or owner passwords if the file is encrypted.

2. Specify the Output File Creation options:

l Pages Per File: Specify how many pages each new output file will contain (such as 5 pages for each split).

l Single File With Page Range: Select this option to create a single output file that contains the page numbers specified.

l Blank Page As A Separator: When selecting this option, a new output file is created whenever a blank page appears within
the PDF document.

l Bookmark Level Per File: Splits the file according to the bookmark level that the PDF contains. If 3 levels are present, the
drop-down will show Level1, Level2, and Level3 as options. Split the PDF by selecting the appropriate bookmark level.

3. Specify Output File Details:

l Folder Path: Specify a folder location in which all output files will be saved.

l File Prefix: Specify the file name, with a .pdf extension, to be used for each output file (and suffixed using index numbers).

Encrypt Document Command

Use this command to encrypt PDF documents and grant permissions to users. Follow these steps:

1. Select a PDF you want to encrypt and set user and owner passwords for the encrypted file.

2. Select one or more permissions to apply to the encrypted document for the user.

3. Select an encryption level (RC4 40-bit, RC4 128-bit, or AES 128-bit).
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4. Specify the name of the output file, with a .pdf extension.

Decrypt Document Command

Use this command to decrypt a PDF document that was previously encrypted. Follow these steps:

1. Select an encrypted PDF document to decrypt, and enter the user/owner password.

2. Specify an output file name with .pdf extension to save the decrypted PDF. The password security is removed for the decrypted file.
All permissions that existed for the encrypted file remain, without password protection. This ensures that all document restrictions
remain for security in the newly created decrypted file.

Also See...

l Database Command

l Email Automation Command
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l Excel Command

l Loop Command

l OCR Command

l Printer Settings Command

l Read from CSV-Text Command

l XML Command
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PGP Command

Use the PGP (Pretty Good Privacy) command to automatically encrypt and decrypt files for security.

Overview

The PGP command helps you to automate the process of encrypting and decrypting files.

The command supports both types of encryption: symmetric (passphrase) and asymmetric (public/private keys):

l PGP Passphrase: Requires a pass phrase to encrypt and decrypt.

l PGP Public/Private Key: Requires a PGP public and private key file to encrypt and decrypt.

Sub-Commands

l Encrypt Files

l Decrypt Files

l Create Keys

Using the Sub-Commands

To insert a PGP command in your task, follow these steps:

1. Double-click or drag one of the PGP commands to the Task Actions List pane. The PGP window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation task.

Encrypt Files Command

Use this command to encrypt one or more files using one of the encryption methods: either passphrase or public/private key.

To encrypt files, follow these steps:

1. Select the 'Passphrase' encryption type and enter a pass phrase. Alternatively, select the Public/Private Key encryption type. For
this type, locate or specify the Public Key File path. Create public key if necessary.

Note: All other options are the same for both encryption types.
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Tip: For enhanced security, you can opt to insert Credential Variables* using the function
key 'F2' for the Passphrase. Learn More
* Available in Enterprise edition from version 10.3

2. Select a symmetric algorithm. The algorithm options are:

l Idea

l TripleDES

l CAST5

l Blowfish

l AES128

l AES192

l AES256

l Twofish256

3. Locate or specify the source file path.

4. Locate or specify the destination file path.

5. Check the option for overwrite files/folder, if necessary.

6. If required, append the extension for the destination file. For example, .enc.

7. Compress the encrypted files using one of the compression algorithms:

l Zip

l Bzip2
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l Zlib

8. If required, check the Armor data (text output) option to enable ASCII Armor output.

Tip: For Source or Destination path, use '*.*' or '*.txt' to select multiple files in a folder.

Decrypt Files Command

Use this command to decrypt one or more files that have been previously encrypted. You can decrypt files that are encrypted with
either Passphrase or Public/Private Key encryption type.

To decrypt a file, follow these steps:

1. Select the Passphrase encryption type, which requires a specific pass phrase.

Alternatively, select the Public/Private Key encryption type. For this type, locate or specify the Private Key file. While using pass-
word-protected private keys, enter the password.

Tip: For enhanced security, you can opt to use Credential Variables using the function key
'F2'. Select a relevant Credential Key and its Attributes for the password.

All other options are same for both encryption types.

2. Enter the pass phrase for decryption.

3. Locate or specify a source file path for decryption.

4. Locate or specify a destination file path.
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5. If required, check the option to overwrite files/folder.

6. If required, select the Remove extension option.

Create Keys Command

Use this command to create public and private encryption keys. You can add additional security to the keys by specifying a password
that encrypts the keys.

To create new keys, follow these steps:

1. Select the Create Keys option.

2. Locate or specify a Public Key File.

3. Locate or specify a Private Key File.

4. Optionally specify a password that encrypts the key files.

Tip: For enhanced security, you can opt to use Credential Variables using the function key
'F2'. Select a relevant Credential Key and its Attributes for the password.

5. If required, select the Overwrite Files option.
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Play Sound Command

Use this command to insert and play sounds in your automated tasks.

Sub-Commands

The Play Sound command provides the following sub-commands:

l Play Beep

l Play Media File

Overview

You can insert a Play Sound command in your automated task to play a beep or another media file before/after it runs a particular com-
mand.

Using the Sub-Commands

To insert a Play Sound command in your task, follow these steps:

1. Double-click or drag one of the Play Sound commands to the Task Actions List pane. The Play Sound window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation task.

Play Beep Command

Use this command to play a beep sound when the task encounters the Play Beep command. You can use a beep sound to alert users
when particular actions take place, or to alert you when prompted for input.

Play Media File Command

Use this command to play a media file in your automation task. When the task plays the media file, it does not proceed to the next auto-
mation task command until the media file finishes playing.
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Also See...

l Clipboard Command

l Comment Command

l Error Handling Command

l Image Recognition Command

l Prompt Command

l Screen Capture Command

l String Operation Command

l Variable Operation Command
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Printer Settings Command

Use this command to automate printer settings in your task.

Overview

One of the most manually intensive activities of any IT staff involve managing printer settings for individuals and groups. Using the
Printer Settings command, you can automate many of these tasks.

Sub-Commands

The Printer command provides the following sub-commands for managing printer settings:

l Get Default Printer

l Set Default Printer

l Remove Printer

Using the Sub-Commands

To insert a Printers command in your task, follow these steps:

1. Double-click or drag one of the Printers commands to the Task Actions List pane. The Printers window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation task.

Get Default Printer Command

To get the default printer using your automated task, follow these steps:

1. Open the Workbench.

2. Double-click the Get Default Printer command.

3. Click Save.

Set Default Printer Command

To change the default printer using your automated task, follow these steps:

1. Open the Workbench.

2. Double-click the Set Default Printer command.

3. Select a printer from the list of installed printers.

4. Click Save.

Remove Printer Command

To remove a printer using your automated task, follow these steps:
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1. Open the Workbench.

2. Double-click the Remove Printer command.

3. Select a printer from the list of installed printers.

4. Click the Run Script command.

5. Click Save.

Also See...

l Active Directory Command

l System Command

l SNMP Command
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Prompt Command

Use this command to insert a user prompt that requests input from a user when running an automated task.

Overview

Some tasks that are interactive, require the user to provide inputs. The Prompt command allows you to request inputs such as inputting
values, opening a file/folder or/and choosing between yes and no whenever required while running such automated tasks.

Sub-Commands

The Prompt command provides the following sub-commands:

l Prompt for Value

l Prompt for File

l Prompt for Folder

l Prompt for Yes/No

Using the Sub-Commands

To insert a Prompt command in your task, follow these steps:

1. Double-click or drag one of the Prompt commands to the Task Actions List pane. The Prompt window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation task.

Prompt for Value Command

Use this command in tasks where the values change frequently. For example, for tasks that interact with online forms, you can ensure
that the user enters the proper values when the task runs.

Further, the value that the user enters during task playback can be assigned to a variable. The variable can be used in other places
within the task, instead of prompting again.

You can also prompt users for passwords and encrypt the keystrokes during playback by enabling the 'Encrypt Keystrokes' option. You
will not be able to assign the value to a variable though, if it is enabled.
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Prompt for File Command

Use this command to prompt the user for one or more files from a single folder. The value of the files selected can be assigned to a list
variable. You can also configure a caption for the prompt window.

Prompt for Folder Command

Use this command to prompt the user for a single folder. The value of the folder selected can be assigned to a value variable. You can
configure a caption for the prompt window.
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If Command

Use this command to prompt the user for a response (Yes or No) to a question while the task is running. The value selected during play-
back can be assigned to a value variable.

Also See...

l Message Box Command

l Variable Operation Command

l Knowing When to Use Variables
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Read from CSV/Text Command

Overview

You can use this command to automate the process of reading data from CSV and Text files and encode the files using ANSI,
UNICODE, and UTF8.

You can do the following:

l Read List Separated or Tab delimited data from a CSV file.

l Read multiple lines in CSV or text files

l Use encoding options: ANSI, UNICODE, and UTF8.

CSV

Use this option to read data using Comma, Tab or Regional List Separator delimiters from a CSV file.

Delimiter: You can select any of the following delimiter options:

1. Comma: Use this to specify comma as the delimiter.

2. Regional List Separator: Use this to specify the delimiter as defined in the Regional Settings. You can update the separator
value from Control Panel > Region > Additional Settings. E.g. Semi-colon (;) will be used as a list separator if the regional settings
are configured to German.

Note: AAE supports the default regional list separators of English, German, French, Italian
and Spanish.

3. Tab: Use this to specify the delimiter if tabs are used to separate fields in a CSV file.

Contains Header: Use this for CSV files that have the first row defined as headers.
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Text

Using this command, read data using Newline, Comma, Tab or Other delimiters from a Text file.

1. Newline: Use this when the text in the file is separated using a newline.

2. Comma: Use this when the text in the file is separated using a comma.

3. Tab: Use this when the text in the file is separated using a tab.

4. Other: Use this when the text in the file is separated using any option other than the ones provided.

Other Options

1. Trim: Use this to trim leading space(s) and/or trailing space(s) from within the CSV/Text file.

2. Session Name: Use this to identify the current session. You can opt to assign a variable as a session.

Also See...

l Database Command

l Email Automation Command

l Excel Command

l OCR Command

l PDF Integration Command

l XML Command
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REST Web Service Command

Web services are usually associated with SOAP. However, RESTWeb Services are getting more popular and thus, Automation Any-
where now supports testing of these RESTWeb Services. REST means using REpresentational State Transfer architecture, to realize
Web services. In REST the HTTP methods GET, PUT, POST and DELETE are supported.

Methods

1. GET Method

2. POST Method

3. PUT Method

4. DELETE Method

1. GET Method

The GET method means retrieve whatever information (in the form of an entity) which is identified by the Request-URI.

Follow the below steps as an example for Get Method.

i. URI: Specify the URI for the RESTWeb Service we want to connect to.

ii. Method: Select the GET Method from drop down.

Tip: Use Tab keys and the sub-tabs for Request and Parameter will be populated automatically.

iii. Request:

l URI Header: Below Keys with their Value pairs are displayed.

l HTTPS: When the HTTPS connection is used it will be True.

l Server URL: Indicates the main host or the server where the web service is being tested.

l Port No: Displays the port number used for connection to the web service.

l URL Path: Displays relative URL of the specific web service.
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Header

Each Key and Value pair for the Header is displayed if applicable. One can customize these header key-value pair using action but-
tons.

Actions

1. Add: You can add a Key and Value to a web service request. This can be useful if a recorded request has additional fields or para-
meters added to it.

Tip: The user can manually add them. The changes will then be reflected while playing of the
command.

2. Delete: User can delete a particular Key and its value by selecting it from request header. This is useful when changes to a par-
ticular key and its values are known. The changes will then be reflected while playing of the command.
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Use the Send Request button to send the request. This will automatically fill in the Response and can be saved to a variable for
ease of processing.

Tip: You can opt to insert a Credential Variable
*
using function key 'F2' for enhanced secur-

ity. Learn More

Parameter

URL: Displays the URL Parameters for the current web service request with Key and Value pairs.

1. Add: You can add a URL/Post Parameters and Value to a recorded request. This can be useful if the request has additional fields
or parameters added to it.

The user can manually add them. The changes will then be reflected in the URI when Send Request is clicked and/or playing of the
command.

2. Delete: Select a particular Parameter for Post or URL which you want to remove. Click Dif elete button. This is useful when
changes to a particular Post or URL parameter is known.
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POST Parameter: Displays the Post Parameters for the current request. Applicable when Method is POST or PUT.

Authorization: RESTWeb Service supports HTTP Basic, Windows AD and Default Network Credentials authentication types.
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Based on authentication type, add the authorization parameters such as the Domain, Username, and Password.

l To use "logged-in" Active Directory (AD) user's credentials for authentication - leave all the fields blank. Logged-in user's AD
domain will be considered for authentication purpose.

l To use a particular Active Directory user's credentials for authentication - enter Domain, Username and Password.

l To use HTTP basic authentication - leave the Domain field blank and enter Username and Password.

You can choose to assign direct values, user defined variables or credential variables for authentication fields.

Note: When you input authorization parameters ensure that the service supports that authentication
type.

Click Send Request and the Response will be filled in automatically.

Tip: The response should be stored in a variable for further processing.
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Response

The response for web service supports both XML and JSON formats.

1. Header: Displays the detail keys and values of response header for the request.

2. Body: Displays the response body for the selected request.
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This response body should be saved to an appropriate variable for testing of the RESTWeb Service, Get Method.

3. Save Response To : Select the variable from the drop down. The entire response will be saved to the selected variable.

4. Save the command and during Play Time the Response will be stored in the variable.

2. POST Method

The Post method is used as a requests that the server accepts the entity enclosed in the request as a new subordinate of the web
resource identified.

RESTWeb Service command supports three content types: application/JSON, application/XML, and default format (x-www-form-urlen-
coded).

1. Enter URI where you want to Post your response.

2. Select the POST Method.
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In the Request Header a drop down will be displayed for the content type. By default, text format is displayed.
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3. For the Parameter tab, use the Add button to Add the value and key pairs when content type is of default format.

4. Click Send Request button.

5. If the content type is JSON or XML, a multi-line text box is displayed for the POST Parameters for ease of use. See below example:
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6. In Response Header and Body, you can validate the response posted.



Copyright © 2018 Automation Anywhere, Inc. 312 https://support.automationanywhere.com

7. Save Response To: Select the variable from the drop down. The entire response body will be saved to the selected variable.

8. Save the command and during run time, the values will be posted to the URI automatically.

3. PUT Method

The PUT method is useful to update data for a particular web service URI. It can also be used to pass different URI parameters based
on the key value pair for updation. Thus a record can be updated using a key value pair using PUT method with request header.

1. Enter the URI.

2. Select the PUT Method.
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3. For the URL Parameters, modify the values as shown in the below example.

4. Click the Send Request button.
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5. You will see an HTTP/1.1 200 OK response with the updated Body Parameters.

6. Save Response to a variable and click Save.

4. DELETE Method

The DELETE method requests that the origin server deletes the resource identified by the Request-URI.

In below example we see how for a URI, passing the appropriate Parameter, and sending the Request the record gets deleted.

1. Enter URI.

2. Select the Method as Delete.
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3. Add the URL Parameter to be deleted.

4. Click on Send Request button.

5. The Response will be displayed as success and the record will be deleted successfully.

Variable Support for REST Web Service using F2

l URL Parameterization: You can use variables in Request - Header tab for values.
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l Parameter: You can use variables for Parameter tab values which includes URL Values, Post values and Authorization Values.
The following illustrates the use of POST Parameterization of a RESTWeb Service.

Note: We have used POST Parameter using Variables.

1. Click Send Request, will display the Set Variable From with values of the variables.



Copyright © 2018 Automation Anywhere, Inc. 317 https://support.automationanywhere.com

Note: In Request Header or POST Parameter, if a Credential Variable is used then on clicking
‘Send Request’ the ‘Set Variable Value’ will not list the Credential Variable. However its value
will be used to generate the output.
You are shown a message notifiying that Credential variable(s) are excluded from the list of vari-
ables.

2. Now, Click Get Output to get the Response.

Note: If your REST Web Service is using a proxy server, go to Tools > Options > Advanced Settings.

Also See

l SOAP Web Service Command
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Run Script Command

Overview

You can use this command to run various scripts from your TaskBot / MetaBot Logic.

Use a Run Script command when you want to:

l Run a VB Script (*.vbs) or JScript (*.js) in the TaskBot / MetaBot Logic.

l Pass parameters to your scripts.

l Specify the Return Value in your scripts.

Also See...

l Run Task Command

l Variable Operation Command
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Run Task Command

Overview

Using the Run Task command, you can run several small tasks from within a larger task. You can create a single task, and within the
task run other tasks, one after the other. This is called "nesting tasks".

Using this command, scheduling becomes easier. You can imbed several tasks into a single, master task, and simply schedule the
master task. This enables you to avoid having to schedule each of the smaller tasks.

Using the Run Task Command

To insert a Run Task command in your task, follow these steps:

1. Double-click or drag the Run Task command to the Task Actions List pane. The Run Task window is displayed

2. Select the task either using Browse or specify the path using a Variable

Tip: If you are using a variable for the file path, it is recommended you use only the system
variable $AAApplicationPath$. If you use a locally defined or any other system variable, the sub
task with such variables will not be uploaded to the Control Room. You will get 'Variabalized
Path' in Remarks column of the Upload Dependencies dialog box. Refer Uploading/ Downloading Tasks and
Dependencies.

l Also on using a local or invalid variable, a message is displayed:

l When you select the default option No the command will not be saved. You should select Yes to save the command. 

 Note: Run Task commands that are created in versions below 10.5.0 and has a variable
other than the $AAApplicationPath$ assigned as the path, will have to be updated and saved
accordingly.

3. Select any of the options - Repeat, Speed or Variable

l Repeat: Use the Repeat option to run the selected task multiple times. You can repeat the task a specified number of times
or for a number of hours. You can also repeat the task until you choose to stop it.
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l Speed: Use the Speed option to set the replay speed of the task. Three speeds are available: Standard (same speed as
recorded), High Speed, and Turbo Action replay (mouse moves are removed).

l Variable: Use this option to pass (associate) a variable from the master task - 'Main Task Variable' to the sub task - 'Run
Task Variable'. Use the Add and/or Delete buttons to add and/or delete the variables.

l Inserting variable(s) in 'Run Task Variable': In order to specify the mapping variables for Run Task, you can either
select a variable from the existing variables list or you can enter a new variable.

l Quick Mapping of Variables *: A 'Quick Map' ensures that a large number of variables with same nomenclature are
associated between tasks. 
* Available from version 7.5.2 onward.
Variables mapped between tasks in earlier versions (below 7.5.2), will have to be re-mapped. Also, on selection of
another task (using browse), the current mapping will be lost.
Mapping of 'Workflow Variables' is also possible in similar fashion.

Note: Quick Map is disabled if no similar variables are found.
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Note: It is possible to pass value type variables marked as Regular Expression. Refer
'Value Type Variables' to know more.

4. Click Save

Use Case Scenario

A task named T1 has a variable firstname with a value of 'John' declared. By using the Run Task command, another task, T2, is
called and firstname is passed as an argument. Now, in task T2, the firstname value is changed to 'Michael'. When the Run Task
command finishes in task T1, the variable firstname contains the value 'Michael'.

Also See...

l Run Script Command

l Stop Task Command

l Pause Command
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Screen Capture Command

Use this command to automate the process of capturing screen shots.

Overview

As part of your automation task, you can capture the entire computer screen or an active open window.

Sub-Commands

The Screen Capture command provides the following sub-commands:

l Capture Desktop

l Capture Window

l Capture Area

Using the Sub-Commands

To insert a Screen Capture command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the Screen Capture commands to the Task Actions List pane. The Screen Capture window is dis-
played.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

Capture Desktop Command

Use this command to capture the full desktop on your computer. The image is saved to a location you specify. You can capture the
image in various formats.

Capture Window Command

Use this command to capture an image of an open application window. Select the window by clicking on the name in the drop-down
list.

The image is saved to a location you specify. You can capture the image in various formats.
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Capture Area Command

Use this command to capture an area of the screen. Select the area by first selecting the application window, and then dragging the
mouse over the area that you want to capture.

The image is saved to a location you specify. You can capture the image in various formats.

Use the Overwrite File option to overwrite older existing images.

Using Wild Cards

You can specify wild cards, using the asterisk (*) symbol, when selecting window titles. For example, you might use a wild card capture
any window that contains the word "Untitled" in the title.

You might also want to capture any window that contains any text before or after the word "Untitled" in the window title. To specify this,
use *Untitled* for the window title. In this case, Automation Anywhere searches for the exact window title ("Untitled"). If it is not
found, Automation Anywhere searches for windows that contain the word "Untitled" in the title.

You can use a wild card character (*) at the beginning or at the end of a window title.

When you 'Enable' Secure Recording

If you enable ‘Secure Recording mode’, no images are captured. Learn More

If you enable ‘Secure Recording Mode’, and try to save the command, a warning message appears:
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If you wish to continue, click ‘Yes’, and the command is saved. Click ‘No’, if you wish to discontinue. You are navigated back to the
command where you can ‘Cancel’ the command.

Also See...

l Clipboard Command

l Comment Command

l Error Handling Command

l Image Recognition Command

l Play Sound Command

l String Operation Command

l Variable Operation Command
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Send Email Command

Overview

Automating email processes is one of the most powerful uses of Automation Anywhere. Sending repetitive emails can bog down the
most productive organizations.

Using the Send Email command, you can:

l Send multiple emails at once. Use a semi-colon between each email address.

l Include attachments with the email.

l Format the message in HTML.

Using the Send Email Command

To send an email from your TaskBot / MetaBot Logic, follow these steps:

1. Click on the Tools menu, and select Options. In the Email Settings, enter a Host Name and Port:

l Host: The SMTP Host allows you to send email from Automation Anywhere. You can obtain this information from your email
provider, or from the configuration settings in your email program.

l Port: This setting defines the TCP/IP port that Automation Anywhere uses to send email. (The default port is 25.)

Refer Setting Email Notifications for details

3. Double-click on or drag the Send Email command to the Task Actions List in the Workbench. The Send Email window is displayed.

4. Enter the From, To, CC, and BCC email addresses.

5. Enter a subject.

6. Attach files you want to send with the email.

l If you want to attach any file type, click the 'Attach' button.

l If you want to attach values of all variables, click the 'Variables' button*.
* Available from version 8.1 onward
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This will append a text file that lists values of all the variables (System and User Defined) used in the TaskBot / MetaBot
Logic.

Note: The System Variable Excel Cell will not be attached as the values input are
dynamic.

7. Select either Text or HTML for email format.

8. Enter the message in the message box.

9. Save the command.

Also See...

l FTP-SFTP Command

l Internet Connection Command

l Launch Website Command

l Web Recorder Command

l Web Service Command
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Services Command

Use this command to automate your Windows and application services.

Overview

You can use the Services command to start, stop, pause, resume, or get the status of any available services.

Sub-Commands

The Services command provides the following sub-commands:

l Get Service Status

l Start Service

l Stop Service

l Pause Service

l Resume Service

Using the Sub-Commands

To insert a Services command in your task, follow these steps:

1. Double-click or drag one of the Services commands to the Task Actions List pane. The Services window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation task.

Get Service Status Command

Use this command to obtain the current status of a Windows or application service. For example, the Windows Audio service status
might be "running". You can assign the status value to a variable.

Start Service Command

Use this command to start a Windows or application service when your task runs.

Stop Service Command

Use this command to stop a Windows or application service that is currently running.

Pause Service Command

Use this command to pause a Windows or application service that is currently running.
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Resume Service Command

Use this command to re-start a Windows or application service that you have previously paused using a Pause Service command.

Also See...

l Active Directory Command

l Printer Settings Command

l SNMP Command
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SNMP Command

Use this command to automate the management of your network.

Overview

Simple Network Management Protocol (SNMP) is used to locate the network management component on one or more computers and
the managed component on multiple network devices.

The Automation Anywhere SNMP command offers powerful network management. Using this command you can easily monitor net-
work devices configured with SNMP agent software. Network devices such as servers, workstations, printers, routers, bridges, and
hubs, as well as services such as Dynamic Host Configuration Protocol (DHCP) or Windows Internet Name Service (WINS) can be
monitored.

Sub-Commands

The SNMP command provides the following sub-commands:

l Get

l Get Next

l Set

l Walk

l Send Trap

Using the Sub-Commands

To insert a Services command in your task, follow these steps:

1. Double-click or drag one of the SNMP commands to the Task Actions List pane. The SNMP window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation task.

SNMP Get Command

Use this command to retrieve data from an SNMP agent.

SNMP Set Command

Use this command to modify data on an SNMP agent.
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Note: Select a 'Value Type' when providing the OID Specifications.

SNMP Get Next Command

Use this extended request command to browse the entire hierarchy of management objects.

SNMP Walk Command

Use this command to retrieve a sub-tree of management values using SNMP GET-NEXT requests.

You can specify a Walk type of All or Within.
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SNMP Trap Command

Use this command to send trap messages to the SNMP Manager from an SNMP Agent. These messages are sent by an SNMP Agent
whenever certain events occur, such as a system restart.

Note: Select any of the Trap Type given when setting the trap.
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Using the SNMP Command Views
Using the Normal View

To use the normal SNMP command view, follow these steps:

1. Select an SNMP Operations Command: Select a command (Get, Get Next, Set, Walk, or Send Trap).

2. SNMP Agent: Specify an agent and community details.

l Agent: Specify an IP Address or host name.

l Community: Specify a community string. This string is used for read-only access to a network element.

3. OID Specifications: Specify the Object Identifier, which the SNMP Manager requests (for example, Get, Set, etc.)

l Object ID: Specify the IP Address or host name.

l Data Type: Select from ASCII or Hex.

l Set value: Set value if the message type is Set.

l Walk Type: Select Walk Type of All or Within when the message type is Walk. For type Within, all variables in the sub-tree
below the given OID are queried. Using All displays the variables that are equal to the specified OID for the given tree type
structure.

l Trap type: Select a trap type from the following:

a. Cold start: Occurs when the SNMP agent initializes its configuration tables.

b. Warm start: Occurs when the SNMP agent re-initializes its configuration tables.

c. Link Down: Occurs when the state of a network adapter on the SNMP agent changes from up to down.

d. Link Up: Occurs when the state of a network adapter on SNMP agent changes from down to up.

e. Authentication Fail: Occurs when the SNMP agent receives a message from an SNMP manager with an invalid com-
munity name.

f. EGP Neighbor loss: Occurs when the SNMP agent cannot communicate with its Exterior Gateway Protocol (EGP)
peer.

g. Enterprise specific: Occurs when specific error conditions and error codes are defined in the system. The user must
provide a Trap Specific Number for this option.

4. Result:

l Log File: View the SNMP log data in the selected log file.

l Assign the value to an existing variable: Specify a variable value.

Using the Advanced View

When you click on the Advanced View button, additional SNMP options are provided. The SNMP advanced options include the fol-
lowing:

l SNMP Version: Select any of device versions - V1, V2 or V3

l Timeout(ms): Specify the response time in milliseconds for the action to wait for before generating an error.

l Remote Port: Specify the TCP/IP port to be used for the Get request. The default is 161.

l Retries: Specify the number of times to retry the message.

V3 allows you to select authentication levels to ensure a more secure environment (compared to V1 and V2). The options provided
therein are:
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l Authentication Level: Choose from 'None', 'Authentication Only' or 'Authentication with privacy'.

l Authentication Method: Select either MD5 or SHA.

Note: Applicable only if Authentication Level selected is other than 'None'. You are also
required to input a 'Password'.

l Password:Input a password for connecting to the device.

l Privacy Method:Select the either 'DES' or 'AES' as the privacy method. This privacy method ensures that your password is pro-
tected with a private key as the program encrypts the same.

Note: Available only if authentication level selected is 'Authentication with privacy'.

l Private Key:Input the private key generated when the authentication level selected is 'Authentication with privacy'.

Also See...

l Active Directory Command

l Services Command

l Printer Settings Command
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Stop Task Command

Use this command to stop an automation task from running.

Overview

You can stop an automation task at any point by inserting a Stop Task command in the Task Actions. For example, you can stop the
task if a specific condition is met, such as when encountering a file larger than 100 MB.

Using the Stop Task Command

To insert a Prompt command in your task, follow these steps:

1. Open the task in the Workbench.

2. Double-click or drag the Stop Task command to the Task Actions List pane.

3. To change the location of the Stop Task command, simply cut/paste it or drag it to another location within the automation task.

Automation Anywhere inserts the Stop Task command above the currently selected line in the Task Actions List.

Also See...

l Run Task Command

l Run Script Command
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String Operation Command

Use this command to manipulate a text string or extract part of a string and store it in a variable.

Overview

String operations are very useful when automating business processes. For example, you might want to extract a portion of a text block
from an email, a website, or an application window.

You can also manipulate strings after capturing them. You might search the string for particular phrases, compare two strings, convert a
string to upper or lowercase, or obtain the length of a string.

Sub-Commands

The String Operation command provides the following sub-commands:

l Before/After

l Compare

l Find

l Join

l Length

l Lower Case

l Replace

l Reverse

l Split

l Sub-String

l Trim

l Upper Case

Using the Sub-Commands

To insert a String Operation command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the String Operation commands to the Task Actions List pane. The String Operation window is dis-
played.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

Before/After Command

Use this command to specify a range of text to extract, using Before and After keywords.

You can insert 'Enter' and 'Tab' variables by using the F2 function key. These variables act as separators for your string between the
Before and After keywords.

To refine your 'Before-After' string command, you can use the 'OR' or 'AND' Logical Operators.

l Use the 'AND' operator to ensure 'Before' and the 'After' conditions are met.

n For instance, when you input a string in 'Before' and if not found, the search will be aborted. The program will not search the
string input in 'After'.

l Use the 'OR' operator to ensure either 'Before' or 'After' condition is met.

n For instance, when you input a string in 'Before' and if not found, the program will continue to search for the string input in
'After'.

Note: The default Logical Operator is 'OR'
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Example: In the text string, 'Name of Applicant James Smith Applicant Location,' let's copy only 'James Smith'. We specify Before =
'Applicant' with an Occurrence of 1. We also specify After = 'Applicant' with an Occurrence of 1. This is the first occurrence after the
Before keyword, although it is the second occurrence from the beginning of the string.

You can also specify the number of characters to be extracted, starting from the first character after the Before keyword. The extracted
string can be trimmed to remove leading or trailing spaces, and you can save the string to a variable.

Tip:

l When using the Before/After command, enter a space as a separator between strings using the SPACE BAR key on the keyboard.

l In some cases, content extracted from websites are separated by an Enter symbol (a small square), which you can see in the CSV
file.

Compare Command

Use this command to compare strings by specifying the strings. You can refine your search by selecting the 'Match Case' option. A
value of True or False is returned. You can assign the values that are returned to a variable.
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Find Command

Use this command to locate a sub-string that exists within the source string by specifying the Start parameter.

If the specified string is a regular expression, select the check box that is provided. Insert the regular expression in the Find String field.
Also, refine your search parameters by specifying the character number in 'Start From', selecting 'Match Case' and/or Regular Expres-
sion.

For example, to find all email addresses in the source, specify the following as a regular expression: \b[A-Z0-9._%-]+@[A-Z0-
9.-]+\.[A-Z]{2,4}\b

Join Command

Use this command to join all separate elements of list variables by defining the source string and a delimiter.

Length Command

Use this command to obtain the length of a string by specifying the source string.
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Lower Case Command

Use this command to convert a source string to lower case .

Replace Command

Use this command to replace a portion of a source string with a specified replacement string. Optionally specify the character position
from which to begin in 'Start' and the number of times it is to be replaced in 'Count'. If the Find String field contains a regular expression,
select the Regular Expression check box.

Reverse Command

Use this command to reverse a specified source string.
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Split Command

Use this command to split a source string. Specify a 'Delimiter' and optionally number of delimiters to be considered in 'Limit'. Refine
the scope by selecting 'Match Case'. The resulting elements are stored in a list variable.

Sub String Command

Use this command to retrieve a sub-string. Specify the source string and parameters such as 'Start From' and optionally 'Length'.

Trim Command

Use this command to trim blanks and spaces from a specified source string.
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Upper Case Command

Use this command to convert a source string to upper case.

Also See...

l Variable Operation Command
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System Command

Use this command to automate repetitive tasks pertaining to your computer system.

Overview

Certain repetitive and routine tasks pertaining to your computer system can be automated to save on time and consequently be con-
serve energy. This topic describes how to use such commands in Automation Anywhere.

Sub-Commands

l Lock the computer

l Log off

l Shutdown the computer

l Restart the computer

Using the Sub-Commands

To insert a System command in your task, follow these steps:

1. Double-click or drag one of the System commands to the Task Actions List pane. The System window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation task.

Lock the Computer Command

Use this command to automatically lock the computer. This command is commonly used at the end of a task, to ensure security if no
one is at the system.

Logoff Command

Use this command to automatically log off the computer. This command is commonly used at the end of a task, to ensure security if no
one is at the system.

Shutdown Command

Use this command to turn off your computer, for example, at the end of the workday.

l The Shutdown command provides the added benefit of energy savings.

l To increase environmental awareness, Automation Anywhere highlights energy-saving actions with a green leaf icon, as shown in
the System window next to the Shutdown command.

Note: The Shutdown command should only be inserted at the end of an automation task. Otherwise,
other commands in the task cannot be run.

Restart Command

Use this command to automatically restart the computer.
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Note: The Restart command should only be inserted at the end of an automation task. Otherwise, other
commands in the task cannot be run.

Also See...

l File and Folder Commands

l Log-to-File Command

l Manage Windows Controls Command

l Open Program/File Command

l Windows Actions Command
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Terminal Emulator Command

Use the Terminal Emulator (TE) command to access and control default, DOS-based actions of remote terminals

Overview

Access and control default, DOS-based actions of remote terminals with Terminal Emulator command. Issue DOS commands - dir,
ipconfig, copy, and recover etc. Also, transfer the exact state of an application between TaskBot / MetaBot Logics to optimize your
automation logic.

Sub-Commands

The Terminal Emulator command provides the following sub-commands:

l Connect

l Disconnect

l Send Text

l Get Text

l Set Field

l Get Field

l Get All Fields

l Wait

l Control

Using the Sub-Commands

To insert a Terminal Emulator command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the Terminal Emulator commands to the Task Actions List pane.

2. Specify required parameters in the fields - Session Name, Host Name, Port, Terminal Type and Terminal Prompt.

Tip: For enhanced security, you can opt to insert Credential Variables in 'Host Name'. Learn
More

3. Click Save.

Connect Command

Use this command to remotely connect to a terminal. Specify the connection details of the terminal. You can connect to the following
types of terminals:

l ANSI

l VT100

l TN3270

l TN5250

Note: The default terminal selected is ANSI.
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Share Session*

Enable the 'Share Session' option to optimize your automation logic. With it you can trim your bulky TaskBot / MetaBot
Logics as it provides the required flexibility to transfer the "exact state of the application to another TaskBot / MetaBot
Logic". You can use the Run Task command to achieve this.

Note: Only Terminal Emulator command session state can be shared between TaskBot /
MetaBot Logics. The existing state is passed on to all Terminal Emulator sub-commands in
the subsequent TaskBot (sub-tasks)/ MetaBot Logics.

Reference Share Session between Tasks to understand how this option helps you achieve more.

TN Terminal - Options

Enabling Secure Connection

Enabling/Selecting 'SSL' ensures a secure connection for the Terminal Types 'TN3270' and 'TN5250'; the default 'Port'
for the same being '992'.

l Terminal Type TN3270: Selecting 'Enable TN3270 Support' allows you to choose a 'Connection Method', which
could be either 'Generic' or 'Specific'. You can hence:

a. Input the 'Device Name' when you select a 'Generic' connection method.

b. Input the 'Device Name' and 'Resource (LU) Name' when you select a 'Specific' connection method.

Note: On enabling TN5250 Support, only the 'Device Name' and 'Resource (LU)
Name' can be input.

You can also select a Terminal Model and Code Page for Terminal Types TN3270 and TN5250.

l The Terminal Model option enables you to connect to various Terminal Workstations and Displays such as IBM
3477, IBM 3278 and more as listed in the Command UI.

l The Code Page enables you to set the encoding type such as German 273, Iceland 871 etc. for the Terminal.
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Advanced View

Advanced view is available on selection of terminal types ANSI and VT100. Specify either of the three protocols viz. Tel-
net, SSH1, and SSH2 .

Note: The default connection type is Telnet.

For SSH1 and SSH2, provide an authentication type to connect to the terminal.

Authentication modes available:

l User Authentication: Specify a user name and password.

l Key file Authentication: Select a location for the key file.*

* Only SSH.COM file format supported.

Note: If using SSH2 connection type, it is mandatory to input 'User Name'. Here,
you can opt to insert a Credential Variable for User Name and Password fields.
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Disconnect Command

Use this command to disconnect from an existing terminal connection.

Send Text Command

Use this command to specify text and send that text to the terminal. You can also send encrypted text by selecting the Encrypt Text
check box.

To send a key after sending the encrypted text, select the required key from the drop-down list.
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Get Text Command

Use this command to receive text from the terminal. You can select from the following options:

l Last Line

l All Lines

l Line From-To

l Lines With Column Range
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Set Field

Use this command to set field either by Index or Name for the terminal types TN3270 and TN5250. Setting data through field for such
type of terminals enhances automation for them.

Get Field

Use this command to get a field value by Index or Name and assign it to a variable for the terminal types TN3270 and TN5250.
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Get All Fields

Use this command to get value of all fields and assign them to array variables for the terminal types TN3270 and TN5250.

Wait Command

Use this command to insert a Wait command. Inserting a Wait command helps you to automate and trigger another action in your auto-
mated TaskBot / MetaBot Logic based on the terminal status.

The following options are provided:
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l Wait till text appears

l Wait till text disappears

l Wait till cursor moves to position

l Wait till cursor moves out of position

l Wait till screen gets blank

l Wait till screen contain text

l Wait till terminal prompt appears

l Wait till terminal Ready State

Control Command

Use this command to control how the terminal is viewed.

The following options are provided:

l Show Terminal

l Hide Terminal

l Clear Terminal

l Set Cursor Position

Also See...

l Database Command

l Email Automation Command

l Excel Command

l OCR Command

l PDF Integration Command

l Read from CSV and Text Files Command

l XML Command
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Share Session Between TaskBot / MetaBot Logics

Imagine having to run hundreds of tasks concurrently, which use commands that are repetitive. For instance, having to connect to the
same application, time and again, from different tasks can be cumbersome. An option that gives you the freedom to achieve this using
a single task would help you optimize your automation logic to a greater extent, in the long run.

The 'Share Session' option is designed to achieve this, precisely. You can use the option 'Share Session' in Terminal Emulator com-
mand when you want to pass on the exact state of the application to the concurrently occurring TaskBot / MetaBot Logics and back.

How to 'Share Session'?

You can create a hierarchy of TaskBot / MetaBot Logics connected by a common thread - 'Share Session':

l Simply create a 'Main Task' that would connect you to the application with 'Share Session' option enabled/selected, using the Run
Task command

l Call in other 'Sub Tasks' that obtain the necessary data/information.

In fact, you do not disconnect from the application (terminal in this case) in the Sub Tasks; you simply pass on the exact state of the
application from Main Task to the Sub Tasks and back. This will ensure,

l Your bulky TaskBot / MetaBot Logics are trimmed off of repetitive commands for connecting and disconnecting.

l Which in turn results in you achieving the same results, faster.

Example: Share session to access and fetch data from applications installed on a mainframe terminal

Here, we cite a hypothetical example to guide you through the workings of 'Share Session':

The assumption is that you have access to a mainframe terminal with various applications installed. Usually you would access each
application using separate sessions to connect to the terminal. Hence, each TaskBot / MetaBot Logic comprises of repetitive com-
mands such as connect and disconnect (to clear the earlier data session).

Now that you are armed with the powerful option 'Share Session' you can literally share your existing session state between TaskBot /
MetaBot Logics.

Ideally you could create a Main Task - TE_Share_Main for instance, that calls the other Sub Tasks - TE_BMIS and TE_CMIS. These
Sub Tasks obtain required data/information from various applications.

1. In the Main Task - TE_Share_Main, connect to the mainframe terminal using the 'Connect' sub-command in Terminal Emulator.
Enable 'Share Session'.
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2. Include a 'Run Task' command to call in the first Sub Task - TE_BMIS. Ensure that this task has used some set of sub-commands
such as 'Send Text' and 'Set Fields'.

Note: Since share session is enabled, the application BMIS starts in the same terminal that is
connected in the Main Task - TE_Share_Main.

3. Use the 'Get Text' and 'Get Field' command to obtain the required information.
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4. To restore the original terminal state, use the 'Send Text' command.

5. The Sub Task ends here and the control is passed on to the Main Task.
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l For the next Sub Task, TE_CMIS, use similar steps - Connect with 'Share Session' option, then use 'Send Text' and 'Set Field' sets
of sub-commands and acquire information using 'Get Text' and 'Get Field' set of sub-commands. Use the 'Send Text' command to
return to Main Task and restore the terminal to it's original state.

6. Create as many Sub Tasks as required and return to the Main Task using Share Session!

7. End the session in the Main Task by adding a 'Disconnect' sub-command.
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Variable Operation Command

Use this command to assign variables to a TaskBot / MetaBot Logic.

Overview

The Variable Operation command has been designed for allowing you to assign or reinitialize user specified variables (user variables)

The type and source of variables used dictate the assignment and reinitializing. These are applicable during TaskBot / MetaBot Logic
execution thus allowing the user to reuse the user variables.

Using the Variable Operation Command

To use the Variable Operation command, follow these steps:

1. Select either User Variables or System Variables.

l For User Variables:

a. Select a user variable to specify a value to an existing user variable that you have defined.

Note: You can specify values in English, German, French, Italian or Spanish as these
regional settings are supported.

b. Assign a value. You can assign a value to the variable. The right side of the 'equal to' operator can be a regular operation;
for example, you can specify: $var1$ = ($var2$ + $var5$ - 10) / 5.

Tip: The operators (, ), /, *, + and - are supported. The left and right parentheses take
precedence, and the operation within them is evaluated from left to right.

Example: In the expression ($Var1$ + 5) * ($Var2$ -10), the first calculation ($Var1$ + 5) will be evaluated
first, then ($Var2$ -10), and the result of both will be multiplied and assigned to the variable specified on the left side
of the equals sign.

l For System Variables: This option enables you to reset one of the following system variables:

a. Error Description

b. Error Line Number

c. Email From

d. Email To
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e. Email Cc

f. Email Subject

g. Email Message

Also See...

l Using the Variable Manager

l Using Variables

l User (Local) Variables

l System Variables

l Comment Command

l Error Handling Command

l Image Recognition Command

l Play Sound Command

l Screen Capture Command

l String Operation Command
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Web Recorder Command

Use this command to edit and enhance an automation task that you build using the Web Recorder.

Overview

The Web Recorder helps you to automate Internet-related task actions. Using the Web Recorder command, you can record tasks to
extract data from the web, download data, test web sites, extract source code, and more.

Sub-Commands

The Web Recorder command provides the following sub-commands:

l Open and close websites in browser sessions

l Manage web controls

l Download data

l Extract additional data from the web

l Test websites and locate broken links

l Navigate URLs

l Extract Website source code

l Search by captions

l Navigate back

l Execute a Java Script

Using the Sub-Commands

To insert a Web Recorder command in your task, follow these steps:

1. Double-click or drag one of the Web Recorder commands to the Task Actions List pane. The Web Recorder window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation task.

For more information on using the specific sub-commands, see Editing a Web-only Task with Web Recorder Commands.
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Note: It is recommended that you first search in the following sequence: By Caption, By Attributes
and By Index.

When you 'Enable' Secure Recording

If you enable ‘Secure Recording mode’: no values, caption, default texts are captured. Also, no values are captured for ‘Extract Data’
and ‘Extract Multiple Data.’ Learn More

Also See...

l Editing a Task with Web Recorder Command

l FTP-SFTP Command

l Internet Connection Command

l Launch Website Command

l Send Email Command

l Web Service Command
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SOAP Web Service Command

Use the SOAP Web Service command to implement SOA (Service Oriented Architecture) over the internet, so that multiple clients can
consume web services through the Web, irrespective of the type of applications or platforms.

Overview

The Web Service command is used to access and exchange information over the internet. By using this command, you can:

l Consume reusable application components as services. Examples are currency conversion, weather reports, and language trans-
lation.

l Connect to different existing applications and different platforms, irrespective of any underlying infrastructure requirements.

The Automation Anywhere Web Service establishes complete inter-polarity between clients/applications and the Web, supporting
XML-based open standards, such as WSDL (Web Services Description Language), SOAP (Simple Object Access Protocol), and UDDI
(Universal Description Discovery and Integration).

Using the Web Service Command

Follow these steps to create a new Web service:

1. Open the TaskBot / MetaBot Logic in the Workbench.

2. Double-click on or drag the Web Service command to the Task Actions List.

3. Enter complete URI: Enter a complete URI (Uniform Resource Identifier) that you want to use for the Web Service.

4. Authentication Details: If you need to use secure Web Services, enter the authentication details, including user name, password,
domain name, and client certificate.
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Tip: You can opt to use Credential Variables* using function key 'F2' in Username and Password
fields for enhanced security. Learn More
*Available in Enterprise edition from version 10.3

5. Enter Header Parameter(s):*To automate a Web Service using 2 stage authentication, specify the http header parameter. Assign a
variable (local or credential) to the parameter to support dynamic correlation of different web services. i.e. allowing the token
assigned to a variable from header of one service to be passed to the header of another. Also, update or delete existing para-
meters.
* Available from version 8.1 onward

6. Build Web Service URI: Optionally, to build a customized WSDL URI, click the Build URI button. In the Build Web Service URI win-
dow, specify input for services, operations, and parameters.

l Select Service, Operations and Parameter Details:Once the connection is established, Services and Operations fields will
be auto-populated. If the selected Operation has parameters, the parameters will be populated in the table with its Name,
Type and Value.

You can Add, Update or Delete the parameters for a particular operation.

l Raw Data Parameter(s):Enable this option to specify the input in XML format.
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7. Test Output: Test the output data by clicking the Test Output button. You can test the output data from the specified URI.

8. Provide Output details: Specify the file to which you want to save the output data.
The output can be extracted as a whole output or as a partially extracted value. To aid this below two options are provided.



Copyright © 2018 Automation Anywhere, Inc. 362 https://support.automationanywhere.com

a. Whole Response: When this options is selected the whole response is captured and can be stored in the selected variable.

b. Selected Response: When this option is selected, only the partial response can be captured from the web service in the
form of XPath and this value can then be stored to a variable.

l Select/View Response: To open an XML Viewer click on this link. Select the appropriate node from the response
body and the XML Path will be automatically created. Store this output into a variable, which can now be passed into
the header parameter of another request. This is particularly useful for correlating two Web Services.

Also See...

l Using Advanced Settings

l FTP-SFTP Command

l Internet Connection Command

l Launch Website Command

l Send Email Command

l Web Recorder Command
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Windows Actions Command

Use this command to automate a Windows-based action, such as minimizing, maximizing, or closing an application window.

Activate Window

Use this command when you need to activate an application that is already running. Specify the window to be activated from the
'Select Window' drop-down.

Tip: Click Refresh to invoke the application you require if unavailable, yet running.

Close Window

Use this command to close an active window when running a TaskBot / MetaBot Logic.

Maximize Window

Use this command to maximize an active window when running a TaskBot / MetaBot Logic.

Minimize Window

Use this command to minimize an active window when running a TaskBot / MetaBot Logic.

Re-size Window

Use this command to re-size an active window when running a TaskBot / MetaBot Logic. Click the 'Capture' button to specify the dimen-
sions to which the window is to be re-sized.
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Get Active Window Title

Use this command to assign the active window title to a variable when running a TaskBot / MetaBot Logic.

Common Errors

You may encounter the following error while using the Window Actions Command > Activate Window:

Cannot Find Window or Application titled <window title> that was open during recording.

Possible Reason(s)

The Window/Application that was open when recording the TaskBot / MetaBot Logic, could be closed.
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The Window/Application does not exist anymore.

Possible Solution(s)

Launch/Open Window/Application and run the TaskBot / MetaBot Logic.

Check whether the Window/Application exists or not in it's destination folder/path.

Also See...

l File and Folder Commands

l Log-to-File Command

l Manage Windows Controls Command

l Open Program/File Command

l System Command
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XML Command

Use this command to process XML information that is generated from web services and cloud computing applications.

Overview

The XML command supports sessions, node editing, and Xpath expression execution, based on a tree structure of an XML document.
The command enables the automated TaskBot / MetaBot Logic to navigate the tree and make selections based on various criteria.

The XML command enables you to capture data that has XML formatting and saves it to a specified location.

Sub-Commands

The XML command provides the following sub-commands:

l Start XML Session

l End XML Session

l Insert Node

l Delete Node/Attribute

l Update Nodes

l Validate XML Document

l Get Node(s)

l Save Session Data

l Execute XPath Function

Using the Sub-Commands

To insert an XML command in your TaskBot / MetaBot Logic, follow these steps:

1. Double-click or drag one of the XML commands to the Task Actions List pane. The XML window is displayed.

2. Specify the required parameters in the fields.

3. Click Save to save the command to your automation TaskBot / MetaBot Logic.

Start XML Session Command

Use this command to specify the session name and data source (a file or text).
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End XML Session Command

Use this command to complement the Start XML Session command and close an open XML session.
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Insert Node Command

Use this command to insert a node with attributes and name spaces you specify. The location of the node is based on the position of
the XPath expression.

Delete Node/Attribute Command

Use this command to delete a node or attribute from the XML file, as a result of specifying the XPath value.

Update Nodes Command

Use this command to update nodes in a session at the position that is specified for the XPath expression.
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Validate XML Document Command

Use this command to validate session data using XML schema files (.xsd) or internal Document Type Definitions (DTDs). You can also
validate whether the session data is well-formed.

You can store the output of the validation step (VALID/INVALID) in a variable. If an error occurs during validation, it is stored in the sys-
tem variables named: $Error Line Number$ and $Error Description$.

Get Node(s) Command

Use these commands to retrieve the values of nodes or attributes in the session data.
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l Get Single Node: Retrieves the value of a single node or attribute from the session data, at the position specified in the XPath
expression. The value is assigned to a variable.

l Get Multiple Nodes: Retrieves values from multiple nodes in the session data, using Text value/XPath expression/Specified attrib-
ute name, based on the specified XPath expression.

The value is assigned to a system variable named $XML Data Node (Node name)$, which you can use in conjunction with a LOOP
command. For example, you can insert a loop to search each node in an XML data set.

Save Session Data Command

Use this command to save the session data to a variable. You can also save it to a location you specify.

Execute XPath Function Command

Use this command to execute an XPath function and store the results in a variable.
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Also See...

l Database Command

l Email Automation Command

l Excel Command

l Loop Command

l OCR Command

l PDF Integration Command

l Read from CSV-Text Command
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Section: Using Variables in Enterprise Client
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Knowing When to Use Variables

This topic explains when you might want to use variables in your automation tasks.

As you build automation tasks, the scripts that are generated can lend themselves to using variables to track or modify the value of a
field or data point. For example, if you want to loop through a set of data in a CSV file, you can use a variable to copy the first row, paste
it to another application, move to the second row, and so on.

All actions that you take in a task can support the use of variables. These actions can include:

l Selecting windows

l Opening programs

l Working with files, folders, keystrokes, spreadsheets, loops, and more.

Two special cases of using variables include:

l Passing a variable between Running Tasks

l Using variables with IF/Else and LOOP commands

Also See...

l Understanding the Types of Variables

l Using the Variable Manager

l Creating a New Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from a Text File

l Watching Variables
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Passing a Variable between Running Tasks

You can pass an individual variable value from one task to another by using this option. The value of the variable in the first running
task becomes the input for the variable in a second task. This feature is important when tasks are run in nested manner.

Tip: The same type of variable should be defined in both tasks.

To pass a variable between running tasks, follow these steps:

1. Select the Run Task command and select the Variable option.

2. In the "Create variable association" field, select the variable from list in Main Task that has to be passed on to the consequent 'Run
Task' variable.

Also See...

l Using Variables with IF-Else and LOOP Commands
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Using Variables with IF-Else and LOOP Commands

The IF/Else and LOOP commands enable you to use variables, allowing you to run a loop until a particular condition is met for the vari-
able.

Using IF/Else Commands with Variables

While inserting an If/Else condition, select a variable you want to use (see example).

Using Loop Commands with Variables

While inserting a Loop condition, select a variable you want to use within the loop until the condition is met (see example).

Also See...

l Passing a Variable between Running Tasks
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Types of Variables

This topic describes the types of variables you can define and use when building automated tasks.

Essentially three variable types exist in Automation Anywhere tasks: User (local) Variables, System Variables and Credential Vari-
ables.

For all Automation Anywhere commands, variables are supported in fields that have the light bulb symbol present.

Use F2 function key and the list of variables will appear for selection.

User (Local) Variables

User variables are typically defined by an automation user, and used for a particular task or set of tasks. The purpose of a user variable
can range from simply holding a single value to holding multiple values, as would be used in an Excel spreadsheet.

For new automation tasks, two variables are pre-defined for your use:

l my-list-variable (type: List)

l Prompt-Assignment (type: Value)

After you create a user (local) variable, you can reinitialize it or assign it when a task runs.

System Variables

System variables are pre-defined variables that are provided by Automation Anywhere. System variables are available for use in all
automation tasks.

Credential Variables

Available in Enterprise edition only from version 10.2.1

Credential Variables are a special category of variables that can be used by the BotCreator - a Client user who creates tasks, in Com-
mands that require credential input.

Note: Credential variables can be used optionally in select commands only.

These credentials are defined by the Control Room administrator in the form of 'Credential Keys' that comprise a set of 'Attribute Val-
ues' and are securely stored in a centralized location - the Credential Vault.
Learn More

Unlike User and System variables, you cannot view 'Credential' variables in the Variable Manager. They are visible in the Insert Vari-
able window while creating a task with commands that support Credential Variables. Refer list of Commands that support Credential
variables in Assigning Credential Variables.

Also See...

l Using the Variable Manager

l Creating a New Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from a Text File

l Watching Variables

l Assigning Credential Variables

https://support.automationanywhere.com/entries/99222048
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User defined variables

Automation Anywhere allows you to create variables according to your automation requirement. These fall in two categories:

1. Analytics Variables are those variables that are defined by the Bot Creator to collect data for analysis. Such variables are marked
for Analytics while creating variables. These are displayed in the Variable Manager for the respective TaskBots under Analytics
Variables.

2. Local Variables are those variables that are defined by the Bot Creator for a particular task. These are displayed in the Variable
Manager for the respective TaskBots and MetaBot Logic under Local Variables.

Each user variable has a source . This source varies from direct assignment to reading values from files, such as text files, Excel or
CSV files, or a database.

Types of user defined variables:

l Value - Holds a single value.

l List - Holds multiple values in a single dimension (1 X n).

l Array - Holds multiple values in two dimensions (n X n).

l Random - Holds a string or numeric value that is determined by the system while running the task.

Note: Analytics and Local Variables can be created only if you have Bot creation privileges.

Also See...

l Using the Variable Manager

l Creating a New User Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables
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Value Type Variables

When/Why To Use a Value Type Variable

You can use a value type variable when you need to hold a single data point and use it in multiple places. This "placeholder" value
can represent either text or numeric data.

After you create the variable, you can use it by inserting the variable in several of the Workbench commands. When the value of the
variable is modified, this value is reflected in any subsequent commands that are run by the TaskBot/MetaBot Logic.

You can mark a value type variable as:

1. Log to Analytics - to upload data to Bot Insight dashboard for data analysis. By default, this is enabled.

Note: If your automation are migrated from an earlier version to Enterprise Client 11, you can
select the option manually by editing the variable. Such variables will not be selected for ana-
lysis by default.

2. Regular Expression - to use the variable in automation that require pattern based searches in files, folders and window title com-
mands.

Note:

l You can input only the first line of text in the 'Value' text box.

l Regular Expression in variables can be used in commands that support wild-cards. For
instance, you can use regular expressions in certain sub-commands of Files/Folders; namely
Copy, Delete, Zip and Print Multiple Files/Folders.

For a list of commands that support variables with regular expression, refer the section 'Commands that support Regular Expression'.

How to Create a Value Type Variable

You can create value type variables in two ways: using direct assignment or using a file.

Direct Assignment

Create a value type variable using direct assignment. This is used when values are generally known and needs to be retrieved repet-
itively for different commands in the task. This makes the task flexible and easy to use.

To create a value type variable using direct assignment, follow these steps:

1. In the Workbench, click on the Variable Manager icon at the top or on the tab on the right side.

2. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.

3. Select type "Value". Generally, this is the default selection.

4. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.

5. Select the "Value" radio button. This is the default.

6. Specify an initial value. This value can be character or numeric.

7. Click Save.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
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Examples of Value Type Variables:

l Name: ValueDB, Value: Oracle

l Name: email, Value: contact@automationanywhere.com
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l Name: Pathname, Value: C:\Automationanywhere\

l Name: RegExDt, Value: ^(19|20)\d\d[- /.](0[1-9]|1[012])[- /.](0[1-9]|[12][0-9]|3[01])$

Common examples of names you can use for value type variables include:

Pathname, CounterValue, DatabaseName, email, etc.

File Assignment

Create a value type variable using file assignment when the value of the variable needs to be retrieved from a text file while a task is
running.

Your task can read the file and change the value of the variable, reassigning the value at each data point in the file.

To create a value type variable using file assignment, follow these steps:

1. Determine the text file you will use for assigning values. In the text file, ensure that the variable name exists, followed by an '=' oper-
ator. This ensures correct assignment of values. Example: Variable Name: Website Text file content: website = auto-
mationanywhere.com

2. In the Workbench, click on the Variable Manager icon at the top or on the tab on the right side.

3. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.

4. Select type "Value". Generally, this is the default selection.

5. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.

6. Select the "Read from text file" radio button.
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7. In the Select File field, browse to the file or type the file path for the required text file. Use the Open File button to view the selected
text file.

8. Click Save.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.

Commands that support regular expression

l Delay/Wait

l File/Folder

l Image Recognition

l Insert Keystrokes

l Insert Mouse Click

l Manage Window Controls

l OCR

l Screen Capture

l Window Actions

Also See...

l List Type Variables

l Array Type Variables

l Random Variables

l Pre-defined variables
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List Type Variables

When/Why To Use a List Type Variable

You can use a list type variable when you need to retrieve multiple values, one by one. It is basically one dimensional placeholder for
data. 
Common uses of list variables include:

l Sending email to multiple recipients

l Passing different values inside of a loop

l Searching multiple web addresses

The values can represent either text or numeric data.

After you create the variable, you can use it by inserting the variable in several of the Workbench commands. When the value of the
variable is modified, this value is reflected in any subsequent commands that are run by the task.

How to Create a List Type Variable

You can create list type variables in two ways: using direct assignment or using file assignment.

Direct Assignment

Create a list type variable using direct assignment when the values of the variable are fixed and need to be retrieved one-by-one as
the task runs.

To create a list type variable using direct assignment, follow these steps:

1. In the Workbench, click on the Variable Manager icon at the top or on the tab on the right side.

2. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.

3. Select type "List".

4. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.

5. Select the "Value" radio button. This is the default.

6. Specify list values in the field provided. The values can be character or numeric.

7. Click the "Add to List" button.

8. Repeat steps 5 and 6 to complete the list.

9. Click Save.

You can use the "Make Random" checkbox to call the values randomly when the task runs.

If you leave the option unchecked, the values will be retrieved in the order you have entered them.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.

Example of List Type Variable:

Name:Email Address

Values: products@automationanywhere.com, support@automationanywhere.com, john.smith@automationanywhere.com
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File Assignment

Create a list type variable using file assignment when the values for the variable need to be retrieved from a text file while a task is run-
ning.

The text file is used to define the list variable. Loop commands make it easy to process the list of values.

Common Use Case: Extract data to a text file

To create a list type variable using file assignment, follow these steps:

1. Determine the text file you will use for assigning values.

In the text file, ensure that the variable name exists, followed by an '=' operator, and a list of comma-separated values.

Example text file with list of values: Variable Name: products

The products.txt file contains:

products = automation, testing, PI, SAP-automation, ERP-automation

2. In the Workbench, click on the Variable Manager icon at the top or on the tab on the right side.

3. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.

4. Select type "List".

5. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.

6. Select the "Read from text file" radio button.

7. In the Select File field, browse to the file or type the file path for the required text file. Use the Open File button to view the selected
text file.

8. Click Save.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
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Also See...

l Value Type Variables

l Array Type Variables

l Random Variables

l Pre-Defined User Variables
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Array Type Variables

When/Why To Use an Array Type Variable

An array variable is a two-dimensional variable that holds multiple values in a table of rows and columns. Arrays are very powerful for
creating staging areas for data that need to be retrieved by your process as it runs.

Common uses of array variables include:

l Extracting data from web pages

l Extracting many rows of data from an Excel spreadsheet or a database

l Read or write data from/to a legacy system, an ERP system, or another application

l Filling out order forms with different fields from Excel to Database

The values can represent either text or numeric data.

After you create the variable, you can use it by inserting the variable in several of the Workbench commands.

Tip: Loop command makes it very easy to process arrays variables. Refer How to Use Array Type Variable in
Loop Command for details on how.

When the value of the variable is modified, this value is reflected in any subsequent commands that are run by the task.

How to Create an Array Type Variable

You can create an array type variable in four ways:

ll Using direct assignment

l Using a text file

l Using an Excel or CSV file

l Using a database

Direct Assignment

Create an array type variable using direct assignment when you want the values of the variable to be defined directly to the variable.

To create an array type variable using direct assignment, follow these steps:

1. In the Workbench, click on the Variable Manager tab on the right side.

2. Click on the Add button. The 'Add Variable' window is displayed, with the 'Create New Variable' option selected.
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3. Select type 'Array'.

4. Enter a name for the variable. The name must begin with an alphabet and should not contain spaces.

5. Select how you want the array to be created. Default selection is 'Value' which indicates that you will define the values of this vari-
able directly in it.

6. Specify the number of rows and columns in the field provided. Default values are 1 X 1.

7. Click the Initialize Values button. The Array Value Details window is displayed based on the rows and columns provided in step 6.

8. Enter the values for each cell.

9. Click the Save button to save the values.

10. Click the Save button again to save the array variable.

You can modify the array dimensions using the Add Row, Add Column, Delete Row, and Delete Column buttons.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.

Text File Assignment

Create an array type variable using text file assignment when you want to read values from a specified text file into the array variable
while the task is running. The text file is used to define the array variable.

To create an array type variable using text file assignment, follow these steps:

1. Determine the text file that you will use for assigning values.

l For Rows enter the data in a new line.

l For Columns use comma separated values.
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l Example: sports_team.txt

2. In the Workbench, click on the Variable Manager tab on the right side.

3. Click on the Add button. The 'Add Variable' window is displayed, with the 'Create New Variable' option selected.

4. Select type 'Array'.

5. Enter a name for the variable. The name must begin with an alphabet character and should not contain spaces.

6. Select 'Read from text file' from the dropdown.

7. In the Select File field, browse to the file or type the file path for the required text file. Use the Open File button to view the selected
text file or to modify it.

8. Click Save.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.

Excel or CSV File Assignment

The Automation Anywhere Web Recorder and Excel commands extract data to Excel and CSV formats. You can use these files to cre-
ate an array variable that might be used for entering or manipulating data for computing or analysis.

Automation Anywhere provides a range of options for retrieving subsets or partial sections of the data.

Create an array type variable using an Excel or CSV file assignment when you want the values of the variable to be retrieved from an
Excel or CSV file.

To create an array type variable using Excel or CSV file assignment, follow these steps:

1. In the Workbench, click on the Variable Manager tab on the right side.

2. Click on the Add button. The 'Add Variable' window is displayed, with the 'Create New Variable' option selected.

3. Select type 'Array'.

4. Enter a name for the variable. The name must begin with an alphabet and should not contain spaces.

5. Select 'Read from Excel/CSV file'from the dropdown.
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6. Browse and select the required file.

7. Select the options you want for reading values from specific locations in the file. You can choose from:

l All cells

l Entire Row

l Entire Column

l Range

Note: If you select Range, specify the From and To. You can use the Open File button to view
the selected text file or to modify it.

8. Click Save.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.

Using a Database

You can define an array variable with values derived from the result of a database query. The array variable is created with dimensions
that are determined as a result of running the query.

To create an array type variable using a database query, follow these steps:

1. In the Workbench, click on the Variable Manager tab on the right side.

2. Click on the Add button. The 'Add Variable' window is displayed, with the 'Create New Variable' option selected.

3. Select type 'Array'.

4. Enter a name for the variable. The name must begin with an alphabet and should not contain spaces.

5. Select the 'Read from database' from the dropdown.

6. Specify the database connection string details using Browse.Clicking on browse opens the Data Link properties dialogue box. Use
it to test and create a valid connection string for the database of your choice.

7. Enter Select Query by typing the entire database query.

8. Click Save.

After the variable is saved, it is displayed in the Local Variables section of the Variable Manager.
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Once you have created array variables by reading data from various sources, use Loop command to easily process them in your auto-
mation task.Learn more.



Copyright © 2018 Automation Anywhere, Inc. 390 https://support.automationanywhere.com

Random Variables

You can create two types of random variables: string and numerical.

Random variables are useful when you need to generate a random, repetitive string or numerical set. The values are generated when
you run the task.

Common use cases:

l String: Generating test data as input for fields or forms

l Numerical: Generating ID numbers in batch

After you create the variable, you can use it by inserting the variable in several of the Workbench commands.

How to Create a Random Type Variable

Creating a Random String Variable

To create a random string variable, follow these steps:

1. In the Workbench, click on the Variable Manager icon at the top or on the tab on the right side.

2. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.

3. Select type "Random".

4. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.

5. Select the "Random String" radio button. This is the default.

6. Specify the string length in the field provided. The value cannot exceed 255.

7. Click Save.

Creating a Random Numeric Variable

To create a random numeric variable, follow these steps:

1. In the Workbench, click on the Variable Manager icon at the top or on the tab on the right side.

2. Click on the Add button. The "Add Variable" window is displayed, with the "Create New Variable" option selected.

3. Select type "Random".

4. Enter a name for the variable. The name must begin with an alphabetic character and cannot contain spaces.
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5. Select the "Random Number - Range" radio button.

6. Specify the "From" and "To" values for the range.

7. Click Save.

Also See...

l Value Type Variables

l Array Type Variables

l List Type Variables

l Pre-Defined Variables
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Pre-Defined User Variables

Automation Anywhere provides two user variables that are pre-defined for your use:

my-list-variable (type: List)

This variable provides a container for a list of values. For more details see List Type Variables

Prompt-Assignment (type: Value)

This variable provides a container for a single value. For more details see Value Type Variables .

These variables can be used quickly by pressing the F2 key.

Also See...

l Value Type Variables

l List Type Variables

l Array Type Variables

l Random Variables

l Restoring Deleted Variables



Copyright © 2018 Automation Anywhere, Inc. 393 https://support.automationanywhere.com

Restoring Deleted Variables

If you delete one or both of the pre-defined user variables (listed below), you can restore them. These include:

l my-list-variable (type: List)

l Prompt-Assignment (type: Value)

To restore either or both of these variables, follow these steps:

1. Open the Variable Manager.

2. Click on the Add button to display the Add Variable window.

3. Click on the "Select Variable from List" radio button.

4. Check the box next to the pre-defined variable that you want to restore, and click on Save.

Note: You cannot restore user variables that you create and then delete.

Also See...

l Value Type Variables

l List Type Variables

l Array Type Variables

l Random Variables

l Pre-Defined User Variables
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System Variables

Automation Anywhere provides powerful pre-defined system variables that you can use to automate common processes.

Note: System variables are populated during command execution.

System Variable types include:

l Date/Time: System-related date and time variables.

l Loop: Useful in conjunction with Loop commands.

l Excel: Useful for Excel automation.

l Email: Useful for Email automation.#

l Trigger: Useful in conjunction with triggers.

l PDF: Useful for use with PDF command.*

l System: Variables specific to a particular client machine.

After system variables are used in a task, you can view their progress while running a task. For more information, see Watching Vari-
ables.

Also See...

l Knowing When to Use Variables

l Using the Variable Manager

l Creating a New User Variable

l Assigning Variables to a Task

l Reinitializing Variables
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Date and Time System Variables

You can use the set of Date and Time system variables to insert or monitor the current date and time of a system as your automation
task runs.

Use Case Scenario

Using Date/Time variables can help you track and log points in time to monitor the success or error of a running process.

To view the system variables and their descriptions, follow these steps:

1. In the Workbench, click on the Variable Manager icon at the top or on the tab on the right side.

2. Click on the "Show System Variables" link.

To insert a Date/Time system variable, follow these steps:

1. In the Workbench, drag and drop a Variable Operation command in the task pane.

2. Select the System Variables radio button.

3. In the drop-down menu, select the system variable that you want to insert.

4. Click Save.

Manage your Date/Time variables by using the options listed in the table. The table shows Date/Time system variable names, return
values, and actions.

For the Date variable, you can use the System Variables window to change the format that is returned in the Date variable. Follow
these steps:

1. In the Workbench, click on the Variable Manager icon at the top or on the tab on the right side.

2. Click on the "Show System Variables" link.

3. Select the Date variable from the Date/Time list of variables and click the ... button.

4. Select the date format in the Select Date Format pop-up window.
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Examples:

A. The following command stores the current DATE, DAY, and YEAR path in a log file. This is important while logging of errors or cer-
tain important information on files to include the date stamp.

1. Drag and drop the Log To File command.

2. Use the F2 function key to insert variables for $Date$, $Day$ and $Year$.

Command: Log to File: Date:$Date$Day:$Day$Year:$Year$ in "C:\Variable Operation.txt"

B. The following command stores the current HOUR, MINUTE, and SECONDS in a log file. This adds the timestamp to the log for ana-
lysis.

2. Drag and drop the Log To File command.

3. Use the F2 function key to insert variables for $Hour$, $Minute$, and $Seconds$.

Command: Log to File: Hour:$Hour$Minute:$Minute$Seconds:$Second$ in "C:\Variable Operation.txt"

Also See...

l System Variables

l User (Local) Variables

l Log to File Command
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System Variables - Loop

A Loop system variable complements the Loop command and works within the scope of a defined loop. Most loop variables have no
value when used outside of loops. You can manage your Loop command using the variable options in the following table.

Example 1:

Start Loop "Each File In Folder D:\My Desktop\JAVA"

Comment: Please enter your commands to loop. Use $filename$.$extension$ variable for each file name in
the Loop.

End Loop

Start Loop "Each row in an Internet Explorer Table of Session: Default"

Comment: Please enter your commands to loop. Use $TableColumn$ variable for each row in Table.

End Loop

Example 2:

1. Comment: -------------------------------------- Start XML Session-------------------------------

2. XML : Start XML Session using existing file "D:\My Desktop\XML Files\Bookstore - 1.xm-
l"Session:Session1

3. Comment: -------Get Multiple Nodes, I have set Xpath Xpression as Book [1], means only First Occurance -------

4. XML : Get Multiple Nodes text value from XPath expression "//book[1]/author". Session:Session1

5. Comment: -------------- Use Loop for "Each Node in XML Dataset" -----------------------

6. Start Loop "Each Node In a XML Dataset Session: Session1"

7. Comment: --------- Pring Node Value to Message box using SYSTEM Variable "XML Data Node (Node Name)" ---------

8. Message Box: "$XML Data Node(author)$"

9. End Loop

10. Comment: ------------ Get Multiple Nodes, I have set Xpath Xpression as "Lang", means only All Occurance --------

11. XML : Get Multiple Nodes attributes name "lang" from XPath expression "//book/title ". Session:Session1

12. Comment: -------------- Use Loop for "Each Node in XML Dataset" -----------------------

13. Start Loop "Each Node In a XML Dataset Session: Session1"



Copyright © 2018 Automation Anywhere, Inc. 398 https://support.automationanywhere.com

14. Comment: ---------Pring Node Value to Message box using SYSTEM Variable "XML Data Node (Node Name)" --------

15. Message Box: "$XML Data Node(lang)$"

16. End Loop

Also See...

l Using Loop Commands

l System Variables

l User (local) Variables
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Excel System Variables

You can use Excel System Variables to manage Excel automation processes. These variables are specific to the scope of the Excel
command.

Excel relevant system variables

1. Excel Cell - This will indicate the column name and position of the cell from the header, when 'Contains Header' is enabled for a
session in Open Spreadsheet of the Excel Command. It is applicable to Excel operations like Get Cells, Set Cells, Go to Cell,
Delete Cells and Find/Replace.

2. Excel Cell Column - This will return the column of the Excel on which the operation has been performed.

3. Excel Cell Row - This will return the cell of the Excel on which the operation has been performed.

Also See...

l Excel Command

l Excel Command - Contains Header

l System Variables

l User (local) Variables
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Email System Variables

You can use Email system variables within an Email automation task to manage your email automation loop. These variables are spe-
cific to the scope of the loop that processes each email message for the server.

Manage your email automation using the e-mail variable options in the table below.

Note: Applicable only for the Loop command: Each Email Message on Mail Server.

When you use the Loop/Email automation command (see example below), a comment in the task explains how you can use these sys-
tem-defined variables.

Example 1:

1. Start Loop "Each message on server: mail.automationanywhere.com,User Name: https://support.automationanywhere.com, Server-
Type: IMAP, Message Format: HTML"

2. Comment: Please enter your commands to loop. Use Email Automation variables for each email on Server (e.g. $Email From$,
$Email To$, etc.)

3. End Loop

Example 2:

In below example we extract emails from inbox and store them in text files. This type of task can be scheduled and emails can be
retrieved offline.

1. Start Loop "5" Times

2. Comment: Please enter your commands to loop.

3. Start Loop "Each message on server: imap.gmail.com, User Name: admin1, SSL, ServerType: IMAP, Message Format: HTML"

4. Comment: Please enter your commands to loop. use sys variables for each email on Server.(e.g. $Email From$, $Email To$, etc.)

5. Log to File: $Email From$ John in "D:\Desktop\1.txt"

6. Message Box: "$Email Subject$ $Email From$"

7. Variable Operation: Reset: $Email From$

8. Message Box: "$Email Subject$"

9. Variable Operation: Reset: $Email Subject$

10. End Loop

11. End Loop
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The variables in this example can be reset using the Variable Operation (System Variable) command. The drop-down menu offers all
of the options for resetting.

Also See...

l Using the Email Automation command

l System Variables

l User (Local) Variables
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Trigger Variables

You can use a trigger system variable anytime you work with an automation task that is launched with a trigger. The trigger value is
determined based on the type of trigger event.

Using trigger variables is particularly helpful when multiple trigger events are used with an automation task. The variable provides
information about the name of the file, folder, window, or service name for the trigger event.

For other uses, this system variable does not contain a value.

The following table provides the return values and description for the trigger variable.

Name Return Value Description

Trigger Value String Returns the name of File/Folder/Window/Service for which a trigger is fired, depending on the
trigger type that was executed.

Also See...

l Using Triggers

l System Variables

l User (Local) Variables
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PDF System Variables

You can use the PDF system variables with the PDF Integration command.

The following table provides the names, return values, and descriptions for the PDF system variables.

Name Return Value Description
PDFFileName String Returns PDF file name for given file without .pdf extension.
PDFTitle String Returns PDF title for given file.
PDFAuthor String Returns PDF author name for given file.
PDFSubject String Returns PDF subject for given file.

Example:

PDF Integration:

Convert "D:\PDF\fw4.pdf" to images as "$PDFTitle$" under folder "D:\PDFImages\"

Also See...

l System Variables

l User (Local) Variables

l PDF Integration Command
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System Variables - Specific to System Settings/Parameters

You can use system-related system variables to include parameters in your automation task that are related to a particular computer.
The variables return actual system settings and parameters, such as RAM, CPU/RAM usage, and total RAM.

Common Use Case: These variables are useful when the performance of a system needs to be tracked during an activity; for instance
load testing.
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The following matrix provides names, return values, and descriptions for the system-related system variables.

Variable Description Example

Machine Returns machine name You can use it in Log to File command to log the name of
the machine on which the Bot was executed.

Clipboard Returns clipboard text data You can use it in Clipboard to copy or in Message com-
mand to display the text that is copied to the clipboard.

System Returns name of the system You can use it in Log to File command to log the name of
the system on which the Bot was executed.

AAAp-
plicationPath

Returns the application path of
the product

You can use it in Run Task command to select the task from
an application path.

AAIn-
stallationPath

Returns the installation path of
the product

You can use it in Message command to display or in Log to
File command to log the installation path of AAE Client. 

AATaskName
Returns the name of the task
being played along with its
path

You can use it in Comment/Message command to display
the name of the task with its application path.

AAControlroom Returns the URL of the Control
Room the Bot is connected to

You can use it in Email Automation command to send the
URL of the Control Room the Bot Runner is connected to.

CPUUsage Returns the CPU usage stats
in percentage

You can use it in Log to File command to log data of CPU
usage for a particular operation within the Bot (Task) while
it was executed.

RAMUsage Returns the RAM usage stats
in MB

You can use it in Log to File command to log data of RAM
usage for a particular operation within the Bot (Task)
while it was executed.

TotalRAM Returns the total amount of
RAM in MB

You can use it in Log to File command to log data of Total
RAM available in the system.

OSName Returns the name of the Oper-
ating System

You can use it in Log to File command to log the name of
the Operating System (OS) used in the system on which a
Bot (Task) was executed.

ArrayRows Returns the number of rows for
selected Array Variable

You can use it in If command with variable conditions
based on the number of rows in the Array Variable.

ArrayColumns
Returns the number of
columns for selected Array
Variable

You can use it in If command with variable conditions
based on the number of columns in the Array Variable.

WorkItem
Returns the data in read only
form for individual attributes of
a selected queue

You can use it only in the Insert Work Item command when
you want to read attributes of the selected queue.

*When you select the System variable, a menu is displayed from which you can select the specific system variable (see steps below).

Steps to select System Related Variables:

1. Click F2 and you will see Insert Variable window.
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2. Select the required variable and click Insert.

Note: Don't confuse System Related Variables with System Variables. To select System from System
Related Variables, refer the following section.

Steps to select System from System Related Variables:

1. Click F2 and you will see Insert Variable window.

2. Select System and click Insert, a pop up window for System Variable Option appears.

3. Click OK and insert the system variable.
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Troubleshooting an error

Error: If you use the $CPUUsage$ variable in a message box and an error message is issued, you need to reset the counter for the sys-
tem by performing the following action:

Open a command prompt and enter the following two commands:

cd\windows\system32 [enter]

lodctr /R [enter]

Examples

When creating an executable file (EXE) for a task, you might want to use the path of the EXE to log a file or refer to a file located in a
folder. In this case, use the AAApplicationPath variable to select the path of the EXE from any location in which it is stored. This elim-
inates the need to use static paths for EXEs.

1. The following command stores the current application path in a log file. Drag and drop a Log To File command to your task, and
press the F2 key to insert $AAApplicationPath$ variable:

Log to File:Automation Anywhere Application Path:$AAApplicationPath$ in "C:\Variable Operation.txt"

2. The following command stores the current RAM usage and CPU usage in a log file. Drag and drop a Log To File command to
your task, and press the F2 key to insert $RAMUsage$ and $CPUUsage$ variables.

Log to File: CPU Usage:$CPUUsage$RAM Usage:$RAMUsage$ in "C:\Variable Operation.txt"

3. The following command stores the current Task path in a log file. Drag and drop a Log To File command to your task, and press
the F2 key to insert $AATaskName$ variable.

Log to File:Automation Anywhere Application Path:$AATaskName$ in "C:\Variable Operation.txt"

Also See...

l Log to File Command

l System Variables

l User (Local) Variables
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Working with Variables

These topics describe how you can create and modify variables, as well as take other actions on variables with your automation tasks.

In This Section

l Using the Variable Manager

l Creating a New User Variable

l Adding Variables to a Task

l Editing a Variable

l Copying a Variable

l Deleting a Variable

l Variable Operation: Assign

l Variable Operation: Reinitialize

l Resetting System Variables

l Reading Variables from an External File

l Watching Variables

l Using Variables to Create Timestamps for Your Files

l Passing a Variable to a VB Script
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Using the Variable Manager

The Variable Manager displays the local variables that are defined for a particular task. You can use the Variable Manager to add,
modify, and copy variables within automation tasks.

In the Workbench, click the Variable Manager tab on the side.

Use the Variable Manager to perform any of the following actions with variables:

l Copy

l Copy All

l Paste

l Add a new variable

l Edit a variable

l Delete a variable

When you click the Show System Variables link, the Variable Manager displays details about all system variables that are available for
each task.

When you click the Queue Category link, the Select Queue Category form is launched wherein you can select any of the queue cat-
egories added by the Queue owner in the Control Room that you are connected with. Refer Queue Orchestration command for details.

When you use the Variable Manager for the first time, you will see that Automation Anywhere provides two pre-defined user variables
for your use:

my-list-variable (type: List)

This variable provides a container for a list of values.

Prompt-Assignment (type: Value)

This variable provides a container for a single value.
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Also See...

l Types of Variables

l Creating a New User Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from an External File

l Watching Variables
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Creating a New Variable

You can create new variables for an automation from the Variable Manager.

To create a new user variable, follow these steps:

1. Go to Workbench → Variable Manager panel

2. Click the Add button at bottom or right-click on an existing variable and select Add.
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2. In the Add Variable window, the Create New Variable option is selected by default.

3. Select the variable type. See more details.

4. Enter a name, and select the method for determining the value of the variable.

Note: By default, the variable is marked for Analytics. If you do not want to use the variable
for data analysis, clear the option Log For Analytics. The variable will be saved as Local Vari-
able.

Several important facts about using variables include:

l The $ signs that surround the variable name indicate that the text inside should be treated as a variable.

l When the task runs, Automation Anywhere replaces the variable name with the actual value of the variable.

l All command fields with the light bulb icon support variables. When you want to insert a variable, use the F2 function key to list all
user and system variables that are available for selection.

l Variable values can be verified in debug mode by using the Variable Watch feature, which displays the run-time values for the
selected variables.

After creating a variable, you can use it within your tasks using most Automation Anywhere commands. Below example illustrates how
to insert a variable that will set a cell value in Excel command.
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Also See...

l Using the Variable Manager

l Editing a Variable

l Copying a Variable

l Deleting a Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from an External File

l Watching Variables
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Editing a Variable

You can edit and modify any variable that you have created. In addition, you can edit the pre-defined variables.

To edit a variable, follow these steps:

1. Select the variable you want to edit.

2. Click the Edit button or right-click on the variable and select Edit. The Edit Variable window is displayed.

3. Modify the variable fields as necessary. You can change the variable type, the name, or the method of determining value.

4. Click Save.

Also See...

l Using the Variable Manager

l Creating a New User Variable

l Copying a Variable

l Deleting a Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from an External File

l Watching Variables
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Copying a Variable

When you need to use a variable from one task in another task, use Copy/Copy All, which are provided in the Variable Manager.

When you select Copy All, you are asked to confirm that you want to overwrite the default variables Prompt-Assignment and my-list-vari-
able.

To copy a variable, follow these steps:

1. Select the variable you want to copy.

2. Click the Copy button or right-click on the variable and select Copy. You can alternatively click on the Copy All button or right-click
and select Copy All. The Copy button is enabled only if a particular variable is selected.

3. Select or open another task in which you want to insert the variables.

4. Click Paste.

The Paste button for a new task is enabled only if variables are first copied.

Note: AAE facilitates copying of variables to a new TaskBot while you copy task commands. This is
helpful, as you do not need to recreate the variables and the commands in the new task. If some of the
copied variables are present in the TaskBot, values and types for these variable are overwritten.
*Available in Enterprise Edition from version 11.0 LTS

Also See...

l Using the Variable Manager

l Creating a New User Variable
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l Editing a Variable

l Deleting a Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from an External File

l Watching Variables
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Deleting a Variable

If a variable becomes obsolete and you want to delete it, you can use the Variable Manager to do so.

When using Copy All to copy all variables to another task, you might need to delete several variables that are redundant or useless in
the new task.

To delete a variable, follow these steps:

1. Select the variable you want to delete.

2. Click the Delete button or right-click on the variable and select Delete.

3. When the confirmation message is displayed, click yes.

Note: Only single variables can be deleted at one time.

Also See...

l Using the Variable Manager

l Creating a New User Variable

l Editing a Variable

l Copying a Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables
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l Reading Variables from an External File

l Watching Variables



Copyright © 2018 Automation Anywhere, Inc. 419 https://support.automationanywhere.com

Adding Variables to a Task

Many of the commands that are available in the Workbench allow you to insert variables in your tasks. Some commands, like Insert
Keystrokes, provide a navigation for you to select and insert variables in your task.

For other command fields that allow you to insert variables, use the F2 function key. It will list all user and system variables that are
available for insertion.

Also See...

l Assigning Variables to a Task

l Creating a New User Variable

l Editing a Variable

l Watching Variables
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Assigning Variables in a Task

After you define variables, you can perform operations on them within your automation tasks. Variable Operation command enables
you to assign and reinitialize user variables. Assignment means that a single value is attached to a variable. This operation enables
the user to reuse the defined variables as the task runs.

Assignment can be performed on three types of variables: Value, List, and Array. For lists and arrays, the assignment is applied by spe-
cific positions within the list or array.

The following table shows the types and source (subtypes) of the user variables and if it supports the assignment operations on them.

Assigning Value Variables

To assign a value to a Value type variable, follow these steps:

1. In the Workbench, drag and drop a Variable Operation command into the task.

2. Select the User Variables option.

3. Under "Specify Variable," select the variable from the list of all user variables that are defined for the task. The variable type and
source is displayed.

4. Select the Assign operation radio button.

5. In the "Specify value" field, enter a value or insert another variable by pressing the F2 function key.

The right side of the assignment can include any regular operation.

Example:singleval1 = ($var2$ + $var5$ - 10) / 5

Operators supported:(, ), /, *, +, -

Order of Operations: Parentheses take first precedence in order, with the operation inside them being evaluated from left to right.

Assigning List Variables

When assigning values to a List type variable, you need to specify the position for that value. Any previous value for that position will
be overwritten.

To assign a value to a List type variable, follow these steps:

1. In the Workbench, drag and drop a Variable Operation command into the task.

2. Select the User Variables option.
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3. Under "Specify Variable," select the variable from the list of all user variables that are defined for the task. The variable type and
source is displayed.

4. Select the Assign operation radio button.

5. For the list variable, the "Select Position" is displayed. Specify the position for this value. For example, $Counter$

6. You can also specify another variable to be inserted here by pressing the F2 function key and selecting the variable.

7. In the "Specify value" field, enter a value or insert another variable by pressing the F2 function key.

Assigning Array Variables

When assigning values to an Array type variable, you need to specify the positions for the values. Any previous values for these pos-
itions will be overwritten.

The source of the array variable can be Excel or CSV files, a database, or a text file, depending on the type of variable you select from
the list.

To assign values to an Array type variable, follow these steps:

In the below example we are assigning an array variable for position (2,2) from another variable defined in the task.

1. In the Workbench, drag and drop a Variable Operation command into the task.

2. Select the User Variables option.

3. Under "Specify Variable," select the variable from the list of all user variables that are defined for the task. The variable type and
source is displayed.

4. Select the Assign operation radio button.

5. For the array variable, the "Select Position" fields for Row and Column are displayed. Specify the position for these values. For
example, "Row 2 and Column 2".

6. You can also specify other variables to be inserted here by pressing the F2 function key and selecting the variable.

7. In the "Specify value" field, enter values or insert another variable by pressing the F2 function key.
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Variable Operation: Rounding Values

When using the Variable Operation command in the Workbench, be aware that values are rounded.

For example, we use a Variable Operation command to assign the value '01.20' to a variable named Temp. The returning value in the
message box will be 1.2, as the extra zeros before and after the value are removed.

Examples:

Example 1

Type: List, Source: Read from text example.

1. Comment: This Loop will execute for 5 times as List read from text file variable has 5 entries.

2. Comment: Create Variable List Type : Source = Read from text file having this RDlsttxt = 11, 21,31,41,51

3. Start Loop "List Variable $RDlsttxt$"

4. Comment: Message box will show the addition of list variable value with other variable value.Here $row$=10

5. Variable Operation: $RDlsttxt$ + $row$ To $Prompt-Assignment$

6. Message Box: "$Prompt-Assignment$"

7. End Loop

Example 2

Type: Array Source: Read from Excel

1. Comment: We use an array variable to read from existing excel file

2. Connect to "$ConnectStr$" Session:'Default'

3. Comment: ArrayRows is a system defined variable used to retrieve total rows in the user defined array.

4. Comment: ArrayExl - is a user-defined array variable, using a source that is Read from Excel file. In this example, we use a list of
books and games having title and cost, which is initialized in the Variable Manager.

5. Variable Operation: $ArrayRows($ArrayExl$)$ To $Row$

6. Start Loop "$Row$" Times

7. Comment: To skip the header title of the csv extracted from the website use below If condition

8. If $Counter$ Equal To (=) "1" Then
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9. Continue

10. End If

11. Execute SQL Statement: 'Insert into Ebaykids (BookTitle,cost) values ("$ArrayExl($Coun-
ter$,1)$",'$ArrayExl($Counter$,2)$')' Session: 'Default'

12. End Loop

13. Open "http://www.ebay.com/"

14. Comment: Extracting the books on the philosophy into a CSV file using Web Recorder

15. Set text 'philosophy books' into _nkw in the webpage 'Electronics, Cars, Fashion, Collectibles,
Coupons and More Online Shopping | eBay'

16. Click on 'Search' Command Button in the webpage 'Electronics, Cars, Fashion, Collectibles, Coupons
and More Online Shopping | eBay'

17. Loop While Web Control Exists (Other HTML Control : Next ) in the webpage 'philosophy books | eBay'

18. Extract Multiple Data from Webpage to $filePath$ from the web page: philosophy books | eBay

19. Click on 'Next' Other HTML Control in the webpage 'philosophy books | eBay'

20. End Loop

21. Extract Multiple Data from Webpage to $filePath$ from the web page: philosophy books | eBay

Also See...

l Using the Variable Manager

l Creating a New User Variable

l Editing a Variable

l Copying a Variable

l Deleting a Variable

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from an External File

l Watching Variables
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Assigning Credential Variables

To securely store sensitive information that is necessary to play automation tasks, the Control Room administrator creates 'Credential
Keys' comprising 'Attribute' values. These Credentials are used by BotCreators (Client users who create tasks), in various commands
that require credential inputs, as 'Credential Variables'.

These special category of variables are centrally stored in a 'Credential Vault' to which the Control Room administrator will have exclus-
ive access privileges. Learn More

A Bot creator, while creating tasks, can assign the Credential variables in command fields that require credential input and support
these. Refer list of commands in this topic.

Note: To access Credential variables during task creation and play, the Bot creator has to be online
i.e. connected to the Control Room.

Using the Credential Variables

The method to input Credential variables in commands that require them is similar to assigning variables. You simply press the func-
tion key 'F2'. The credential values are retrieved in the command during play time.

Before you start assigning variables, remember:

l A BotCreator can only insert the Credential variables in commands; no add or update rights are available to the BotCreator.

l Credential Variables can be seen and accessed only from the Insert Variables window.

l Only the name of a Credential Key is visible in the command field and list of Credential variables; Attribute values is not displayed.
Not even while editing or debugging the task.

l Bulk Edit is allowed only on commands that comprise same Credential variables.

l A Credential variable is read only; hence you are not allowed to edit its values. You cannot append another variable (Local/System
variable) or a string to it. To insert such variables, you must delete the Credential variable first.

l To delete a Credential variable, double click or hit 'Backspace' and then 'Delete'.

l Copying and pasting of the variable converts it to string. Manually inputting the variable name also converts it to string.

Important: Users who have migrated from version less than 10.3 note that when you insert a cre-
dential variable in existing tasks, the earlier parameters are deleted.

Steps to Assign Credential Variables

To assign variables in command fields that support Credential variables, follow the steps given below:

1. To add a Credential Variable, press F2 and select the required Credential 'Key' in the Insert Variable window:

https://support.automationanywhere.com/entries/99222048
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2. Select the required Attribute

3. The command is assigned the credentials as shown:

l Here, 'MyFTP' is the Credential Key, while 'HostName' and 'UserName' are its Attributes.

Note: Password fields are displayed encrypted.
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Commands that support Credential Variables

The following commands support use of Credential variables:

1. Active Directory

2. Citrix Automation

3. Database

4. Email Automation

5. Excel

6. FTP/SFTP

7. Insert Keystrokes

8. Manage Windows Controls

9. Object Cloning

10. PDF Integration

11. PGP

12. REST Web Services

13. SAP Integration

14. SOAP Web Services

15. Web Recorder

Also See...

l Understanding Types of Variables

l Active Directory Command

l Database Command

l Email Automation Command

l Excel Command

l FTP/SFTP Command

l Insert Keystrokes Command

l Manage Windows Controls Command

l Object Cloning Command

l PDF Integration Command

l PGP Command

l REST Web Services Command

l SOAP Web Services Command

l Web Recorder Command
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Reinitializing Variables

When you create user variables and use them within automation tasks, you need to reinitialize them each time you use them.

You can reinitialize any type of user variable, including:

l Value variables (Only read from txt type)

l List variables

l Array variables

l Random variables

Reinitializing Value Variables

To reinitialize a value type variable, follow these steps:

1. In the Workbench, drag and drop a Variable Operation command into the task.

2. Select the User Variables option.

3. Under "Specify Variable," select the variable that you want to reinitialize.

4. Select the Reinitialize radio button.

5. In the "Specify value" field, browse to select a new text file for the variable to reinitialize the value.

6. Click Save. Any previous values for this variable will be overwritten.

Reinitializing List Variables

To reinitialize a list type variable, follow these steps:

1. In the Workbench, drag and drop a Variable Operation command into the task.

2. Select the User Variables option.

3. Under "Specify Variable," select the variable that you want to reinitialize.

4. Select the Reinitialize radio button.

5. In the "Specify value" field, type in new values or browse to locate a new text file.

6. Click Save.

Only the new values that are specified will be assigned. Any previous values for this variable will be overwritten.
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Reinitializing Array Variables

Several options are available for reinitializing array variables.

To reinitialize an array type variable, follow these steps:

1. In the Workbench, drag and drop a Variable Operation command into the task.

2. Select the User Variables option.

3. Under "Specify Variable," select the array variable from the list of user variables that are defined for the task. The variable type and
source is displayed.

4. Select the Reinitialize radio button.

5. Specify new dimensions. For example, Row 2 and Column 2. You can also specify other variables to be inserted here by pressing
the F2 function key and selecting the variable.

6. In the "Specify value" field, enter values or insert another variable by pressing the F2 function key.

7. Click Save.
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Restrictions and Usage Rules:

l If the rows and columns are numeric, you can use the Initialize Values button to insert new values. In this case, both the structure
and values for the array are completely redefined.

l For an array having source type Excel, you can reinitialize the entire row, column, range, or all of the cells.

l For an array having source type of Excel or CSV file, you need to specify a path in order to reinitialize it.

l The Open File option is enabled only when you specify a valid file path.
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l For an array having a Database source type, you can specify connection properties to a new database with its SQL query.

Reinitializing Random Variables

To reinitialize a random variable, follow these steps:

1. In the Workbench, drag and drop a Variable Operation command into the task.

2. Select the User Variables option.

3. Under "Specify Variable," select the variable that you want to reinitialize.

4. Select the Reinitialize radio button.

5. In the "Specify value" field, specify new values for the number range or string.

6. Click Save. Any previous values for this variable will be overwritten.
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Use Case Scenarios

Example 1:

Type: List Source: Read from text Reinitialize

1. Comment: Reinitialize Variable Type: List, Source: Read from text file having this RDlsttxt =https://su-
pport.automationanywhere.com, testing@gmail.com, sales@automationanywhere.com, buynow@automationanywhere.com

2. Variable Operation: Reinitialize $RDlsttxt$

3. Start Loop "List Variable $RDlsttxt$"

4. Comment: This Loop will run 4 times as 'List read from text file variable has 4 entries.

5. Comment: The following command will send emails to the address IDs listed in the above Read from text file -List variable.

6. Send Email: Subject "Automation Anywhere finished executing the task." with Attachment(s).

7. Message Box: "Email to '$RDlsttxt$' has been sent sucessfully."

8. End Loop

Example 2:

Type: Array Source: Read from Excel

1. Comment: Reinitializing the Array Source: read from excel file (ArrayExl) with the CSV file extracted from the website.

2. Variable Operation: Reinitialize $ArrayExl$

3. Variable Operation: $ArrayRows($ArrayExl$)$ To $Row$

4. Start Loop "$Row$" Times

5. If $Counter$ Equal To (=) "1" Then

6. Comment: To skip the header title of the csv extracted from the website

7. Continue

8. End If

9. Execute SQL Statement: 'Insert into Ebayphilosophy (BookTitle,cost) values ("$ArrayExl($Coun-
ter$,1)$",'$ArrayExl($Counter$,2)$')' Session: 'Default'

10. End Loop

Also See...

l Using the Variable Manager

l Creating a New User Variable

l Editing a Variable

l Copying a Variable

l Deleting a Variable

l Assigning Variables to a Task

l Resetting System Variables

l Reading Variables from an External File

l Watching Variables
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Resetting System Variables

When using some system variables, you have the option to reset the values while a task is running.

The following system variables can be reset:

l Error Description

l Error Line Number

l Email From

l Email To

l Email Cc

l Email Subject

l Email Message

To reset a system variable, follow these steps:

1. In the Task Editor, drag and drop a Variable Operation command into the task.

2. Select the System Variables radio button.

3. Select the system variable you want to reset.

4. Click Save.

When the task runs, the value for the system variable will be reset.

Also See...

l Using the Variable Manager

l Creating a New User Variable

l Editing a Variable

l Copying a Variable

l Deleting a Variable

l Assigning Variables to a Task

l Reinitializing Variables
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l Reading Variables from an External File

l Watching Variables
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Reading Variables from an External File

If you don’t want to specify the value of the variable at the time you create the variable, Automation Anywhere allows you to set the val-
ues of variables using an external file such as CSV, Excel, text, and database.

Reading from a Text File

To read variable values from a text file, follow these steps:

1. In the Variable Manager, click the Add button at bottom or right-click on an existing variable and select Add to invoke the Add Vari-
able window.

Note: In the Add Variable window, the Create New Variable option is selected by default.

2. Select the desired variable type, enter a name, and select the 'Read from Text File' option from the dropdown.

To ensure that Automation Anywhere reads text files properly when assigning values for the variables, follow these guidelines:

l One text file can have multiple<variable> = <value>pairs, on separate lines (line returns using the ENTER key).

l For value type variables, only one value should be assigned.

l Example:myvar=value1wheremyvaris the name of the variable.

l Example:my-list-var= value1,value2,value3

l Ensure that your text file is specified in the Variable Manager before the task runs.

l For List type variables, you can define the comma-separated values for the variable.

l Variable names are not case-sensitive.

Example: Text file with different <variable>=<value> pairs:

Age=12,13,16,21

Games=Football,Soccer,Rugby

username=my-username

Removed the password field.

Reading from an Excel File

When you create an array variable and specify that values should be read from an Excel file, data can be read for the following:

l For an entire row

l For an entire column

l For a range of cells that you specify using the 'From' and 'To' fields
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Reading from a Database

To read values from a database file, you need to specify a connection string and a SELECT query.

Note: Reading variable from database is applicable only for array type variables. Learn More.
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Watching Variables

This topic describes how to use the Automation Anywhere Variable Watch feature to watch your variables, when the automated task is
running.

To track the progress of variables within the task, Automation Anywhere provides a way for you to watch variables as they change.
This makes the progress of variables easier. This can be achieved using "Variable Watch Table" feature which is enabled when you
are using the Debugging mode.

The Variable Watch Table displays current variable values while the task runs, and applies to all types of variables (user and system
variables) that are defined for that task.

Using the Variable Watch Table

To use the Variable Watch Table, click on the Enable Debugging button at the top of the Workbench. The Variable Watch Table pops
up and displays the actual variable values (or what it contains) as the task runs a particular step.

Initially, the Variable Watch Table is empty. Use the Add button to include variables you want to track.

When the "Add Variables in Watch" window is displayed, select the variables you want to watch and click the Add button.

Any user variables and system variables that are defined for the task can be added to the table.
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As shown below, the Variable Watch Table contains all of the variables selected for watching. The values get populated and changed
as the task runs.

For an array variable, the Variable Watch Table shows the column/row value. For example, (1,1) is displayed in the left column (Name)
in the table.
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Also See...

l Using the Variable Manager

l Creating a New User Variable

l Editing a Variable

l Copying a Variable

l Deleting a Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from External Files
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Using Variables to Create Timestamps for Your Files

Timestamps are useful tools to use in your automation tasks to track when particular events occur.

The following system variables are available for you to use to create timestamps for your files:

l Year

l Month

l Day

l Hour

l Minute

l Second

l Date

You can combine any of these variables to design your own timestamp formats.

To design date/time timestamps, following these steps:

1. Launch the Variable Manager.

2. Click on "Show System Variables".

3. Select the Date/Time variable and use a combination of variables.

Using the Date Variable with File Names

If you use the Date variable to append a date to file names, you cannot use a slash (/) in your date format. Microsoft Windows prohibits
the use of the slash character in file names.

Examples:

1. To create a timestamp for Year, Month, and Day, that is appended to the end of string 'ABC', type: ABC$Year$$Month$$Day$

This example might look like this: ABC2013521

2. To create a complete timestamp for the previous example with the current date and time, type:
ABC$Year$$Month$$Day$$Hour$$Minute$$Second$

This example might look like this: ABC201352107:03:03

3. For clarity, you can insert text characters between the variables.

For example, to display ABC2013-5-21, type: ABC$Year$-$Month$-$Day$

Also See...

l Using the Variable Manager

l Creating a New User Variable

l Editing a Variable

l Copying a Variable

l Deleting a Variable

l Assigning Variables to a Task

l Reinitializing Variables

l Resetting System Variables

l Reading Variables from External Files
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Passing a Variable to a VB Script

Sometimes, people prefer to run VB (Visual Basic) scripts to accomplish a task or process. In conjunction with Automation Anywhere,
running VB scripts can be very powerful. These scripts can be automated, using the Run Script command.

Sample Use Cases:

l Obtain data from a file on a website

l Calculate dates and times

Use the Run Script command to pass values in a variable to the Parameter field. You can then obtain the output from the Return Value
field.

Commands that are required to pass values to a VB script and obtain the results include:

1. Pass values in the VB script: WScript.Arguments.Item(0)

2. Return values in VB script: WScript.StdOut.WriteLine "Variable"

For "Variable", the double quotes are not required for Return values.

Separate the values with a space.

Also See...

l Working with Variables

l Types of Variables
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How to use Array Variable in Loop Command

Once you have created the Array Type variables, you can process them in automated tasks using Loop command.

Using Direct Assignment Array Variable

1. Open the Workbench.

2. Create an array variable using Direct Assignment from Tools > Variable Manager (we'll call it $Student_Data$).

3. Double-click the Loop command and select the option Times.

4. Press F2 to insert the $ArrayRow$ variable and select the Array Variable as $Student_Data$.

5. Create a value variable (we’ll call it $row$) to save the data that is fetched from the rows.

6. Double-click the Variable Operation command and press F2 to select $Counter$ variable under Specify value.

7. Double-click the Loop command again and select the option Times.

8. Press F2 to insert the $ArrayColumn$ variable and select the Array Variable as $Student_Data$.

9. Double-click the Message command and press F2 to insert $Student_Data$ variable. You will see that Array variable option dia-
logue box appears. Press F2 to select $row$ variable in Row Value and $Counter$ variable in Column Value.

10. Click OK to save the values and click Save to save the message.

Using Read from Text File Array Variable

1. Open the Workbench.

2. Create an array variable using Read from Text File option from Tools > Variable Manager (we'll call it $Sports_team$).

3. Double-click the Loop command and select the option Times.

4. Press F2 to insert the $ArrayRow$ variable and select the Array Variable as $Sports_team$.

5. Create a value variable (we’ll call it $row$) to save the data that is fetched from the rows.

6. Double-click the Variable Operation command and press F2 to select $Counter$ variable under Specify value.

7. Double-click the Loop command again and select the option Times.

8. Press F2 to insert the $ArrayColumn$ variable and select the Array Variable as $Sports_team$.

9. Double-click the Message command and press F2 to insert $Sports_team$ variable. You will see that Array variable option dia-
logue box appears. Press F2 to select $row$ variable in Row Value and $Counter$ variable in Column Value.

10. Click OK to save the values and click Save to save the message.

Using Read from CSV/Excel Array Variable

1. Open the Workbench.

2. Create an array variable using Read from CSV/Excel option from Tools > Variable Manager (we'll call it $Employee_Data$).

3. Double-click the Loop command and select the option Times.

4. Press F2 to insert the $ArrayRow$ variable and select the Array Variable as $Employee_Data$.

5. Create a value variable (we’ll call it $row$) to save the data that is fetched from the rows.

6. Double-click the Variable Operation command and press F2 to select $Counter$ variable under Specify value.

7. Double-click the Loop command again and select the option Times.

8. Press F2 to insert the $ArrayColumn$ variable and select the Array Variable as $Employee_Data$.

9. Double-click the Message command and press F2 to insert $Employee_Data$ variable. You will see that Array variable option dia-
logue box appears. Press F2 to select $row$ variable in Row Value and $Counter$ variable in Column Value.

10. Click OK to save the values and click Save to save the message.

Using Read from Database Array Variable

1. Open the Workbench.

2. Create an array variable using Read from Database option from Tools > Variable Manager (we'll call it $Employee$).

3. Double-click the Loop command and select the option Condition.
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4. From the ‘Loop While’ dialogue box, select Variable option.

5. Click on Edit to select the Loop Condition.

6. Select the appropriate variable, operator and value. For reference, see the following image:

7. To display the values of the variable, you can use Message Box.
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Section: Customizing Enterprise Client
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Using the Login Settings

*Applicable for version 9.0 onward.

The Login Settings allows you to save your windows credentials, so that they can be used for running scheduled and/or automated
tasks.

If you are using version 9.0 or less, the Auto Login option will allow you to run tasks on computers
that are unattended. See details.

You can use this setting in conjunction with the following types of activities:

l Scheduling tasks

l Running reports

l Running workflows

l Triggers

Operating System Support

Windows login settings for Auto Login is supported for the following operating systems:

l Windows 2000

l Windows 2003

l Windows 7

l Windows 8

How Login Settings Work for Auto Login

Login Settings can be used to set username and password that can help you Auto Login the computers and run an automated task.
The Auto Login works as follows:

l Auto Login checks whether the computer is locked or the user is logged off.

l If the computer is locked, hibernating, or in standby mode, Auto Login unlocks the computer or logs into the machine by using the
user name and password provided.

l The automated process runs.

l After the task completes (successfully or with errors), the program restores the computer to its original state.

As a task is running, if one of the following actions occur, Automation Anywhere can log off or lock the computer:

l Stop Task key (Escape key by default) on the keyboard is pressed

l Pause key on the keyboard is pressed

l An error occurs while the task runs.

To enable Auto Login option to run an automated task, follow the below mentioned steps:

1. Go to Tools > Options > Login Settings.
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(Image as seen in Enterprise edition 9.0)

2. Input the windows username and password under the 'Windows Login Credentials'.

3. Select the check box for setting Auto Login. This shall enable you to apply Auto Login to all of your tasks.

(Image as seen in Enterprise edition 9.0)

Note: Do not use interactive commands (commands that prompt a user for input) for tasks that use the
Auto Login feature.
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Using Login Settings for Scheduling Tasks

You can save Login credentials for scheduling an automated task. This will ensure that you don't have to input your credentials again
while scheduling a task using Scheduler

1. Go to Tools > Options > Login Settings.

2. Input the windows username and password under the 'Windows Login Credentials'.

3. Select 'Schedule a task' check box if you want to schedule an automated task.

(Image as seen in Enterprise edition 9.0)

4. To enable Auto Login for a scheduled task, make sure you also select the check box for 'Auto Login your computer when the task
runs'.



Copyright © 2018 Automation Anywhere, Inc. 447 https://support.automationanywhere.com

(Image as seen in Enterprise edition 9.0)

Tip: It is recommended, you enter the domain name to enable Auto Login to work properly when used in
conjunction with scheduling.

Enabling Bypass Legal Disclaimer *

* Available in Enterprise Edition 7.5 onward.

For details contact https://support.automationanywhere.com

If you operate your tasks in an environment that require stringent security measures, you may not be able to log on automatically to run
certain tasks. Given this scenario, to make your Auto Login option work, you may be required to enable the 'Bypass Legal Disclaimer'
feature.
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The feature is available for use, when you select 'Auto Login your computer when the task runs' option. If you wish to bypass the secur-
ity measures and automatically log on, enable 'Bypass legal disclaimer'.

Caution Note: Please note that this feature should be used with utmost care before enabling the
same. The sole responsibility of using this feature lies with the user and Automation Anywhere shall
not be held liable for its misuse and/or related consequences.

Also See...

l Using the Advanced Settings

l Setting up Email Notifications

l Defining Client Hotkeys

l Setting View Options

l Using Run-Time Settings

l Using ROI Settings

l Customizing Task List View
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Using the Auto Login Option

The Auto-Login option allows you to run tasks on computers that are unattended. Auto-Login unlocks the computer, and runs the auto-
mated tasks, and returns the computer to the original state.

You can use in conjunction with the following types of activities:

l Scheduling tasks

l Running reports

l Running workflows

l Triggers

How Auto Login Works

When an automated task runs, Auto Login works as follows:

l Auto-Login checks whether the computer is locked or the user is logged off.

l If the computer is locked, hibernating, or in standby mode, Auto Login unlocks the computer or logs into the machine by using the
user name and password provided.

l The automated process runs.

l After the task completes (successfully or with errors), the program restores the computer to its original state.

Note: Use the Auto Login Advanced Settings to add security features to Auto Login

As a task is running, if one of the following actions occur, Automation Anywhere can log off or lock the computer:

l Stop Task key (Escape key by default) on the keyboard is pressed

l Pause key on the keyboard is pressed

l An error occurs while the task runs.

Scheduling Tasks to Use Auto-Login

You can enable the Auto-Login option when you schedule a task to run.

1. Go to Tools > Options > Auto Login.

2. Select the check box for setting Auto Login This shall enable you to apply Auto Login to all of your tasks.
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(Image as seen in Enterprise Edition 8.2)

3. Select a task and go to the Schedule tab.

4. Input the required parameters and click save:

5. Input the username and password in the 'Login to Schedule Task' window. Click Save.

Refer Scheduling a Task for details.

l To turn off Auto-Login, click on the Tools > Options. Under the Auto-Login option, deselect the 'Enable Auto-Login your computer
when the task runs' check box.

l If an error occurs while a task is running, Automation Anywhere returns the computer to its previous state, regardless of other tasks
waiting to process.



Copyright © 2018 Automation Anywhere, Inc. 451 https://support.automationanywhere.com

Note: Do not use interactive commands (commands that prompt a user for input) for tasks that use the
Auto-Login feature.

Enabling Bypass Legal Disclaimer *

* Available in Enterprise Edition 7.5 onward. For details contact https://support.automationanywhere.com

If you operate your tasks in an environment that require stringent security measures, you may not be able to log on automatically to run
certain tasks. Given this scenario, to make your Auto Login option work, you may be required to enable the 'Bypass Legal Disclaimer'
feature.

The feature is available for use, when you select 'Auto Login your computer when the task runs' option. If you wish to bypass the secur-
ity measures and automatically log on, enable 'Bypass legal disclaimer'.

Important: Please note that this feature should be used with utmost care before enabling the same.
The sole responsibility of using this feature lies with the user and Automation Anywhere shall not be
held liable for its misuse and/or related consequences.

Operating System Support

Auto-Login is supported for the following operating systems:

l Windows 2000

l Windows 2003

l Windows 7

l Windows 8

Also See...

l Using the Advanced Settings

l Setting up Email Notifications

l Defining Client Hotkeys

l Setting View Options

l Using Run-Time Settings

l Using ROI Settings

l Customizing Task List View

mailto:support@automationanywhere.com
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Setting up Email Notifications

Automation Anywhere client enables you to notify TaskBot / MetaBot Logic status after it has been executed, by email.

To enable email notifications, ensure that you configure your email settings first. For this follow the steps given here:

1. In the main Automation Anywhere window, click on Tools→ Options.

Note: You can also configure email notification settings when you click on Properties tab →
Notification

2. Click on Email Settings

3. Now set the following fields given under Outgoing Mail Server (SMTP):

l Host - The SMTP Host enables you to send email from an Automation Anywhere client over the Internet. You can obtain this inform-
ation from your Internet email provider, or from the configuration section of your email program.

l Port - This setting defines the TCP/IP port that Automation Anywhere uses to send email. The default port is 25, the Internet stand-
ard for sending SMTP email.

l Username - If your outgoing mail server requires a user name and password, specify the user name in this field.

l Password - If your outgoing mail server requires a user name and password, specify the password in this field.

Go Green !

l Other-Automation Anywhere cares about the environment and wants to help spread the message. As part of our Green Campaign,
a message is included at the end of each email notification. You can deselect this option if you do not want your outgoing emails to
include the Go Green message.

The next step involves setting the email notification options:

1. Click on Email Notification to set notification content. Enter a "From" and "To" email address and one or more email addresses to be
notified.
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2. Also include a subject line and main body content for the email.

Tip:

1. Always try to include the TaskBot / MetaBot Logic name with the variable <taskname> / <logicname>.

2. If you plan to notify only one email address with TaskBot / MetaBot Logic updates, use the Tools→ Options→ Email Notification to
simply set it one time. However, if you want different TaskBot / MetaBot Logics to send status emails to different email addresses,
specify the email addresses within each TaskBot / MetaBot Logic.

Also See...

l Using the Auto-Login Option

l Defining Client Hotkeys

l Setting View Options

l Using Advanced Settings

l Using Run-time Settings

l Using ROI Settings

l Customizing the Task List View
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Defining Client Hotkeys

You can define Hotkeys to save time and eliminate keystroke and mouse errors.

Defining Hotkeys Using Automation Anywhere

You can define hotkeys for the following operations:

l Start recording

l Stop recording

l Stop a running task

These actions have hotkeys defined by default. To select different keys on the keyboard for these actions, simply press the "Hotkey..."
button and select a key combination from the list.

To reset the action to the default, press the "Default" button.

Note: To use hotkeys, ensure that Automation Anywhere is running in the Windows system tray.

Configuring a New Hotkey

Follow these steps to configure a new hotkey:

1. From the main Automation Anywhere window, click on Tools -> Options

2. In the Options window, click on Hotkeys

3. Set the Hotkeys for 'Start Recording', 'Stop recording' and 'Stop Task' by clicking the Hotkey button.

Note: You can modify a hotkey by pressing the Hotkey button. Also set the selected key as
default.

Alternately, you can select Properties tab -> Hotkey -> to set hotkeys for the selected task
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4. Select an action and a key combination from the list.

5. Click OK.

Also See...

l Using Auto-Login Option

l Setting up Email Notifications

l Setting View Options

l Using Advanced Settings

l Using Run-Time Settings

l Using ROI Settings

l Customizing the Task List View
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Setting View Options

Viewing options provide you the necessary leverage to control the way certain options are displayed. For instance, you can customize
to display the run-time window and keep tab upon the error(s) the task encounters when running.

(Image as seen in Enterprise edition 9.0)

Configure your options from Tools > Options > View:

1. Show Run Time Window: Show or hide the Run Status window that Automation Anywhere displays in the lower right side of your
screen while a task runs.

2. Show Errors: Show or hide any errors that Automation Anywhere issues while running a task.

3. Show Start Page: Show or hide the Automation Anywhere Start Page when starting up the Client.

Also See...

l Using Auto-Login Option

l Setting up Email Notifications

l Defining Client Hotkeys

l Using Advanced Settings

l Using Run-time Settings

l Using ROI Settings

l Customizing Task List View
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Using Advanced Settings

Using advanced settings options enables you to customize the way you control mouse moves/clicks, keystrokes, capture screen-shots
etc when recording a task.

Configure these settings from Tools→ Options→ Advanced Settings:

Options for Recording Options

1. Record Mouse Moves - To stop recording mouse moves while recording a task, clear this option. Some mouse moves have applic-
ation-specific meaning, such as when recording application menus. In these cases, keep this option enabled.

2. Record Mouse Clicks - To stop recording mouse clicks while recording a task, clear this option

4. Record Keystrokes - To stop recording keystrokes while recording a task, clear this option.

5. Capture Screen-shots While Recording - To capture and display images of the screen-shot while you record tasks use this option.
For more information about this feature, see Using SnapPoint.

Options for Application Location

Application Path - Check this to specify a different application path. The default application path is the Automation Anywhere Files
folder under My Documents.

The application path can be set to a local drive or to a network path. The network path could be a mapped drive as well.

While setting up an application path, you have to ensure the following:

1. The application path must be unique; it should not be shared between users.

2. It must be accessible at all times.

3. Users must have read and write privileges for the application path.

When changing this location, all of your tasks will be saved in the new location. The new path will take effect when you restart the
Automation Anywhere Client.

Note:

l After changing the application path, all the triggers, hotkeys, and scheduled tasks will run
as normal.
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l However, if your domain name changes, you will have to manually update the application path.

l If a network drive is specified, the speed of your tasks will be determined based on your net-
work speed.

Options for Editing and Logging

1. Edit Task on double click in Task List - By Default, a double click on a task will run or execute a task. Enable this option to change
the default setting to edit a task on a double click.

2. Enable System Logging - For more information about this feature, see Viewing System Logs.

3. Enable Debug Logging - To debug errors that appear in Automation Anywhere and its services, you can choose to enable logs dur-
ing task execution. When you enable this option the status bar of the application indicates Debug logging enabled.

l On enabling debug logging, Debug, Info, Warning, Error and Fatal logs are saved.

l On disabling debug logging, only Error and Fatal logs along with maximum 256 lines of buffered data of the recently raised
Warning and Info logs are saved.

Note: By default, the Exception logs are always enabled.

4. Clear Logs - Use this to delete all Application Logs. However, the logs for applications that are running shall not be cleared.

To clear the Application Logs,

1. Close all running applications.

2. Manually delete all files in <Application Path>\LogFiles folder.

Note: The Clear Logs button does not delete the service logs that are common for all users. To
delete the service logs, you need to delete them manually from <public documents>\Automation Any-
where Client Files\LogFiles.

5. Export Logs - Use this to export all logs to the new folder - AAE_Client_Logs_<date>_<time>

To Export Logs to this folder,

1. Either create and select a new folder or select an existing folder.

2. Click Select Folder in the explorer:

3. This automatically creates two sub-folders - Application Logs and Service Logs wherein the exported logs will be saved.
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Note: When you use the option Clear Logs, it does not clean up the Application and Service Logs that
were saved using Export Logs.

Options for Proxy Server
1. Proxy Server Settings (For Web Service) - These are applicable for Web Service command only. If your environment is using a

proxy server, specify the Host Name/IP Address and the Port Number.

Also See...

l Using the Auto-Login Option

l Configuring Web Recorder Settings

l Setting up Email Notifications

l Defining Client Hotkeys

l Setting View Options

l Using Run-Time Settings

l Using ROI Settings

l Customizing Task List View

Enable Debug Logging

The Enable Debug Logging feature helps you to collect logs that you can send to the Support Team of Automation Anywhere for invest-
igating the AAE Client issues, for example, when you are trying to troubleshoot issues.

When you enable debug logging, the system saves debug logs for the following applications and services of AAE Client:

l Main

l WorkBench

l Player

l Client Service

l Scheduler Service

l Metabot Designer

l EventWatcher

l FipsDataMigration

l Terminal Emulator

l Auto login service

l Proxy Server

To enable debug logging:

1. In the AAE Client, click Tools > Options > Advanced Settings on the Options screen.

2. Select the Enable Debug Logging check box.
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By default, logging is enabled for Error and Fatal issues. If you choose the Enable Debug Logging option, the system displays "Debug
logging enabled" message in bold red on the Status Bar.

For more information on how to export logs, see Export Logs in Using Advanced Settings.

You can find the logs for the Client applications in the Application Logs and services in the Service Logs sub-folders. You can find
them in the <Log file folder selected by you>\AAE_Client_Logs_<date>_<time> folder.

Application Log Path: <Application Path>\LogFiles

Service Log Path: Common Folder Path\Automation Anywhere Client Files\LogFiles

Note: By default, the system stores maximum ten log files of 1 MB each. The system overwrites existing
log entries if they cross this limit.

In case if you have different log configuration files for applications and services, then the Enable Debug Logging check box is dis-
played in the Indeterminate state and the system displays "Debug logging enabled" message on the Status Bar.

The following table shows the different states of Enable Debug Logging check box when you enable and disable the debug logging.

Services Applications States of Enable Debug Logging check box Description
Debug log-
ging is
enabled

Debug log-
ging is
enabled

The state of the check box is
set to selected when Debug
logging is enabled.

Debug log-
ging is dis-
abled

Debug log-
ging is
enabled

The state of the check box is
set to indeterminate when the
state of the debug logging is
different for Application and
Service or if someone edits
the log configuration file.

Debug log-
ging is
enabled

Debug log-
ging is dis-
abled

The state of the check box is
set to indeterminate when the
state of the debug logging is
different for Application and
Service or if someone edits
the log configuration file.

Debug log-
ging is dis-
abled

Debug log-
ging is dis-
abled

The state of the check box is
set to cleared, when debug
logging is not enabled for
both applications and service.

Note: If the debug log file is deleted accidentally, the system creates a new file using the default
settings when the Client applications are started or when you make any updates on the Options screen.

If the debug log file is corrupt, the system takes a backup of the existing file with file name <origFileName>_Date_Time_backup.xml
and it replaces it with the default log file when any application starts or when you open the Options screen.

For more information on how to clear logs, see Clear Logs in Using Advanced Settings.

For Auto Login, you need to configure Debug Logging manually in the Automation.Autologin.Settings.XML file because Auto Login still
follows the old logging and configuration mechanism. For more information, see"Enable Debug Logging for Auto Login" below.

Enable Debug Logging for Auto Login

To enable debug logging:

1. In your Windows Explorer, browse to C:\Users\Public\Documents\Automation Autologin/<yourusername>.

2. Edit the Automation.Autologin.Settings.XML file.

3. Include <log><debug>true</debug></log> within the <AutoLogin> XML element and save the XML file.
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4. Copy the edited Automation.Autologin.Settings.XML file to C:\Users\Public\Documents\Automation Autologin.

5. Create a folder with the name LogFiles for storing the debug logs in C:\Users\Public\Documents\Automation Autologin.
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Using Java Settings

A Java Plugin is required to enable automation (record and play) of Java applications. You can install the plugin using the Plugin Set-
tings option. Learn More

It is recommended that you install the Java Plugin from Plugin Settings and use the Java Settings option only to add the plugin to a spe-
cific JRE. Note that you will have to launch Automation Anywhere in the administrator mode in order to be able to configure the JRE set-
tings.

Note: From AAE 10 SP2 onwards, the desktop (standalone) Java applications (running on JRE 6 or later
versions) can be automated without installing the AAE Java Plugin as AAE provides support to automate
dynamic Java Applications (Standalone Java Applications that run from a packaged JRE). To automate web
based Java applications, you still need the AAE Java Plugin.

Applying Java Settings

Configure the Java settings, by clicking on Tools > Options > Java Settings.

Note: If any Java application is running, close the same.

Tip: Configure both 32 and 64 bit JRE settings if both used for recording web-based tasks. Then
toggle between 32 and 64 for recording using this option.

1. Select the appropriate JRE file from the location by clicking the browse button.

2. Select 32 or 64 bit configuration via a radio button. Click OK.

3. The Options window is invoked. Click Apply.
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4. You must confirm that you wish to copy the listed files to selected JRE folder

5. The settings are added to the 'Java Runtime Environment List'.

6. Click OK.

Tip: If you wish to delete the settings from the list, click the delete icon.

Note: It is possible to make deletions provided you are in the administrator mode.
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If you want to automate multiple Java Applications operating on different JREs, make sure that you add all those JREs to the Java Set-
tings.

Note: Ensure that while recording a Java application, you choose the right JRE from the list above
and click ‘Apply.’ Restart AAE and the JAVA application

You can get to know the JRE version of the Java Application from the Task Manager, as shown in the image below:

 For more details, you can refer Java Plugin Installation and Configuration
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Java Plugin Installation and Configuration

A Java Plugin is required to enable automation of Java applications. You can install the plugin from Plugin Settings. However, to
enable the Client to automate your processes that use Java applications, you need to configure a custom Java Runtime Environment
(JRE) from Java Settings.

Note: From AAE 10 SP2 onwards, the desktop (standalone) Java applications (running on JRE 6 or later
versions) can be automated without installing the AAE Java Plugin as AAE provides support to automate
dynamic Java Applications (Standalone Java Applications that run from a packaged JRE). To automate web
based Java applications, you still need the AAE Java Plugin.

The Java plugin can be installed from Plugin Settings. Learn More

Tip: It is recommended that you use Plugin Settings to install the Java Plugin; while use Java
Settings only to configure customized JRE.

Note: You will have to launch Automation Anywhere in the administrator mode in order to be able to
install Java Plugin and configure the JRE settings.

Installing Java Plugin

You can opt to install the plugin using either the user interface i.e. Plugin Settings or the command line for a silent installation. Refer
the article on Plugin Settings for details.

Configuring Java Settings for AAE Client

The following are the steps to configure Java Settings:

1. Make sure JAVA is installed on the machine that has Client.

2. Ensure that Client is open under the Admin mode (Right Click > Run as Administrator).
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3. Before you start to record JAVA application (desktop or Web), configure the settings in Tools > Options > Java Settings of Client.

4. In Java Settings, browse JRE from Program files > Java

5. If want to work with JAVA application using 32 bit JRE, select JRE from Program files (x86)/Java/JRE and select 32 bit radio option.
If want to work with JAVA application using 64 bit JRE, select JRE from Program files/Java/JRE and select 64 bit radio option.

6. Click OK.
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7. Now select the setting that you want to use, 32-bit or 64-bit.

8. Click OK.
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9. Click on Apply and you will see the plugin is added to the list.

10. If you want to automate multiple Java Applications (which use different versions of JREs) and ensure that you add all those JREs to
the Java Settings. The image below shows 3 JREs added to the Java Settings:

11. Exit & restart Client.

Note: Make sure both Client application & Java application is opened either normally or “Run
as Administrator”. But both should be in same mode.
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12. Open Java desktop or web app

Note: Make sure your Java app is using 32 bit JRE if tools has 32 bit Java settings. If Java
app is using 64 bit JRE, tools should have 64 bit java.

Specifically for JAVA desktop app: Through Command line you can externally open your JAVA desktop application either in 32 or
64 bit (moreover you can open Java application using different JRE versions of same bit e.g. 1.6 & 1.7).

13. After following the above mentioned steps, Start Recording the Java Application; you should be able to record correct controls with
Java Accessibility. (You can verify technology as “Java Accessibility’ from Client Command Editor)

14. Play test should play if all settings are matching as mentioned above.

15. If you create EXE of Java test & run on fresh machine has Java, Player should prompt you saying unavailable JRE settings & ask-
ing you to allow to add required files. Say “Yes” should inject require files in Java\JRE*\lib\EXT and Java\JRE*\bin. Then your Test
will fail/stop. Now replay the EXE, it should work.

Note: This applies for machine regardless of whether Automation Anywhere Enterprise is
installed or not.

Frequently Asked Questions

1. Why am I not able to Add/Modify Java Settings?
Open Client “Run as Administrator” & try.

2. How do I identify which JRE is used by my Java Application?
In TASK Manager, search for Java.exe or Javaw.exe & Right click on Go to Location to see JRE version/bit being used or Go to
Start > All Programs > Accessories > System Tools > System Information > Software Environment-Running Tasks > search for
Java.exe or Javaw.exe. Again check out the Path of JRE

3. I am not able to record/capture Java controls?
Ensure that before recording/capturing a Java Control, you have chosen the right JRE under Java Settings.

l Open the Java Settings under Tools> Optionsof Client
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l Select the appropriate JRE from the List on which your Java Application is running and Click on Apply.

l To check with version of JRE is used by the Java Application, open the Task Manager and add the ‘Command Line’ column

l Restart Client.

l You should now be able to record your Java

4. I am still facing problems to Record Java Controls? Why Updating New JRE Version, fails my Java Recording & Play? 
This problem is with 32 bit JRE only. Go to Program file (x86)\Java\JRE*\lib\EXT, remove “access-bridge-32.jar”

l Go to Program file (x86)\Java\JRE*\bin, Remove below files JavaAccessBridge-32.dll JAWTAccessBridge-32.dll Win-
dowsAccessBridge-32.dll.
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l Now open Client “Run As Administrator” & remove JAVA settings for 32 bit and Reset them again.

l Restart Client. Your recording & play should work

5. All the settings are correct, but Recording & Play does not work.
Make Sure settings are compatible with your Java app, 32 or 64 JRE.
If want to work with 32 bit JRE, make sure it is selected in Java setting & vice versa.
If correct then:

l Exit Client & Java application.

l Reopen both in same “mode”, either Run as Admin or Normally

l Start Recording & Play, Client should work.

6. Player does not play java test, even when all settings & mode are correct.
In Case of Player, Make sure to use Tools > Options > Runtime Settings > Run Task as an Administrator check box, as per
Requirement. 

l If Client & Java app, opened normally, uncheck “Run Task as an Administrator” & Play.

l If Java App is opened Run as Admin, Check “Run Task as an Administrator” & Play. 

l Same applies to Java test EXE created by “Create EXE” feature.

7. You will get an error as follows when automating a Java Application.
Restart the Java Application and re-run the automation task.

8. Other FAQs: http://java.com/en/download/faq/win8_faq.xml
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Using Run-Time Settings

The Automation Anywhere run-time settings enable you to customize how your automated task runs and performs, and helps to ensure
that it runs as expected.

After recording your task, you should check and adjust these settings. The run-time settings take effect, when you initiate a run of your
automated task.

Settings: An Overview

Note: Applicable to Windows 7 or later, in which user account control (UAC) is enabled. For other
operating systems or when UAC is not enabled, turn this setting off. For details refer Setting User Access
Control.

Run Task as an Administrator

Use this setting when running critical tasks for which a Windows prompt is issued asking for authorization to run a process. When this
setting is turned on, the user name and password of the computer administrator is required to be entered before the task can be run.

"Start In" Path of Task

Use this setting when a specific path is not specified in the Log-To-File command or other commands, in which a file or folder path is
required for running a task.

While the task runs, a new folder is created in the location specified in this setting field. After you apply this setting, all newly created
files and folders are located in this path location.

Internet Explorer Timeout

Internet connection speeds can differ widely. Hence adjustments are required to ensure proper running of a task which involves load-
ing web pages.

Use this setting to adjust the timeout value, based on your local internet connection speed or the time taken by the web page to load
completely.

For example, if you use a slow dial-up connection and experience frequent timeout errors while a task is running, adjust this setting to
increase the timeout period.

Capture Screen-shots while Running a Task

Use this setting to capture visual logs (screen-shots) as a task runs. You can turn this setting off by un-checking the check-box.
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Tip: Turning this setting off can enhance performance and free up hard drive memory.

For more information on capturing visual logs, see Using SnapPoint.

Also See...

l Using the Auto-Login Option

l Setting up Email Notifications

l Defining Client Hotkeys

l Using Advanced Settings

l Using ROI Settings

l Setting View Options

l Customizing Task List View
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Using ROI Settings

Automation Anywhere calculates the return on investment (ROI) that results from automating tasks.

The ROI is a cumulative savings amount in U.S. dollars that is calculated as you run automated tasks.

Note: The ROI calculation is based on cost of hourly time, run time, debug time, alert assistance
time, documentation time, training time, and knowledge capture.

l Click on Tools > Options > ROI Settings to change the hourly rate. Changes to this value will be reflected in future ROI calculations.

(Image as seen in Enterprise edition 9.0)

Also See...

l Using the Auto-Login Option

l Setting up Email Notifications

l Defining Client Hotkeys

l Using Advanced Settings

l Using Run-Time Settings

l Setting View Options

l Customizing Task List View
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Using Plugin Settings

Automation Anywhere provides you the option of installing/re-installing plugins that enable you to access UI objects in technology spe-
cific applications.

This functionality can be utilized when you wish to record and run:

l Web based tasks in Internet Explorer 11, Chrome, and Edge

l Applications that use Silverlight, Flex, and/or Java technologies

To install these plugins, go to Tools→ Options→ Plugin Settings.

Installing from the Options menu is convenient as not only does it allow you to confirm whether the plugin is installed, but also provides
an option to install plugins in case they fail to install during Client Installation.

Installing the Internet Explorer 11 Plugin

You will be needing to install the plugin if you wish to record and execute your web recorder tasks in Internet Explorer 11.

1. In order to install the IE 11 plugin, go to Tools→ Options→ Plugin

2. Click 'Install' in the column corresponding to 'IE 11'.

l Your installation process is complete when you see the confirmation message for the same.

Note: You can verify if the IE 11 plugin has been installed in the browser from Tools → Manage Add-
ons:
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Pre-requisites for installation

It is recommended that you run Automation Anywhere using the 'Run as Administrator' mode.

Windows Server 2012 users, please note that:

l The IE Advanced Security should be turned 'OFF'.

l The Enable Enhanced Protected Mode* in IE should be un-checked. (Go to IE Settings→ Internet Options→ Advanced tab →

Security.)

Installing the Silverlight Plugin

In order to be able to record tasks for applications that use Silverlight and consequently run them, you are required to install related plu-
gins. In your client, switch to 'Administrator Mode' (if not) and follow the given steps:

1. Go to Tools→ Options→ Plugin Settings

2. Click 'Install' in the column corresponding to 'Silverlight'

l The installation process begins.

l Your installation process is complete when you see the confirmation message for the same.
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Installing the Flex Plugin

In order to be able to record tasks for applications that use Flex and consequently run them, you are required to install related plugins.
In your client, switch to 'Administrator Mode' (if not) and follow the given steps:

1. Go to Tools→ Options→ Plugin Settings

2. Click 'Install' in the column corresponding to 'Flex'

l The installation process begins.

l Your installation process is complete when you see the confirmation message for the same.

Installing the Chrome Plugin

In order to capture objects in Google Chrome while using the Object Cloning command, you should have the Chrome Plugin
installed/enabled. You can install the plugin using any of two methods:

1. While installing the Automation Anywhere Enterprise Client. Refer the installation guide for details.

2. Using the 'Fix' option in the window that appears while recording:

3. Installing from Tools→ Options→ Plugin Settings menu by clicking install.

l Chrome Plugin is ready to install:
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l Your installation process is complete when you see the confirmation message for the same.

Tip: To add Automation Anywhere Enterprise extension in Chrome, use the 'Open Folder' option to drag
and drop the extension in the browser or use 'Fix'.

Command Line

You can also install the Chrome plugin using the command line in silent mode:

1. Launch the command window in administrator mode.

2. Go to the application installation path

3. Type the required parameter(s) as shown:

"C:\Program Files (x86)\Automation Anywhere Enterprise\Client\AAPluginInstallation.exe" /chrome /silent

Note: It is important to leave a space before specific parameters as shown in the above
example.

Tip: The silent parameter installs the plugin in silent mode, which restricts the system from
displaying any messages.

Installing the Java Plugin

To enable automation (record and play) of applications that use Java technology, you must install the Java Plugin. You can use the
user interface or the command line to install the plugin.

Note: From AAE 10 SP2 onwards, the desktop (standalone) Java applications (running on JRE 6 or later
versions) can be automated without installing the AAE Java Plugin as AAE provides support to automate
dynamic Java Applications (Standalone Java Applications that run from a packaged JRE). However, to auto-
mate web based Java applications, you will still need the AAE Java Plugin.

User Interface

1. Run the application in administrator mode.

2. Go to Tools→ Options→ Plugin Settings

3. Click on 'Install' for Java:

l The Java Plugin is installed.

 Note: This automatically configures all installed JRE and are listed in Java Settings. Refer Java Set-
tings.
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4. Click on OK:

Command Line

You can use the command line to install, reinstall, and uninstall the Java plugin. You can also install the plugin in silent mode.

To /install /reinstall /uninstall from the command line,

1. Launch the command window in administrator mode.

2. Go to the application installation path

3. Type the required parameter(s) as shown:

C:\Program Files(x86)\Automation Anywhere\Enterprise\Client> AAPluginInstallation.exe /java /in-
stall /silent /"C:\Program Files\Java\jre1.8.0_112"

Note: It is important to leave a space before specific parameters as shown in the above
example.

Tip: The silent parameter installs the plugin in silent mode, which restricts the system from
displaying any messages.

Parameters

1. /install - Install the java plugin.

2. /uninstall - Uninstall the java plugin.

3. /reinstall - Reinstall the java plugin.

4. /silent - Silently Install/uninstall/reinstall java plugin

5. /jrePath - Path of JRE in which user wants to install java plugin.

Installing the Edge Plugin

Available only for machines that run with Microsoft Windows 10.

To enable recording of web-based automation for Microsoft Windows 10, you can install the Edge plugin using any of the three meth-
ods:

1. While Installing the Client

2. From Tools menu in the Client

3. From command line

Important: You must close all open instances of Edge browser sessions on your machine before
installing the plugin.
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1. You can install the plugin while installing the AAE Client. Refer the Client Installation Guide for details.

2. From AAE Client Options in Tools menu:

a. Run the application in administrator mode.

b. Go to Tools→ Options→ Plugin Settings:

c. Click for Edge

d. The Edge plugin is installed.
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e. You should enable the extension from settings of Edge browser.

Refer Microsoft link for details on adding extensions in Edge browser.

f. The plugin shows up in the extension pane once you enable the plugin:

3. From command line:

a. Run the command prompt in administrator mode

b. Go to the application installation path

c. Type the required parameter(s) as shown:

C:\Program Files(x86)\Automation Anywhere\Enterprise\Client> AAPluginInstallation.exe /edge
/install /silent

Note: You can also reinstall the plugin using the command line. Use Reinstall parameter
instead of install.

Tip: The silent parameter installs the plugin in silent mode, which restricts the system
from displaying any messages.

Parameters

1. /install - Install the Edge plugin.

2. /uninstall - Uninstall the Edge plugin.

3. /reinstall - Reinstall the Edge plugin.

4. /silent - Silently Install/uninstall/reinstall Edge plugin

https://docs.microsoft.com/en-us/microsoft-edge/extensions/guides/adding-and-removing-extensions
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Reinstalling/Uninstalling Plugins

If, at any given point of time, you wish to reinstall or uninstall the plugin(s), you can simply click the ' Reinstall' or 'Uninstall* ' link in Plu-
gin Settings:

* Uninstall and Reinstall is available as an option for IE 11, Edge and Java plugins only.

To Uninstall plugins, follow these steps:

1. IE-11 - Use the 'Uninstall' link provided in the Plugin column (see above image).

2. Silverlight - Uninstall the 'Microsoft Silverlight' program from Control Panel → Uninstall or change a program.

3. Flex - Uninstall 'Adobe Flash Player xx NPAPI' from Control Panel → Uninstall or change a program.

 Note: AAE does not have the provision to uninstall Silverlight and Flex/Flash plugins as they
could be in use by other applications.

4. Chrome - Uninstall the 'Chrome' plugin from Chrome → Extensions page. 

 Note: AAE does not have the provision to uninstall this plugin from Tools → Options → Plugins.

5. Java - Use the 'Uninstall' link provided in the Plugin column (see above image) and follow the below steps:

1. Clear the ‘Enable Java Access Bridge’ check-box from Control Panel → Ease of Access→ Ease of Access Centre → Use
the computer without a display.

2. Delete the two files - Automation.JavaAccessBridge64.dll and WindowsAccessBridge-32.dll from the AAE Client installation
location.

6. Edge - You can use one of three methods to uninstall Edge.

a. Use the Uninstall link provided in the Plugin column

b. Use the uninstall option from the extension in Edge browser
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l The plugin is uninstalled successfully:

c. Use the command line:

a. Run the command prompt in administrator mode

b. Go to the application installation path

c. Type the required parameter(s) as shown:

C:\Program Files (x86)\Automation Anywhere\Enterprise\Client> AAPluginInstallation.exe
/edge /uninstall
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Configuring Web Recorder Settings

Available from version 9.0 onward.

To automate your web enabled tasks in Automation Anywhere, you can configure the 'Web Recorder' settings from Tools > Options >
Web Recorder Settings.

For Recording

1. Record on Mouse Down - Select this option to record a task with the help of Web Recorder using mouse down event i.e. while
scrolling.

For Play Time

1. Internet Explorer Time Out - Define the time (in seconds) within which the Internet Explorer browser should wait till the required
page uploads.The maximum time out allowed is 240 seconds.

2. Parallel Threads to Find Broken Links -Use this to input the number of broken links that can be processed at a time. Default is set
at 10.

3. Find Broken Links Time Out - Use this to allow the web recorder to wait for the 'Broken Link' to exist. Default is set at 10.

General Settings

1. Launch Internet Explorer as a Process - Enable this option while recording in stringent security environment.

Also See...

l Using Advanced Settings

l Using the Auto-Login Option

l Setting up Email Notifications

l Defining Client Hotkeys
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Copyright © 2018 Automation Anywhere, Inc. 485 https://support.automationanywhere.com

Customizing the Task List View

At times, for ease of use you might want to remove certain columns from being displayed in the Task List.

You can customize your view of the Task List columns by following these steps:

1. From the main Automation Anywhere window, click on View -> Columns Displayed.

2. Add, remove, or reorder columns in the display.

3. Save, cancel or reset your changes to the display.

Adding a Column

Select a column from the list of available columns and click Add.

The newly added column is displayed in the list on the right.

Removing a Column

Select a column from the list on the right depicted below the text 'Show these columns in this order:' and click Remove.

The column is removed from the list and is added back to the list on the left side (Available Columns)

Note: The File Name column is required and cannot be removed from view.

Reorder Columns

Use the Move Up and Move Down buttons to change the left-to-right column position in the view. The columns that are listed from top-
to-bottom are displayed in the Task List view from left-to-right.

Save Changes

Click Save to save any changes you make to the view and apply them to the Task List.
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Cancel Changes

Click Cancel to abandon any changes you make to the view.

Reset Display to Default

Click Reset to restore the default column settings in the Task List view.

Note: The default column order is: File Name, Type, Repeat, Status, and Last Run Time.

Also See...

l Using Auto-Login Option

l Setting up Email Notifications

l Setting View Options

l Using Advanced Settings
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l Defining Client Hotkeys
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Setting User Access Control and Data Execution Prevention

In some cases, when using Automation Anywhere on Windows 7 etc User Access Control (UAC) and Data Execution Prevention (DEP)
settings need to be modified.

To ensure smooth operation on machines that run on OS Windows Vista and above, follow these steps:

1. Check to see whether User Access Control (UAC) is turned on for the computer that is running Automation Anywhere:

l On the Windows desktop, click on Start > Control Panel > User Accounts > Change User Account Control Settings.

l Drag the slider to the bottom so that the setting is on "Never Notify".

2. Add Automation Anywhere to the list of exceptions under Data Execution Protection (DEP):

l On the Windows desktop, click on Start > Control Panel > System > Advanced System Settings.

l On the 'Advanced' tab, click the 'Settings' button in the 'Performance' area.

l Click on the tab "Data Execution Prevention" and select the option "Turn on DEP for all programs and services except those
I select:"

l Click on the 'Add' button, and add the Automation Anywhere.exe (Program Files (x86)\Automation Anywhere) folder to the
list.

l Click on Apply and then OK.

3. Reboot the computer to ensure that the new settings take effect.

Also See...

l Using Auto-Login Option

l Setting up Email Notifications

l Defining Client Hotkeys

l Setting View Options

l Using Advanced Settings

l Using Run-Time Settings

l Using ROI Settings

l Customizing the Task List View
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Section: Using Special Features
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Using the OCR Feature

The OCR Feature command provides the following options:

l Capture Window: Specify the window title. Automation Anywhere captures the window as an image.

l Capture Area: Specify a specific area of the window to capture.

l Capture Image By Path: To extract text that is contained within an image that is stored on your local or network drive, specify the
location of the file. The drive must be accessible when you run the task.

l Capture Image by URL: Specify a website URL that contains the image you want to capture.

Using Keywords to Identify Captured Text

To make specifying the target text to capture easier, use the Before and After keywords. For example, in the text string "Name: ABC Inc.
Location:", to copy only "ABC Inc.," specify Before = "Location" and After = "Name:". You can also trim the captured text to remove lead-
ing and trailing spaces.

Also See...

l Using Image Recognition

l Using SnapPoint

l Using the Report Designer

l Using the ROI Calculator
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Using Image Recognition

Use the Image Recognition feature to compare many large images and automate application processes using visual elements.

For automated testing, Image Recognition can be used for user interface validation. You can compare a current application screen to
an expected application screen, as well as ensure that all user interface elements are valid.

Using Image Recognition, you can do the following:

l Locate an image within another image that is saved in a file or captured from a window at run time. The image is captured dynam-
ically at run time in a window that you specify.

l Specify the minimum percentage match for which you want the command to return true.

l Left-click, right-click, or double-click the image if it is found within the larger image.

l Capture images from BMP, JPG, and GIF file formats.

l Compare images with two modes: Tolerance and Comparison Mode.

l Tolerance Mode: Compares images having light and dark colors. It performs the color grading check.

Specifying a 0% tolerance compares exact pixel color with the source image. Specifying a tolerance of 10% compares
the 10% (plus/minus) color shade with the source image.

l Comparison Mode: Provides the following options:

l Normal mode: Compares the RGB components of the pixels with the source.

l Gray-scaled mode: Converts the pixel to gray scale and then performs a comparison.

l Monochrome mode: Converts the pixel to either black or white and performs the comparison.

When you 'Enable' Secure Recording

Note: If you enable ‘Secure Recording mode’, ‘Image1’ and ‘Image2’ are not captured. Learn More

Note: While ‘Secure Recording mode’ is enabled and you try to capture ‘Image2’ an error message appears
“Secure Recording mode. Ensure that the ‘Image2’ does not show any secure data.”
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Using SnapPoint

Use the SnapPoint feature to add screen shots to an automation task or to recapture screen shots when a task is running.

Capturing Images While Recording Tasks

Automation Anywhere provides a state-of-the-art technology for capturing and displaying screen shot images as you create automation
tasks.

Note: If you enable ‘Secure Recording mode’, no images are captured. Learn More

To capture screen shots, click on the Tools menu, select Options, and select Advanced Settings. Click on Capture Screenshots While
Recording.

You can re-size and move images inside the Workbench to place them in a desired location. The captured image is the active window
during recording, and shows you exactly where your mouse cursor is located.

For example, in the following screen shot, line number 24 in the task, Mouse Click: Left Button on 2 in Calculator, and the cor-
responding image showing the Windows calculator.

Using the Visualize Tab

Use the Visualize tab in the Workbench to view a complete graphical layout of the current task. The following screen shot shows a task
after having clicked on the Visualize tab. The example shows that you clicked Start, then Run, then OK in the Run window, then num-
ber '1' in the calculator.
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Setting SnapPoints to Refresh the Images

When you create a task manually using the Workbench, or you modify a recorded task, the images that you captured during recording
might not remain the most current. Automation Anywhere provides a convenient way to refresh the images, called SnapPoints.

To set SnapPoints, click the Set SnapPoint button. You can now set SnapPoints in the column to the left of the line numbers, as shown
below. When you run a task after setting SnapPoints, Automation Anywhere recaptures the images for those commands on which you
set SnapPoints.

The images are captured after the task runs.
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Commands that Support SnapPoints

The following commands support SnapPoints:

l Insert Keystrokes

l Insert Mouse Click

l Prompt

l Excel

l Web Recorder

l Window Actions

l Message Box

l Manage Windows Controls

l Screen Capture

When you 'Enable' Secure Recording

Note: If you enable ‘Secure Recording mode’, no images are captured. Learn More

Note: When you click on ‘Visualize’, it is disabled while 'Secure Recording' is on.

Note: If the ‘Secure Recording Mode’ is enabled, ‘SnapPoint’ is disabled. Also, if you try to enable
Snap view whilst ‘Secure Recording Mode’ an error message “Secure Recording mode. Image have not been
captured during recording” appears.

https://support.automationanywhere.com/hc/en-us/articles/231173467-Using-the-Secure-Recording-mode
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Using the Report Designer

Use the Automation Anywhere Report Designer to run reports for your automation projects. These reports gives a graphical rep-
resentation of automated tasks over a period of time. It also displays the ROI for an organization using Automation Anywhere products.

In This Section

l What is a Report?

l Running Reports

l Saving Reports

l Sending Email Notifications for Reports

l Scheduling a Report to Run

l Triggering a Report to Run

l Viewing a Report Graphically
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What is a Report?

Reports are important feature to measure the success and calculate the ROI that Automation Anywhere brings to your organization
with respect to time.
Automation Anywhere provides graphical reports that display the status of tasks and workflows, as well as the ROI over time.

You can view the following types of reports:

Task Run: Displays how many times a task has run successfully, and how many times it has failed during the period. You can view this
report for:

l All Tasks saved in the default location, i.e., My Documents\Automation Anywhere\Automation Anywhere\My Tasks

l Tasks in a specified folder

l Selected tasks.

To graphically view your Task Run, see the Visualize Report.

Workflow Run: Displays how many times a workflow has run successfully and how many times it has failed during the period. You can
view this report for:

l All workflows saved in the default location, i.e., My Documents\Automation Anywhere Files\Automation Anywhere Files\My Work-
flow

l Workflows in a specified folder

l Selected workflows

Task Timeline: Displays task history in a graphical time line. Select a task and time line to view the number of times a task was run or
modified during the period. It also shows whether the task was created or deleted during that time. You can view this report for:

l All tasks saved in default location, i.e. My Documents\Automation Anywhere Files\Automation Anywhere Files\My Tasks

l Tasks in a specified folder

l Selected tasks

Workflow Timeline: Displays workflow history in a graphical time line. You can select a workflow and a time line to see the number of
times the workflow was run or modified during the time period. It also tells you whether the workflow was created or deleted during that
time. You can view this report for:

l All Workflows saved in default location, i.e. My Documents\Automation Anywhere Files\Automation Anywhere Files\My Workflow

l Workflows in a specified folder

l Selected workflows

ROI: Displays how much USD/Dollar Value has been saved by using Automation Anywhereduring the time period.

Visual Logs: Graphically displays tasks that have run by providing step-by-step SnapPoints for each action in a task.
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Running Reports

How do I run a report?

Running a report is simple.

To run a report, simply specify your criteria in the Report Designer and click Run Report.

To run a saved report, double-click the report file in the Task List, or select the report in the Task List and click Run.

Also See...

l What is a Report?

l Saving Reports

l Sending Email Notifications for Reports

l Scheduling a Report to Run

l Triggering a Report to Run

l Viewing a Report Graphically
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Saving Reports

How do I save a report?

To save a report after specifying the criteria, click Save and Run Report.

Automation Anywhere stores your selections and saves the report as a template for future use.

If you want to save a report as an image, click on the File menu and select Save As Image.

Also See...

l What is a Report?

l Running Reports

l Sending Email Notifications for Reports

l Scheduling a Report to Run

l Triggering a Report to Run

l Viewing a Report Graphically
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Sending Email Notifications for Reports

Using the Notification property, you can automatically send an email notification after a report completes.

The email includes the report as an image, as well as other helpful information.

Also See...
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Scheduling a Report to Run

Using the Automation Anywhere scheduler, you can schedule a report to run at a specific time.

To schedule a report to run, follow these steps:

1. In the Task List, select the report.

2. Select Schedule.

3. Specify the scheduling parameters.

Also See...
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Triggering a Report to Run

Using the Automation Anywhere trigger feature, you can run a report based on a trigger event.

To trigger a report to run, follow these steps:

1. In the Task List, select the report.

2. Select Trigger.

3. Define your trigger.

You can use the Notification property to send an email notification after the trigger event runs the report. For more information, see
Sending Email Notifications for Reports.

Also See...

l What is a Report?
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Viewing a Report Graphically

Automation Anywhere provides a step-by-step graphical view of all tasks run. To turn on the Visualize view, follow these steps:

1. Click on the Tools menu, and select Options.

2. Click on Advanced Settings.

3. Check the 'Capture Screenshots While Recording a Task' check box.

4. Click the Apply and OK buttons.

5. To view your task graphically, simply click on the bar representing the task using the Task Run report view.

If SnapPoints are not supported by the task, a message is displayed to notify you immediately.

Using the Visualize Report, you can:

l View the number of days that the task has run during a specific date range.

l View a specific day and the number of times that a task has run during that day.

l Compare your tasks using all of the saved SnapPoints in the task folders (..My Documents\Automation Anywhere\SnapPoints).

Also See...

l What is a Report?

l Running Reports
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Using the Workflow Designer

To assist you in designing and improving your business workflows, Automation Anywhere provides a Workflow Designer tool. The
Workflow Designer helps you build Workflow flow diagrams in a graphical environment. You can subsequently use these Workflow to
build and run automated Workflows using Automation Anywhere.

Overview

A Workflow shows a high-level, graphical view of your business or IT Workflow, with a representation of conditional logic and Workflow
flow. Some Workflows might be simple, some more complex.

The Workflow Designer provides an intuitive, drag-and-drop interface to help you quickly design your workflows.

Creating a Workflow?

To create a new Workflow, follow these steps:

1. Click on the Tools menu and select Workflow Designer. The Workflow Designer provides the following design objects:

l Start: The starting point for the Workflow. Each Workflow can have only one Start object.

l Run Task: Runs a previously built task (.atmx file). Before proceeding to the next Workflow step, the Workflow stops until the
Run Task command is completely finished.

When you insert a Run Task object, it displays one Successful arrow and one Unsuccessful arrow. Both arrows are required for
a complete Workflow. If you accidentally delete one of these arrows, move the mouse over the Run Task object and pull
another arrow over to connect it with the desired object.
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Note: You can edit a task from the Run Task list by right-clicking the task and viewing the
menu.

l Conditional (If): Provides an event condition on which the subsequent steps in the Workflow depend. Based on the result of the
condition (True or False), the Workflow moves along the appropriate path to next steps.

When you insert a Conditional object, it displays one True arrow and one False arrow. Both arrows are required. If you acci-
dentally delete one of the arrows, move the mouse over the object and pull another arrow over to connect it with the desired
object.

Use multiple AND or OR conditions*- You can include 'AND' or 'OR' conditions when you wish to include multiple conditions in
the same command.

* Available from version 7.5.2 onward

Refer If Else Command to know how.

l End: The end of the Workflow. When the Workflow reaches this object, execution is stopped.

l Arrows: Connects objects and pathways in the Workflow. To insert an arrow from any object, move the mouse over the object until
the mouse icon changes to a hand icon: 
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Tip: Prior to running a Workflow or exiting the Workflow Designer, always validate the Workflow. Val-
idation ensures that your Workflow objects are correctly connected and that errors do not occur.

Running a Workflow

To run a Workflow from the Workflow Designer, click on Run or double-click the Workflow file in the Task List.

When you run the Workflow within the Workflow Designer, Automation Anywhere indicates the path followed in the Workflow. For
example, you can easily see whether a True or False condition occurs.

After a Workflow has completed a run, the Workflow Designer highlights the complete path in color.
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Repeating a Workflow

To repeat a Workflow, use the Repeat property. The Workflow will run again.

Sending Email Notification for a Workflow

To send an email notification when a Workflow run is complete, use the Notification property.

Saving a Workflow as an Image

To save a Workflow as an image, click on the File menu and select Save as Image.

Printing a Workflow

To print a Workflow, click on the File menu and select Print.

Scheduling a Workflow to Run

You can schedule a Workflow to run using the Automation Anywhere Scheduler. Refer Scheduling Tasks to Run.

Triggering a Workflow to Run

You can use triggers to schedule a Workflow to run. Refer Scheduling Tasks Using Triggers.

Associating Workflow Variables to Task Variables

Workflow variables can be associated with various tasks. The associated variable is clearly shown in Run Task command.

Only type of variable association should be same, the names of variables can differ. 

Steps to associate Workflow variable to task variables:

1. Click the Run Task command.

2. Select Task using Browse. 

3. Select Variable option as action.

4. Create variable association section appears.

5. Select Worflow Variables from drop down list and associate them with the drop down of list for the Task Variables.

Use the 'Quick Map' button if you have a large set of variables to associate *.
* Available from version 8.1 onward.
Refer Run Task Command for details.

6. Associate workflow variables to task variables using Run Task > Variable option.

l Both drop downs will only display Value type of variables defined.
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7. Use Add button to add more variable association of Workflow to Task. 

8. Select an association and use Delete button, to remove it.

Note:

1. If there are changes to the task variables type or source, the association will be invalid.             

2. If there is change in application path of a task, the association will be updated automatically. However, one needs to manually
Save the workflow.

3. The SAVE button is enabled for these workflows with an appropriate message.

Also See...

l Using SnapPoint

l Using the Report Designer

l Using the ROI Calculator

l Using Variables
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Using the ROI Calculator

Use the ROI Calculator as a planning tool that calculates your return on investment (ROI) on process improvement.

The ROI calculator makes the following calculations:

l Resource costs for time saved

l Reduced error rates

l Automated troubleshooting

l Automated documentation

l Resource realignment

l Training benefits

l Knowledge capture

Automation Anywhere calculates the ROI based on the results of automating processes. The ROI is a cumulative dollar amount from
running tasks.

As the basis for the ROI calculations, you can set the hourly personnel rate to calculate hourly savings. For more information, see the
'ROI Settings' in the ROI Calculator.

To make the ROI calculations easy to understand and useful in sharing, you can view the ROI as a graphical chart.

Note: You can reset the ROI at any time by clicking 'Reset ROI' button.

You can also generate ROI related reports using the Report Designer as shown:
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Section: Communicating with Control Room
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Uploading and Downloading Tasks to the Server

This topic describes how to use the Repository to move automation tasks to and from the server.

l The Automation Anywhere client provides an easy-to-use facility for communicating with the server.

l To launch the Repository facility, click on the Repository tab on the main client screen.

l Ensure the client is already registered with the server.

You can use the Repository to perform the following tasks:

l Transferring tasks between the client and server.

l View the date and time that a task was last modified on the client or the server.

l View any new tasks that have been created on a client or uploaded to the server.

l Compare task files to identify differences between versions of the files that reside on the client and server.

Refer Comparing Files that Reside on the Client and Server for details.

Uploading a Task to the Server

You can upload tasks to the server (or the Control Room Repository Manager using any of the four methods:

1. Selecting Upload from the Action button drop-down list

2. Clicking the 'Upload' button at the top right 'Task List' pane

3. Right clicking the selected task and choosing 'Upload'
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4. Selecting the task from the Repository:

l When the task is successfully uploaded, a confirmation window is displayed. Click OK.

l The task is displayed in the Server Repository Manager.

Note: If you have configured Version Control, you will have to add comments while uploading the
task. Learn More

Downloading a Task from the Server

To download a task from the Server (or Control Room Repository Manager), you must use the Repository facility. Follow these steps:

1. In the main Automation Anywhere window, click on the Repository tab. The Repository facility is displayed, with a split screen show-
ing files that reside on the server as well as the client.

2. Highlight the task file that you want to download to the client.

3. Click the Download button. The task is copied to the client.

Note: Be aware that files that are downloaded to the client with same names will be overwritten.
Before downloading files, be sure that the latest version of the task is on the server.

Also See...

l Comparing Files that Reside on the Client and Server
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Comparing Files that Reside on the Client and Server

Your team of automation users can create, upload, edit, and run many tasks, moving task files between the client and server. Main-
taining several copies of task files and having multiple users modify single tasks can require the need for users to view how and when
a task file was last changed.

This topic describes how to compare versions of task files that reside on the client and server.

Using the Compare File feature, you can compare two different versions of a task file to identify any recent changes. You can view
these differences by using the Task Actions List panes that are generated after running the comparison.

To run a comparison of two task files, follow these steps:

1. Launch the Repository facility by clicking on the Repository under Manage tab on the main client screen. Make sure that the client
is already registered with the server.

2. Highlight the task file you would like to compare by clicking once on the file name, either in the Server or Client pane. In presence
of a file with duplicate name in the Client or Server, the Compare button is enabled.

3. Click on the Compare button to run the comparison. A new window is launched, displaying the comparison results.

l If no differences between the files are found, the message "No differences found." is displayed at the top.

l If differences are found, the number of differences is displayed at the top.

l Differences in the task file actions are displayed in the following colors:

n BLUE: Changed. Task actions that have been changed are marked in blue.

n GREEN: Inserted. Task actions that have been newly inserted are marked in green on the client, and are shown as a blank
line on the server.

n RED: Deleted. Task actions have been deleted are marked in red on the server, and are shown as a blank line on the cli-
ent.
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Also See...

l Uploading and Downloading Tasks to the Server
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Section: MetaBots - Getting Started
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AAE Client MetaBot Designer Overview

A MetaBot is a highly re-usable automation blueprint of an application. This automation blueprint can be constructed using:

l Visual captures - These are GUI components (screens) of an application.

l In MetaBot Designer, a visual capture is referred to as Screen.

l Application APIs - These are interfaces that allow low level operations of an application by circumventing GUI.

l The MetaBot Designer also supports the most common format of API on Windows platform – the DLL.

l Navigational flows - These are pre-configured use cases of an application and leverage Visual captures and APIs.

l In MetaBot Designer, Screens and DLLs form the Assets using which you can define and pre-configure any use case of a
target application to create a navigational flow, known as Logic.

Learn More

Benefits of using MetaBots

Using MetaBots in automation tasks have the following benefits:

l MetaBots are highly re-usable; create once, use everywhere. They show up in automation command library in AA Enterprise and
can be leveraged by any automation task.

l Enterprises can leverage MetaBot library to standardize org-wide automation in a rapid manner.

l MetaBots ensures systematic, accelerated automation ROI.

l MetaBots help to eliminate common navigational errors in complex automation tasks.

l MetaBots help to automate without requiring access to live application

l MetaBots can be easily calibrated to newer versions of applications to ensure compatibility.

The MetaBot Designer

The MetaBot Designer helps you to conceptualize, create, manage and upload MetaBots.

With MetaBot Designer, you can:

l Create MetaBots.

l Add Assets – Screens and DLLs to your MetaBots.

l Manage your MetaBot Assets.

l Configure and Calibrate the Screens.

l Create custom objects on the Screens.

l Create Logic to represent a navigational flow using Screens and DLLs.

l Upload the MetaBots to the Control Room for use by other Enterprise Client users.
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l Edit MetaBots created by other users.

l Export and Import MetaBots for use in different Control Room setups.

Installing the MetaBot Designer

The MetaBot Designer comes pre-installed with Automation Anywhere Client.

To access MetaBots, the Client user has to have the required access privileges that are provided by the Control Room administrator.

l To do a quick check that MetaBot Designer is installed and working fine, ensure that you see MetaBots under AUTOMATE on left
panel.

l Click on MetaBots tab to launch the My MetaBots view. 

l If you are using MetaBots for the first time, the list does not display any file. You can simply start creating MetaBots using
either New or Record option. Learn More

l However, if you have upgraded to the current version, you will see MetaBots created in earlier version(s) listed under My
MetaBots.

l To access the MetaBots Designer console, you need to click on Edit. Learn More

Launching the MetaBot Designer

After successful installation of Automation Anywhere Client setup, the feature is added to the product under the Automate Tab.

Note: You will have to exit and restart Automation Anywhere Client for the changes to take effect,
if you have upgraded to the current version.

Click on 'MetaBots' to launch the Enterprise Client - MetaBot Designer.

Understanding Enterprise Client - MetaBots

A BotCreator Client with MetaBots Repository access permissions can create, record, edit, upload, download, and rename MetaBots
from the Client - My MetaBots list view.

From the Enterprise Client - MetaBots view, a BotCreator can create a new MetaBot, record screens for a new MetaBot, upload and
delete MetaBot(s).

Additionally, if Version Control is enabled for controlled edits of MetaBots, a BotCreator can Check Out the MetaBot for editing and
view Version History. Learn More

From the My MetaBots list view, a BotCreator can perform the below actions:
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1. New - Use this to create a New MetaBot. Learn More

2. Record - Record is an alternate method of creating a MetaBot. Learn More

3. Delete - Use this to delete obsolete MetaBots or ones that are no longer required. Learn More

Some of these features are also accessible from the MetaBot Designer console. Learn More



Copyright © 2018 Automation Anywhere, Inc. 521 https://support.automationanywhere.com

Understanding MetaBot Designer

Using the MetaBot Designer, you can:

l Specify folders in an existing MetaBot,

l Add DLL's to create low level operations of an application by circumventing GUI

l Add and record new screens to a MetaBot;

l Create simple independent yet functional logic blocks.

l Also, create MetaBots and upload them to Control Room to create a repository for using/reusing MetaBots in automation tasks.

MetaBot Designer Decoded

The work space in MetBot Designer allows you to work with multiple MetaBots at the same time. MetaBots that you wish to work on can
be kept open in the form of tabs.

Once you create a MetaBot, you are taken to Assets tab by default where in you can start by adding new assets (Screens/DLLs).
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Understanding Assets

The following explains the options available within an Assets view:

1. MetaBot Tab - The MetaBot opens in its own tab. This tab is dedicated to the Assets and Logic for that particular
MetaBot.

2. Assets Tab - When highlighted it indicates that the view is open in 'Assets'; it displays all the Screens, DLLs and
Folders inherent to this particular MetaBot. It is selected by default for a new MetaBot.

3. Add Folders* - You can organize your MetaBot using 'Folders'. This will enable you to easily manage all your
screens and dll's that are to be uploaded/have been uploaded.
Learn More

4. Add Screen* - When you require to capture a single screen for an application executable that is running, this feature
is extremely useful.
Learn More

Note: You will have to invoke the application screen before using this feature.
Also, if the application is closed, you will be prompted to open the required applic-
ation.

*If your Screens are set at lower resolutions; e.g. 1024 X 768, the 'Add Folder' and 'Add Screen' options can be
accessed from the 'Edit' menu.

5. Record Screen - When you need to capture multiple screens of the related application/webpage at one go, use
Record Screen. Every screen / Menu item / Popup / context menu that you interact with during the recording gets cap-
tured.
Learn More

Tip: Use Record Screen to record all the Screens/UI elements (Menu item / Popup /
context menu etc.) while you interact with the application in a workflow mode. These
UI elements cannot be captured using Add Screen.

Note: If an application has multiple exe's, you are required to create a separate
MetaBot for each.
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6. Add Dll - If you need to use an 'Application Programming Interface’ (DLL) within your MetaBot, you can add it to the
MetaBot using 'Add Dll'. Remember though, you cannot include special characters in DLL names.
Learn More

Note: The Screens, DLLs and Folders are displayed in the order they were added.

7. Configure - Use this to edit properties for the recorded/added screen. Here you can provide aliases such as a
'Screen Name' and a 'Screen Title'. You can also select an object to define its properties such as Name, Path, Value,
ID, Class, Index, States etc and the 'Play Mode' to be used when running tasks. Some of these properties help to
uniquely identify an object during playback. You can thus use configure to improve the reliability of your automation.
Learn More

8. Calibrate - Since an application may get updated continually during its lifecycle with improvements and newer fea-
tures, your captured screen and its object properties might need a re-look after every update of the application. In
MetaBots Designer you can use ‘Calibrate’ to instantly compare an existing screen with a newer screen to identify
changes if any.
Learn More

9. Upload - The MetaBots can be 'uploaded' to the Server i.e. uploaded to the Control Room, which acts as the central
library from where fellow MetaBot Designers can pick up the MetaBots necessary to their task(s). The client with
MetaBot privileges can upload and deploy the MetaBots to the server.
Learn More

10. Delete - Use this to delete MetaBots that are no longer required.

Note: Deleting a MetaBot from the MetaBot Designer doesn’t delete it from Control
Room.

Once you have captured the desired assets, move on to create Logic using those assets.
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Understanding Logic

A Logic is an independent yet functional unit of a process that represents a part navigational flow of an application and
can be integrated into automation tasks as and when required.

You can use Assets (Screens and DLL's) to design a Logic block. Subsequently, you can upload the Logic Blocks to
Control Room so that they can be downloaded to Development/Runtime Client(s) with appropriate MetaBot privileges.

The following explains the options available within a Logic view:

1. MetaBot Tab - The MetaBot opens in its own tab. This tab is dedicated to the Assets and Logic for that particular
MetaBot.

2. Logic Tab - When highlighted it indicates that the view is open in 'Logic'; it displays all the Logic Blocks and Folders
inherent to this particular MetaBot.

3. Add Folder - Similar to Assets; for instance, you can add Logic Blocks that are functionally similar to a folder.

4. Add Logic - Use this to create your navigational flows in the Logic Editor.
Learn More

5. Record Logic - Use this to record the logic flow and automatically save Screens in Assets.
Learn More

6. Edit - Use this to edit an existing navigational flow.

7. Upload - Use this to publish (upload) your (new or edited) Logic to the Control Room.
Learn More

8. Delete - Use this to delete obsolete Logic.

Note: The Logic and Folders are displayed in the order they were added.
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Creating a MetaBot

Let’s create your first MetaBot. It will allow you to add vendors to your Inventory Management System.

1. Open the MetaBot Designer and click on New.

2. A smaller window, New MetaBot, opens which lists all currently running applications on your machine.

3. Opt to create either a MetaBot with a single application or with multiple applications. When you choose Application Specific option,
you can create automation using screens only from that particular application. Whereas when you choose All Applications option,
you can create automation using a combination of screens from different applications per your automation flow.

4. Select a folder in which you want to store the MetaBot by clicking the browse button. This launches the Select Folder window:
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Tip: Save your MetaBots to logically created folders. These can be created by clicking :

l To select a default folder to save your MetaBots click Set Default.

l Click OK to return to the New MetaBot window.

5. For easy understanding, lets create a MetaBot using a single application. Select Application Specific .

6. From the list, select an application (inFlow Inventory in this case) for which you want to create a MetaBot. Type in a name - “inFlow
Inventory - Create Vendor.”

7. Click Create.
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Tip: If you forgot to launch the application before starting to create a MetaBot for it, just
open it now and click on Refresh on the New MetaBot window. Your application will appear for
selection in the list.

8. This creates and opens a new but empty “inFlow Inventory - Create Vendor.”. It cannot do anything for you yet.

9. To create a vendor in the application, we need its screen asset. Click on 'Add Screen'.

10. On the center of your screen, a small window Open Screens is displayed. This window will show all instance of currently open
screen of the target application.
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l If multiple instances of an application are open, you will see multiple screens. For example, if you have two instances of IE
open, you will see two separate screens displayed in Open Screens.

11. Select the capture type for screen objects - Standard or OCR.

Note: This option is available only for creating a screen and not when you record a screen.

l Select Standard when you are using technology such as MSAA, html etc. This option is selected by default.

l Select OCR when you want to capture objects from application images which are exposed over applications such as Citrix
or RDP. While capturing screens with OCR ensure that the screen DPI is set to Standard or 100%.
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Note: If you want to create a Logic for OCR Screens, it is recommended that you use
Import Dataset command.

l When you select OCR, parent object properties are linked to child objects automatically while creating the Screen. You can
choose to change the linking while configuring the screen for greater accuracy.

You can also choose the OCR engine to capture objects from screens:

Note: The OCR engine that you choose will be used for executing automations. It cannot
be changed when you edit a MetaBot screen. Hence, the selected OCR engine should also be
installed on the Bot Runner machines to ensure your automations do not fail.

l To use an OCR engine, you must ensure it is installed on your machine. TESSERACT is the default OCR engine.
You can also opt to capture your screen objects using MODI or TOCR.

If you are using Tesseract, you will have to install Visual C++ Redistributable for Visual Studio 2015. You can down-
load it from Microsoft’s website. To use an OCR engine, other than Tesseract, you must ensure it is installed on your
machine.

l If you select MODI and it is not installed, you are shown:

When you use MODI as your OCR engine, ensure that:

https://www.microsoft.com/en-in/download/details.aspx?id=48145
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l Microsoft Office 2003 or later is installed on your computer.

l The sub-component "Scanning, OCR, and Indexing Service Filter" (under Microsoft Office Document Ima-
ging) is selected during installation for Microsoft Office 2007.

l The component is installed separately if you are using Microsoft Office 2010 and above. Click here for
details.

l If you select TOCR and it is not installed, you are shown:

12. Click on the inFlow Inventory home screen instance to proceed.

13. The selected screen gets added to your MetaBot.

14. The next step would be adding more screens to your Assets library. Use either the 'Add Screen' or 'Record Screen' option. Refer
Adding and Recording Screens for details.

15. Let's add another screen to Assets. This screen will be used to add vendor names to the inventory repository.

16. You can configure these Screens to edit object properties which help in uniquely identifying the associated object during auto-
mation execution. Refer details in Configuring MetaBot Screens.

http://support.microsoft.com/kb/982760
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17. Let’s use these screens to create a logic to create a Vendor. Click on Logic tab. Refer Using the Workbench to create Logic for
details.

18. Click Add Logic.

19. This opens the Workbench, a place where you define the navigational flow by selecting screens/dlls, add commands, define logic,
save and play the flow to see if it works as expected.

20. Click on Vendor in the screen that was captured first. This will open a properties window near the selected object that will allow you
to configure Actions.
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21. Select LeftClick from the list of actions.

22. In Advanced Options input the Wait time for the object to load. Select Show Object Properties to view the properties that will be
used to search the object during play time.

The Object Properties are configured based on the Search Criteria selected when configuring screens. The object property selec-
ted for search is shown in blue font. For details refer Configuring MetaBot Screens.

Tip: If the selected object has dynamic properties in its search criteria, it is recommended to
use '*' in place of the actual value. For instance, change the value of property 'HTML ID' as
shown:
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Tip: If no name is displayed for the selected control, you can give an easily identifiable name
to it. You can also rename the selected control if required. Learn More.

23. Subsequently, add other screens by clicking 'Next'. For instance, the above action will navigate you to the create vendor screen
wherein you can create a vendor and add details:
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24. If your Logic requires that you add commands, select ones that are most appropriate for your logic. Learn More

25. You can also choose to add another logic from the MetaBot that you have selected.

a. Click MetaBots tab and select a Metabot from the list:
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b. This launches the MetaBot window from which you can select a Logic:

Note: You can select only those Logic that are available for the MetaBot from which you
want to add. You cannot select Logics from other MetaBots. Those are available when you
Create a new Logic from the Workbench

26. If needed, you can also add DLLs. Learn More

27. Once done, click Save.

28. You will be prompted to enter a name for this new logic that you just created. Click on Save to finish.

29. The saved actions will appear in the Logic Editor under the Actions List.
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30. Let’s run this logic to see if it works as expected. Click Run.

31. You have successfully created a MetaBot with a logic to create a Vendor in your inventory repository.

32. We will now use this Metabot in an automation task. Assuming Automation Anywhere Enterprise Client is also installed on your
machine and supports MetaBots, open the Workbench to create a new automation task.

33. Select inFlow Inventory - Create Vendor from the list of MetaBots on the top left and drag it onto the action list.

Note: These are available to other MetaBot users after the MetaBots have been Uploaded to the
Control Room and later Downloaded to the Client.

34. This invokes the MetaBot UI where you can browse and select from the list of available Logics. Select the Add Vendor logic, add
required Input Parameters as well as Output Parameters, and click Save.
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Note: You can also directly create a Logic inside a logical folder of the selected MetaBot in
the Workbench.

l To create a Logic, click New,

Note: To create a Logic by default, click on the arrow, select Metabot Logic and then
click New:

l This launches the Create Logic window. Select a MetaBot from the list of My MetaBots:
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l The Create Logic window displays a list of MetaBots, the Application for which it is created, and list of Logics if available.
Refer Using the Workbench to create Logic for details.

35. The logic gets added to your TaskBot.

Tip: If you specify any Input/Output parameters while creating a logic in the Logic editor, you
can see them here. Learn More

36. Save the task and run.

Tip: You can launch the application first and then use the logic.

37. You have successfully used a MetaBot to create a repository of vendors in your inventory management system.
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Adding and Recording a MetaBot

You can create MetaBots using the MetaBot Designer either by adding an empty MetaBot or recording a series of steps of a workflow.

Creating a New MetaBot

This creates an empty MetaBot for the selected application. You can then progressively add screens to this MetaBot at any point of time
using Add Screen and Record Screens.

Creating a MetaBot using 'New'

1. Click New MetaBot

2. Select Application Specific to create a MetaBot for a single application. Else select All Applications to create an "application
agnostic" MetaBot i.e. a MetaBot that makes use of multiple applications. Specify the name that reflects the purpose of creating the
Metabot.

Note: Click Refresh if your application is not listed. Alternately, despite 'Refresh' if it is
not listed, verify if the application is running in 'Admin' mode. If yes, restart the MetaBot
Designer in 'Admin' mode.

l When you select All Applications, the Application(s) list is disabled:
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3. Click Create to save the MetaBot.

l The MetaBots are saved in the My MetaBots folder.

Tip: Refer the detailed steps given in Creating a MetaBot.

Creating a MetaBot using 'Record'

You can also create a new MetaBot by capturing the entire process in sequence.

Recording is especially useful when you want to capture a workflow. Here, you can opt to

l Record only screens
or

l Record screens with the workflow in the form of logic.

1. Record Screen(s)

Use this option when you want to capture only screens with relevant object properties.

1. Click record

2. Specify either Application Specific or All Applications based on your workflow to capture GUI properties.
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3. Select 'Record Screen(s) option in the Record MetaBot window.

4. Click on the image in Open Screens.

l MetaBot Designer begins recording the selected screen of the application:
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Note: Each click will record the screen.

l You know you are in recording mode when you see:

5. Click Pause if you wish to stop recording for sometime but resume from where you left off.

6. Click Resume to continue recording:

Note: If an application has multiple exe's, you are required to create a separate MetaBot for
each.

2. Record Screen(s) with Logic

Use this option when you want to save the workflow in the form of Logic directly instead of configuring, calibrating and then designing a
logic flow. This will also add recorded screens to the Asset library.

Follow Steps 1 through 6. However, instead of selecting 'Record Screen(s), select 'Record Screen(s) with Logic:
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When you hit Stop, the Logic Editor is launched. Here, you can choose to edit the workflow and save as Logic.

Tip: You can also record logic with screens for an existing MetaBot using the 'Record Logic' option
in 'Logic' tab. Learn More

Adding Screens to a MetaBot using 'Add Screen'

Use this to capture a single screen for an application that is running. This will add a screen to the existing MetaBot.

To add a Screen,

1. Click 'Add Screen'

2. Select the capture type for screen objects - Standard or OCR and Click on the image in the Open Screens window. Refer details
on screen capture type in Creating a MetaBot
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Note: OCR selection is available only for Add Screen option and not for Record Screens.

3. Wait for the Screen to capture:

4. The screen is added to the current MetaBot.

Recording Screens in a MetaBot using 'Record Screens'

Recording is especially useful when you want to capture a workflow.

Use Record Screen to record all the Screens/UI elements (Menu item / Popup / context menu etc.) while you interact with the applic-
ation in a workflow mode. These UI elements cannot be captured using Add Screen.

To record a Screen:

1. Click 'Record Screen'



Copyright © 2018 Automation Anywhere, Inc. 545 https://support.automationanywhere.com

2. Click on Open Screens window

3. The screens that are captured are saved to the current MetaBot

Tip: It is recommended that you keep the zoom level of your screens to 100% while creating, record-
ing and playing your MetaBots.

Updating MetaBots

Update your MetaBots by adding to or modifying the existing one. You can add/record screens, add dll's, folders and re-upload to Con-
trol Room. You can re-configure and re-calibrate captured screens.

i.e. carry out all functions that you would when creating a new MetaBot.

Deleting MetaBots

You can delete a MetaBot or Screens and/or Dlls from a MetaBot.

Delete in one of the following ways:

1. From the 'Edit' menu:

2. Using 'Delete' button:
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Note: You can verify whether the 'Screen' to be deleted is used in multiple logic from a 'Logic
List':
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Configuring MetaBot Screens

Essentially, you need to create MetaBots in such a manner that they cover all possible run time scenarios. This will ensure that the
tasks in which they participate run without any glitches. Thus, simply capturing a screen may not help in most cases. This is where the
Configure feature comes into picture.

Use 'Configure' to edit object properties for the recorded/added screen. Here you can provide aliases such as a 'Screen Name' and a
'Screen Title'. You can also select an object to define its properties such as Name, Path, Value, ID, Class, Index, States etc and the
'Play Mode' to be used when running tasks.

The object properties have a very important objective. A set of these properties help to uniquely identify the associated object during
playback. As you would have noticed, the product intelligently selects some of these properties by default for every selected object to
get you going through most of the scenarios. However, for complex cases, you can always play with these properties to make your
MetaBots truly reliable. For instance, you can customize certain objects using the 'Custom Object' option.

1. Configure a Screen

1. Select a screen.

2. Click Configure

3. This launches the Screen Configuration editor which has options to go to Previous and Next screen, select a screen View and
Object Details. It also shows the Screen Name, Screen Title, Screen Type and Technology / OCR Engine used to capture the
screen.

4. Highlight the control which you wish to use during run-time.

l The object properties are populated in the right panel of the screen.

5. Optionally, provide a Screen Name.

Note: Screen Name is the one that we provide to the added screen, while Screen Title is the
one that appears on the screen window that is configured.

l You can rename the Screen if you feel that it would be easier for a user to identify with something else.

l Also, it is recommended that you provide a generic screen title to ensure compatibility with all situations

Note: Use ' * ' to add a generic title.

6. Screen Type allows you to figure out the object capture type that was used - Standard or OCR while adding the selected screen.
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7. Depending upon the object capture type, the system displays Technology or OCR Engine. For Standard captures, Technology is
shown as UIAutomation. For OCR automation, the system displays the OCR engine used to capture the object. For details, refer
the section on adding screens in Creating a MetaBot.

2. Configure Object Properties

You can configure the object properties using View, Selected Object Details, and Object Search Criteria. Here, you can rename the
objects, select a play type, manually link one object with another and define the search criteria that will be used for executing the auto-
mation.

1. To customize the View type of object that has been captured, select any one from the list:

2.  The Object List is populated as per the View selected.

l Custom Objects - These are the ones that you define especially when the object properties are not captured while record-
ing/capturing a screen.

To classify an object as custom, simply drag and select the area; choose whether to treat the object as Push Button, Text
Box, Static Text, Link or Image.

Note: All custom objects are highlighted with a blue outline when you select an object
whereas the non-custom objects are highlighted in red outline.
Similarly, when you mouse-over the objects custom objects are highlighted with blue-dotted
line while non-custom objects are highlighted with red-dotted line.
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When custom objects move or are re-sized, you will have to update relevant Screen(s) to reflect the same. You can achieve
this by moving and/or re-sizing those during configuration.

a. To move the customized object to a different location, click and drag it to the target location.
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b. To re-size a customized object, hold down the click button and drag the pointer as required.

l Linked Objects - These are the ones which are linked to a particular object in the screen. Objects are linked to other objects
or UI elements that can be searched easily during automation execution.

For objects that are captured using OCR, the linking is done automatically by the system and hence you do not need to link
those objects manually. However, for screens that are captured using Standard technology, you need to link objects manu-
ally. Learn More

Note: If you have html elements in your screen and you want to link those, it is recom-
mended that you configure them as custom objects and then use linking.

a. To link an object with another, select the easily identifiable object in the screen and click the icon in Linked
Objects . The easily identifiable object is the Parent object while the one that is linked to it is the Child object.

b. Move your cursor to the object that you wish to link and click the link

c. The object is now linked:

d. You can link multiple child objects to a single parent object.

e. You can also change the linking between parent and child objects. When you do so, the Bot Creator who edits the
automation that uses these objects is shown a message. Learn More

Tip: The properties of the parent and child objects can be seen separately in the
properties window when you create a Logic. When you execute the automation, the child
objects are searched on the play type of the parent object. Learn More

f. You can also de-link the objects that were linked. Click on the icon in Linked Objects.

Be aware that while de-linking objects you must ensure that they are not used in your automations.
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If the objects are already being used in automation and you click Yes, messages are shown when those auto-
mation are opened in edit mode by the Bot Creator. Learn More

l TextBox Objects - These are the objects that appear as text-boxes in the captured screen.

l StaticText Objects - These are the ones that appear as text in the captured screen.

l Co-located Objects - These are the ones that are neighboring to the currently selected object belonging to the same parent
control.
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Note: These objects are not visible in the View filter.

l Nameless Objects - These are the ones which have not been categorized in any of the other object types. These objects
are the ones that appear on the screen, but are not configured. These have unique system generated names as it enables
easy identification during Screen and Import/Export Command configuration.

Important: From Enterprise Client Metabots version 11.0 onward, these Nameless objects
are defined as TextBox or StaticText based on the object type.

The Nameless objects captured before an upgrade to the 11.0 version continue to exist as
Nameless. However, it is recommened that you assing names to those for easier iden-
tification in Import or Export automation.

3. Customize Selected Object Details

After configuring object properties, you can choose to customize the object details per your automation requirement. In the Selected
Object Details panel you can provide Name of the object, select a Play Type, and select the Object Properties to support the object
Search Type.

1. In the Selected Object Details panel, you can optionally specify an alias in the Name text-box for the same reason as renaming
Screen/Title names.

Note: Here, 'Name' is the selected object name. Specify user friendly / easily identifiable
name for the object. This is helpful when you use this screen in a task for automation.

2. Select a Play Type - whether Object, Image, Coordinate or Text.
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Note: Observe that the play type is enabled automatically depending upon the selected object
type. You may however select the one that suits the purpose of the Logic.

l Object - Use this as the play type for object selected on the basis of its object properties. This could be useful when the
selected objects are dynamic in nature; in the sense that they keep shifting their positions in the target application. This is
considered the most reliable form of automation as it is performed on the UI based elements of the object.

Tip: If object based automation execution is not possible, then you can opt for the other
play modes - Image, Coordinate, or Text.

l Image - Use this as the play type for objects selected on the basis of its image properties. This could be useful when object
based automation is not feasible or fails for certain reasons. For example, image based automation works for Citrix, RDP,
and Legacy applications such as delphi.
You can also use this option when you want to run automation to extract text from screens that were captured using OCR.
Learn More

l Coordinate - Use this as the play type for objects selected on the basis of its coordinates properties. This could be useful
when selected object is available at the same co-ordinates in the target application.

l Text - Use this as the play type for objects selected on the basis of its text properties. This could be useful when you want to
extract text from an image based object in the target application. Since the text is extracted using OCR engine while con-
figuring screens, only that OCR engine is used to execute the automations. Hence, the selected OCR engine should also
be installed on the Bot Runner machines to ensure your automations do not fail.

3. Select Properties type that you wish to use during play time from Object Search Criteria. You can choose to view select properties
or view them all. Some properties are selected by default.

Note that for objects that are not linked manually to other objects, its own search properties are used whereas for objects that are
linked to other objects using the Link option, the selected object will be searched based on search properties of the linked object
during automation execution.

You can also change the Values of the properties, if required to make your MetaBots more reliable.

Note: Properties could differ depending upon the type of object/control captured. For example,
for objects captured using OCR, the object properties show the number of times an object appears
in the screen:

4. Save when you have all screens covered for configuration.
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Tip: Use the 'Previous' and 'Next' buttons to access other screens in the MetaBot without exiting
Application Configuration.

and
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Calibrating MetaBot Screens

An application can undergo continual change during its life-cycle with improvements and newer features. MetaBot Designer's Cal-
ibration feature allows you instantly compare an existing screen with newer screen to identify those changes.

With a single click you can then upgrade the existing screen and upload it so that all the automation tasks using that screen can lever-
age the newer features.

Guide to Calibrating a Screen

1. Select a screen.

2. Click Calibrate to launch the Application Calibration editor

l The calibration screen is divided into two panels: The one on the left - Calibration Source indicates your current screen
(which needs to be calibrated) and one on the right Calibration Target (usually the latest screen) .

3. In the Calibration Source panel, the screen that has been selected from the Metabot is displayed.

4. In the Calibration Target panel the latest screen that will be used to calibrate is displayed.

5. Click Calibrate.

l You know the Calibration is successful when the following message is displayed:
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Note: You cannot calibrate screen that pop-up or do not have a title.

l The properties displayed under the screens are calibrated accordingly and displayed in the 'Calibration Result' panel:

Here you can choose to view calibration in four 'Views':

Note: MetaBot Designer provides you quick summary (in numbers and percentages) of the
newly added objects, updated ones, missing from targeted screen and matching objects that
were found.

l Once you complete the calibration, you can actually compare the screens by clicking on the objects on either panes. The
objects will be highlighted accordingly. Any unchanged object will get highlighted in both panes. And if it doesn't get high-
lighted, it indicates a change between your current screen and the calibration source.

5. Save when done.

6. Next, you can opt to retain or overwrite existing screen if a newer one is detected. You can also choose to carry forward any
existing custom object, if configured.
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Tip: Use the 'Previous' and 'Next' buttons to access other screens in the MetaBot without exit-
ing Application Calibration.

and
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Adding Folders to a MetaBot

You can bundle similar screens and Dlls together using folders. This will help you to logically manage MetaBots for ease of under-
standing and use.

i.e. Keep all the Screens/DLLs related to new employee record creation together in a folder "New Employee".

MetaBots can have any number of folders. You can also perform certain operations on a folder i.e. configure, calibrate, upload and
delete.

Note: You can add 'Folders' to 'Assets' and 'Logic'.

Guide to Creating a Folder

1. In the MetaBot Designer, click on Add folder

2. In the 'Add folder' window specify the folder name. Ensure that you use a name that reflects the type of folder created. Save by click-
ing 'Create'

l This is how a folder is displayed in the work-space window:

l Double click the folder to access related screens and dlls.

Note: Use the back button ( )if you wish to return to the main/previous window.

Moving Assets and Logic within Folders

You can move your Assets (Screens & DLLs) and Logic within Folders of a MetaBot.

l To move an Asset (even Screen or DLL individually) and/or Logic, simply drag and drop it to the target folder.
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l To move an Asset (even Screen or DLL individually) and/or Logic, a level up, select the option 'Move Up' in the context menu:

Remember - to move to a folder you need 'drag and drop' action; but to move a level up you require to use the context menu.
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Using the Workbench to create Logic

Use the Automation Anywhere Workbench to create simple manageable independent navigational flow - Logic that can be integrated
into other automation TaskBots / MetaBot Logics as and when required. Logic is a pre-configured use case of an application that lever-
ages Assets (Screens and Dlls).

The Workbench

Use the following components to create a Logic.

1. New - Use this to create a new MetaBot Logic

2. Run - Use this to run the Logic in edit mode of the Workbench

3. Save - Save a new or an edited Logic

4. Screen - Displays name of the selected screen provided during screen configuration

.
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5. Captured Object - This space displays the captured Assets (Screen or Dll).

6. Previous/Next - Use this to navigate between captured Assets (Screens and Dlls).

7. Show/Hide Assets - A toggle control used to display or hide captured Assets(Screens and Dlls).

/

8. Assets carousel -Displays captured/recorded screens and dlls in the chronology they were added. It invokes on clicking 'Show
Assets'. Offers a visual means to viewing and adding Assets. Use this to configure the required Asset to the logic.

9. Edit button - Use to edit an existing Command or Action.

Note: 'Run', 'Save' and 'Edit' are enabled when an Action/Command is configured.

10. Commands tab - Use to add Commands to the Logic.
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11. Context menu - Use to perform any of the actions given in the list:
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12. Variable Manager/Error View - Use the 'Variable Manager' to manage variables and the 'Error View' for viewing and fixing task
errors.

13. Properties Window - Use the floating 'Properties Window' to add and/or update actions.
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Creating a Logic

A Logic is a combination of 'Commands' and 'Actions'.

1. To create a Logic, click New

Note: To create a Logic by default, click on the arrow, select Metabot Logic and then click
New:

l This launches the Create Logic window. Select a MetaBot from the list of My MetaBots:

l The Create Logic window displays a list of MetaBots, the application for which it is created, and list of Logics if avail-
able.
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l If no MetaBot is present in the MetaBots folder, the Create Logic window shows only the My MetaBots folder:
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2. You can also add an existing logic by selecting a Metabot from the MetaBots panel:

Refer Using MetaBot Logic in Bots for details.

3. Configure commands and assets as per your automation work-flow.

4. To Add and/or Update various Actions to build your Logic, click on the captured Screen/Dll.

5. To add actions in Screens, select relevant action in the floating Properties window that appears when you click on an object.
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Refer Selecting Actions in Logic Editor for details on actions allowed in the Logic Editor

l The action selection depends upon the Object and Control Type selected for 'Screen' and Class and its API selected for
'DLLs'.

l Also, the properties and relevant actions are controlled by the Play Mode that has been selected while configuring the
screen.

Tip: You can identify the 'Object Type' and it's 'Play Type' based upon the icon that
appears in the title bar of the Properties window.

l All non-custom objects are highlighted with a red outline while custom objects are highlighted with a blue outline to allow
you to easily identify the object type when you select them.

Tip: You can also hover your mouse pointer to identify the object type - custom objects
are highlighted with blue-dotted line whereas non-custom objects are high-lighted with red-
dotted line.

l The name of the object is also shown as tool tip. This labeling allows you to identify and select the required object:
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l System performs the selected action at the location of the cross hair. You can place the cross hair within the corresponding
object by dragging it. You can also place the cross hair anywhere outside of the object also. This can be helpful when you
want to perform the chosen action relative to the selected object.

l Drag the cross-hair to select the precise location where you want to perform an action:

Note: If you reset the cross-hair position, ensure that you click Update to cap-
ture the click's latest position as shown:

l For objects that are difficult to recognize, you can perform a Left Click, Right Click or Double Click action relative to the tar-
get object's position. You can also use linked objects to easily identify difficult to search objects.

n Relative click is used when your target object is difficult to search and you want to configure the bot to click relative
to that particular object.
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l You can drag the cross-hair to change the click position. This could also be outside the highlighted object's
boundary.
For example, in the following illustration the space between two objects is very less. For more accuracy, you
can choose a relative click positioned away from the subsequent object.

Note: The cross-hair color is blue for custom objects and red for standard
objects.

l If you update the action from click to some other action, for example SetText, you cannot perform relative
click. The cross-hair will not be visible.

n If you have linked easily identifiable objects to other difficult to search objects during configuration, the objects will
be searched based on the parent object properties/play type during automation execution. You can view these prop-
erties in the properties window when you select Show Object Properties for the parent and child objects.

a. The linked (child) object properties are shown by default:
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b. To view the selected (parent) object properties, click on the tab corresponding to the linked object properties:

n For objects that are captured using OCR, you can view and edit the number of times it appears in the screen in the
OCR Occurrence property:

6. To add actions to a Dll, select relevant action in the floating Properties window that appears when you click on an API class.
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l Expanding your desired DLL will reveal its name-spaces and related classes.

l Select a class from the list. The supported APIs for the selected class are displayed on the right pane.

l From the list of APIs select the one for which you need to input a value.

Tip: Use an Array type variable to input values if you want to assign multiple values to
a single parameter. Learn More

l You can also choose to assign the output value to a variable. To add and edit variables in the Logic, click on Variable Man-
ager tab. Learn More

In Logic, variables are storage locations for known or unknown information. When building Logic, variables play an import-
ant role in maintaining or calculating information.
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l Also assign System Variables, if required, while configuring the Logic. Learn More
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l You can use the Error View to manage errors that occur in your Logic. Use the Error Handling command to mange those.

7. Save the Logic.

8. You can now test run the Logic by clicking Run.

Tip: Use ‘Run from this step’ option if you want to skip the earlier steps while doing a test
run.
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9. The Run Time window for a MetaBot appears towards right at the bottom of your screen:

l Click the Pause icon to pause the Logic run:

l Click the Play icon to resume playing the Logic:

l Click the Stop icon to discontinue :

Note: Once you are done creating your Logic, you can upload it to the Control Rolom for other
MetaBot users. Learn More

Object linking Messages

When you create automation using MetaBot Logics that are updated, you are shown messages based on the updates made:

1. On removing the link of an object that was used in the MetaBot Logic:
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2. On changing the linking of an object that was used in the MetaBot Logic:
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Recording Logic

At times you may want to capture the workflow directly instead of creating Screens, configuring them and then manually designing the
Logic. To enable direct capture of workflow with Screens, you can opt to record Logic for an existing MetaBot.

Remember that to record logic for a new MetaBot, you will have to use the 'Record Screen(s) with Logic' option given in 'Record' from
the MetaBot Designer panel. Learn More

However, in order to record logic for an existing MetaBot, you will have to use 'Record Logic' from Logic section of the MetaBot
Designer.

This topic describes the second option.

How to Record Logic

1. Open the target application.

2. Choose an existing MetaBot; the one that is relevant to that application.

3. Go to the Logic tab, select Record Logic.

4. Click on the image in the 'Open Screens' window to begin recording the Logic flow.
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5. This will launch the application and the MetaBot Recorder window.

6. Perform actions as required for the Logic.

Note: The MetaBot Recorder window displays the status of the current action being performed.

7. Click on Stop once done. This will launch the Logic Editor wherein you can verify whether all actions are captured or not.

8. Modify if necessary and Save the Logic.

Note: Recorded Screens are added to your Assets library.
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Selecting Actions in the Workbench

You can select various 'Actions' in the Workbench based upon the object and control type selected. Actions are allowed on HTML, .
NET and Java Swing/AWT controls.

Actions allowed on HTML controls

The following Actions are allowed on HTML Controls:

1. Click

2. DoubleClick

3. Right Click

4. Left Click

5. SetText

6. AppendText

7. GetProperty

8. GetVisibility

9. GetTotalItems

10. GetSelectedIndex

11. GetSelectedText

12. SelectItembyText

13. SelectItembyIndex

14. GetChildrenName

15. GetChildrenValue

The next section describes in brief the options available in Set Text, Append Text and Get Property.

Get Text, SetText and AppendText

Get Text, SetText and AppendText actions are available when the selected object types are Text/Text Box, Client, Password, Windows
Control or Custom Objects.

While building your Logic, remember that the properties and relevant actions are controlled by the 'Play Type' configured for the selec-
ted Screen.
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l or Action type as 'SetText', you can use keystrokes option to emulate entering text using a keyboard.

Note: In SetText, 'Keystrokes' is selected by default when the Play Type is either 'Image' or
'Coordinate.

l Use virtual keyboard to enter certain special keyboard keystrokes:

l Optionally, select 'Mask' to encrypt the keystrokes.

l Enter the required text in 'Enter Text box'. Optionally, assign a variable to 'Delay'.

l Advanced Options : Provide appropriate 'Delay' between keystrokes in 'Advanced Options'.

Provide 'Wait time for the object to exist' to allow for object load time and ensure the logic does not fail during play time.

If play type is set to 'Image' for the control, you can configure image Match and Tolerance values in percentage.

A Match value defines the extent of overall mismatch allowed between Image1 and Image2; Tolerance defines the extent of mis-
match allowed between any two pixels under comparison.

Similarly, if the play type is set to 'Object' for the control, you can select your OCR engine and configure the Tolerance values in
percentage.
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GetProperty

Use the 'Get Property' action when you want to search the objects based on their properties during play time.

When you select action as 'Get Property', you will be able to select properties names such as Object ID, Name, Value, Class, Type,
Index, Description, State, IsVisible, IsProtected etc based on the object control selected.

Tip: Use the 'IsVisible' property to identify whether a specific object is visible or not. For custom
objects, you can achieve this by using the 'GetVisibility' action; refer the next section.

GetVisibility

Use the GetVisibility action to build a logic based on an object's visibility during play time. This screen area could be a custom object or
an object with Play Type Image. The 'GetVisibility' action returns the visibility status as True or False.

To add a 'GetVisibility' action in the Logic Editor, the object should be configured for Play Type 'Image'.

Tip: GetVisibility can be combined with conditional commands such as If.
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Actions allowed on Window Controls

The following Actions are allowed on Window Controls:

1. Click

2. DoubleClick

3. RightClick

4. LeftClick

5. SetText

6. AppendText

7. GetProperty

8. GetChildrenName

9. GetChildrenValue

SetText for Window Control - Use the action type 'SetText' for Window Controls. Select the entire window and specify the action type.

Note: The Window Control for Play Type 'Object' uses keystrokes by default.
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OCR screens

For screens that are captured using OCR technology, when you select play type as Image for custom objects, you are allowed actions -
SetText, GetText, LeftClick, RightClick, DoubleClick, and GetVisibility.

l GetText - When you select GetText for play type Image for a custom object, you can choose an OCR engine to extract text while
creating a MetaBot Logic. You can choose an OCR engine other than the one selected during screen configuration for optimizing
your automation.
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Section: MetaBots - Variables
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Adding, Editing and Deleting Variables

Variables are storage locations for known or unknown information. When creating Logic, variables play an important role in main-
taining or calculating information. Variables can help you in a number of ways, from fetching online data to transferring data between
applications.

Automation Anywhere allows you to use various types of variables - locally defined or system defined in a MetaBot Logic. The fol-
lowing section describes how to add, edit and delete locally created variables.

Adding Variables to a MetaBot Logic

You can use the F2 function key to list all user and system variables that are available for insertion in a MetaBot Logic.

User defined variable types

You can create four types of variables that can be used in a MetaBot Logic - Value, List, Array, and Random.

1. Value - You can use a value type variable when you need to hold a single data point and use it in multiple places. This "place-
holder" value can represent either text or numeric data.

After you create the variable, you can use it by inserting the variable in several of the Logic Editor commands. When the value of
the variable is modified, this value is reflected in any subsequent commands.

You can also mark a value type variable as 'Regular Expression' . These, you can use when creating TaskBots /MetaBot Logics
that require pattern based searches in files, folders and window title commands.

2. List - You can use a list type variable when you need to retrieve multiple values, one by one. It is basically one dimensional place-
holder for data. 
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Common uses of list variables include:

l Sending email to multiple recipients

l Passing different values inside of a loop

l Searching multiple web addresses

The values can represent either text or numeric data.

3. Array - Use an Array type variable for creating staging areas for data that need to be retrieved by your process as it runs. It is a two-
dimensional variable that holds multiple values in a table of rows and columns.

4. Random - You can create two types of random variables: string and numerical. Random variables are useful when you need to gen-
erate a random, repetitive string or numerical set. The values are generated when you run the TaskBot / MetaBot Logic.
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Common uses of Random variables include:

l String: Generating test data as input for fields or forms

l Numerical: Generating ID numbers in batch

Parameter Types

Since MetaBot Logics can be used in TaskBots, you might want to pass on certain parameters to another TaskBot / Logic (of the same
MetaBot) when executing a Bot. For this, you can use variables and define their parameter types. Defining the type of parameters
ensures optimum use of variables across Bots.

In MetaBot Logic, you can define four types of parameters - None, Input, Output, and InputOutput.

Refer Variables - Parameter Types for details.

Editing a Variable

You can edit and modify any local variable that you have created. In addition, you can edit the pre-defined variables.
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To edit a variable, follow these steps:

1. Select the variable you want to edit.

2. Click the Edit button or right-click on the variable and select Edit. The Edit Variable window is displayed.

3. Modify the variable fields as necessary. You can change the variable type, the name, description or the method of determining
value.

4. Click Save.

Adding or Editing Description

You can add and edit description to the Value, Array, and List type variables when the Parameter Type is Input, Output, and InputOut-
put. This is highly useful as it provides contextualized help without any clicks, while using any the MetaBot Utilities/Logics on TaskBots.
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Deleting a Variable

To delete a variable, use the Variable Manager.

For instance if you 'Copy All' variables to another Logic, you might need to delete several variables that are redundant in the new nav-
igational flow.

To delete a variable,

1. Select the variable you want to delete.

2. Click the Delete button or right-click on the variable and select Delete.

3. When the confirmation message is displayed, click yes.
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Note: You can delete variables one at a time.
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System Variables

Automation Anywhere provides powerful pre-defined system variables that you can use to design Logic Blocks.

Note: Though similar, not to be confused with System Variables available in Task Editor.

System Variable types that can be used in the Logic Block include:

l Date/Time: System-related date and time variables.

l Error Handling: Error Handling related variables.

l System: Variables specific to a particular client machine.

Date/Time System Variables

You can use the set of Date and Time system variables to insert or monitor the current date and time of a system as the navigational
flow is implemented.

Tip: You can change the date format for the System Date.
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Click to change the date format:

Error Handling Variables

Use the set of Error Handling system variables to return task error line number and description.

System Type System Variables

You can use 'System' variables to include parameters in your automation task that are related to a particular computer. The variables
return actual system settings and parameters, such as RAM, CPU/RAM usage, and total RAM.

Common Use Case: These variables are useful when the performance of a system needs to be tracked during an activity; for instance
load testing.

The following table provides names, return values, and descriptions for the system-related system variables.

*When you select the System variable, a menu is displayed from which you can select the specific system variable (see steps below).
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Steps to select System from Variables:

1. Click F2 and you will see Insert Variable window.

2. Select System and click Insert; a pop up window for System Variable Option appears.

3. Click OK and insert the System Variable.



Copyright © 2018 Automation Anywhere, Inc. 593 https://support.automationanywhere.com

Variables - Parameter Types

Since MetaBot Logics can be used in other TaskBots / Logics (of the same MetaBot), you might want to pass on certain variable para-
meters to another TaskBot / MetaBot Logic when executing a Bot. For this, you can use variables and define their parameter types,
which can then be added as Input or Output Parameters in an automation.

You can add and update parameter types from Variable Manager→ Add/Edit :

Parameter Types

In MetaBot Logic, you can define four types of parameters for all variable types - None, Input, Output, and InputOutput

1. None - When you want to use the variable value only in the MetaBot Logic that it was created for, define the variable as None, You
cannot pass the value of such variables to another TaskBot or MetaBot Logic. Its value can only be read during Logic execution.

2. Input - When you want the variable to accept values from TaskBot or MetaBot Logic of the same MetaBots, define the variable as
Input Parameter Type. You can also assign any other value/variable as an Input Parameter in the automation.

3. Output - When you want to use the variable value as an output in the MetaBot Logic it was created for and pass on the value to
other TaskBot or MetaBot Logic as an Output Parameter, define the variable as Output Parameter Type.

4. InputOutput - When you want to use the variable value as both input and output in the MetaBot Logic it was created for and pass
on the value to other TaskBot or MetaBot Logic, define the variable as InputOutput Parameter Type. You can assign a value/vari-
able as an Input Parameter and a variable as an Output Parameter in the automation.

Passing parameters from and to MetaBot Logic

As an Automation Expert, when you are creating automation that comprise a combination of TaskBots and MetaBot Logics, you would
want to pass its parameter values from one to another for smooth functioning of your automation.
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Automation Anywhere allows you to pass parameters from a Logic to other TaskBots, Logics, and Dll APIs. The reverse is also possible
- you can pass parameters from TaskBots, Logics, and Dll APIs to Logics.

What is 'Passing of Parameters'?

When you create MetaBot Logic, you want to ensure that it can be optimally used in various TaskBots and MetaBot Logics. To achieve
this, you first have to create variables with different parameter types - None, Input, Output, and InputOutput.

Each variable, based on its parameter type, is then used as an input parameter or output parameter or both in a TaskBot/ MetaBot
Logic.

When it is used as an input parameter, you can add values to the variable or assign another variable as its value.

When it is used as an output parameter, you can only assign variables as its value. This will be read during automation execution.

This is passing of parameters from and to MetaBot Logic.

Refer Using MetaBot Logic in TaskBots to know how to use variables as parameters.

Refer Variables - Parameter Types for details on types of parameters.

Note: If you have upgraded from Automation Anywhere Enterprise 10.x to the current version, refer
the following sections on variable behavior while passing it as a parameter.

Passing parameters from Logic to TaskBot and from TaskBot to Logic

The table below shows the variable behavior when it is passed as a parameter from Logic to TaskBot and vice versa:

Variable type in
TaskBot (T1) / Logic
(L1)

Variable type in
TaskBot (T2) / Logic
(L2)

Behavior

Value (V1)
Value (V2) V1 overwrites V2
List (L2) V2 is converted to 1x1 list and is assigned V1's value
Array (A2) V2 is converted to 1x1 Array and is assigned V1's value

Random (R1)
Value (V2) V1 overwrites V2
List (L2) V2 is converted to 1x1 list and is assigned V1's value
Array(A2) V2 is converted to 1x1 Array and is assigned V1's value

List (L1)
Value (V2)

First index of the list is assigned when it is used outside of the loop. In
loop, the value is assigned with reference to counter. If it is outside of the
range, then first index is considered.

List (L2) V1 overwrites V2
Array (A2) V2 is converted to nx1 Array and is assigned V1's value

Array (A1)
Value (V2) You have to input row and column of V1 and its value is assigned to V2
List (L2) You have to input the column of V1 and its value is assigned to V2
Array (A2) V1 overwrites V2

Note: The target variable value is overwritten by source variable value. However target variable
type remains unchanged.

Passing parameters from Logic to API Dlls and from API Dlls to Logic

The table below shows the variable behavior when it is passed as a parameter from Logic to API Dlls and vice versa:
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Variable type being
passed from Logic Variable type of DLL API Behavior

Value (V1)
Value (V2) V1 overwrites V2
List (L2) Not supported. Read-only cell
Array (A2) Not supported. Read-only cell

Random (R1)
Value (V2) V1 overwrites V2
List (L2) Not supported. Read-only cell
Array (A2) Not supported. Read-only cell

List (L1)
Value (V2)

First index of the list is assigned when it is used outside of the loop. In
loop, the value is assigned with reference to counter. If it is outside of
the range, then first index is considered.

List (L2) V1 overwrites V2
Array (A2) Not supported.

Array - A X B (A1)

Value (V2) You have to input row and column of V1 and its value is assigned to V2
List (L2) You have to input the column of V1 and its value is assigned to V2

Array (A2) V1 overwrites V2 when V2 is A X B type. If V2 is one dimensional, you
have to input the column.

Note: You can assign output variables to value type variables only.
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Section: MetaBots in Enterprise Control Room
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Uploading MetaBots to Control Room

MetaBots can be uploaded to the Control Room from where any number of Bot Creator Clients with MetaBot license can download and
integrate them within automation tasks.

1. In the My MetaBots List, select (highlight) the MetaBot you want to upload.

2. Upload the Metabot using one of the following methods:

l In the Actions button, select Upload from the drop-down list.

l Context click the MetaBot and select Upload.

l Go to Repository in Manager, select the MetaBot, and click on Upload.
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Tip: Ensure the MetaBot is closed in the MetaBots Client. Also, note that if the cor-
responding MetaBot is the only MetaBot that is opened in the MetaBots while uploading, you
need to exit from the MetaBots Client.

Uploading MetaBots when Version Control is Enabled

When Version Control is enabled, you can upload a MetaBot to the Control Room repository with comments, after using the 'Edit'
option.

1. In the 'My MetaBots' List, select (highlight) the MetaBot you want to Edit and Upload.

2. Edit the Metabot using one of the following methods:

l In the Actions button, select Upload from the drop-down list.

l Right click the MetaBot and select Upload.

l This launches the Upload Comment window:

l Input your comments and click Save. This uploads the MetaBot to the Control Room.
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Uploading Multiple MetaBots

1. Go to Manage > Repository.

2. Select the My MetaBots folder in the Client Repository list.

3. Select multiple MetaBots (use either ctrl or shift keys as required).

4. Click the Upload button.

5. In the Upload Files window, the MetaBots that are 'Allowed' to be uploaded are selected; if required, deselect the ones that you do
not want to upload.

Tip: No prefixed icon/sign denotes a successful upload. This ensures that the version history
can be used as a reference point by the Client.

Note: MetaBots marked 'Not Allowed' cannot be uploaded; the reason for which is depicted in
the 'Remarks' column.

6. Add your 'Upload Comments' and click 'Upload'. These comments are applicable to all MetaBots that are uploaded.

Uploading Renamed MetaBots

MetaBots that are already present in the Control Room repository and are renamed from a file system cannot be reuploaded to the Con-
trol Room repository. If you attempt to upload such a MetaBot from the Client, following message appears:
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When you upload the renamed MetaBot(s) from the Repository, following messages appear:

l For a MetaBot:

l For multiple MetaBots:

You will have to revert to its original name in order to upload it.
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Creating Roles and Assigning Permissions for MetaBots

You can define user roles and assign the necessary permissions for using MetaBots in the web based Control Room from the Admin-
istration → Roles page

Creating New Roles

To define new user roles, click

In the Create Role page, input the role name:

Select View my bots feature. This will enable the Bots panel below Features panel.

You can assign permissions based on the role you wish the user to play.

Note: MetaBot users require a separate set of privileges to access the MetaBot files. Hence, the Con-
trol Room admin has to grant separate MetaBot Repository access rights at MetaBot file level, apart
from the folder rights in Which Bots and supporting files? page.

Access Permissions for MetaBot Users

To grant privileges such as Execute, Upload, Download, and Delete, click the MetaBots tab beside the TaskBots and Other Sup-
porting Files tab in the Bots panel. You can grant access privileges to a user at each MetaBot file level.
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1. Select All - User can use the MetaBot in TaskBots, upload to Control Room, download to Client, and also delete the downloaded
MetaBot.

2. Execute - User can use the Metabot in TaskBots but is not allowed to open the downloaded MetaBot in MetaBots Designer. This
allows sharing of MetaBot as a Black-boxed bot. User cannot see/modify the content of a MetaBot.

3. Upload - User can upload MetaBots.

4. Download - User can download and modify MetaBots.

5. Delete - User can delete the downloaded MetaBots.

 Note: If you grant 'Download' permission to a user, the 'Execute' permission is automatically
enabled so that a user can choose to either view/edit the content of a MetaBot that is downloaded or
not all i.e. use it as a black-box.

You can choose to provide access rights based on the role that the user is allotted.

E.g. A BotCreator Client who has access to MetaBots can be granted all permissions whereas a BotRunner Client with MetaBots
license can be granted only the 'Execute' permission.

You can verify whether the User has been created in the Roles list page. Learn More

https://support.automationanywhere.com/hc/en-us/articles/115003197894-Roles-Page
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Section: MetaBots in Enterprise Client
AISense - an overview

Automation Anywhere AISense enables intelligent automation of all the environments where object based automation is not available
or is not reliable. Following type of applications are ideally suited for automation through AISense

Business applications which are exposed over Citrix (XenDesktop and XenApp)

Applications which are accessed over Remote Desktop Protocol (RDP)

Legacy applications such as Delphi etc.

AISense scans the application screen image and uses computer vision to identify all the UI elements (e.g. Labels and Text boxes).
Post that, it automatically creates all the application UI objects from the image. All such automatically created objects are directly avail-
able for automation through MetaBot Logic. This saves a lot of time for user to manually create the objects on which automation is to be
created.

Also it creates AI powered intelligent linking among the automatically created objects. This linking enables searching of one(child)
object on the basis of other (parent) object. Intelligent linking ensures that automation continues to run reliably even when the absolute
position or relative position of child and parents undergo modification.

MetaBot "Export Dataset" facilitates bulk data extraction from any application. This is available for standard technologies (e.g. HTML,
.NET) and also for applications which are exposed as images, e.g. applications exposed over Citrix or RDP. For such applications,
AISense ensures that a single scan of application is enough to extract all the objects visible on the screen. It greatly reduces the auto-
mation execution time by a factor of 5 to 10, depending on the number of fields (objects) being extracted.

Similarly, improved MetaBot "Import Dataset" facilitates bulk data entry into any application. For Citrix/RDP type of applications, it
greatly reduces the automation execution time by a factor of 5 to 10, depending on the number of fields (objects) being entered.

For more information, follow the below mentioned articles:

l Creating a MetaBot

l Adding and Recording a MetaBot
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l Configuring MetaBot Screens

l Using Workbench to Create Logic

l Export Dataset command

l Import Dataset command

Renaming MetaBots

To rename a MetaBot, follow these steps:

1. In the 'My MetaBots' List that is available in the Automate tab of the Client, select (highlight) the MetaBot you want to rename.

2. Rename the MetaBot using one of the following methods:

l In the File menu, select Rename.

l In the Actions button, select Rename from the drop-down list.

l Right click the MetaBot and select Rename.

Tip: Ensure the MetaBot is closed in MetaBot Designer. Also, note that if the cor-
responding MetaBot is the only MetaBot that is opened in the MetaBot Designer while renam-
ing, you need to exit from MetaBot Designer.

3. In the Rename File window, specify a name for the MetaBot.

4. Click Save.

The renamed MetaBot is displayed in the My MetaBots List view.

Renaming Existing MetaBots

You can rename a MetaBot which is present only in your local machine and is not yet uploaded to Control Room. If the MetaBot is
present in Control Room, system does not allow you to rename the MetaBot since it may be used in other TaskBots and renaming it
may impact those TaskBots.

When you attempt to rename a MetaBot in the Client that already exists in the Control Room, following message appears:

Tip: It is recommended that you do not attempt to rename MetaBots from a file system.

MetaBots that are renamed from a file system cannot be uploaded again to the Control Room repository. If you attempt to upload such
a MetaBot from the Client, following message appears:
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When you upload the renamed MetaBot(s) from the Repository, following messages appear:

l For a MetaBot:

l For multiple MetaBots:

You will have to revert to its original name in order to upload it.

Renaming MetaBots if Version Control is enabled

You can rename a MetaBot in the local repository. However, note that if you rename a MetaBot and upload to the repository, it will over-
write the existing MetaBot with the previous name. The version history will be lost in such case.

l When renaming a file that has been uploaded to the server repository, you will be prompted:
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l If the file is checked out for edit, you will be prompted a message as only the local MetaBot version will be renamed :

Tip: Undo Check out to rename the MetaBot.

l If you try to upload a MetaBot that was renamed from a file system, you are shown:

Deleting MetaBots

In some cases, you might want to delete an existing MetaBot.

Tip: It is recommended that you do not attempt to delete MetaBots from a file system.

To delete a MetaBot, follow these steps:

1. In the 'My MetaBots' List, select (highlight) the MetaBot you want to delete.

2. Delete the Metabot using one of the following methods:

l In the Edit menu, select Delete.

l In the Actions button, select Delete from the drop-down list.
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l Right click the MetaBot and select Delete.

Tip: Ensure the MetaBot is closed in MetaBot Designer. Also, note that if the cor-
responding MetaBot is the only MetaBot that is opened in the MetaBot Designer while delet-
ing, you need to exit from MetaBot Designer.

3. In the Delete MetaBot? window, click on Yes.

l The MetaBot is removed from the 'My MetaBots' List view.

Note: After deleting a MetaBot, you cannot restore it in the Client. Before deleting a MetaBot,
ensure you no longer have use for that MetaBot.

Tip: As a best practice, ensure all MetaBots are copied to the Control Room repository as a way of
backing up your MetaBots.

Deleting a MetaBot if Version Control is enabled

If you have version control enabled, while deleting the MetaBot from the Client, apart from confirmation, you will be notified that it will
be deleted locally only.
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 Note: To delete the MetaBot from the Control Room repository, you will have to select it from the
relevant folder of the repository.

If the MetaBot is checked out, you will not be allowed to delete it.
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Enabling Version Control

The MetaBot Designer has an integrated feature on Version Control that allows MetaBot users to manage various versions of
MetaBots and enforce controlled edits.

 Note: Automation Anywhere supports Subversion v1.8.13 and v1.8.14 with Visual SVN Server 3.3.x

(Image as seen in Enterprise Client - MetaBot Designer version 10.3)

Control the versioning of MetaBots in Clients by enabling the feature from Automation Anywhere Enterprise Control Room.

Learn More

Using Version Control in MetaBot

To perform controlled edits to your MetaBots, use versioning to create new files, check out for edit, upload with comments and view the
version history.

You can context click the MetaBot in the 'My MetaBots' list view of the Automation Anywhere Enterprise Client.

You can also perform similar operations using Actions.

https://support.automationanywhere.com/hc/en-us/articles/230204128-Version-Control-Integration
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Tip: Ensure the MetaBot is closed in the MetaBot Designer Client. Also, note that if the cor-
responding MetaBot is the only MetaBot that is opened in the MetaBot Designer while performing these
operations, you need to exit from the MetaBot Designer Client. 

Perform the operations detailed below using either context click or 'Actions'.

1. Edit: You can edit a MetaBot from the 'My MetaBots list' provided it has been 'Uploaded' and 'Checked Out'. On editing, you are
guided to the 'Assets' view of the selected MetaBot in the MetaBot Designer. Here, you can opt to add/record screens, dll's, and
add/update Logic(s).

A new MetaBot created in the local repository (of the Client) has a plus sign ( ) appended to the MetaBot name.
Refer the article on 'Creating a MetaBot' to learn how to create a new MetaBot.

2. Check Out: A MetaBot that already exists in the Control Room repository can be checked out for editing. A check mark (
) indicates the file is checked out for editing.

The option toggles to 'Undo Checkout' once the MetaBot is checked out for editing. This enables you to undo the last update(s) to
the checked out file. Select 'Yes' to confirm:

3. Upload: Post editing, you can upload a MetaBot to the Control Room repository with comments. No prefixed icon/sign denotes a
successful upload. This ensures that the version history can be used as a reference point by the Client.

You can also opt to upload MetaBot(s) from the My MetaBots folder in the Repository.
Learn More
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4. Version History: You can view revisions to a MetaBot and if required, roll back any updates. It allows you to identify the user and rel-
evant 'Action' that was performed during a specific 'Date and time' with relevant check in 'Comments'. Learn More

5. Rename: You can rename a selected MetaBot in the local repository provided it has not been checked out. Note that if you rename
a MetaBot and upload to the repository, it will overwrite the existing MetaBot with the previous name. The version history will be lost
in such case. Learn More

6. Locate on Disk: In some cases, you might want to locate the MetaBot that is associated with an automated task you've created.

Automation Anywhere MetaBot files have the file extension of: '.mbot'

To locate a MetaBot on your computer, follow these steps:

1. In the main Automation Anywhere window, select the MetaBot in the My MetaBots List for which you want to locate the
.mbot file.

2. Either click on the Edit menu or on the Actions button, and select 'Locate on Disk'. The MetaBot files are listed in
the File Explorer.

3. Locate the automation MetaBot file. The .mbot name matches the name you've assigned to the MetaBot.

7. Delete: You can delete a MetaBot from the local repository provided it has not been checked out. Learn More
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Viewing Version History

Use Version History to view the history of updates to the selected MetaBot. Also roll back updates, if required.

On selecting Version History, you will be able to view a list of all revisions created for the selected MetaBot.

Viewing history of file versions

You can view 'Version History' of the selected MetaBot from:

1. The Context Menu:

OR

2. Actions list:

3. On selecting Version History, you will be able to view versioning details for the selected MetaBot:

The Version History is displayed in descending order of the time-stamp i.e. the latest revision at the top and the first revision at
the bottom. It allows you to identify the user and relevant 'Action' that was performed during a specific 'Date and time' with rel-
evant check in 'Comments'.
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Rollback Updates

You can also rollback the updates to a specific revision. Use this to revert updates/changes in the selected MetaBot to the selected revi-
sion from the version history.

Tip: Ensure MetaBot Designer client is closed before using Rollback.

Select the revision to which you want the updates to be rolled back and confirm:

On confirming, all the changes done since the selected revision to the latest revision will be rolled back and a success message is dis-
played:

 Note: It is recommended you check in (upload) the file once it is rolled back to the selected revi-
sion so that the latest revision(s) are reflected in the updates.
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Using MetaBot Logic in TaskBots and MetaBot Logics

You can integrate Logic in your TaskBots as well as other MetaBot Logics in the Automation Anywhere Workbench to create auto-
mation. Based on your work-flow, you can add either one or more Logic from a single MetaBot or multiple Logic from various MetaBots.

Adding MetaBot Logic to a TaskBot

1. To begin, click on the MetaBot section given at the top of the command panel in the Workbench

2. Double click/drag and drop a MetaBot from the list of MetaBots.



Copyright © 2018 Automation Anywhere, Inc. 615 https://support.automationanywhere.com

3. The MetaBot window is launched.

4. Select the desired logic from the list. If this logic needs certain values and/or variables as input and/or output, they get listed under
the Input and/or Output Parameters pane. Otherwise, the parameter tables appear empty.

l If Input and InputOutput parameter type variables are available in the Logic, you can assign a value or variable required as
an input in Input Parameters pane.

l Similarly, if Output and InputOutput parameter type variables are available in the Logic, you can assign another variable as
an output in Output Parameters pane.

l Refer Variables - Parameter Type and Passing Parameters in Automation for details.

Tip: Use the 'Search Logic' facility to navigate to the Logic you want.

5. If you have assigned variables in the logic, you will have to assign the required set of values to the Input and Output Parameters.

l You cannot leave these blank.

l You can also assign variables to the Input and/or Output Parameters from the list of variables available in the task.

Tip: If the Input and/or Output parameters require use of credentials or sensitive data,
you can opt to use 'Credential Variables'. Select the required variable listed under $Cre-
dentialVariables$ from Insert Variables. You cannot, however, pass these variables from one
TaskBot/MetaBot Logic to another TaskBot/MetaBot Logic.
Refer the article Assigning Credential Variables for details.
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6. The Description field provides information about the Logic that is being configured. The name of the user who updates the Logic
Information and the date and time it was modified is also displayed.
Similarly, you can refer the Input and Output parameter Description below the Logic description. This is added when you are cre-
ating variables.
This is highly useful as it provides contextualized help without any clicks, while using any the MetaBot Utilities/Logics in TakBots.

Tip: If you want to view the description without scrolling, hover your mouse over the Descrip-
tion field and the entire text is shown as tool tip.

Note: If your Logics and Input/Output parameters were created in 10.x versions, by default the
description is not shown. However, you can update the Logic description and that is shown once it
is edited and saved using the Properties option. Similarly, you can edit the variables to include
the parameter description.

7. Once you are done, click Save to include the MetaBot Logic in your TaskBot.

Note: During TaskBot execution, if your target application is open in admin mode, you will have to
run the task in admin mode.

The Workbench depicts the event data for Logic:

Enable Debug Logging
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The Enable Debug Logging feature helps you to collect logs that you can send to the Support Team of Automation Anywhere for invest-
igating the AAE Client issues, for example, when you are trying to troubleshoot issues.

When you enable debug logging, the system saves debug logs for the following applications and services of AAE Client:

l Main

l WorkBench

l Player

l Client Service

l Scheduler Service

l Metabot Designer

l EventWatcher

l FipsDataMigration

l Terminal Emulator

l Auto login service

l Proxy Server

To enable debug logging:

1. In the AAE Client, click Tools > Options > Advanced Settings on the Options screen.

2. Select the Enable Debug Logging check box.

By default, logging is enabled for Error and Fatal issues. If you choose the Enable Debug Logging option, the system displays "Debug
logging enabled" message in bold red on the Status Bar.

For more information on how to export logs, see Export Logs in Using Advanced Settings.

You can find the logs for the Client applications in the Application Logs and services in the Service Logs sub-folders. You can find
them in the <Log file folder selected by you>\AAE_Client_Logs_<date>_<time> folder.

Application Log Path: <Application Path>\LogFiles

Service Log Path: Common Folder Path\Automation Anywhere Client Files\LogFiles

Note: By default, the system stores maximum ten log files of 1 MB each. The system overwrites existing
log entries if they cross this limit.

In case if you have different log configuration files for applications and services, then the Enable Debug Logging check box is dis-
played in the Indeterminate state and the system displays "Debug logging enabled" message on the Status Bar.

The following table shows the different states of Enable Debug Logging check box when you enable and disable the debug logging.
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Services Applications States of Enable Debug Logging check box Description
Debug log-
ging is
enabled

Debug log-
ging is
enabled

The state of the check box is
set to selected when Debug
logging is enabled.

Debug log-
ging is dis-
abled

Debug log-
ging is
enabled

The state of the check box is
set to indeterminate when the
state of the debug logging is
different for Application and
Service or if someone edits
the log configuration file.

Debug log-
ging is
enabled

Debug log-
ging is dis-
abled

The state of the check box is
set to indeterminate when the
state of the debug logging is
different for Application and
Service or if someone edits
the log configuration file.

Debug log-
ging is dis-
abled

Debug log-
ging is dis-
abled

The state of the check box is
set to cleared, when debug
logging is not enabled for
both applications and service.

Note: If the debug log file is deleted accidentally, the system creates a new file using the default
settings when the Client applications are started or when you make any updates on the Options screen.

If the debug log file is corrupt, the system takes a backup of the existing file with file name <origFileName>_Date_Time_backup.xml
and it replaces it with the default log file when any application starts or when you open the Options screen.

For more information on how to clear logs, see Clear Logs in Using Advanced Settings.

For Auto Login, you need to configure Debug Logging manually in the Automation.Autologin.Settings.XML file because Auto Login still
follows the old logging and configuration mechanism. For more information, see"Enable Debug Logging for Auto Login" on page 460.
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Section: Frequently Asked Questions
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Automation Anywhere Client FAQs

1. How does the Client communicate with Server?

2. Can I download/upload all types of documents?

3. What is the process of registration?

4. What do I do in case of an 'Account Lockout'?

How does the Client communicate with Server?

In the main Client window click on 'Repository' tab to communicate with the server. You can directly upload, download or compare any
task on the server with the one on the client.

Can I download/upload all types of documents?

Yes. You can download/upload all types of documents.

What is the process of registration?

The first time you start the client, it will ask you to login and when you click 'Login' after inputting your credentials, you are registered
with the server (Control Room), automatically.

What do I do in case of an 'Account Lockout'?

After the minimum allowable attempts have been exhausted for logging in to the Client account, it is locked for use. It can be unlocked
only by the Control Room administrator, if a threshold value has been set in the Control Room. If the default domain policy is enabled,
you are required to contact your System Administrator.
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Files Folders FAQs

1. Can I create a file with any extension?

2. If I use a Files / Folders command like "Delete Files 'c:\MyPrgs\*.*' " , will this delete all the files in the sub-folders too?

3. Can I get list of all the file names in a folder to perform some operation on it?

4. Can I provide value for file/folder name when the task runs?

Can I create a file with any extension?

Yes, you can create file with any extension using the 'Create File' sub command in the Files/Folders command.

If I use a Files / Folders command like "Delete Files 'c:\MyPrgs\*.*' ", will this delete all the files in the sub-folders too?

No, this command will delete all the files in the current folder only. In the above example it will delete all the files in 'c:\MyPrgs' directory
only.

Can I get all the file names in a folder to perform some operation on it?

Yes, you can use the "Loop for Files in a <folder>"command.
Here $FileName$ will have next filename inside the specified folder in each Loop execution. You can use this System variable to per-
form any operation inside the Loop - End Loop block.

Can I provide value for file/folder name when the task runs?

Yes. Automation Anywhere has a 'Prompt' command to provide value at run time. You can provide value for any window, prompt for
file/folder and even prompt for yes/no as well.
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IF Condition FAQs

1. Can I execute certain commands only if a window exists?

2. Is it possible for me to know if one of my software is running or not? I want to do certain action only if that software is running.

Can I execute certain commands only if a window exists?

Yes. There are number of conditions in IF command. One of them is 'If Window Exists' .

Is it possible for me to know if one of my software is running or not? I want to do certain action only if that software is running.

Yes, you can use If Condition (If Application Running) to see if any application is running or not. You can specify the exe name that you
want to test in the If condition. For e.g. consider the following script
If Application Running ('F:\WINNT\system32\calc.exe')
   Comments: Add your commands when the Calculator program is running
End If
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Internet FAQs

1. What is E-Mail Notification?

2. What is this 'Email Settings' displayed in the Notification tab in the properties window?

3. Does your automation software provide any facility to send an email?

What is E-mail Notification?

You can use E-mail notification when you want to be notified that a task has finished running. An e-mail will be sent to the addressed
specified along with the status of the task that was running and few other properties.

What is this 'Email Settings' displayed in the Notification tab in the properties window?

This Button will open up the Options user interface that allows you to set the outgoing mail server, its port number and Exchange
Server authentications, if any. Every mail that you send or receive requires the mail server. You have to obtain this information from
your Internet E-mail provider or you may obtain it from the configuration section of your e-mail program.

Does your automation software provide any facility to send an email?

Yes, Automation Anywhere provides a command 'Send mail'. You can use this command to send e-mails to anyone. Note that this com-
mand will get information about the e-mail Server, its port number and Exchange Server authentications, if any, from the Mail Setting in
the Options menu every time a task runs.
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Loops FAQs

1. What is a Loop Command?

2. I want to do particular action on all the folders inside a folder. How do I do that using your automation software?

3. Can I get all the file names inside a folder using the Loop command?

What is a Loop Command?

A loop command allows repeated execution of a group of commands when these commands are placed inside the 'Loop “ End Loop"'
block. The number of the times these commands are executed will depend on the type of Loop command selected. The 'Loop - End
Loop' block might also contain within it another 'Loop - End Loop' block i.e. nested loop commands.

I want to do particular action on all the folders inside a folder. How do I do that using your automation software?

You can use the Loop command (Start Loop 'Each folder in '<folder>') in Automation Anywhere. If there are 'n'™ folders in the specified
folder then this loop will be executed 'n'™ times. You can get each folder's name using the $FolderName$ system variable inside this
loop block.

Can I get all the file names inside a folder using the Loop command?

Yes, you can get the file name using the System variable $FileName$ inside a specified folder by using the Loop command " Start
Loop'Each File' in '<folder>'.



Copyright © 2018 Automation Anywhere, Inc. 625 https://support.automationanywhere.com

Manage Windows Control FAQs

1. How to use and manage Windows Controls to get check-box or radio button status in Automation Anywhere?

2. Does a task recorded using MWC work in the background?

3. Why aren't some controls highlighted when I try to capture them using MWC?

How to use and manage Windows Controls to get check-box or radio button status in Automation Anywhere?

Manage Windows Controls command allows you to work with windows controls like check-boxes and radio buttons. With this com-
mand you can find out if the radio button or check box is checked or not. Automation Anywhere supports only standard Windows
check-boxes and radio buttons.

Click on Manage Windows Control in Task Editor and select the appropriate radio button. Select the window to capture the check box
or radio button. The value captured can be assigned to a variable.

Does a task recorded using MWC work in the background?

Yes. A task recorded using MWC works in the background.

Why aren't some controls highlighted when I try to capture them using MWC?

We capture standard Windows control using MWC. Client controls and Java are not supported by MWC. In such cases, controls are not
highlighted.
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Moved Icons-Menus FAQs

1. I recorded a task that opens a program from Start Menu > Programs and while running the task, the menu to open that program has
moved. It clicks on a wrong program name and hence opens a wrong program. Do I need to re-record the task?

2. Will my task run correctly even if files, program shortcut icons in the Quick Launch and the Desktop have moved?

I recorded a task that opens a program from Start Menu > Programs and while running the task, the menu to open that program has
moved. It clicks on a wrong program name and hence opens a wrong program. Do I need to re-record the task?

No, the SMART Automation Technology built into Automation Anywhere provides a powerful feature that lets you use your original
task. You can check an option from Tools > Options >'Move Icons/Menus' . After selecting this option when you run a task it opens the
same program that was opened while recording even if the menus have moved.

Will my task run correctly even if files, program shortcut icons in the Quick Launch and the Desktop have moved?

Apart from a few exceptions, opening of most of the files and shortcut icons from both Quick Launch and Desktop will run correctly if the
icons have moved from their original location. Note that, the 'Move Icons/Menus' should be checked in Tools > Options menu for this
feature to be enabled.
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Report Designer FAQs

1. What is Report Designer?

2. Can I print my report generated by Report Designer?

What is Report Designer?

Report Designer allows you to create your custom reports. Automation Anywhere features Task Run (i.e. whether they were successful
or not), Task Timeline(i.e. run, created, modified and deleted), Workflow Run, Workflow Timeline, ROI and Visual Logs reports.

Reports can be generated by day, week, month as well as 'all time'. You can also generate a report for a custom date range.

Can I print my reports generated by Report Designer?

Yes. You can print a report generated by Report Designer directly from Automation Anywhere. Just click on the Print logo in the top left
corner of the graph.
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Recordings FAQs

1. How do I record a task using Automation Anywhere?

2. Does it matter if the window size and locations of my applications change between recording and running?

3. Do I need to finish all my work in one application before moving onto the next application or can I switch back and forth between
various applications while recording?

4. Can Automation Anywhere work if computer is locked? Can I record a task to unlock the computer?

5. Is it possible to execute a task in stealth mode when computer is locked?

6. Can I stop the task while it is running?

7. Can I pause the task while it is running?

8. Can my recorded activity run in background, while I have control of mouse and keyboard so that I can do other things?

9. I use remote access software to access a remote machine. Can I record a task that performs activities using remote access soft-
ware?

10. I recorded a task on 'abc.xls' but I want to run it on xyz.xls, how do I do that?

11. Is it possible to password protect my task?

How do I record a task using Automation Anywhere?

You can easily create new task using SMART task recorder. Click 'RECORD'; perform the activities on your computer that you want to
record, click 'STOP' and then 'SAVE' the recorded activities to a task. You can playback your recorded actions by selecting the task and
then click the 'RUN' button. For further details refer to the Help file.

Does it matter if the window size and locations of my applications change between recording and running?

No. Automation Anywhere's SMART Automation Technology automatically adjust to changes of window size and location.

Do I need to finish all my work in one application before moving onto the next application or can I switch back and forth between vari-
ous applications while recording?

You can switch back and forth between various applications while recording.

Can Automation Anywhere work if computer is locked? Can I record a task to unlock the computer?

Yes. Automation Anywhere offers secure Auto Login technology. Auto Login allows scheduled tasks to run even when computer is
locked. When you schedule a task you can enable Auto Login capability. If Auto Login in enabled, and if computer is locked, Auto-
mation Anywhere will unlock the computer, run the task and lock it back.

Is it possible to execute a task in stealth mode when computer is locked?

Yes. To enable the task to run in stealth mode check Properties->Security-> Run this task in stealth mode option. This will hide the exe-
cution of the task. To allow the task to run when computer is locked, enable Auto Login capability. Auto Login allows scheduled tasks to
run even when computer is locked. When you schedule a task you can enable Auto Login capability.

An additional security option can also be set, where if you want to lock mouse and keyboard while task is running, just select 'Disable
mouse and keyboard for this task' option from Properties->Security.

Can I stop the task while it is running?

Yes. Hold the Escape Key for 2-3 seconds.

Can I pause the task while it is running?

Yes. Press â€P̃auseâ€™ on your keyboard. This will temporarily stop the execution of the task. Click on the â€R̃esumeâ€™ button that
will appear at the bottom right hand corner of your screen to continue running the task from where it was paused.

Can my recorded activity run in background, while I have control of mouse and keyboard so that I can do other things?

One of the distinguishing features of Automation Anywhere is its ability to run tasks in background. Advanced technologies like Web
recorder, Object recorder and hundreds of powerful actions allow you to run many of your tasks in background. Few tasks like task
recorded with standard recorder requires control of mouse and keyboard and therefore cannot run in background. Few other obvious
exceptions include commands that requires screen, like taking screenshots or comparing images on the screen, but a vast majority of
actions allow the task to run in the background.
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I use remote access software to access a remote machine. Can I record a task that performs activities using remote access software?

Yes. Automation Anywhere supports all the remote access software.

I recorded task on 'abc.xls' but I want to run it on xyz.xls, how do I do that?

You can run the same task with different files of the same program. By default the task will only run on the specific file(s) it was recor-
ded on. However you can check 'Enable this task to run with other similar files and windows' option under the Properties>General tab.
Now for example if you recorded a task on abc.xls, you can run this task on def.xls, xyz.xls or any other *.xls files

Is it possible to password protect my task?

Yes, it is possible to password protect a task. While saving the task click on the Password Protection checkbox and specify the pass-
word. Alternatively, you can password protect a saved task by going into the Security tab in the main screen of Automation Anywhere.
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Scripting FAQs

1. I have been using VBScripts and JScript to accomplish some of my routine work. Can I somehow reuse them in your automation
software?

2. How do I know if my Script ran without any Error?

I have been using VBScripts and JScript to accomplish some of my routine work. Can I somehow reuse them in your automation soft-
ware?

Yes. Not only you can integrate disparate scripts like VBScripts & JScripts within an Automation Anywhere task but you can use in-built
automation services like repeat, notification, etc., on VBScript & JScripts as well. For more information about Automation Anywhere
check Automation Software.

Automation Anywhere Editor has a command 'Run Script' . You can use this command to Run your VBScript or JScript files from Auto-
mation Anywhere. You can even pass arguments to your VBScript and JScript files as you might have been doing it to run it through
command prompt. You can also have return values, if any, to your VBScripts and JScript files.

How do I know if my Script ran without any Error?

You can use the 'If Script Successful' sub-command inside the 'If command'. This command will run the script and will execute the 'If -
End If' block only if the script ran successfully.

http://www.automationanywhere.com/products/automation-software.htm
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Tasks FAQs

1. Can I run many tasks in a batch?

2. When I use "Run Task" command, how do I know if the task has successfully completed?

Can I run many tasks in a batch?

Yes, You can create a new task in which you can use 'Run Task' command to run your individual tasks.

When I use "Run Task" command, how do I know if the task successfully completed?

You can use the 'If Task Successful' sub-command inside the 'If command'. This command will run the task and will execute the 'If - End
If' block only if the task ran successfully.
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Triggers FAQs

1. Can I execute a task based on availability or non-availability of any file, folder, performance or service?

2. Is there any way to get an alert whenever I receive a new email?

Can I execute a task based on availability or non-availability of any file, folder, performance or service?

Yes, it is possible to execute a task with Triggers, based on availability or non-availability of any file, folder, performance or service.
There are triggers based on Window (open or close), File (create, delete, renamed or modified), Performance (CPU usage, free disk
space, process count) and Process and Services.

Is there a way to perform a task when a new email arrives?

Yes. Automation Anywhere has a trigger functionality that can perform any task when a new email arrives. You need to set the'Email
Message Trigger' on the task.
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Variables FAQs

1. How do I use a variable in the task?

2. If I create a variable for one task, can I use it in another task?

3. List variables can have many different text values. When I use the list variable which value will be executed?

4. Is it possible to store special characters like Tab key in a variable?

5. I have to run a task that needs to use a different value for a variable in every repeat. How do I do that with your automation soft-
ware?

6. What are these System Variables $CurrentDirectory$, $FolderName$ and $FileName$?

How do I use a variable in the task?

You can use variable inside different commands like'Insert Keystrok', 'Open Program/File','Files/Folders'. In all the commands variable
names are specified by enclosing the variable names in between the $ sign. For e.g. $Password$         

If I create a variable for one task, can I use it in another task?

Variables created for one task are only available locally for that task and not for any other task. But, if you have upgraded from a lower
version to version 5.5 and above, all the variables created in the lower versions will be available to you as global variables that can be
used with any task.

List variable can have many different text values. When I use the list variable which value will be executed?

Every time a task comes across a list variable during the playback, the next text value in the sequence of the list variable is used. If the
list variable reaches the last text value then its subsequent reference will return the first text value.

Is it possible to store special characters like Tab key in a variable?

Yes, you can store any special character as a text value in a variable.

I have to run a task that needs to use a different value for a variable in every repeat. How do I do that with your automation software?

Automation Anywhere provides "Loop â€“ End Loop" commands. You can place your repetitive task inside a Loop â€“  End Loop block.
You can use a List variable inside it for data that keeps on changing with each loop.

What are these System Variables $CurrentDirectory$, $FolderName$ and $FileName$?

These system variables are used with commands 'Loop for Folders in a folder' or 'Loop for Files in a folder'.

Consider a command in the task - "Loop for Folders in a <folder>".
Here the <folder> is the specified folder on which the Loop will execute. Its full path is available at execution time by the system vari-
able "$CurrentDirectory$"
If <folder> has 'n' number of folders, the loop will be executed 'n' times. Each time the $FolderName$  variable will have the next
folder's name inside the specified folder.

Now if the task is like "Loop for Files in a <folder>".
Then $FileName$ will represent the next file name inside the specified folder.
Outside the loop $CurrentDirectory$, $FolderName$ and $FileName$ doesn't have any usage.
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Visualize Technology FAQs

1. What is Visualize Technology in Automation Anywhere?

2. What is SnapPoint in Automation Anywhere?

3. What is Image Recognition in Automation Anywhere?

What is Visualize Technology in Automation Anywhere?

Automation Anywhere has an in-built Visualize Technology that allows for pictorial and storyboard views of the automated task. Visu-
alize Technology is used in the different views in Task Editor, to capture images on demand with SnapPoint and Image Recognition
with the IF command.

What is SnapPoint in Automation Anywhere?

In Automation Anywhere when a task is recorded the images of all mouse clicks and keystrokes are captured automatically. But when
a task is created in Task Editor the images need to be captured on demand. SnapPoint allows you to capture images on demand; just
enable SnapPoint and set it for the commands that you want.

What is Image Recognition in Automation Anywhere?

Image Recognition is another feature of the Visualize Technology available in Automation Anywhere. Image Recognition allows the
recognition and comparison of images. It allows your automated task to "see".

http://www.automationanywhere.com/features/visualize.htm
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Web Recorder FAQs

1. What is a Web Recorder?

2. What is Web Data Extraction? How do you extract data with Web Recorder?

3. How do you check for broken links with Web Recorder?

4. What is Manage Web Control?

5. Can Automation Anywhere automate web based processes? If yes, what type of websites can be automated?

What is a Web Recorder?

Web Recorder reliably and accurately records and automates web based tasks. Automation Anywhere Web Recorder understands all
the web controls. You can open or close browser, perform clicks, fill forms, import data from the web, download files, extract data,
extract source, check for broken links and much more.

What is web data extraction? How do you extract data with Web Recorder?

Extracting structured or unstructured data from the Internet automatically with the help of scripts is web data extraction or screen scrap-
ing. Automation Anywhere as a data extraction or screen scraping software is both flexible to suit any kind of web technology or page
format and is also non-intrusive.

See two demos below to see how to use Automation Anywhere web recorder for data extraction.
Demo 1: Web data Extraction using intelligent pattern matching technology
Demo 2: Web data Extraction demo 2

Learn more on Web Data Extraction and Screen Scraping.

How do you check for broken links with Web Recorder?

To check for broken links with Web Recorder, go to Task Editor and select Web Recorder -> Find Broken Links command. Enter the
URL and specify if you want the entire website to be checked or just the specified webpage. Enter the path of the file to save the results
and click Save. Automation Anywhere will check for broken links as specified. You can schedule to run this task at pre-defined time.

What is Manage Web Control?

To capture image links, radio buttons, text boxes, check boxes and other web controls Automation Anywhere Web Recorder -> Man-
age Web Controls allows capture of web controls and assign them variables.

Can Automation Anywhere automate web based processes? If yes, what type of websites can be automated?

Yes. Automation Anywhere can automate web based processes with its Web Automation capability. You can automate any website,
even complex websites that use javascript, AJAX, Flash or iFrames.

Learn more on Web Automation

http://www.automationanywhere.com/solutions/webDataExt.htm
http://www.automationanywhere.com/solutions/screenScrape.htm
http://www.automationanywhere.com/solutions/screenScrape.htm
http://www.automationanywhere.com/lrn/keyFeat/wdePattern.htm
http://www.automationanywhere.com/lrn/keyFeat/wdeStructured.htm
http://www.automationanywhere.com/solutions/webDataExt.htm
http://www.automationanywhere.com/solutions/screenScrape.htm
http://www.automationanywhere.com/solutions/webautomation.htm
http://www.automationanywhere.com/solutions/webautomation.htm
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Workflow Designer FAQs

1. What is Workflow Designer?

2. How do I use Workflow Designer?

3. How do I run Workflows?

What is Workflow Designer?

Workflow Designer allows you to create an easy to understand, intuitive graphical representation of a IT or a business processes. Auto-
mation Anywhere allows any user (Business or IT) to easily create end to end business workflows.

How do I use Workflow Designer?

Open Workflow Designer (Shortcut Ctrl+K). Drag-n-drop the objects from the toolkit to design an entire business process.
Workflow Designer provides four objects to design a Workflow:

l Start

l Run Task

l Condition (IF)

l End

How do I run workflows?

Running a workflow is very easy. Just click on the Run button in the Workflow Designer. The other option is to click on the workflow in
'MyWorkflow' file in the Task List and click Run.

On running the workflow through the Workflow Designer, it highlights the part of the workflow that is being carried out. Once, the work-
flow has completed running, it highlights the complete path taken.
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AAE - Integration With Version Control System - FAQs And Best Practices

Overview

Automation Anywhere Enterprise (AAE) provides a direct integration with Subversion (a Version Control System - VCS) so as to man-
age the life-cycle of Automation Tasks. 

When Subversion is configured with AAE Control Room, most of the Subversion features such as check-in, check-out, undo check-out,
version history etc. are available to the Bot Consumers. 

This document provides answers to some of the Frequently Asked Questions and also provides a guidance (Dos and Don’ts) on VCS
Integration. 

FAQs

Q: What all Subversion versions are supported by AAE?
A: Currently AAE supports Subversion 1.8.13, 1.8.14 and 1.7.2. We recommend that you use the 1.8.13 and 1.8.14 version. 

Q: Does AAE support the latest version of Subversion?
A: No. The latest version of Subversion is not officially certified. 

Q: Can I use any front-end for Subversion E.g. Visual SVN Server, Tortoise etc.? Or will that affect AAE integration? 
A: You can use any front-end for Subversion. AAE directly communicates with Subversion and will not communicate with the front-end
application. However, we strongly recommend that you DO NOT perform any operation on the Automation Bots from the front-end
Application. 

Q: Do you support any other Version Control System other than Subversion E.g. TFS, GitHub? 
A: No. AAE currently only integrates with Subversion.

Q: I have hosted my Subversion on Unix. Will it work with AAE?
A: Yes. However, we test and certify Subversion hosted on Windows. 

Q: I understand that I can enable/disable VCS anytime time from the Control Room settings. Is there any downside to using this option
frequently?
A: We recommend that if VCS is enabled, DO NOT DISABLE THAT unless absolutely required. Disabling VCS means that you will lose
the version history and the base version of the Bots will be created again.

Q: What happens if my Subversion repository is changed? Say, my existing repository gets corrupt and I have to create a new one OR I
have to move the Subversion from one system to another.
A: Again, changing the Subversion repository means that you will lose the version history of the bots as the base version will be cre-
ated again. 

Q: Can I bring the version history if the Subversion repository changes? 
A: You can ONLY do that via external tool (e.g. Visual SVN Server, TortoiseSVN). With AAE, it’s not possible.

Q: What happens if I rename the Bot in AAE Client?
A: A new file will be created (with the new name) in Subversion; and that will be the base version. 

Q: I have Bots whose file size is large. Will I get any indication in AAE on the Subversion Repository size (consumed and remaining
space)
A: No. You have to ensure that enough space is allotted to Subversion repository. 

Q: What happens if the network breaks when I am uploading / downloading a file? 
A: In such case, ensure that the file is present in the Control Room repository. In the worst case, you will have a copy of the file on the
Bot Creator machine (upload scenario) OR you will have a copy of the file in the Control Room Repository (download scenario). 

Q: Is there any file upload/download time-out? Can I configure that?
A: Yes. Please follow these steps:

1. Navigate to the AAE Client Installation folder (e.g. C:\Program Files (x86)\Automation Anywhere Enterprise 10.3\Client)

2. Locate and open the file AAClientService.exe.config

3. Locate the section RequestTimeOutInSecond

4. Increase its value (by default the value is 15; you can increase that to 60)

5. Restart the AAClientService and check if you are able to upload/download the file. 
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Q: What happens if Control Room is upgraded? Will the VCS integration work? 
A: Yes. (If you are upgrading from Control Room 10.2 to 10.3, you have to connect to VCS again; for version later than 10.3, the VCS
state is maintained)

Q: What happens if the Subversion repository is connected to multiple applications?
A: It should be okay. However, do not make changes to Automation Bots from any external tool e.g. Visual SVN Server, TortoiseSVN
etc.

Q: Can I connect the Subversion repository with multiple Control Rooms?
A: No. 

Q. I have Development, Test and Production Control Rooms. Can I have SVN for each of the Control Rooms?
A. We recommend that Subversion should ONLY be configured for Development Control Room. Test and Production Control Rooms
should not be configured with a Version Control System.

Q: I am not able to connect to Subversion from the AAE Control Room. What do I do?
A: Check the debug logs. They will be generated in the WebCR.log file located in Public Documents (e.g. C:\User-
s\Public\Documents\Automation Anywhere Server Files\Logs) 

Q: My AAE Control Room repository is getting changed. Will that affect Subversion?
A: No.

Q: I have my AAE Control Room hosted on High Availability – Disaster Recovery mode (multiple IIS). Will that impact Subversion? 
A: No. 

Q: I want to control the way Subversion versions the file. Can I do that? 
A: No. Subversion has its own method for versioning files. You cannot change that. 

Q: What if the Subversion repository gets corrupted?
A: We recommend that you back-up the Subversion repository periodically. Refer the Subversion help on back-up.

Q: Can I connect to an existing Subversion repository (non empty)? 
A: No. The repository has to be empty. 

Dos

1. Subversion repository and Control Room repository should be on same machine for optimal performance. 

2. When you enable VCS from a disabled state; make sure to click on 'connect' to upload the base version. 

3. When base version is getting uploaded; stay on the Control Room page; only the partial base versions will be uploaded. Do not
close the control Room application. To check whether files are getting base versioned (uploaded); open the Subversion in browser
and check the files are indeed getting added to the repository. 

4. When resetting base version (when connecting to a new Subversion repository) ; make sure Control Room has got the latest and
greatest. 

Don’ts

1. Do not do any backend operation - on Control Room and Subversion repository (such as renaming file, updating file info.dat) 

2. AAE Client should not connect to multiple Control Rooms; in any case; whether VCS enabled or not. 

3. Do not manually copy the task from one AAE Client to another; we recommend that you upload it to Control Room and download it
to the other AAE Client. 

4. Don’t use any front end UI (TortoiseSVN, Visual SVN) to manage automation tasks in VCS 

5. When resetting base version (when connecting to a new Subversion repository); make sure Control Room has got the latest and
greatest. 
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Java Automation FAQs

This article provides answers to frequently asked questions for Java Automation.

Note: From AAE 10 SP2 onwards, the desktop (standalone) Java applications (running on JRE 6 or later
versions) can be automated without installing the AAE Java Plugin; as AAE provides support to automate
dynamic Java Applications (Standalone Java Applications that run from a packaged JRE). To automate web
based Java applications, you still need the AAE Java Plugin.

1. What do I need to do to automate my Java application via AAE?
To automate a Java application, you will need to install the AAE Java Plugin from the Tools > Options > Plugin Settings > Java of
AAE Client.

2. Why is admin access required to install the Java Plugin?
The Java plugin installation copies a few files into the JRE application path (ONLY if the files are not present) and enables the Java
Access Bridge in the ‘Ease of Access Centre’ (in Control Panel).
Both the above actions require Administrator privileges and hence admin access is required to install the Java plugin.

3. I want to automate multiple Java applications (running on different versions of JREs) at the same time. Is that possible?
Once you install the Java Plugin (via Tools -> Options -> Plugin Settings -> Java of AAE Client), navigate to the Java Settings panel
(Tools -> Options -> Java Settings of AAE Client). You will notice that the plugin has been installed in all the JRE versions that are
installed on the system. This enables AAE to automate multiple Java applications running these different versions of JREs

4. Do I need to reinstall the plugin if I install an additional JRE?
No; if the JRE version is 1.8 or greater.
Yes; otherwise.

5. Do I need to install the AAE Java plugin if I want to automate a website having Java controls?
Yes. The Java control will make use of the JRE of the AAE Client machine and hence Java plugin is mandatory to be installed to
automate a Java Control on a web-page.

6. What does the Java plugin do?
The Java plugin will copy few files into the JRE installation path; the versions of the files will be different for 32-bit and 64-bit Oper-
ating System.

The following files will be copied to the ‘JRE installation folder\bin’ path ONLY if they are not present.

l JavaAccessBridge.dll

l JAWTAccessBridge.dll

l WindowAcessBridge.dll

The following files will be copied to ‘JRE installation folder\lib\ext’ path ONLY if they are not present.

l Access-bridge.jar

l Jaccess.jar

l jaccess-1_2.jar

l jaccess-1_3.jar

The following file will be copied to ‘JRE installation path\lib’ path IRRESPECTIVE of the JRE version:

l Accessibility.properties.

In addition to the above, it also enables the Java Accessibility Bridge in ‘Ease of Access Centre’ in Control Panel.

7. Are all the above files (e.g. Access-bridge.jar, Jaccess.jar etc.) Oracle files?
Yes

8. Will the above files be copied in each of the JRE version?
Yes; ONLY if they do not exist in the JRE. When you install Java Plugin, the accessibility.properties file will he modified in all the
JRE versions.

9. What if Oracle updates an existing JRE? Will that impact the Java plugin?
Yes. If the JRE version is less than 1.8, the Java plugin may get un-installed as part of JRE update. We recommend that you re-
install the Java plugin in such case.
For JRE versions 1.8 and later, you do not need to re-install the Java Plugin even if the JRE is updated.

10. Why are there 2 options to install Java plugin?
The recommended option to install the Java Plugin is Tools > Options > Plugin settings > of AAE Client.
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However, if a new version of JRE is installed on the system, you can add the AAE Plugin to that via Tools > Options > Java Settings
of AAE Client.
Also if there is a custom JRE, you can add the Java plugin to that via Tools > Options > Java Settings.

11. Can I install the plugin via command-line?
Yes. Refer the Java Plugin section in Using Plugin Settings. 

12. What are the options for command-line installation?
Refer the Java Plugin section in Using Plugin Settings. 

13. Can I install the Java plugin in a silent mode?
Yes, Refer the Java Plugin section in Using Plugin Settings.

14. What if I ONLY use the Tools > Options > Java Settings of AAE Client, and not install Java plugin via Plugin Settings (Tools >
Options > Plugin Settings > Java)?
It will not work. For initial use, you must install the Java plugin from the Tools > Options > Plugin Settings > Java. You can then use
the Tools > Options > Java Settings to install Java plugin in custom JREs.

15. Do I need to run the Java application in Admin mode to automate?
If AAE Client is run in Admin mode or ‘Run Task as an Administrator’ is enabled in Tools > Options > Runtime settings, the Java
application has to run in Admin mode.
The state of AAE Client, AAE Player and Java application must be the same; either all run in Admin or all run in non-Admin.

16. What do I need to do to install the Java plugin manually?
Follow the link below to install the Java Access Bridge.
http://docs.oracle.com/javase/accessbridge/2.0.2/setup.htm#installing-jab-64-bit 

http://docs.oracle.com/javase/accessbridge/2.0.2/setup.htm#installing-jab-64-bit
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Other FAQs

1. I recorded a task that opens a program from Start Menu > Programs and while running the task, the menu to open that program has
moved. It clicks on a wrong program name and hence opens a wrong program. Do I need to re-record the task?

2. Will my task run correctly even if files, program shortcut icons in the Quick Launch and the Desktop have moved?

3. Can I get the snapshot and/or log data into file when error occurs?

4. My scheduled tasks do not run?

5. My task is big. How do I test only a few commands that I have added in the task?

6. I want to copy a command and use it at many places. Do I need to create the command every time?

7. I have created a keystroke which contains complex sequence of keys, which I use repeatedly in many of my task. Do I need to copy
the keystroke every time I need to create a new task?

8. I have recorded a task that can be repeated as it is; only one text has to be replaced every time. I need to enter this text while run-
ning the task. How do I do that in your automation software?

9. Can I edit multiple commands at the same time? Is it possible to replace window title in all commands?

10. What happens to a triggered or scheduled task if a high priority task is already running?

11. Can I use Automation Anywhere as a macro recorder?

12. Can I use Automation Anywhere to integrate Excel commands with other applications?

13. How does Automation Anywhere carry out database automation?

I recorded a task that opens a program from Start Menu > Programs and while running the task, the menu to open that program has
moved. It clicks on a wrong program name and hence opens a wrong program. Do I need to re-record the task?

No, the SMART Automation Technology built into Automation Anywhere provides a powerful feature that lets you use your original
task. You can check an option from Tools > Options >'Move Icons/Menus' . After selecting this option when you run a task it opens the
same program that was opened while recording even if the menus have moved.

Will my task run correctly even if files, program shortcut icons in the Quick Launch and the Desktop have moved?

Apart from a few exceptions, opening of most of the files and shortcut icons from both Quick Launch and Desktop will run correctly if the
icons have moved from their original location. Note that, the 'Move Icons/Menus' should be checked in Tools > Options menu for this
feature to be enabled.

Can I get the snapshot and/or log data into file when error occurs?

Yes, Automation Anywhere has advanced error handling capabilities. You can select action like Continue or Stop Task. You can spe-
cify error handling options like Take Snapshot, Run Task, Log data into file, Send Email and Variable Assignment.

My scheduled tasks do not run?

If your scheduled tasks don't run, follow the simple checklist to fix the problem.

1. Ensure that you have provided the username/password: For security reasons Windows XP requires your Windows XP username &
password to run scheduled task. For more information on what to do if you don't have password read Why username/password?
On any other Windows operating system, if your account requires a password to log on, then you need to provide that password
while scheduling the task, otherwise you don't need to provide a password.

2. If you have multiple account ensure that you have provided the correct username/password: If you have multiple accounts on same
computer like one domain account and one local account, please make sure the username that you have provided is the same
username you have used to login to the computer. The tasks will not work if you scheduled the task using one user Account and
now you are logged into another user Account. Automation Anywhere automatically fills the username that you are logged in as.

3. Check Status in Control Panel->Scheduled Tasks window: Please go to Control Panel->Scheduled Tasks window. Select the task
that corresponds to your task (it start with your task name) and right-click and select 'Run'. See if it runs. If it does not run please see
what the 'Status' column shows.

4. Schedule Calculator Application: If your task still doesn't run go to Control Panel->Scheduled Tasks. Click on Add Scheduled Task.
From the list of applications, please select Calculator as shown below. If the calculator does not run then your scheduler service is
not installed correctly on your computer.
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My task is big. How do I test only a few commands in the task?

Select the command that you do not want to run. Right-click and select 'Disable'. Save the task and run it. while running the task it will
not run the commands that are disabled. To enable the commands again right-click and select 'Enable'.

I want to copy a command and use it at many places. Do I need to create the command every time?

No. You can use the 'Duplicate' function by Right click on command and select 'Duplicate'. This command Duplicates the currently
selected command. You can then just drag the newly created command using mouse.

I have created a keystroke that contains complex sequence of keys that I use repeatedly in many of my tasks. Do I need to copy the
Keystroke every time I need to create a new task?

No. You can right click on that Keystroke and click on 'Convert To Variable'. You can then save the keystroke as a variable.

I have recorded a task that can be repeated as it is; only one text has to be replaced every time. I need to enter this text while run-
ning. How do I do that in your automation software?

1. Open the Task in the Editor

2. Right click on the Keystroke which you have to enter every time.

3. Click on the "Convert to Prompt" in the pop-up menu.

4. Enter the message that should be displayed which running.

5. Save the task.

6. While running, a dialog box will appear that will ask you to input the text that you wanted to enter.

7. Once you click ok then entered text will be typed.

Can I edit multiple commands at the same time? Is it possible to replace window title in all commands?

Yes. Bulk Edit is available for commands like keystrokes and delay. Select multiple commands of keystrokes or delay and right click on
it. Select'Bulk Edit' option; specify the new details for the selected commands.

To replace the window title, select any command that has a window in it; right click and select 'Change Window Title' option. You can
replace particular command's window title or you can change all commands windows title in a task.

What happens to a triggered or scheduled task if a high priority task is already running?

In the above case currently running high priority task will continue and all other task will be in queue.

Automation Anywhere features advanced task-queuing technology. This technology ensures that every task will complete based on its
priority, regardless of how many other tasks interrupt the running task.

The order of execution is decided by the priority (high, medium and low). If two tasks in a queue have the same priority, the pre-
cedence is decided by the category (triggered, scheduled and manual) of the tasks. Thus, if the two tasks have the same priority, a
triggered task has higher precedence, followed by scheduled tasks, then manual tasks.

Can I use Automation Anywhere as a macro recorder?

Automation Anywhere can be used as an intelligent keyboard macro recorder and mouse macro recorder that allows you to easily cre-
ate, edit and run macros.

l Automate keystrokes and save thousands of clicks to automate repetitive tasks.

l Record keyboard & mouse macros or use point & click wizards to create automated tasks in minutes.

l To learn more: http://www.automationanywhere.com/landing/macro-recorder.htm

Can I use Automation Anywhere to integrate Excel commands with other applications?

Automation Anywhere has an advanced Excel integration and Excel automation feature. Automation Anywhere allows automation of
data transfer between Excel and any web or windows based application like Salesforce, SAP, Access, SQL, etc.

Learn more on Excel Automation.

How does Automation Anywhere carry out database automation?

Automation Anywhere works with any SQL databases like Oracle, MS SQL, Sybase, etc. to transfer, maintain or update databases.
Automation Anywhere's database automation solution can take data from various databases, web and in-house applications, collate

http://www.automationanywhere.com/landing/macro-recorder.htm
http://www.automationanywhere.com/landing/macro-recorder.htm
http://www.automationanywhere.com/landing/macro-recorder.htm
http://www.automationanywhere.com/solutions/excelautomation.htm
http://www.automationanywhere.com/solutions/excelautomation.htm
http://www.automationanywhere.com/solutions/datatransfer.htm
http://www.automationanywhere.com/solutions/excelautomation.htm
http://www.automationanywhere.com/solutions/database-automation.htm
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them and generate reports.

Learn more on Database Automation.

http://www.automationanywhere.com/solutions/database-automation.htm
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Common Error Messages

This section provides you with information about common error messages that Automation Anywhere issues.

ERROR 429: ActiveX Component Can't Create Object

l Description: Error occurs due to problem in loading the User Interface of TA/AA

l Solution: 'Run Time Error 429' surfaces when the 'GDIPlusWrapper.dll' gets corrupted. You can type the below mentioned com-
mand under Start - Run - cmd:

For Windows 7 32 bit - regsvr32 C:\WINDOWS\system32\GDIPlusWrapper.dll

For Windows 7 64 bit - regsvr32 C:\WINDOWS\sysWOW64\GDIPlusWrapper.dll

Also See...

l Enabling the Debugging Option
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Client Login Errors

As a user when you try to login to Client, you may get the following errors depending on the input that is provided:

Error-1: Login Unsuccessful

You will get the above error in the following cases:

l When you provide invalid UserName and/or password

l The user you are trying to login as has been not been created in Control Room

l The user you are trying to login as has not been allotted a license (Development/Runtime) in the Control Room

l You have not verified your user account using the email sent from Control Room

l The user you are trying to login as has been deactivated in the Control Room

l The user you are trying to login as has already been registered into the Control Room from a different machine

l The user you are trying to login as has registered to the Control Room under different Windows credentials

Remedial Actions

l Provide valid UserName and password

l Check with your Control Room admin that the user you are trying to login as indeed exists in the Control Room

l Check with your Control Room admin that the user you are trying to login as has been allotted either a Development or Runtime
license in Control Room

l Verify your Automation account using the mail sent from Control Room (in cases where Control Room is configured with outgoing
mail server). This verification mail will have the subject “Your Automation Account is Created”

l Check with your Control Room admin that the user that you are trying to login as has 'Active' status in Control Room

l Check with your Control Room admin whether the user you are trying to login as has already registered into Control Room from a
different machine. If yes, you will not be able to login

l Windows Credential check. This can be better explained with the below mentioned example:

Valid Login Scenario:

l Tom logs in into his laptop (say TomLaptop) using his Windows Credentials (say Tom.Watson)

l Tom starts the AAE Client and puts in his AAE UserName (say Tom_AAE) and a valid password into the AAE Client Login window
and registers to the Control Room

l Tom_AAE user has now registered into the Control Room from TomLaptop under Tom.Watson Windows Account

Invalid Scenario: Machine Change> Login Failure
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l Tom’s laptop crashes and Tom gets a new temporary laptop (TempLaptop)

l Tom logs in into TempLaptop with his Windows Credentials (Tom.Watson), installs AAE Client on TempLaptop and tries to login
as Tom_AAE user from the AAE Client

l Tom will NOT be logged in as Tom_AAE,as user has already been registered from TomLaptop.

l Control Room Admin deletes Tom_AAE user from Control Room

l Control Room Admin creates new user with the same name (Tom_AAE)

l Tom can then login as Tom_AAE from TempLaptop

l Tom_AAE user has been registered into Control Room from TempLaptop under Tom.Watson Windows Credentials.

Invalid Scenario: Windows Credentials Change> Login Failure

l John logs in into TempLaptop using his Windows Credentials (say John.Smith)

l John starts AAE Client and puts in Tom’s AAE UserName (Tom_AAE) and a valid password into the AAE Client Login Window

l John will NOT be able to login into AAE Client; as that user (Tom_AAE) has already registered under Tom.Watson Windows cre-
dentials

Error-2: Unable to Connect to Server

You will get the above error in the following cases:

l The Control Room URL provided in the login is incorrect

l The AAE Client machine is not able to connect to Control Room URL

Remedial Actions

l Check that the Control Room URL mentioned in the login is correct

l Open a web-browser on the AAE Client machine and navigate to the Control Room URL. You should be able to see a login screen
if you are not logged in into the Control Room

l Ensure that the port mentioned in the Control Room URL is open for communication
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Error-3: Invalid User Name / Password

/

You will get this error if any of the User Name or password field is not provided

Remedial Action

l Provide a valid UserName and password

Error-4: Forgot Password

You will get this message when you click on ‘Forgot Password’ on the AAE Client login

Remedial Actions

For Control Room configured without SMTP (outgoing mail server): Contact the Control Room Admin and request him/her to reset the
password against your user

For Control Room configured with SMTP:

l Open the Control Room in a web-browser

l You will get the login window.

l On the login window, provide your AAE username and click ‘Forgot Password’ on the web-page.

l You will get a confirmation mail on your registered email account that will enable you to reset your AAE password.
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Error-5: Invalid Certificate

You might face an invalid certificate error when you log on to your Control Room instance from the Client if the Control Room cer-
tificate:

l Is not present

l Is invalid

l Has expired

l Is from an untrusted authority

Note: The above error message will only be shown if the AAE Client machine has the following
registry entry:
HKEY_LOCAL_MACHINE\SOFTWARE\Automation Anywhere\ValidateServerCertificate with value as 1.

Remedial Action

Contact your Control Room administrator.

Error-6: Version Mismatch

When you log on to a Control Room of either higher or lower version, you are shown a version mismatch error.

Remedial Action

Contact your Control Room administrator to ensure you have the compatible versions of Control Room and Client installed.
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Error-7: Active Bot Session

When you try to log on to your Client using a different machine, you are shown the above error if a Bot is deployed to the Client session
that is already active on a previous machine. This is possible if your Control Room is configured to support a Floating license model.

Remedial Action

1. If you want to log on to another machine, terminate the Bot session i.e. the player that is active on the previous machine by clicking

2. Wait for the TaskBot to complete and then log on to the other machine.

Error-8: Password policy updated

When you provide your old credentials during Client Login/ Re-Login or Auto-Login after the password policy is updated in the Control
Room, you are shown:

Remedial Action

You will have to update your password from the Control Room interface to login.

1. Click Yes to launch the Control Room in your default browser.

Note: If you want to choose to login later, you can click No. You will then stay on the Client
login page.

2. Login using your credentials.
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3. You are shown the password update page:

4. Change your password to one that meets the new password policy requirements and save.

5. You can now login to the Client.
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Enabling the Debugging Option

Automation Anywhere provides a facility that enables you to debug your more complex automation tasks. Debugging tasks can be use-
ful for automating longer, more complicated business or IT processes.

To enable the debugging option, follow these steps:

1. Open the task in the Task Editor.

2. Click on the Debug menu, and select Enable Debugging.

3. Use the toolbar to insert breakpoints in your task.

4. Debug the task line-by-line using the Step Over (F10) functionality.

You can use the Set SnapPoint feature in a task to capture images of the task while it runs.

Using the Debugging Option

You can use the Debugging option to do the following:

l To debug your task one command at a time, insert a breakpoint next to each command. This makes the task pause at the break-
point.

l To insert a breakpoint, select a command and insert a breakpoint by clicking F9.

l To remove a breakpoint, select the command and click F9.

l Select the Step Over feature to move one command at a time.

l To clear all breakpoints, click Clear All Breakpoints.

l To stop debugging, click on the Debug menu and select Disable Debugging.

Note: Automation Anywhere does not save debugging information and breakpoints. When you close
the Task Editor, all breakpoints are lost.

Also See...

l Using the Error View

l Logging into Windows when Application Paths Change
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Frequently Asked Questions

l How does a user register as a Client with Automation Anywhere?

l Will a change in the domain name affect the working of my Client?

l Why is the client only able to view the 'Run' button?

l How do I copy an Excel cell and move to the next cell in the record?

l How do I paste data in an application and move to the next item?

l How do I create time stamps for files using Automation Anywhere system variables?

l What is the recommended way to open an application as part of a task?

How does a user register as a Client with Automation Anywhere?

1. Launch Automation Anywhere by clicking the Automation Anywhere Client icon.

2. In the Client Login window, click on the Server Settings link.

3. Enter the Server IP Address. If the client is on the same system as the server, enter 'localhost'.

4. Select the server Port used for the server.

5. Click on Apply and OK.

6. In the main client window, click on the Tools menu and select Server Communication.

7. Enter the user name and password provided while registering the client in the Automation AnywhereEnterprise Control Room.

8. Click the Login button.

9. If registered correctly, the message 'Registration Successful' is displayed.

Will a change in the domain name affect the working of my Client?

Yes. The Client that has already been registered and has a domain change, will have to be re-registered as the domain name is
required especially while scheduling tasks and using the Auto-Login feature.

Note You can verify the correct Domain Name in the Machine Information section of Control Room for
that particular Client.

The Client that has had a domain name changed, can do any of the following (in the sequence mentioned):

1. Change the Application Path in Tools > Options > Advanced Settings. This will ensure that all the data that was available in the
earlier path is available to the Client in the current domain.

2. Create a New Client. However, it is recommended that you use this option as a last resort.

Why is the client only able to view the 'Run' button?

If the Server Administrator does not grant permissions to a client, the client cannot view privileges other than Run.

1. To procure adequate permissions, request Create Task permissions from your Server Administrator.

2. The Administrator grants the Create Task privilege using the Enterprise Control Room, in the Client Control Center, using the Client
Information section.

3. For Upload, Download, Delete, and View privileges for a particular folder on the server, request Access Control List permissions
from the Enterprise Control Room.

4. After the Access Control List is updated in the Client Control Center and the Create Task privilege is granted, the client must re-
login.

5. The client should now be able to communicate with the server using the new privileges.
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How do I copy an Excel cell and move to the next cell in the record?

When you highlight the Excel cell and use Ctrl+C to copy a cell, it copies an extra ENTER keystroke with the data. To copy only the cell,
follow these steps:

1. Use the following keystrokes:

These keystrokes copy the cell data.

2. To move the cursor to the next cell after copying the current cell, use the following keystrokes:

l ENTER to move one row down in the same column

l TAB to move to the next cell to the RIGHT in the same row

l Shift + ENTER ( [SHIFT DOWN][ENTER][SHIFT UP] ) to move one row up in the same column

l Shift + TAB ( [SHIFT DOWN][TAB][SHIFT UP] ) to move to the next cell to the LEFT in the same row

l To skip a cell, use the corresponding key twice. For example, to move RIGHT to alternate cells, you must enter [TAB][TAB]

How do I paste data in an application and move to the next item?

Most applications support the keyboard shortcut Ctrl+V to paste data that has been copied to the clipboard. To paste the data using the
keyboard, follow these steps:

1. Ensure that the cursor is in the correct cell in a table, or in the correct control in a browser page, etc.

2. Type Ctrl+V. To simulate Ctrl+V in Automation Anywhere, use: [CTRL DOWN]v[CTRL UP].

These keystrokes will paste the data in your application.

3. Use the following examples as a guide in how to move to the next record or cell in your application using the keyboard:

l Use the TAB key to move from a highlighted link to the next link in an Internet Explorer web page.

l Use the [RIGHT ARROW] to move to the next cell in the same row in a Microsoft Word table.

l Some applications also support using the Space bar to move to the next control or button.

How do I create time stamps for files using Automation Anywhere system variables?

Automation Anywhere provides the following system variables that you can use to append time stamps:

l Year

l Month

l Day

l Hour

l Minute

l Second

l Date

You can combine these variables to create a custom time stamp.
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Examples:

l To append Year, Month, and Day at the end of ABC, you can use:

ABC$Year$$Month$$Day$

l To create a complete time stamp with date and time, you can use:

ABC$Year$$Month$$Day$$Hour$$Minute$$Second$

l You can also include text characters between the variables, for example:

ABC$Year$-$Month$-$Day$

l To configure your own format for the Date variable, click on the Tools menu and select Variable Manager. Click on System Variable
and then Date. If you use the Date variable to append a date to file names, be sure no slashes (/) exist in the date format, because
file names in Windows might not use the / character.

What is the recommended way to open an application as part of a task?

The recommended methods for opening an application in a task include:

l When you record a task, double-click the application icon on the desktop.

l Click on the Start menu, and then Programs. Select the application.

If the location of these icons change, resulting in an error when the task runs, follow these recommendations:

1. Open the task in the Task Editor.

2. Select the actions that involve navigating to menu items and clicking. They might involve several mouse moves and mouse clicks.

3. Delete these actions.

4. Replace them with single-line commands that you create by double-clicking the Open Program/File command and specifying the
path to the application. The Open Program/File dialog includes a text box in which you can type parameters that Automation Any-
where can pass to the application.

5. The task can now open your application, regardless of where the icon is located.
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Logging into Windows when Application Paths Change

Occasionally, the application path for your Automation Anywhere tasks might require changing. For security reasons, you can set the
Windows Login option in Advanced Settings to change the application path of your tasks.

Follow the steps given below:

1. Go to Tools -> Options -> Advanced Settings

2. Select the Application Path check-box if un-checked.

3. Click on the browse button

l The Windows Login command window is invoked:

4. Enter these parameters:

l Username: Enter the user name you created in User Accounts. How do I create a User Name and Password?

l Password: Enter the password that is associated with your user account.

l Domain Name: Specify the domain name. If not specified, the Windows Login uses the computer's domain name.

The new application path takes effect after you restart Automation Anywhere.
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Object Cloning Command - Unable to find <object property name>

The Show Tip functionality of Automation Anywhere helps you easily understand and thereby rectify the error pertaining to object not
found that is encountered when using the Object Cloning/SMART Recorder command.

On execution of a task, if an object is not found you will be shown an error that takes into consideration the various parameters that
have been input.

To view the message click on 'Show Tip' link. This will display a possible solution. If however, this does not suffice, you can click on the
'Learn more' link which will guide you to this topic.

Tips displayed

While using wild-card when the Search criteria do not match

1. Click on Show Tip link on the Error Message.

2. The Error messages clearly indicates the object not found with recommended action.

3. The user can try modifying the Search Criteria with Wild Card.

4. Use * for specific properties.

5. One can use * at beginning, end or middle for any property.

6. One can also view the same tip details in Test Log as shown below.

<content missing>

More Tips as per Technology when Object not found

l MSAA: If object not found and HTML Properties are checked in Search Criteria then Provide wildcard support in value or Uncheck
HTML properties like HTML Href, HTML InnerText.

If object not found and HTML Properties are not checked in Search Criteria then check other Unique properties like Name, Value,
Parent, Index

l Silverlight: If object not found then check other Unique properties like Name, Value, Parent, Content

l Flex: If object not found then check other Unique properties like Name, Value, ObjectID, Parent

l UI Automation:

l Java: If object not found then check other Unique properties like Name, Value, ObjectID, Parent, Index

l HTML: If object is not found then check other Unique properties like HTML Tag, HTML Tag-Index, HTML Name, HTML ID.

If object not found and HTML Properties are checked in Search Criteria then Provide wild-card support in value or Un-check HTML
properties like HTML Href, HTML InnerText

When to modify Search Criteria when objects do not have common/default properties

1. Click on Show Tip link on the Error Message.

2. The Error messages clearly indicates the object not found with recommended action.

3. Modify the search criteria to include unique object properties for the test to execute successfully.
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4. If object property is dynamically changes during run time, try un-checking properties, and the object will be found.

5. One can also view the same tip details in Test Log as shown below.

<content missing>

Below table displays the main search criteria for different objects with respect to various technologies.

Textbox/Static Text Link/Image Other
1. Common to All Type Type Type

Path Path Path

2. .NET/WPF Name Name Name
Object ID Object ID Object ID

3. Silverlight Parent Parent Parent
Name Name Name

4. Flex Class Class Class
Index Index Index

5. MSAA Name Name Name

6. MSAA-HTML HTML ID HTML Href HTML ID
HTML Name HTML Name HTML Name
HTML Inner Text HTML Inner Text

7. HTML HTML Value HTML Href HTML Value
HTML Tag HTML Inner Text HTML Tag
HTML Type HTML Value HTML Type
HTML Title HTML Tag HTML Title
HTML Name HTML Type HTML Name
HTML ID HTML Title HTML ID
HTML TagIndex HTML Name HTML TagIndex

HTML ID
HTML TagIndex

HTML Frame Src HTML Frame Src HTML Frame Src
HTML Frame Name HTML Frame Name HTML Frame Name
HTML Frame Path HTML Frame Path HTML Frame Path
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Troubleshooting Object Cloning

This topic explains you what to do when you are unable to capture objects in Internet and/or Intranet websites using Object Cloning
Command.

If you are unable to capture objects in Internet and/or Intranet websites using Object Cloning Command, consider checking the security
settings that are used for that site.

Go to Internet Explorer > Settings > Internet Options > Security.

For Websites Not Assigned to Security Zone

In case the website is not assigned to any security zone inInternet Explorer,level of security set for the Internet zone is applied to it by
default. To capture objects from such websites using Object Cloning Command, set the security level at Medium-high or lower.

For Websites Assigned to Security Zone

l To capture objects in Local Intranet Websites

If your website is assigned only to Local Intranet security zone in Internet Explorer, set the level of security in Local Intranet to
Medium-high or lower and turn off ActiveX Filter.



Copyright © 2018 Automation Anywhere, Inc. 659 https://support.automationanywhere.com

l To capture objects in Local Intranet Websites assigned to Trusted zone

If your Local Intranet website is assigned to Trusted sites security zone in Internet Explorer, set the level of security in Trusted sites
to Medium-high or lower and turn off ActiveX Filter.
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l To capture objects in Internet Websites

For websites in Internet zone, set the level of security in Internet to Medium-high or lower.

l To capture objects in Internet Websites assigned to Trusted zone
If the Internet website is assigned to Trusted sites security zone in Internet Explorer, set the level of security in Trusted sites to
Medium-high or lower.
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Troubleshooting Information

These topics provide troubleshooting information to help you diagnose and fix problems that might arise while installing, configuring,
and using an Automation Anywhere client.

Information pertaining to the following has been described:

l Troubleshooting Installation Issues

l Running a Task - Troubleshooting

l Scheduling - Troubleshooting

l Auto-Login Issues

l Triggers not working correctly with Microsoft Office files

l Capture button disabled in Web Recorder despite clicking Launch

Troubleshooting Installation Issues

1.Error while unpacking program, code LP5

If you receive an error while unpacking the program code, you might need to add Automation Anywhere to the firewall exceptions list.

Follow these steps to add Automation Anywhere to the exceptions list:

1. Open the Windows Control Panel (all items view).

2. Click on the Windows Firewall icon.

3. Click on the "Allow a program through Windows Firewall" link in the left blue pane.

4. Click on the Change Settings button.

5. Allow an existing exception by completing these steps:

a. On the left side, check the program exception name box to allow the program through Windows Firewall.

b. Check (allow) the box for each Private or Public network location for which you want the program to have access through
Windows Firewall.

6. Add a program exception by completing the following steps:

a. Click on the "Allow another program" button.

b. If the Automation Anywhere program is listed, click on the program to highlight it.

c. If the Automation Anywhere program is not listed, click on the Browse button and navigate to: "C:\Program Files\Automation
Anywhere\Automation Anywhere.exe" This is the Automation Anywhere executable file location.

d. Click the Open button.

e. Click the Add button.

7. When done, click OK.

8. Close the Windows Firewall window.

2. MSSTDFMT.DLL Error Windows 7 only

If you receive this error message, follow these steps to resolve it:

1. Download the file 'mssfdfmt.zip' from the location:

2. http://www.dll-files.com/dllindex/dll-files.shtml?msstdfmt

3. Save this file to any location on your system and extract it.

4. Copy the MSSTDFMT.DLL file from the downloaded folder and paste it to this folder location: 'C:\Windows\syswow64\sysWOW64'

5. In the folder 'sysWoW64', locate the file 'cmd.exe'.

6. Right click on 'cmd.exe' and click on 'Run as administrator'. A Windows command prompt window is displayed showing 'C: \Win-
dows\system32>'

7. Type: Regsvr32 C:\Windows\SysWOW64\MSSTDFMT.DLL and press Enter to register the file.

Completing these steps should resolve the error.
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Back to the top

Running a Task - Troubleshooting

A task that contains Microsoft Excel commands runs very slowly. In this case, follow these steps:

1. Disable Debug mode.

2. Remove or reduce Delay commands by 1 second.

3. Minimize the Excel files. While Excel is in a maximized state, it displays the user interface, consuming resources.

4. Stop capturing screen shots while running the task. Follow these steps:

a. On the Automation Anywhere main window, click on the Tools menu and select Options.

b. Select Run Time Settings.

c. Uncheck the option: "Capture Screenshots while Running a Task".

Be aware that screenshots will not be captured while running the task, so monitoring progress is more difficult.

Back to the top

Scheduling - Troubleshooting

1. Scheduled Task Not Running

If a scheduled task fails to run using the scheduler, follow these steps to resolve the problem:

1. Ensure that you specify the correct Windows user name and password.

l If your account requires a password to log on, specify that password when scheduling tasks. Otherwise, no password is
required.

2. If you have multiple accounts, ensure that you have provided the correct user name and password. If you have multiple accounts
on the same computer (such as a domain account and a local account), verify that the user name provided is the same as that used
to log onto the computer.

3. Scheduled tasks do not run if you schedule them using a user account different from that logged on. Automation Anywhere auto-
matically fills in the user name that was used to log in.

4. Check the status in Control Panel by completing the following steps:

a. Open the Windows Control Panel and go to Administrative Tools > Task Scheduler.

b. Select the task corresponding to your task (the name begins with your task name) and right-click on it.

c. Click on Run to verify that the task runs.

l If the task does not run, check the Status column and go to Step

Schedule the Calculator Application by completing these steps:

1. Open the Control Panel and click on Administrative Tools.

2. Click on the Task Scheduler.

3. In the Active Tasks drop-down, select Calculator (see figure below). If the calculator does not run, the scheduler service is not
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installed properly on your computer.

To verify that it is running, complete the following steps:

1. Click on the Windows Control Panel and select Administrative Tools and then Services.

2. Verify that the status of the Task Scheduler service reads 'Running.'

3. If the Task Scheduler is not running, right-click on it and select Start. Also, ensure that the 'Startup type' is set to 'Automatic'. This
starts the service automatically the next time you start your system.

l Restart the Task Scheduler.

If the Task Scheduler still fails to run, complete the following steps:

1. Click on the Windows Control Panel and select Scheduled Tasks.

2. In the Advanced Menu, click 'Stop using Task Scheduler.'

3. Wait 10 minutes.

4. Click on 'Start using Task Scheduler.'

2. Migrating schedules to a newer version

If using a version prior to 8.0, you are required to migrate schedules in the Client from earlier versions to the latest one.

A schedule migration utility, bundled within the setup, is available post installation. Run this utility to save time on automating path
updates, which are now required to run the older schedules, successfully.

All you need to do is:

1. Run the migration utility without Admin privileges to migrate all the schedules by the logged in user. A logged in user need only
provide his/her Windows credentials

2. Run migration utility with Admin privileges to migrate all the schedules pushed by the Control Room admin. User will need to
provide their Windows credentials to complete this activity.
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Note: After migration, all schedules of earlier version, pushed by the Control Room admin will be
visible to the user. However, the new schedules will continue to remain invisible on the Client side.

Schedule migration utility path:

<AA Installation Path>\AutomationScheduleMigration.exe

For instance:

C:\Program Files (x86)\Automation Anywhere Enterprise 8.0\Client\AutomationScheduleMigration.exe

Back to the top

Auto-Login Issues

You have issue with Auto-Login? Check the below:

l Ensure that SAS.dll is present in system32 (e.g. C:\Windows\System32) folder in case of Windows 7 OS and above. If it is not there,
then copy the same from the product installation folder (e.g. C:\Program Files\Automation Anywhere 7.1\Client\32-Bit OR from 64-
Bit; depending on OS)

l Verify for proper working of Ctr+Alt+Del:

l Registry: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System\SoftwareSASGeneration

l Value: Dword 3

l Verify Auto-Login Registry and value.

[HKEY_CLASSES_ROOT\CLSID\{75A22DF0-B81D-46ed-B119-CD30507BD614}]@="Automation.CredentialProvider"

[HKEY_CLASSES_ROOT\CLSID\{75A22DF0-B81D-46ed-B119-CD30507BD614}\In-
procServer32]@="Automation.CredentialProvider.dll""ThreadingModel"="Apartment"

l Verify Auto-Login service is enabled and running.

l Goto services.msc -> 'Automation Anywhere Enterprise Auto Login Service'
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l Credentials cross-check:

1. Select Task > Provide schedule > Enter window authentication credentials with domain e.g. User name :domain\username
& Password

2. If the schedule has been successfully added, go to Tools > Option > Auto-login Settings. Check the username and pass-
word.

l It should match.

Back to the top

Triggers not working correctly with Microsoft Office files

To use a trigger for Microsoft Office file when a file is modified, we need to use the condition for File -> When file is renamed.

The trigger will be fired correctly for modified as well as renamed conditions. This is the inherent behavior for Microsoft Office.

Back to the top

Capture button disabled for options 'Extract Source' and 'Execute Java Script' in Web Recorder command

The 'Capture' button will get enabled for options:

l Extract Source - if the page that is launched has an iFrame.

l Execute Java Script - if the page that is launched has a java-script.

Back to the top

Contact Technical Support

After completing the previous steps, if you are unable to run your task using the Task Scheduler, it is likely that the Scheduler service is
not installed correctly on your computer. Please contact Automation Anywhere Technical Support for further assistance.

http://www.automationanywhere.com/support/openSupportCase.htm
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Using the Error View

The Automation Anywhere Task Editor provides two options for viewing and fixing task errors and working with task variables. To activ-
ate the Error View and the Variable Manager, click on these links:

Error View

Use the Error View to manage errors that occur in your tasks. This view is automatically updated when the Error Handling feature is
used.

Variable Manager

Use the Variable Manager to create and manage variables that you use in your tasks. You can add, edit, or delete local (user-defined)
variables.
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Variable Watch Table

Use the Variable Watch Table to track the values of your variables. The Variable Watch Table is enabled when you enable Debug
Mode by clicking on the Enable Debugging link.

You can move the Variable Watch Table, as well as expand it as required.

To view how variables dynamically change, click the Add or Remove buttons. You can view both user-defined variables and system
variables.

Use the Variable Watch Table as part of your debugging process.

Also See...

l Logging into Windows when Application Paths Change
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